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Welcome
Welcome to DaVinci Resolve for Mac, Linux and Windows!
DaVinci is the world’s most trusted name in color and has been used to grade more
Hollywood films, TV shows, and commercials than anything else. With DaVinci Resolve,
you get a complete set of editing, advanced color correction, professional Fairlight
audio post production tools and Fusion visual effects combined in one application so
you can edit, compose, grade, mix and master deliverables from start to finish, all in a
single tool!
DaVinci Resolve has the features professional editors, colorists, audio engineers and
VFX artists need, and is built on completely modern technology with advanced audio,
color and image processing that goes far beyond what any other system can do.
With this release, we hope to inspire creativity by letting you work in a comfortable,
familiar way, while also giving you an entirely new creative toolset that will help you cut
and finish projects at higher quality than ever before!
We hope you enjoy reading this manual. With its customizable interface and
keyboard shortcuts, DaVinci Resolve is easy to learn, especially if you’re switching from
another editor, and has all of the tools you need to create breathtaking, high end work!
The DaVinci Resolve Engineering Team

Grant Petty
CEO Blackmagic Design
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Chapter 1

General
Improvements
DaVinci Resolve 17 introduces many improvements that extend to all the
different pages in the program. In addition, there have been fundamental
changes and enhancements made to DaVinci Resolve’s basic functionality.
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Overall Interface Improvements
This section covers some of the most visible improvements to the DaVinci Resolve
user experience.

Transitions, Titles, and Effects Thumbnail View
In order to make the selection of Transitions, Titles, and Effects more intuitive, DaVinci Resolve
now shows each effect as a thumbnail representation in addition to the text name. This allows
the user to quickly scan through all the numerous options to select the appropriate effect
visually, rather than remembering them based on name alone. You can now preview transitions
and titles before you place them on the Timeline to quickly audition multiple options before
making your final decision.

Transitions Thumbnails
To preview a transition before you place it into the Timeline, ensure that “Hover Scrub Preview”
is checked in the Transitions option menu, then simply hover your pointer over any transition in
the Transitions tab and move it across the thumbnail. The transition will preview in the Viewer
using the two clips nearest the smart indicator in the Cut page, or the two clips nearest the the
playhead in the Edit page.

Scrubbing over a Transition Thumbnail previews the transition in the Viewer.

Once you’ve chosen your transition, it can be applied by dragging it from the Transitions tab to
any edit point on your Timeline in the Edit page. In the Cut page, you can either select the
thumbnail and then select one of the transition alignment tools at the bottom of the Transitions
tab, drag it directly to an edit point in the upper or lower Timelines, or simply double click the
transition to insert it at the smart indicator position.

Titles Thumbnails
To audition titles before you place them into the Timeline, ensure that “Hover Scrub Preview” is
checked in the Titles option menu, then simply hover your pointer over any thumbnail in the
Titles tab. If the title is animated (i.e., Fusion titles), moving the pointer across the thumbnail will
preview the animation. Once you’ve chosen your title, you can drag it from the Titles tab to your
Timeline in the Edit page or in the Cut page to either the upper or lower Timelines, or use the
editing selection modes at the bottom of the tab.
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Scrubbing over a Title Thumbnail previews the title in the Viewer.

Effects Thumbnails
A thumbnail icon now represents each specific effect available in DaVinci Resolve.

Video Effects
To preview a video effect before placing it on a clip, ensure that “Hover Scrub Preview” is
checked in the Effects option menu, then simply hover your pointer over any thumbnail in the
Effects tab and move it across the thumbnail. The effect will preview in the Viewer using its
default parameters, and scrub through the clip that is selected in the Timeline. If no clip is
selected then it will use the clip currently under the playhead.
To activate a specific video effect on a clip, simply drag the thumbnail of the selected effect to a
clip on the Timeline. In the Cut page, you can also double click the thumbnail to apply the effect
to the selected clip. To adjust the effect’s parameters, open the Effects tab in the inspector.

Scrubbing over an Effect Thumbnail previews that effect in the Viewer.

Audio Effects
To activate a specific audio effect on a clip, simply drag the thumbnail of the selected effect to a
clip on the upper or lower Timelines in the Cut page, or onto a clip in an audio track on the Edit
page. Once the effect has been dropped on a clip, its audio plug-in controls will open for you to
adjust the plug-in’s parameters.

Generators
The various video generators included in DaVinci Resolve can be previewed by hovering your
pointer over any thumbnail in the Generators tab. To edit a generator into your timeline, simply
grab the thumbnail of the generator you wish to use, and place it in your Timeline in the Edit
page, or in either the upper or lower Timelines in the Cut page.
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Improved Inspector
The inspector has been redesigned for the Media, Cut, Edit, and Fairlight pages to make it
easier to find specific controls and to adjust common settings for your clips. Instead of a long
vertical list, different aspects of the inspector have now been organized into panels, with each
controlling specific grouped sets of parameters for your clip. Inspector panels that are not
applicable to your clip are grayed out.
Methods of using controls in the inspector:
 To activate or deactivate a control: Click the toggle to the left of the control’s name.
The orange dot on the right means the control is activated. A gray dot on the left
means the control is deactivated.
 To reveal a control’s parameters: Double-click the control’s name.
 To reset controls to their defaults: Click the reset button to the right of the
control’s name.

Video
The Video tab consists of commonly used controls to modify the size, opacity, motion, and
timing of your clip. This tab is composed of the Composite, Transform, Smart Reframe,
Cropping, Dynamic Zoom, Stabilization, Speed Change, Retime and Scaling, and Lens
Correction controls. Smart Reframe is a new feature that’s described later in this document.
All other controls are described in detail in the DaVinci Resolve Reference Manual.

The Video Inspector parameters
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Audio
The Audio tab contains four commonly used audio controls for video editing purposes,
including Clip Volume, Clip Pan, Clip Pitch, and Clip Equalizer. All of these controls are
described in detail in the DaVinci Resolve Reference Manual.
NOTE: There are many more refined plug-ins and effects for audio clips in the Audio
FX library. If you apply any of these, the controls will appear in the inspector’s Effects
tab Audio section, instead of here.

The Audio Inspector parameters

Effects
If a clip has any effects assigned to it, the controls for those effects will show up here. The
effects will be further sub-grouped by type: Fusion, Open FX, or Audio. In the Cut page, you
can now drag an effect directly into the this Inspector panel to apply it to a clip. If a clip does not
have any effects assigned to it, this panel will be dimmed. All effects are described in detail in
the DaVinci Resolve Reference Manual.

The Effects Inspector parameters
for the Binoculars effect
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Transition
This panel lets you adjust the parameters of a selected transition. The transition type can be
changed in the drop-down menu, and each transition exposes a set of parameters unique to
that specific transition. All transitions are described in detail in the DaVinci Resolve
Reference Manual.

The Effects Inspector parameters
for the Cross Dissolve transition

Image
The image panel exposes the Camera Raw parameters. If the video clip is in a Raw format, the
specific camera’s Raw controls will be exposed for user manipulation. Raw still images from
Nikon and Canon cameras can also be adjusted in this panel. Camera Raw controls are
explained in detail in the DaVinci Resolve Reference Manual.

The Image Inspector for a Blackmagic RAW file

File
The File tab provides a consolidated way of to view and edit media file metadata. The tab is
composed of the following parts:
 Clip Details: Presents data about the clip’s data format (codec, resolution,
frame rate, etc.).
 Metadata: Presents a reduced set of common metadata fields for quick user entry.
– Timecode: The start timecode of the clip. This field is editable if you want to

manually change the clip’s starting timecode.
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– Date Created: The date that the clip was created. This field is editable if

you want to manually change the clip’s creation date.
– Camera: Sets the Camera # metadata.
– Reel: Sets the Reel/Card ID.
– Scene: The Scene number of the clip.
– Shot: The Shot letter/number of the clip.
– Take: The Take number of the clip.
– Good Take: This checkbox indicates if the clip is a good or circled take.
– Clip Color: Assign a specific color to a clip that is reflected in the Timeline.
– Name: The clip name field; this can be entered manually.
– Comments: Add a text description to the clip.
– Auto Select Next Unsorted Clip: When this box is checked, the next clip in the

Media Pool is automatically selected when you click the Next Clip button. This allows
rapid metadata entry without having to select each individual clip in the Media Pool.

The File Inspector parameters

Show Panel in Workspace Submenu
You can now assign keyboard shortcuts to show and hide individual panels in your workspace
for instant configuration of the UI. The panels, such as Inspector, Media Pool, Metadata, etc., are
dependent on which page you are working in. Keyboard shortcuts to toggle these panels on or
off can be assigned using the Keyboard Customization window. Alternatively, you can choose
your panels in the Workspace > Show Panel in Workspace drop-down menu.
This function provides the ability to turn on or off a panel by clicking the name of the panel in
the UI toolbar at the top of the DaVinci Resolve interface, if you decide you want to hide it to
make a little more room.
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Show Page Navigation
You can now show and hide the Page Navigation icons at the bottom of the DaVinci Resolve
interface to provide the maximum amount of screen real estate for the GUI on smaller monitors.
To toggle the Show Page Navigation function:
– Check Workspace > Show Page Navigation.
With this interface element hidden, you can use keyboard shortcuts to access the individual
pages (Shift - 2 through 8), Project manager (Shift - 1) and Project settings (Shift - 9). You can
also access these functions from DaVinci Resolve’s main menu bar.

Improved Editing of Parameter Values Using Arrow Keys
Manually editing numerical parameter values in DaVinci Resolve has been refined. You can now
use the arrow keys to navigate and make adjustments to the decimal level in number fields.
To use the arrow keys to adjust numerical parameters:
1 Double click to select a numeric value in a field, and a highlight appears around
that value.
2

Use the left/right arrows to navigate the cursor to the right of the decimal value you
want to adjust.

3

Use the up/down arrows to change the value of that decimal place.

4

If you select the entire number, the up/down arrows will adjust the minimum value.

This cursor is in place to adjust the tenths
position using the up and down arrows.

Viewer Overlay Submenu
A View > Viewer Overlay submenu provides a dedicated command for turning all overlays on
and off, Toggle On/Off, which can be toggled from the keyboard by pressing Shift-` (accent
grave). This submenu also lists all Viewer Overlay modes that can be selected on whatever
page you happen to be on, enabling you to either choose these from the menu or assign
keyboard shortcuts to activating these modes.

Viewer Fast Forward and Rewind Speed Indicators
An indicator showing the speed at which playback is occurring now appears in the Viewer
just to the right of the Loop arrow in the Media, Cut, and Edit pages. This indicator only appears
during a fast forward or rewind operation and shows numeric multiples of real time
playback (x2 x8, x16, x64, etc.).

MacOS Title Bar Integration
DaVinci Resolve 17 has removed the white title bar previously found at the top of the
DaVinci Resolve window in macOS, and integrated its window management features into the
main GUI. This gives you more space to work with on smaller resolution monitors. The Close,
Minimize, and Zoom options are still found in their accustomed position at the upper-left corner
of the UI, but even these can be removed by selecting Workspace > Full Screen Window, for
the maximum amount of screen real estate possible.
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New Preferences and Project Settings
DaVinci Resolve 17 has added several new settings and preferences to customize your
hardware and the properties of the toolset.

Assign Capture and Playback to Separate Devices
If you have more than one Blackmagic Design video device connected to your computer,
you can now independently configure them for playback and capture. You can change the
setup of your devices in the Video and Audio I/O section of the System tab of the
DaVinci Resolve Preferences.
 For playback use: Select your Blackmagic device for video output from
DaVinci Resolve. The default is “None,” and any changes to this setting require a
restart of the program.
 For capture use: Select your Blackmagic device for video input to DaVinci Resolve.
The default is “None,” and any changes to this setting require a restart of the program.
This selected device is also used for Resolve Live.

New Resize Filter Options
DaVinci Resolve 17 now lets you take control of the exact algorithm used in all resizing
operations. The new Resize Filter options available are: Bessel, Box, Catmul-Rom, Cubic,
Gaussian, Lanczos, Mitchell, Nearest Neighbor, Quadratic, and Sinc. These options can be set
in the Image Scaling section of the Project Settings, by setting Resize Filter to “Custom”
and choosing the exact filter from the drop-down menu. These new filters are also available in
the “Resize Filter” drop-down menu in the Retime and Scaling section of the Video tab of
the inspector.
In practice, the difference between these methods can be quite subjective. However, if
you need to match a specific resizing method used from another application, you can do it here.
For everyday use, the normal resizing filters in DaVinci Resolve should be sufficient. These
include: Smoother, Bicubic, Bilinear, and Sharper as described in the DaVinci Resolve
Reference Manual.

Ability to Enable and Disable Open FX Plug-ins on Startup
You can now selectively enable and disable specific Open FX plug-ins on startup. You can use
this function to streamline and organize the Open FX list to just the plug-ins you commonly use,
or to exclude a problematic plug-in that causes instability in the system. Additionally,
DaVinci Resolve automatically checks the last plug-in loading result on startup, and skips any
plug-ins that previously caused a crash or hang.
Individual Open FX plug-ins can be manually Enabled and Disabled in the Video Plugins panel
in the System tab of the DaVinci Resolve Preferences.
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The Video Plugins panel allows you to enable or disable
specific Open FX plug-ins at startup

Pro Tools Keyboard Customization
If you are coming to DaVinci Resolve as an experienced Pro Tools user, you can set up your
keyboard shortcuts to mimic the Pro Tools layout by selecting “Pro Tools” in DaVinci Resolve >
Keyboard Customization (option-command-K) window.

Timeline Sort Order Setting
A new user setting allows you to determine the default sort order of the Timelines that appear
in the Viewer drop-down menus throughout DaVinci Resolve. To change this, open the UI
Settings panel of the User tab in the DaVinci Resolve Preferences, and choose an option from
the Timeline Sort Order drop-down menu.
 Alphabetic: Sorts Timelines alphabetically A-Z.
 Creation Date: Sorts Timelines by oldest creation date first.
 Recently Used (default): Sorts Timelines by the last actively used Timeline first.

Thai (ภาษาไทย) and Vietnamese (Tiếng Việt)
Language Localization
Now the Thai (ภาษาไทย) and Vietnamese (Tiếng Việt) languages are supported in
DaVinci Resolve’s interface. “ย น
ิ ดีตอ้ นรับ” and “chúc may mắn” to our Thai and Vietnamese users!
To change DaVinci Resolve’s interface language choose from the “Language” drop-down menu
in the UI Settings section of the User tab in the DaVinci Resolve Preferences.
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Performance and Cache Improvements
DaVinci Resolve 17 also boasts some impressive performance and caching improvements.

Improved Playback Performance in the Color Page
Color Page playback performance across the board has been enhanced in DaVinci Resolve 17.
It should be most noticeable in marginal playback situations, for users who were previously only
getting 22-23 fps in a 24 fps timeline.

Adjustment Clips Rendered to Cache
Adjustment clips can now be rendered to the Cache in Smart and User modes in the same
manner as normal video clips. For more information on using the various cache modes, see
Chapter 6 “Improving Performance, Proxies, and the Render Cache” in the DaVinci Resolve
Reference Manual.

Sharing Optimized Media Between Projects
Optimized Media is now shared across projects in the same database (previously optimized
media was confined to a single project). This means that if you create optimized media for a clip
in one project, that same optimized media will be used for that clip in any other project that’s in
the same database. This happens automatically, and requires no user input. This will cut down
the space requirements for working with the same media across different projects dramatically.
This database-wide functionality has changed somewhat how Optimized Media is now
managed. Deleting optimized media from DaVinci Resolve now must take place manually, by
removing the files in the CacheClip/Optimized Media folder in your OS. There is also currently
no way to show which files in your project have been optimized and which have not.

Collaborative Workflow Improvements
DaVinci Resolve 17 has introduced significant performance gains in its Collaborative Workflow.
You should see dramatically increased speeds in navigating bins, as well as the loading and
saving projects and timelines. This increased speed should be particularly noticeable with
larger projects.
Additionally, connecting to a remote database server and using other collaborative workflow
features is no longer exclusive to the Studio version of DaVinci Resolve and is now available to
all DaVinci Resolve users. These features are no longer restricted to the Studio version of
DaVinci Resolve.
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New Proxy Media Workflow
DaVinci Resolve 17 introduces a new Proxy Media workflow to provide a playback optimization
option that makes it easier to exchange projects online, work on projects remotely, and work
with external media asset management systems. It creates a simple and flexible system for
editing collaboration that can be custom configured to your specific requirements.

Creating and Using Proxy Media
Proxy Media is essentially more highly compressed (and potentially lower resolution) versions of
your source media that are linked to your source media in DaVinci Resolve via metadata. This is
done in such a way as to make it easy to switch back and forth between the original and proxy
media as your needs require.
Typically, this lets you use lower bandwidth proxy media for increased real-time effects
performance and full speed playback while editing, while easily reverting back to more
bandwidth and processor-intensive source media for color correction, finishing, and final
output. In addition to enabling better performance, these proxy files are fully portable, which
lets you move your whole project easily from workstation to workstation, and even across the
internet, accompanied by much more compact proxy media.
You set the resolution and format of your proxies in the Optimized Media and Render Cache
section of the Master Settings panel in the Project Settings. There are two settings that control
the actual media files created by the Generate Proxy Media command.
 Proxy Media Resolution: Choose “Original” to keep proxies the same resolution as the
source media. If you prefer, reduce the resolution of the proxy media files by choosing
Half, Quarter, Eighth, or Sixteenth to save bandwidth. The “Choose Automatically”
option balances visual quality with efficiency by only reducing the resolution of media
files that are larger than the currently selected Timeline resolution, using whatever
reduction ratio best matches the Timeline resolution.
 Proxy Media Format: Lets you choose the specific QuickTime format and codec that
the proxy files will be created with. There are several ProRes and DNxHR varieties
to chose from, as well as H.264 and H.265 options. Which format you chose will be
determined by the bandwidth and quality tradeoffs that you need for a particular
project. For example, if you simply want better playback speed from RAW media while
preserving image quality, you may want to pick a high-quality codec like ProRes 422
HQ, or DNxHR HQX. If your goal is to send your media across the internet to another
editor, you may want to chose a more compressed format, such as ProRes Proxy, or
even H.264 or H.265, to keep file sizes small.

The Proxy Media Resolution and Format settings

To generate proxy media in DaVinci Resolve:
1 Select all of the clips you wish to generate proxies for in the Media Pool.
2

Right-Click any selected clip and choose “Generate Proxy Media” from the
contextual menu.
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DaVinci Resolve will display a progress bar and give you a time estimate for completion as it
renders out your selected clips to the format and codec determined by the Proxy Media
Resolution and Format settings.
NOTE: If your source clip has a separate audio file synced to it in the Media Pool, any
proxies generated from that clip will include the synced audio, but that audio will be
embedded in the video clip instead of being created as a separate file.

Where is Proxy Media Saved?
Proxy media is created in the “Proxy generation location” destination, found in the Working
Folders section of the Master Settings of the Project Settings. The proxies are further organized
into subfolders by original source clip location. It is important to have enough free space on this
drive to contain the proxies. Once created, these proxy files can then be moved to any other
drive location on the system, if you wish, and then re-linked to their source files.

Generating Proxy Media in Other Applications
Proxy files can also be generated in applications outside of DaVinci Resolve, such as other
NLEs or various media asset management systems. To properly link the proxy to its source
media in DaVinci Resolve, the proxy file must meet the following criteria:
– Proxy files must have identical timecode to the source file.
– Proxy files must have the same file name as the source file (excluding extensions).
– Proxy files must have the same frame rate as the source file.
– The format and codec used for proxy files must be supported in DaVinci Resolve.

If your proxy file meets these criteria, you’ll be able to manually link proxy media created in
other applications to source clips in the Media Pool as described below.

Managing Proxy Media
You can check the status and location of all your proxy media in the List view of the Media Pool.
Right-click on any column heading and click the checkboxes of “Proxy” and “Proxy Media Path.”
 Proxy: This column shows the current proxy status.
– None: Indicates no proxy media has been created.
– Offline: Indicates a proxy has been created but can not be found in the

Proxy Media path.
– (Resolution): A number indicating the resolution of the created proxy

and that it is online.
 Proxy Media Path: The location of where DaVinci Resolve is looking for the proxy file.
If this location is incorrect, you can relink the proxy to a new path manually.

The proxy columns in List view, showing Proxy Media status and location
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Linking Clips to Proxy Media
If you’ve created proxy media in another application, or moved the internally created proxy
media out of its default location in “ProxyMedia,“ you’ll need to manually link the proxies to their
source media files in your Media Pool.
To link proxy media to a source clip:
1 Select one or more clips in the Media Pool you wish to link proxy media to.
2

Right-click one of the selected clips, and choose “Link Proxy Media” from the
contextual menu.

3

Use the file browser to find the specific proxy file or directory (in the case of multiple
clips) to set a new Proxy Media path, and click Open. If you select an incorrect file or
directory, a warning dialog box will appear and no linking will occur.

To unlink proxy media from a source clip:
1 Select a clip or clips in the Media Pool you wish to unlink proxy media from.
2

Right-click on any clip and select “Unlink Proxy Media” from the contextual menu. This
will remove the metadata link from proxy to source and will set the status in the Proxy
column to “None.”

NOTE: Unlinking a proxy file does not delete it. The proxy file remains on the hard
drive where it was created. As of this writing, proxy files must be deleted manually
using your OS file system outside of DaVinci Resolve.

Re-generating Proxy Media
You can generate more than one proxy file per clip. This can be useful if you want to set
multiple Camera Raw parameters and choose between them, or to create proxy files of different
resolutions.
To generate a new proxy:
1 Make your desired changes to the current clip’s settings.
2

Right-click on the same clip and select “Generate Proxy Media” from the
contextual menu.

A new proxy file is created in the same directory as the previously linked proxy file, and its file
name is appended with “_s00x” to differentiate it. The latest proxy generated is automatically
linked to the source file, but previous proxy versions are retained on disk, so you can then
manually relink the different versions as needed.

Switching Between Proxy Media and Source Media
You can switch between using your original source media and the proxy media for playback at
any time by checking or unchecking Playback > Use Proxy Media If Available in the Menu bar.
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Using Proxy Files for Delivery
By default, the Deliver page always reverts proxies to the original source media for final output
to ensure the highest quality render. Checking the “Use proxy media” box in the Advanced
Settings of the Video Render settings in the Deliver page overrides this so DaVinci Resolve
uses proxy media for final output instead. This can be useful if you need to save rendering time
while making dailies, or to quickly create outputs of your timeline for producers or audio
engineers where master quality is not necessarily needed. You will also need to check the “Use
proxy media” box if you are editing with proxies and do not have access to the original
source media.

Moving Proxies Using a DaVinci Resolve Archive (.dra)
When moving proxies from one DaVinci Resolve system to another, it can be time consuming
and problematic to manually copy many individual assets (proxies, graphics, source files, etc.)
from different folders and locations. By far the easiest way to move complete projects system to
system is by letting DaVinci Resolve do all that file management for you, by creating a
DaVinci Resolve Archive (.dra). An archive file contains not only your project, but all its media as
well, maintaining the file paths and organization of the original project.
To create a DaVinci Resolve Archive file, right-click on any project in the Project Manager, and
choose “Export Project Archive” from the drop-down menu. Within this mechanism, a new
Archive setting in DaVinci Resolve 17 makes working with proxies simple and elegant.

Creating a Proxy-Only Archive to Share
In the Archive Options dialog, if you check Proxy Media, and uncheck Media Files and Render
Cache, DaVinci Resolve will make an Archive using only the proxy media. This allows you to
create a compact and easily transported version of your project to either move to another
computer, or to give to an editor working remotely. If proxy media is not available for a clip (say
a graphic or a media file you didn’t create a proxy for in the first place), the original media is
automatically exported to ensure that nothing goes offline.

Archive Setting options for exporting only Proxy Media

The resulting .dra is a folder that is a fully self-contained version of your project and proxy
media. This folder can easily be moved from drive to drive, or zipped up and sent across
the internet.

Working Remotely Using Proxy Media
The proxy workflow in DaVinci Resolve opens up many new possibilities for editing
collaboration and media management. For example, one common workflow is to use the RAW
camera master source clips in the editing suite, but to then generate low resolution proxies to
take home to edit on a laptop.
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To create a portable set of proxies for editing on a laptop:
1 Set up the Resolution and Format settings for the proxies in the Project Settings. In
this case, you may want to use “Choose Automatically” and a low- bandwidth, easily
editable codec like ProRes LT or DNxHR LB.
2

Select all source media in the Media Pool and Generate Proxy.

3

Export a DaVinci Resolve Archive (.dra) onto an external drive, with only Proxy
Media checked.

4

Go away. Once at home, connect that drive to your home laptop, and use the Restore
Project Archive command in the Project Manager to import the archive.

5

When you’ve finished working at home, export a timeline, bin, or project from your
laptop when finished, and bring just that file back into the edit suite to continue working
with the original source media.

Another common scenario might involve sending proxies over the internet to an editor in
another city or country.
To send a project to another editor over the internet:
1 Set up the Resolution and Format settings for the proxies in the Project Settings. In this
case, you may want to use a low resolution like “quarter” or “one-eighth,” and a lowbandwidth, highly-compressed codec like H.265 for the smallest file sizes possible.
2

Select all of the source media in the Media Pool and Generate Proxy.

3

Export a DaVinci Resolve Archive (.dra), with only Proxy Media checked.

4

Using the file compression tools in your OS, zip the archive folder so it becomes one
large file.

5

Upload the resulting .zip to the online file sharing service you prefer, and send the
download link to the remote editor.

6

Once the other editor unzips and imports the archive, you and they can then simply
send timelines, bins, and/or project files back and forth to collaborate. These files are
small enough to transfer over email or an instant messaging service.

Additionally, you may have your editing computer connected via ethernet to a Media Asset
Management system that can create its own proxies. In order to edit smoothly via the network,
you need to use low bandwidth proxies instead of the source media.
To create proxy media externally to edit over a local network:
1 Import the original source media files to your Media Pool from the network storage
system you’re using.
2

Set up the proxy generation settings in your Media Asset Management software to
accommodate the amount of network bandwidth you expect to have access to.

3

Make sure the timecode and frame rate of the proxies match the original source media,
and render the proxies to a network location.

4

Select all of your original source media in the Media Pool, and choose
“Link Proxy Media.”

5

Choose the proxy media at the network location where they’ve been rendered.
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Proxy Media vs. Other Playback
Optimizations in DaVinci Resolve
There continue to be other methods of optimizing real time performance in DaVinci Resolve, so
it’s natural that one might wonder how this is different from Optimized media, Timeline Proxy
Mode, and other performance optimization techniques available in DaVinci Resolve. The key
aspect of proxy media that differentiates it is that proxy media is independent, portable, and
can be created by applications outside of DaVinci Resolve, if desired.

Proxy Media vs. Timeline Proxy Mode
One of the oldest performance optimization options, originally named “Proxy Mode” in previous
versions of DaVinci Resolve, has been renamed “Timeline Proxy Mode” in DaVinci Resolve 17 to
differentiate it from Proxy Media. While the new Proxy Media feature creates actual media files
on disk, “Timeline Proxy Mode” simply reduces the resolution of the timeline on the fly, allowing
for increased real time playback performance. To be clear, Proxy Media and Timeline Proxy
Mode are two entirely different features, which are wholly independent of one another.

Proxy Media vs. the Render Cache
Proxy Media is designed to create easy-to-edit primary source material on the Timeline, for
improved performance before you start editing. The Render Cache is designed to improve the
real time performance of clips that have enough computationally intensive effects (such as
Resolve FX, color corrections, noise reduction, compound clips, fusion compositions, etc.) to
slow playback, even at the current Timeline resolution. Proxy Media is independent and
portable (you can move clips wherever you want; you just have to relink them afterward), while
the Render Cache media is not designed to be moved or interacted with externally and only
works with the project it was made for.

Proxy Media vs. Optimized Media
On the surface, Proxy Media and Optimized Media appear similar in function. Both options are
designed to create lower bandwidth, easier to edit versions of source media. However,
Optimized Media is managed internally by DaVinci Resolve, cannot be exported, and is not user
accessible. In contrast, Proxy Media creates fully portable and independent media that can be
easily managed by the user.
The chapter in the DaVinci Resolve Reference Manual titled “Improving Performance, Proxies
and the Render Cache” goes into detail on when and how to use DaVinci Resolve’s various
playback optimizations modes, but included below is a quick reference.
 Timeline Proxy Mode: My timeline is playing back, just a little bit too slowly.
 Cache Clip: I need help playing back a few clips in real time that have
heavy effects applied.
 Optimized Media: I need help playing back all my source media in real time,
and I will only be editing on this computer.
 Proxy Media: I need help playing back all my source media in real time, and I need to
collaborate and share media with other users, programs, or outside storage locations.
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Improved Media Handling
This release of DaVinci Resolve has greatly improved the media handling of interlaced material.

Improved Processing of Interlaced Material
The processing and output of interlaced media has been significantly improved in
DaVinci Resolve 17, with better support for processing interlaced timelines natively. Video clips
brought into DaVinci Resolve will automatically be tagged as progressive, upper, or lower field
interlaced. This new native interlace processing will allow for much better compositing and title
support for those making interlaced deliverables.
To set up native interlaced processing:
1 Select your Timeline Format in the Master Settings section of the
Project Settings window.
2

Turn on the Enable Interlace processing checkbox.

3

Notice that your Timeline frame rate has changed to an interlaced fields per
second specification (50, 59.94, 60). Select the correct interlaced format from the
drop-down menu.

4

Choose an interlaced Video format in the Video Monitoring section of the
Project Settings, to output a native interlaced signal using a Blackmagic video
monitoring device.

DaVinci Neural Engine Deinterlacing (Studio Only)
There is a new deinterlacing quality option in addition to “normal” and “high,” called
DaVinci Neural Engine. As the name suggests, this option uses the advanced machine learning
algorithms of the DaVinci Neural Engine to analyze motion between the fields of interlaced
material and reconstructs them into a single frame. This option is computationally intensive,
but ideally will deliver an even more aesthetically pleasing result than the “high” setting.
To choose this deinterlacing mode, use the “Deinterlace quality” drop-down menu of the Image
Scaling panel of the Project Preferences, and choose DaVinci Neural Engine. Deinterlacing is
automatically applied to any interlaced video material that is placed in a progressive timeline.

Real-Time 3:2 Pulldown Removal
If you have 29.97fps interlaced material that was encoded with a 3:2 pulldown, DaVinci Resolve
can reconstruct the original footage’s progressive frame rate in real time. For example, if you
have source media from a film camera (24fps progressive) that has been telecined to
NTSC video (29.97fps interlaced), DaVinci Resolve can pull the original 24 discrete film frames
out of the various interlaced fields that make up the NTSC signal.
To remove 3:2 pulldown in real-time:
1 Select one or more 29.97 fps interlaced clips in the Media Pool.
2

Right-click one of the selected clips and select Clip Attributes.

3

In the Video tab, turn on the Remove 3:2 Pulldown checkbox.

4

Set the Frame where the 3:2 cadence started in the “First Frame of Clip” drop-down
(this is usually the “A” frame).

5

Click OK.
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The footage will now behave like a 24fps progressive clip.

Telecine footage with 3:2 pulldown removed; the scrambled
number (mix of the numbers 1 and 2) at the end of the
KeyKode is a field indicator, showing that this A frame was
created properly from fields 1 and 2 of the interlaced signal

Improved Format Support
As the production industry evolves, so too does DaVinci Resolve’s support for new and
improved media formats. Version 17 introduces many new developments.
New Decoding support
– Support for decoding QuickTime PNG clips
– Support for decoding uncompressed RGB 8-bit and YUV 10-bit AVI clips
– Support for decoding spanned Panasonic 8K SHV clips
– Support for decoding 32-bit PSD format images
– Support for Canon and Nikon raw formats on the inspector

New Decoding/Encoding and Media Management support
– Support for 12K Blackmagic RAW clips
– Dolby Vision functionality is now available on Windows systems
– Support for reading per frame metadata from Blackmagic RAW, ARRI, RED,

and Sony camera files
– Improved support for exporting per-frame ARRI metadata for ARI/ARX/MXF formats
– Support for decoding and rendering per-frame EXR metadata
– Improved metadata support for Sony MXF clips
– Support for decoding and encoding GoPro CineForm clips for

non-multiple of 16 resolutions
– Support for decoding and encoding mp3 audio in Linux
– Support for decoding and encoding high-throughput JPEG 2000 (HTJ2K)
– Ability to bypass re-encodes for supported JPEG 2000 profiles on renders
– Support for encoding IMF MCA audio metadata
– Support for exporting non-HDR DCP metadata option
– Support for HDR tags in DCP workflows
– Support for a 16-bit SDR IMF preset
– Support for Photon 4.8.0 for IMF validation
– Support for decoding and encoding H.265 clips with alpha on macOS
– Native support for 44.1 KHz sample rate audio clips and instruments
– Support for IMF supplemental packages with Dolby Atmos content
– Support for importing AES31 timelines
– Support for Canon IDTs for the EOS C70 Camera
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New GPU support
– Support for additional NVIDIA encoder parameters for H.264 and H.265
– Support for NVIDIA Ampere GPUs on Linux and Windows systems

New Internet Account support
– Support for directly uploading to Twitter from DaVinci Resolve

Media Pool Improvements
DaVinci Resolve 17 has improved its core media pool functionality and increased the options for
sharing assets between workstations.

Support for Viewing and Adjusting
Media Pool Clips in Inspector
You can now directly modify Media Pool clips in the Inspector, before you edit those clips into a
timeline. This allows you to change the parameters of source media so that clips that are edited
into a timeline carry those new settings with it. For example, you can prepare your material prior
to editing by changing the clip’s file and RAW settings, adjusting the audio levels and EQ, or
assigning it a specific lens correction, etc. Once modified, any part of that clip would have the
correct Inspector parameters already in place when you edited them into your timeline.
To adjust Media Pool clips in the Inspector:
1 Select one or more clips in the Media Pool Panel of either the Cut, Edit, or
Fairlight pages.
2

Open the Inspector panel, and adjust any parameters in the Video, Sizing,
Audio, and File tabs.

These parameter changes are stored with the Media Pool clip, and will be carried over when
any part of that clip is edited into the Timeline. Of course, each clip’s Inspector parameters can
be further modified once it’s in the Timeline, and those Timeline parameters are independent
from the Media Pool Inspector settings. This means that any further adjustments you make to
the clip in the Timeline do not affect that same clip’s adjustments in the Media Pool.

Import and Export Specific DaVinci Resolve Project Bins
You can now import/export specific bins from one DaVinci Resolve project to another, allowing
you to pass bins quickly between projects and workstations that have access to the same
media. All Metadata, In/Out points, Timelines, etc. are transferred along with the clips in the bin,
but none of the actual media files are included.
To export bins from the Media Pool:
1 Select one or more bins in the Media Pool.
2

Right-click the selection and choose “Export Bin,” or choose File > Export > Export Bin.

3

Choose where to save the DaVinci Resolve Bin file (.drb) in the file system dialog,
and click Save.
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To import bins into the Media Pool:
1 Right-click in the Media Pool and choose “Import Bin,” or choose File > Import >
Import Bin.
2

Do one of the following:
– Choose a DaVinci Resolve Bin file (.drb) from the file system dialog.
– Double click the .drb file in your file system.

The bin or bins will appear in the Media Pool. Any bins imported this way will have the word
“import” appended to their name, to avoid duplicate names. If you import a bin that contains
clips that were already in the Media Pool, the potentially duplicate clips are excluded from the
import and instead relinked to the media referenced by your project. This keeps your Media
Pool tidy. However, if the bin or bins have been moved to another computer, you may have to
relink offline media.

Import and Export Individual DaVinci Resolve Timelines
You can now export and import individual timelines from one DaVinci Resolve project into
another previously existing DaVinci Resolve project, allowing you to pass timelines quickly
between projects and workstations, without creating additional imported project files. Just the
timeline and its associated clip information is exported, none of the actual media files
are included.
To export a timeline from the Media Pool:
1 Select a timeline from the Media Pool.
2

Choose File > Export > Export AAF, XML, DRT (Shift-Command-O).

3

Choose “DaVinci Resolve Timeline Files (*.drt)” from the format options popup in the file
system dialog.

4

Choose where to save the DaVinci Resolve Timeline file (.drt) in the file system dialog,
and click Save.

To import a timeline into the Media Pool:
1 Choose a bin in the Media Pool in which you want the imported timeline to be saved.
2

Do one of the following:
– Choose File > Import Timeline > Import AAF, XML, DRT (Shift-Command-I), then Select

a DaVinci Resolve Timeline file (.drt) from the file system dialog, and click Open.
– Double click the .drt file in your file system.

The timeline will appear in the Media Pool, along with all of the clips associated with it.
Any timelines imported this way will have the word “import” appended to their name, to avoid
duplicate names. The imported timeline will be automatically conformed to corresponding
media that’s already in the Media Pool. However, if the timeline has been moved to another
computer, you may have to reimport or relink missing or offline media in to bring the imported
timeline fully online.
NOTE: Only a single timeline can be imported and exported at a time using this
method. To import or export multiple timelines, use the Import/Export Bin function
described above.
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Media Management of Timelines Creates DRT Files
When performing Media Management operations to copy or transcode media from a timeline, a
DaVinci Resolve Timeline (.drt) file is automatically created in the same bin as the resulting
media files, linked to the newly created media.

Disable Timelines
You can now disable/enable timelines in the Media Pool for both performance and
organizational purposes. This is particularly useful for editors who like to maintain a history of a
program’s editing via an ongoing series of periodically duplicated timelines. Since having a
large number of timelines within a single project file can affect performance, having the ability
to disable timelines lets you maintain these backup/alternate timelines without any penalty.
Disabled timelines are never loaded into RAM, have no effect on the speed at which a project
opens, saves, exports, or loads, and have no effect on program performance. A disabled
timeline also hides the timeline from the viewer drop-down menus throughout the program.
Disabled timelines are still visible in the Media Pool, but have a crossed out eye icon in the
lower left to show the status. A disabled timeline cannot be opened in any page of
DaVinci Resolve.
To disable a timeline:
– Select the timeline, right-click on it and choose “Disable Timeline”

from the drop-down menu.
To enable a timeline:
– Select the timeline, right-click on it and choose “Enable Timeline”
from the drop-down menu.

The crossed-out eye in the lower left of the
thumbnail indicates this timeline is disabled

New Offline Clip Relinking Icon and Dialog
A new offline clip relinking dialog makes it easier to find specific clips that are missing. If
DaVinci Resolve fails to find your media, a Relink icon in the Cut and Edit Media Pools will
highlight orange.

The new Relink Media icon that appears for unlinked media

Clicking this icon opens a new dialog box showing the volumes that the missing files initially
belonged to. You can then use this information to track down the media on your file system, find
that specific hard drive, or ask a client if they provided you the media from this volume. Clicking
the Locate button lets you re-connect the missing clips to a new file location of your choosing.
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If the quick search initiated by the Locate buttons doesn’t find media that you know is there, you
can initialize an exhaustive deep disk search for the media by clicking on the Disk
Search button.

The new Relink Media dialog, showing the volume
names where the missing clips originated

Support for Continuing Media Management Jobs on Error
DaVinci Resolve 17 has more user-friendly behavior when dealing with errors during media
management operations. In previous versions, DaVinci Resolve would stop and wait for user
input immediately upon encountering an error, meaning that if an error happened while you
were out at lunch, nothing would happen until you came back. Now, DaVinci Resolve will skip
error-flagged files and continue to perform any remaining media management to all the
other clips.

Ability to Save Smart Bins and Smart Filters Across Projects
If you have a commonly used Smart Bin or Smart Filter set up, you can now use it across
multiple projects in your database.
To set up Smart Bins or Smart Filters across projects:
– Create a new Smart Bin or Smart Filter, and turn on the “Show in all projects”
checkbox in the upper right corner of the Create Smart Bin dialog.
These persistent Smart Bins will be found in the User Smart Bins folder in the Smart Bins pane
in every project. Persistent Smart Filters will be found in the User Smart Filters section of the
Clips drop-down menu in the Color page.

Support for Growing Files in the Media Pool
If you’re using a third-party application that records live to a growing video file, you can now
begin to edit that file while it’s still recording. Simply import the growing file into the Media Pool,
and DaVinci Resolve will continuously refresh to check if the file has changed, automatically
updating its attributes in the Media Pool.
To set this option, check the “Automatically refresh growing files in the Media Pool” box in the
Decode Options of the System tab in the DaVinci Resolve Preferences.
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Scripting API Improvements
DaVinci Resolve 17 has added support to its scripting API for the following features:
 Querying and setting individual Timeline settings
 Importing an AAF to the current Timeline
For more information on scripting for DaVinci Resolve, choose Help > Documentation >
Developer, and open the Scripting folder for the Readme and examples.
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Chapter 2

Cut Page
Improvements
The Cut page in Resolve 17 has been reworked to include optimized
design elements and new functionality to create a faster editing
experience.
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New Metadata View in Media Pool
Resolve 17 adds a new Metadata view to the Media Pool. Each clip is represented by its own
card with a thumbnail and basic clip metadata information visible. This view is designed to have
more metadata information than a thumbnail but more targeted information than the List view.
This feature, combined with its sort modes, are a powerful way to organize and reorganize your
clips in the Media Pool.
The metadata fields of the Metadata view (from the top down):
 Thumbnail: A scrubbable thumbnail image of your clip.
 Row 1: A main description field that is variable and determined
by the sort order selection.
 Row 2: Start Timecode, Date Created, Camera #.
 Row 3: Scene, Shot, Take.
 Row 4: Clip Name, Comment.

The Metadata View icon view (highlighted icon in the top bar),
showing the thumbnail being scrubbed next to the clip’s metadata

The strength of the Metadata view is the automatic clustering of your clips based on the sort
order you choose in the Media Pool Sort By menu, at the very upper-right corner of the Media
Pool. It is also possible to use these sort options in the Thumbnail, List, and Filmstrip
views as well.

The Media Sort options of the Cut
page Media Pool

Each different sort mode changes the main description field on the card, as well as re-arranging
the Media Pool to reflect the selected organization method.
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The sort modes available in the Metadata view are:
 TImecode: This mode clusters the clips by creation date, changes the main description
field to creation date and start timecode, and orders the list by timecode.
 Camera: This mode clusters the clips by Camera #, changes the main description field
to camera # and start timecode, and orders the list by timecode.
 Date Time: This mode clusters the clips by day, changes the main description field to
creation date and file name, and orders the list by timecode.
 Clip Name: This mode clusters the clips by the first letter of the clip name in
alphabetical order, changes the main description field to clip name, and orders the list
by timecode.
 Scene, Shot: This mode clusters the clips by scene, changes the main description field
to scene-shot-take, and orders the list by scene-shot-take.
 Clip Color: This mode clusters the clips by clip color name, changes the main
description field to creation date and start timecode, and orders the list by timecode.
 Date Modified: This mode clusters the clips by day, changes the main description field
to creation date and file name, and orders the list by the last time the clip was modified
by the OS filesystem.
 Date Imported: This mode clusters the clips by day, changes the main description field
to creation date and file name, and orders the list by the date the clip was added to the
Media Pool.
 Ascending: Orders the Media Pool from lowest numerical value to highest, and
alphabetically from A to Z.
 Descending: Orders the Media Pool from highest numerical value to lowest, and
alphabetically from Z to A.

(Top) The Metadata view with clips sorted by Scene-Shot-Take;
(Bottom) The Metadata view with the same clips sorted by Camera
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Audio Trim View
When performing a trim operation in the Cut page, you can now set the option to expand the
audio waveform of a Timeline clip while trimming. This mode gives a much more accurate view
of the audio, making it easier to pick a specific edit point between words, beats, etc.
To toggle Audio Trim view:
 Click the Audio Trim icon, between the Snapping and Marker tools.

The Audio Trim View icon activated (circled)

With this option enabled, you’ll see an expanded waveform for audio/video clips that are
being trimmed in the Timeline, while you’re trimming. This shrinks back down after you finish the
trim operation.

The Audio Trim view showing an expanded audio waveform while trimming in the Timeline

Safe Area Framing Guides
This drop-down menu overlays many useful framing guides over the Viewer to let you see what
part of the image will be included and what will part will be cropped out if you change the
Timeline’s aspect ratio. The framing guides can be turned on and off by toggling the Safe Area
Framing Guide icon in the Viewer, and the exact guides can be selected in the
drop-down menu.
The aspect ratios available in the Framing Guide drop-down are:
 Social Media: 1:1, 4:5, 9:16, 1.91:1, 16:9.
 Broadcast and Film: 1.33, 1.66, 1.77, 1.85, 2.35.
 Safe Area Guides: These options add additional guide lines on the Viewer to protect
your composition from possibly being cut off at the extreme edges of a physical
cathode ray tube. While somewhat anachronistic in this age of flat screen digital
televisions, many legacy programs still adhere to these guidelines. Safe Areas still can
be useful guides in ensuring your image is not inadvertently cropped by the variety of
mobile devices and social media sites in use today.
– Action: Keep all movement and important action within this box.
– Title: Keep all on screen text within this box.
– Center: Designates the exact middle of the image.
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The Safe Area Framing Guide icon
(circled) and the possible framing options

Ability to Import ATEM Mini Pro
ISO Projects
It is now possible to import ATEM Mini Pro ISO projects directly into DaVinci Resolve.
ATEM projects include the master program clip, as well as each individual camera “ISO”
(isolated) clip, and each angle’s audio recordings. All transitions, timecode, and camera number
metadata are imported, as well as whatever graphics were stored in the ATEM’s media pool.
Once the project is loaded, the Sync Bin view is enabled in the Cut page, so you can
seamlessly continue your multi-camera edit. For more information on using the Cut Page,
see Chapter 18 “Introducing the Cut page” in the DaVinci Resolve User Manual.

An ATEM Mini Pro project opened in the Cut page Sync bin

It’s also possible to instantly switch your ATEM camera ISOs to the original camera recordings
made in a Blackmagic Camera. This workflow enables the highest visual quality, and the ability
to output in higher resolutions (such as 4K or UHD) than are supported by the ATEM internally.
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To relink to camera masters from ATEM ISO recordings:
1 (Before you shoot) Check the “Record in All Cameras” setting in the
ATEM software control.
2

(Before you shoot) Check the “ISO record all inputs” setting in the
ATEM software control.

3

At this point, record your show as you normally would.

4

Copy all the resulting camera masters from each camera’s memory card to
the ATEM project’s “Video ISO Files” folder, and then import the project into
DaVinci Resolve.

5

Click the “Show Camera Originals” button in the Cut page Viewer to instantly switch
between ATEM ISOs and Camera Masters.

The Show Camera Originals button

Sync Bin View in Cinema Viewer
The Sync Bin camera selection can now be viewed full screen in the Cinema Viewer by
pressing “P” on your keyboard, allowing you to see a larger, more detailed view of each specific
camera. In this full-screen mode, the Sync Bin view controls operate identically to those in the
normal Viewer.

Sync Bin Timeline Audio Only Playback
When the “Video Only” mode is activated in the Cut page, audio from the sources in the Sync
Bin are now muted, and the audio playback is from the clips in the Timeline only.

Dedicated Timecode Entry Mode
There is now a dedicated timecode entry mode for the Cut page. Previously, you would type
numbers on the numeric keypad to enable timecode entry, but this precluded you from using
these keys as shortcuts for other functions. Now there are three ways of telling DaVinci Resolve
that you want to perform a timecode action, regardless of what the numeric keypad keys are
assigned to in the Keyboard Customization preferences.
To activate Timecode Entry mode on the Cut page:
1 Select Playback > Goto > Timecode (=) and enter your timecode value.
2

Press “+” or “-“ keys, and enter your timecode value to move the current position
forward or backward by that amount.

3

Click on the Timeline Timecode display on the Viewer, and enter your timecode value.
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Full Screen Viewer Icon on the Cut Page
The Cut page Viewer has a Full Screen Viewer icon in the upper-right, that can be clicked to
enable Full Screen view. Press Escape to return to your normal view mode.

The Full Screen Viewer icon

Quick Export Dialog Options
The Quick Export Dialog in the Cut page has been updated. The interface has been redesigned
to incorporate the Twitter preset, as well as more prominently listing the basic info (fps,
resolution, etc.) for each preset.

The Quick Export dialog

Navigable Clip Paths in Source Tape
The Media Pool in the Cut page has a navigable title bar that shows a clip’s Media Pool
hierarchy. You can now navigate up and down this hierarchy in the Source tape. In
DaVinci Resolve 17, the Source tape has a flattened view, which shows all clips in both the
current bin and any sub-bins it may contain. This is useful when navigating bin structures that
reflect the original camera file system. For example, you may have a camera that records each
memory card as a separate folder, and then each individual clip is saved as a separate folder
inside that folder. When you bring this file system into the Media Pool using the Create Bins
option, these nested levels are mirrored in the Media Pool bin structure. Now when you click on
a card bin in the Source tape, it will directly show you all the clips on that card, rather than show
many individual sub-bins. This view is also viewable in Thumbnail, List, and Filmstrip views.
As you navigate in the Source tape, the current clip is highlighted, and its hierarchy will now
appear in top of the Media Pool title bar. By clicking directly on bins in this bin path, you can
quickly broaden or narrow the scope of the Source tape, say from Shoot Day to Camera to Card
to Clip and vice versa.

The Media Pool title bar showing a clip’s Media Pool hierarchy. Clicking directly on
these bins will narrow or broaden the scope of the clips in the Source tape
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New Change Clip Duration Dialog
The new Change Clip Duration dialog in DaVinci Resolve 17 allows you to directly change the
duration of a clip by typing in frames, a timecode value, or using time and frame-based presets.
You can activate the Change Clip Duration dialog by selecting one or more clips on the
Timeline and choosing Clip > Change Clip Duration (Command-D), or by right-clicking on a clip
and choosing Change Clip Duration from the contextual menu. The Change Clip Duration dialog
works both on the Cut and Edit pages.

The new Change Clip Duration
box in Timecode mode.

Options for the Change Clip Duration Dialog box:
 Format: You can chose between working with TIme (Timecode) or Frame values.
 Duration: Type in the timecode value or number of frames you wish to make the new
duration of the selected clip.
 Preset: Select a duration by clicking on 1, 5, or 15 seconds (or their equivalent
value in frames). End will extend the duration to the last frame of the selected clip,
regardless of any Out points set.
 Extend Beyond Clip Length (Cut page Only): This will append black filler to any clip
whose duration is set longer than the clip itself.
 Cancel/Change: Click Cancel to exit without changing the duration of the clip, or
Change to apply the duration change to the selected clip.

TIP: You can change the duration for more than one clip at a time by selecting multiple
clips before opening Change Clip Duration. All clips selected will be the changed to
the same duration set in the Change Clip Duration dialog box.
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Editing the Duration Field
in the Cut Viewer
When editing using Source tape in the Cut page, you set In and Out points to insert a specified
range of video. The duration of that video range appears in the Duration field, which is in the
upper-right corner of the Viewer.
This field is now editable, and updates the Out point to match the value you enter. You can
directly enter a certain number of frames, use the + or - modifiers to change the value by that
exact amount, or make adjustments to the hh:mm:ss:ff field directly.

Switching Timelines in the Cut Page
You can switch from working on one timeline to another by using the drop-down list at the top
of the Cut page Viewer. This change unifies Viewer behavior across the Cut, Edit, Color, and
Deliver pages.

The Timeline Selection drop-down at the top of the Cut page Viewer

Navigating Edit Points and Markers
You can now use the navigation tools Playback > Previous / Next > Clip (Up Arrow / Down
Arrow) or Marker (Shift - Up Arrow / Shift - Down Arrow) in the Cut page Timeline. This new
feature now unifies Clip and Marker navigation shortcuts between the Cut and Edit pages.

Improved Transition and Effect Behaviors
You can now double click a transition in the Cut page’s Transitions panel to apply it directly to
the edit point referenced by the Smart Indicator. Double-clicking an effect in the Effects panel
applies it directly to the topmost clip at the position of the playhead.
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Chapter 3

Using the
DaVinci Resolve
Speed Editor
The DaVinci Resolve Speed Editor is an edit controller designed
specifically to work hand-in-hand with the Cut page.
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Introducing the DaVinci Resolve
Speed Editor
The DaVinci Resolve Speed Editor is specifically designed for custom integration with the Cut
page. It efficiently combines transport control, editing functions, and multi-camera support into
a powerful edit controller with a small footprint.

The DaVinci Resolve Speed Editor

Using the Speed Editor Keys
To maximize the functionality of all the keys on this reduced-sized edit controller, there are four
different finger actions used to modify a key’s commands:
 Press: A short tap to the key and release, as if you were typing.
 Double Press: Two short taps to the key and release. The double press triggers the
secondary function of the key that is written on the lower side of the keycap.
 Press and Hold: Tap the key and hold it down.
 Double Press and Hold: One short tap, and then tap again and hold the key down.

Navigation Using the Search Dial
The most prominent feature of the DaVinci Resolve Speed Editor is the large Search Dial on its
right hand side. Primarily used for navigation, in certain circumstances this dial can also be used
for parameter selection and the direct manipulation of the clips, providing an alternative to click
and drag mouse input.
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Since navigation of the Timeline is where most editors spend the majority of their time, you will
want to decide on how the playhead reacts on the Timeline. In the Cut page you have two
options: Lock or Free Playhead.
 When set to Locked, the playhead is fixed in the center of the Timeline, and your
edited clips scroll past it as you play (press the Spacebar), jog, or shuttle with
the Search Dial in either direction. Locked mode is preferred while using the
DaVinci Resolve Speed Editor.
 When set to Free, the playhead moves across the clips as you play (press the
Stop/Play bar), jog, or shuttle using the Search Dial in either direction; the clips stay still.
Once the playhead gets to the right or left edge of the Timeline, the Timeline pages
over to reveal the next part of your edit.

Playhead Lock controls

Key

Description

SOURCE

Pressing this key instantly brings the Source Tape into focus, allowing
you to navigate through all the source media in your bin.

TIMELINE

Pressing this key instantly brings the Timeline Viewer into focus,
allowing you to navigate through the Timeline.
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Key

Description

SHTL (Shuttle)

Puts the Search Dial into Shuttle mode. Used to quickly navigate long
clips or sync bins. Rotating the dial left of center “rewinds” through the
clip or timeline, rotating it right “fast forwards” through them. The greater
the rotation from center, the faster the Shuttle goes. A LED on the
keyboard will illuminate to show you that this mode is selected.

JOG

Puts the search dial into Jog mode. Used to navigate to specific frames
with accuracy and precision. Traditionally, you place your finger the the
search dial dimple, and rotate it to the left to go frame-by-frame reverse,
and to the right to go frame-by-frame forward. The faster you rotate
the search dial, the faster the navigation. A LED on the keyboard will
illuminate to show you that this mode is selected.

SCRL (Scroll)

Puts the search dial into Scroll mode. Scroll mode is essentially a
“higher geared” Jog mode. Rotating the wheel left reverses the play
direction, while rotating it right moves forward. Scroll works in terms
of seconds, rather than frames. The speed at which you rotate the
search dial determines how fast the playhead moves through the
footage. A LED on the keyboard will illuminate to show you that this
mode is selected.

TIP: As a rule of thumb, Shuttle is most effective at the scene level, Jog the clip level,
and Scroll at the timeline level.

Intelligent Keyboard Edit Modes
The DaVinci Resolve Speed Editor has dedicated keys to perform common editing functions.
DAVINCI RESOLVE SPEED EDITOR
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Key

Description

IN / CLR

This key selects the In Point of a clip or timeline. Double press this key
(CLR) to clear the In point.

OUT / CLR

This key selects the Out point of a clip or timeline. Double press this key
(CLR) to clear the Out point.
If you are viewing a bin in the Source tape, you can use the In and Out
buttons to limit the Source tape between the two points. This allows you
to quickly reduce the Source tape to a specific section, regardless of
how many clips are in your bin.

To reduce the Source tape based on In and Out points:

SMART INSRT
(Smart Insert) / CLIP

1

In the Source tape, set the newly desired duration using
the In and Out keys on the Speed Editor.

2

Press the “Source” key.

3

The Source tape is now limited to the duration between the
two points.

4

If you wish top return to the original full Source tape,
press the “Esc” key.

Automatically inserts an incoming clip at the closest edit point to the
playhead (as shown by the Smart Indicator) on the selected track,
pushing all clips to the right of the edit point forward to make room for
the incoming clip you’ve inserted to Track 1. Because this is a smart
operation, you are prevented from inserting a clip at any arbitrary
frame; incoming clips are only inserted at the closest previously existing
edit point.
Double Press this key (CLIP) to Smart Insert the entire source clip,
ignoring any In and Out points previously set on the clip.

(Top) Before doing a Smart Insert, (Bottom) After inserting clip DD
between clips AA and BB
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Key

Description

APPND (Append) /
CLIP

The position of the playhead is ignored; incoming clips are always
placed after the last clip in the Timeline.
Double Press this key (CLIP) to append the entire source clip, ignoring
any In and Out points previously set on the clip.

Performing an Append edit of clip DD to the Timeline

RIPL O/WR
(Ripple Overwrite)

At its simplest, Ripple Overwrite substitutes a clip in the Timeline with
an incoming clip. If you use Ripple Overwrite on a clip on Track 1, this will
automatically move all clips that are to the right of the affected clip in the
Timeline either forward to make room, if the incoming clip is longer, or
back to eliminate gaps, if the incoming clip is shorter.

Performing a Ripple Overwrite to substitute an entire clip at the playhead (BB)
with the incoming clip (DD)

TIP: Using Ripple Overwrite is an efficient way to audition
different takes of the same shot without disrupting the narrative
flow of the entire scene.

Chapter – 3

Using the DaVinci Resolve Speed Editor

47

Key

Description

CLOSE UP / YPOS

Pressing this key reframes a clip as a zoomed-in close up to make up for
a lack of actual close ups that would have been shot with either longer
lenses, or by moving the camera closer to the subject. This function is
particularly useful when you’re working with 4K media in a 1080 timeline,
or 8K media in a 4K timeline, which enables you zoom into existing wide
shots to create medium shots, or medium shots to create close up shots,
with no loss of quality.
Performing this edit adds the incoming clip as an approximate 20% to
40% zoomed close up and also performs a face detection. If a face or
faces are found, it automatically re-positions the face top center in the
frame. You can always reposition the close up manually using the Sizing
controls in the Inspector.
Press and Hold this key (YPOS) to adjust the Y position of the Clip using
the search dial.
How this key works depends on the mode that is active in the Cut page.

Source mode:
The selected clip in the Source Tape view is edited into the Timeline as
a close up, duration based on the In and Out points set in the clip, and
the Smart Indicator on the Timeline.

Timeline mode:
The clip under the playhead has a Close Up applied to it, and is
copied to the track above it, with a 5 second duration starting from the
playhead position.

Live Overwrite mode:
This will perform a Close Up on the selected camera as it’s overwritten
into the Timeline.
The LED on this key will then illuminate, to show you that this
mode is armed.
PLACE ON TOP

This key lets you edit the incoming clip as a superimposition above
whatever other clips are in the Timeline; the incoming clip is always
placed on top, so if there are clips in Tracks 1, 2, and 3, the incoming clip
is automatically placed on Track 4, regardless of which track is selected.
The frame the incoming clip aligns with depends on the following:
 The incoming clip aligns with the closest Timeline edit point in
proximity to the playhead (as shown by the Smart Indicator) if no
Timeline In or Out points have been defined. The playhead is ignored.
 The incoming clip aligns with a Timeline In point if one has been set.
 The incoming clip’s Out point will align with a timeline Out point
if one has been set without an In point. This “backtimes” the clip.

Before placing a clip on top
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Key

Description

PLACE ON TOP
(Continued)

After editing clip DD into the Timeline with a Place on Top edit

SRC O/WR
(Source Overwrite)

This edit requires overlapping timecode in multiple clips and Track 1 of
the Timeline to work properly, such as when recording synced timecode
to multiple cameras during a multi-cam shoot. If there is no overlapping
timecode, this edit does nothing.
If you are working with footage from multiple cameras that have synced
timecode, then the easiest way to use this edit type is to set In and Out
points over a clip in the Timeline where you want to cut away to another
angle. In the following example, a wide shot of a cooking show covers
the moment when the chef starts slicing a chili.

Setting timeline In and Out points to identify a cutaway

You can then select a clip in the Media Pool that corresponds to the
desired angle you want to add as a cutaway, which has synced timecode
that overlaps with the clip on Track 1 in the Timeline. Don’t set In and Out
points; if necessary, you can clear previously set In and Out points by
pressing Option-X.

Choosing a Media Pool clip from another camera that has overlapping timecode
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Key

Description

SRC O/WR
(Continued)

When you click the Source Overwrite key, a synced section of the
selected Media Pool clip will be edited into the Timeline between the
In and Out points you placed, superimposed on top. The result is a
perfectly timed cutaway.

Using Source Overwrite to edit a superimposed and synced section of the
source clip into the Timeline between the In/Out points

Alternatively, you can also use Source Overwrite to automatically place
a source clip with a marked In/Out region on top of a clip in the Timeline
so that its timecode syncs with the timecode of the Timeline clip, when
you don’t know exactly how much of the incoming source clip you want
to edit into the Timeline, and you just want it synced appropriately.

Search Dial Live Trimming Tools
Several of the most powerful features of the DaVinci Resolve Speed Editor involve the intuitive
trimming controls afforded by the search dial.
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Key

Description

TRIM IN

When this key is pressed and held, it lets the user trim the nearest
In point on the Timeline (as shown by the Smart Indicator), by simply
rotating the search dial back and forth. The trim point is highlighted in
green. Release the key to confirm the edit.
In Source mode, holding this key and rotating the search dial adjusts the
In Point of the clip in the Viewer.
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Key

Description

TRIM OUT

When this key is pressed and held, it lets the user trim the nearest
Out point on the Timeline (as shown by the Smart Indicator), by simply
rotating the search dial back and forth. The trim point is highlighted in
green. Release the key to confirm the edit.
In Source mode, holding this key and rotating the search dial adjusts the
Out Point of the clip in the Viewer.

ROLL / SLIDE

When this key is pressed and held, it lets the user trim the nearest
transition point (as shown by the Smart Indicator), and roll the edit point
back and forth between the clips by simply rotating the search dial. The
trim point is highlighted in green. Release the key to confirm the edit.
Double Press and Hold this key (SLIDE) to Slide the entire clip back
and forth in the Timeline. A four-way multiview will show the In and Out
points for both source and destination clips as you slide.

SLIP SRC
(Slip Source)

When this key is pressed and held, it allows the user to slip in place the
footage of the clip to the left of the Smart Indicator back and forth by
moving the search dial. A four-way multiview will show the In and Out
points for both source and destination clips as you slip. The clip that will
slip will be highlighted in orange. Release the key to confirm the edit.

SLIP DEST
(Slip Destination)

When this key is pressed and held, it allows the user to slip in place the
footage of the clip to the right of the Smart Indicator back and forth by
moving the search dial. A four-way multiview will show the In and Out
points for both source and destination clips as you slip. The clip that will
slip will be highlighted in orange. Release the key to confirm the edit.

TRANS DUR
(Transition Duration)
/ SET

Holding down this key when a transition is under the Smart Indicator will
allow you to change the duration of the transition using the search dial.
Turning the dial left will shorten the transition, and right will lengthen it.
Once the duration is correct, release the key.
Double Pressing this key (SET) allows you to set the current transition
length as the default transition duration.

TIP: Multiple transitions can be changed at the same time by holding down Command
and selecting the transitions on the Upper Timeline, then pressing the appropriate
transition key (CUT, DIS, SMTH CUT).
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Transition Keys
This set of keys provide immediate shortcuts to the most commonly used transition commands.
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Transition keys for Cut,
Dissolve, and Smooth Cut

Key

Description

CUT

This key will set a simple cut at the Timeline edit point, as shown
by the Smart Indicator. If there is another transition already present
there, it will replace it.
The LED on this key will illuminate to show you the Cut Transition is
armed in Live Overwrite mode.

DIS (Dissolve)

This key will add a one second dissolve centered between the two
shots at the Timeline edit point, as shown by the Smart Indicator. If
there is another transition already present there, it will replace it.
The LED on this key will illuminate to show you the Cut Transition is
armed in Live Overwrite mode.

SMTH CUT
(Smooth Cut)

This key will add a Smooth Cut transition centered between the two
shots at the Timeline edit point, as shown by the Smart Indicator. If
there is another transition already present there, it will replace it.
The LED on this key will illuminate in Live Overwrite mode to show you
the Cut Transition is armed.
Smooth Cuts are special-purpose transitions designed to make short
jump cuts in the middle of a clip unnoticeable. This is done by using
optical flow processing to match the same features on either side of
a cut in order to automatically morph a subject from one position to
another over the duration of the transition.

Chapter – 3

Using the DaVinci Resolve Speed Editor

52

Key

Description

SMTH CUT
(Continued)

The Smooth Cut effect works best on clips such as sit-down interviews
and close-up head shots with a minimum of background and subject
motion, and where the subject’s position on either side of the cut is not
significantly different. A good example of when Smooth Cut is effective
is when you’re cutting pauses, partial repeats, filler sounds such as “um”
or “you know,” or other speech disfluencies out of an interview clip to
tighten the dialog, and you want to eliminate the little “jump” that occurs
at the cut without having to cut away to B-roll. Applying a short two- or
four-frame Smooth Cut transition to the edit can make this kind of edit
invisible, as long as the speaker doesn’t change position significantly
during the cut. The more motion there is in the background of the shot,
and the more the speaker changes position, the harder it will be to get
a useful result using Smooth Cut. Although the default duration for any
transition is one second, you’ll find that Smooth Cut transitions may work
much better when they’re short; 2- to 6-frame Smooth Cut transitions
often work best to disguise jump cuts.

Function Keys
Function Keys
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Key

Description

ESC / UNDO

This key functions the same way as the escape key on your keyboard,
but in the Cut page it is also used to clear a selected camera in the
Sync Bin.
Double press this key (UNDO) to undo your last action. Multiple doublepresses take you back through the Undo history.
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Key

Description

SYNC BIN

This key will open up the Sync Bin for easy multi-camera editing.
For more information on using the Sync Bin see Chapter 20,
“Fast Editing in the Cut Page” in the DaVinci Resolve Reference Manual.
Distance Indicators to Adjacent Edits
When using the Speed Editor’s search dial while using the Sync Bin, the
Cut page playhead in the lower timeline now has two small windows to
either side showing the distance to the nearest edit. The left window
shows the time to the nearest previous edit, and the right window shows
the time to the next previous edit. Both windows are in seconds:frames
(SS:FF) format. This feature allows you to quickly jump to, or modify an
edit point using the direct timecode entry method.

The Distance Indicators when using the Search Dial in
the Sync Bin. The left window is showing one second
and ten frames to the previous edit, and the right
window is showing thirty three frames to the next edit
as shown by the smart indicator.

AUDIO LEVEL /
MARK

Press and holding the Audio Level key allows you to adjust the selected
clip’s Volume parameter by rotating the Search dial. If no clip is selected
it will modify the clip on the highest track under the playhead.
Double pressing this key (MARK) adds a marker placed at the playhead’s
current position. Double press again to enter the marker’s editing dialog
box to add comments, durations, etc.
Double press and holding this key allows you to set the color of the
marker before you add it, by rotating the search dial.

Double pressing and holding down the Audio level/Mark
key brings up a rotary marker color selector that you can
navigate with the search dial
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Key

Description

FULL VIEW / RVW

Pressing this key expands the Viewer to Full View mode on the interface
monitor. Pressing this key again returns the Viewer to its normal mode.
Double press this key (RVW) to review your edit. This function plays
back a pre-roll before and post-roll after the last edit in Full View mode.
The pre- and post-roll time durations can be set in the Editing section of
the User tab in the DaVinci Resolve preferences.

TRANS / TITLE

Press and hold this key to bring up a drop-down menu of your available
transitions in alphabetical order and an icon describing their shape.
Rotating the search dial left and right will navigate you through the list.
When you find the transition that you want, simply release this key and it
will be placed at the Timeline edit point as shown by the Smart Indicator.
Double press and hold this key (TITLE) to modify the font of an existing
title. If the playhead is over a basic title and this key is held, you can
rotate the search dial to change the font of the title. This only modifies
the first text element in a title. Once you’ve selected your font, release
the key to set it.
The LED on this key will illuminate to show you the Standard Transition is
armed in Live Overwrite mode.

Drop-down Transition menu

SPLIT / MOVE

Press this key to create a new cut in a clip at the playhead position.
The cut will affect all clips under the playhead if more than one track is
being used.
If the playhead is over an existing split, pressing this key will remove the
split and join the two parts of the clip back together.
Double press this key (MOVE) to move your selected clip in the Timeline.
Using the search dial, you can move the clip backwards and forwards in
the Timeline from edit to edit. The Timeline will reflow to adapt to your
clip placement. When you find the place you want to move your clip to,
release the key to set it.
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Key

Description

SNAP /
(Viewer Resize)

Press this key to enable the Snapping mode designed specifically for
the search dial. With snap turned on in Jog mode, and when the search
dial is rotated very slowly, the playhead will briefly pause at each edit
point in the Timeline. This key has an LED to show you when this mode
is active.
Double press and hold this key (Three Lines) to dynamically resize
the Viewer window using the search dial. Rotating the dial to the left
increases the Viewer size, and to the right decreases it.

RIPL DEL
(Ripple Delete)

Pressing this key will delete the selected clip or clips, and then close any
gaps that occur by rippling the Timeline to the left. If no clip is selected,
this key will ripple delete the clip under the playhead.

Sync Bin Multi Camera Selection
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Key

Description

VIDEO ONLY

Press this key to only allow the video from your source clip
into a video track on the Timeline.
This key has an LED to tell you when it is active. Press this
key again to deactivate.

AUDIO ONLY

Press this key to only allow the audio from your source clip
into an audio track the Timeline.
This key has an LED to tell you when it is active. Press this
key again to deactivate.
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Key

Description

STOP/PLAY

This key starts and stops playback on your Timeline or
source media. It’s conveniently arranged for using your
thumb, while your fingers are on the search dial.

CAM 1-9

These keys only function in Sync Bin view. Each camera key
allows you to choose its corresponding camera angle as
active in the Sync Bin. Pressing any Camera key will expand
that camera angle into the Source Clip view, making it easy
to set specific In and Out points and perform edit functions.
You can change camera angles instantly in the Source Clip
view by simply pressing another Camera key. If you wish to
return to the Sync Bin view, press the Escape key.
These keys illuminate and have a switcher-like function in
Live Overwrite mode, as explained below.

Live Overwrite Mode
DAVINCI RESOLVE SPEED EDITOR
SMART
INSRT

APPND

CLIP
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CLOSE
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PLACE
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TRIM
IN

TRIM
OUT
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MOVE
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VIEW

MARK
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JOG
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SCRL

Live Overwrite keys

RND

CAM
4

CAM
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CAM
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VIDEO
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2

CAM
3

AUDIO
ONLY

SLIDE

SLIP
SRC

SLIP
DEST

TRANS
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CUT

DIS

SMTH
CUT

STOP/PLAY

Key

Description

LIVE O/WR

The Live Overwrite mode in the Speed Editor can be
thought of as switching a live Multicam shoot without all
the annoying constraints of linear time. With all the camera
angles locked together in the Sync Bin, you can perform
and trim all the edits, transitions, and camera switches, you
want and never go out of sync. Every edit you make will be
perfectly synchronized to the Timeline automatically.
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LIVE O/WR (Live Overwrite Mode) / RND (Random)
Press this key to enter Live Overwrite mode. An LED will illuminate to tell you this mode is
active. It immediately activates the Sync Bin and the Multicam Viewer, and switches the Speed
Editor into a different mode, slightly changing the functionality of several keys to accommodate
the Live Overwrite workflow. A key that is in Live Overwrite mode has an LED light illuminate to
let you know that the key’s function is currently active.
Double Press this key (RND) to edit a Random camera angle with a random duration into the
Timeline from the Sync Bin.
Using Live Overwrite Mode
Editing Multicamera shoots in Live Overwrite mode starts with the base layer on track V1.
The clip you put here has two additional functions other than its video content. First, it provides
a continuous timecode track that is the foundation of all the Sync Bin functionality. Second, it
provides content to measure all of the ripple functions against.
NOTE: Live Overwrite Mode only works with clips in the Sync Bin. If there are no clips
set in the Sync Bin, this mode will not function. For more information on setting up the
Sync Bin, see Chapter 20, “Fast Editing in the Cut Page,” in the DaVinci Resolve
Reference Manual.

A good starting point is to place your master camera angle, uninterrupted from beginning to
end on track V1. You will be able to edit this track, remove whole sections, and re-arrange it as
necessary later in the process, but for now, this master clip on V1 will serve as the backbone
of the edit.

Live Overwrite mode, with the master camera angle (Cam 4) edited in on track V1

Once the master clip of the Sync Bin is on V1, you can start using the Live Overwrite mode in
earnest. The concept to understand about Live Overwrite is that this method of editing
bypasses traditional In and Out points all together, and edits are performed with the Camera
keys working in conjunction with the Search Dial.
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Performing a Live Overwrite edit:
1 Press the Live O/WR button to activate the mode. The LED on the key will illuminate.
2

Use the search dial to navigate the Sync Bin to where you want to make an edit (switch
camera angles). You will notice all cameras and the Timeline will move together in sync.

3

Select a camera angle in the Multicam Viewer you wish to edit in, and press and hold
the corresponding Camera key on the Speed Editor, while rotating the search dial
forward. This will edit in a new clip on top of the V1 track, and you can use the search
dial to immediately set its duration.

4

Release the Camera key to set the edit.

Performing a Live Overwrite by holding down the Camera
5 key and rotating the search dial to the right

From here you can immediately press and hold another Camera key and rotate the
search dial to continue the Multicam edit. You can think of this method as “painting-on”
clips to the Timeline, rather than inserting them. Clips edited in this fashion will never
overwrite other clips on the same track. Live Overwrite will always add the clip to the
next highest track, and create a new track automatically if necessary.

”Painting-on” the next edit by holding down the Camera 7 key
and rotating the search dial to the right

Continuing the edit from here does not require working in a linear fashion. Because the master
track is on V1, you can skip ahead anywhere on the Timeline and start “painting-in” camera
angles wherever you wish, and because the Timeline and Source clips are locked together in
the Sync Bin, whatever edit you add will always be in perfect sync.
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Live Overwrite Mode Key Modifiers:
Selecting Live Overwrite mode subtly changes the functions of many keys on the Speed Editor,
so they work in conjunction with this mode. Each of these keys has an LED that illuminates to
tell you the function is active before you perform a Live Overwrite edit.
Key

Modifier

Description

LIVE O/WR

CUT

Automatically adds a simple cut to the beginning of each
clip edited to the Timeline. This option is also effectively no
transition added.

DIS

Automatically adds a Cross Dissolve transition to the
beginning of each clip edited to the Timeline. If the edited
clip is immediately adjacent to another clip on the same
track, the dissolve will be centered on the cut. If there is no
clip immediately adjacent, the dissolve will start on the edit
instead, and dissolve from the video on the track underneath
the clip.

SMTH CUT

Automatically adds a Smooth Cut transition to the beginning
of each clip edited to the Timeline. If the edited clip is
immediately adjacent to another clip on the same track,
the Smooth Cut will be centered on the cut. If there is no
clip immediately adjacent, the Smooth Cut will start on the
edit instead, and Smooth Cut from the video on the track
underneath the clip.

TRANS

Automatically adds whatever transition is set as the “Standard
Transition” in the Transitions panel to the beginning of each
clip edited to the Timeline. If the edited clip is immediately
adjacent to another clip on the same track, the transition
will be centered on the cut. If there is no clip immediately
adjacent, the transition will start on the edit instead, and
transition from the video on the track underneath the clip.

CLOSE UP

Automatically performs a Close Up action on the camera as
its edited into the Timeline.
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Chapter 4

DaVinci Resolve
Editor Keyboard
Improvements
The DaVinci Resolve Editor Keyboard has updated its function key
controls to expand its versatility in both DaVinci Resolve and your
computer’s native OS.
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Using the Function (Fn)
Key on the Editor Keyboard
There are three types of key actions mapped to the DaVinci Resolve Editor Keyboard. The
Function (Fn) key in the lower left of the keyboard toggles these modes and each type of key
action modifies the resulting commands. These key actions give you access to standard
computer functions in your native OS.
 Key Press: Simply pressing the key once.
 Fn + Key Press: Holding down the Fn key and then pressing another key.
 Tap Fn + Hold: Pressing the Fn Key once, then pressing Fn again and holding it down,
then pressing another key. This is a total of three key presses.

Editor Keyboard Function (Fn) Key Map
Key Press

Fn + Key Press

Tap Fn + Hold

SYNC BIN

F1

DECREASE SCREEN BRIGHTNESS

INSERT BLACK

F2

INCREASE SCREEN BRIGHTNESS

FREEZ

F3

SHOW ALL WINDOWS

TRANS

F4

SHOW ALL APPLICATIONS

PIC IN PIC

F5

DECREASE KEYBOARD LED BRIGHTNESS

SWAP

F6

INCREASE KEYBOARD LED BRIGHTNESS

VIDEO ONLY

F7

PREVIOUS TRACK

AUDIO ONLY

F8

PLAY/PAUSE

INSERT

F9

NEXT TRACK

O/WR

F10

MUTE

REPL

F11

DECREASE VOLUME

FIT TO FILL

F12

INCREASE VOLUME

UP ARROW

PAGE UP

PAGE UP

DOWN ARROW

PAGE DOWN

PAGE DOWN

LEFT ARROW

HOME

HOME

RIGHT ARROW

END

END

HOME

END

END

KEYPAD ENTER

CALCULATOR

CALCULATOR

DELETE

FORWARD DELETE

FORWARD DELETE

CAM

PRINT SCREEN

PRINT SCREEN

TIMECODE

PAUSE

PAUSE

DUR ENTER

NUM LOCK

NUM LOCK
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Chapter 5

Media and
Edit Page
Improvements
The Media and Edit pages have numerous improvements spanning the
gamut of editorial workflow. More clip functionality in the Media Pool,
enhanced integration with Fusion, and better Timeline management are all
included in this release.
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Media Pool Improvements
A variety of new features have been added to the Media Pool, which make it easier to set up
and import clips into a timeline.

Converting Compound Clips or Timelines to Multicam Clips
It’s now possible to convert compound clips and timelines into multicam clips for easier editing
using the Edit page’s Multicam Editing interface. This conversion is a one-way process.
You cannot reconvert a multicam clip back to a timeline or compound clip. If you wish to
preserve the original timeline or compound clip, make sure to duplicate it first, and then convert
the copy. For more information, see Chapter 32 “Multicam Editing” in the DaVinci Resolve
Reference Manual.
To convert a compound clip or timeline to a Multicam clip:
– Right-click on the clip or timeline in the Media Pool and choose “Convert Compound
Clips (Timelines) to Multicam Clips” from the drop down menu.

Insert Selected Clips to Timeline Using Timecode
Clips can now be edited directly from the Media Pool into a timeline, such that each clip’s
source timecode is aligned with an identical record timecode value in the Timeline. This can be
useful for long form multi-camera events, like weddings or concerts, where all cameras are
linked by the same timecode to ensure all edits are perfectly synced. This function matches the
Source Overwrite edit on the Cut page.
IMPORTANT: The timecode of the Timeline must overlap the timecode of
the clip(s) for this edit to function. This can be set in the Start Timecode field of the
New Timeline settings.

To insert selected clips to timeline using timecode:
1 Select one or more clips to edit into the Timeline in the Media Pool. If there are In and
Out points set on the clip, the edit will respect those boundaries. If no In/Out points are
set, each selected clip’s full duration will be edited in its entirety.
2

Set a destination control to determine which track in the Timeline you want to edit to.

3

Right-click one of the selected clips and choose “Insert Selected Clips to Timeline
Using Timecode” from the drop-down menu.

4

All of the selected clips will be overwritten into the Timeline at their appropriate
timecode locations onto the destination track.

IMPORTANT: If multiple selected clips have overlapping timecode, no edit will occur.
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Insert Selected Clips to Timeline with Handles
This command inserts multiple clips into the Timeline serially, using the current sort order of
the Media Pool, with handles subtracted from the current In and Out points of each clip (using
the Default Handles Length in the Editing panel of the User Preferences). Combined with the
Add Transition tool (Command-T), this function is useful when quickly creating montages from
multiple clips.
To insert clips with handles to the Timeline:
1 Select the clips to insert into the Timeline with handles in the Media Pool.
2

Right-click any selected clip, then choose “Insert Selected Clips to Timeline
With Handles.” The clips will be inserted starting at the Timeline In point with
the default handles length already calculated.

TIP: To finish creating the montage, select the clips in the Timeline, then choose
“Add Transition” (Command-T) from the Timeline menu. This will apply the default
transition to all of the clips at once.

Ability to Create Timelines with Audio Mixer Presets
For advanced audio workflows and ease of use with Fairlight, you can now create a timeline
with pre-assigned audio tracks using a previously created Fairlight Configuration preset. To use
this function, create a new timeline, and check the “Use Fairlight Configuration Preset” box.
A drop-down menu then appears, allowing you to select the specific preset for the Timeline.
You can create Fairlight Configuration presets using the Fairlight Presets Library, available from
the Fairlight menu. For more information, see Chapter 150 “Setting up Tracks, Buses, and
Patching” in the DaVinci Resolve Manual.

Support for Importing Boris Continuum FX
with AAF Timelines
Boris Continuum FX effects and settings will now be imported along with a timeline via
AAF export. You’ll need to have the same Continuum suite of effects installed on both
machines (OFX version for DaVinci Resolve, AVX for Avid). When importing an AAF, Boris
Continuum effects that were used in the original NLE will appear on each affected clip in the
resulting DaVinci Resolve timeline, with all previously applied parameters available in the
inspector. The Sapphire and Mocha suites are not available for AAF import at this time.

Import XML, EDL, and AAF Timelines
with an Empty Media Pool
It is now possible to import an XML, EDL, or AAF file into DaVinci Resolve without having any of
that timeline’s corresponding media in the Media Pool.
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Timeline Improvements
There have been several new features that improve timeline functionality in terms of playback,
organization, and interoperability with other pages in DaVinci Resolve.

Convert Fusion Compositions to Edit Effects
If you have created a Fusion Composition that you would like to use across a number of
projects, you can now save it to the Effects toolbox in the Edit page. This allows easy access to
the effect from the Edit page, and simple application to video clips in the Timeline.
To convert a Fusion composition to an Edit effect:
1 Export the composition as a macro in Fusion, by right clicking on a node and selecting
Create Macro from the contextual menu.
2

Save the macro file (.setting) to the following directory:
– MacOS: /Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/

Templates/Edit/Effects
– Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Fusion\Templates\

Edit\Effects
– Linux: /opt/resolve/Fusion/Templates/Edit/Effects

The effect will now be available as a drag and drop effect in the “Fusion Effects”
section of the toolbox in the Effects Library on the Edit page.

Change Transitions to Fusion Compositions
If you need to create a more complex transition than you can get from the Inspector, it is now
possible to change any transition to a Fusion Composition on the Edit Page timeline.
To convert a Resolve transition to a Fusion composition:
1 Add a transition between two clips on your Timeline.
2

Right-click on the transition and select “Convert to Fusion Cross Dissolve.”

3

Right-click on the transition again and select “Open in Fusion Page.”

A new Fusion composition opens with the base Cross Dissolve nodes and tools already set.
You now can use all of the powerful tools in the Fusion page to customize your transition.

The node tree you start with after converting a transition to a Fusion Cross Dissolve
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Scroll Wheel Controls on Timeline
Additional Scroll Wheel Timeline controls have been added to the Edit page Timeline.
To manipulate the Timeline, rotate the scroll wheel while holding down:
 Shift: Expands or contracts all the Video or Audio track heights, depending
on what section the pointer is located at when you scroll.
 Option: Zooms in and out the view of the Timeline.
 Command: Navigates forwards and backwards in the Timeline.

Zoom Around Mouse Pointer
You can set up the Edit Timeline zoom controls to stay centered on the pointer as you zoom in
or out, instead of staying centered on the Timeline playhead as usual, by selecting View >
Zoom Around Mouse Pointer. This can be helpful when navigating longer timelines.
With this option enabled, zooming in and out of the Timeline using the scroll control of your
pointing device while holding the Option key down keeps the Timeline centered on the pointer.
Deselect this option to return to the behavior of only zooming in or out centered on the
playhead position.

Fast Review on the Edit Page
The Fast Review feature of the Cut page is now available in the Edit page. Fast Review plays
back your timeline at variable fast forward speeds where the speed of playback is dependent
on the length of each clip on the Timeline. Longer clips play back at faster speeds than shorter
ones. This feature is designed to allow you to quickly scan through a large amount of material
on a timeline.
To use the Fast Review feature on your Edit Page timeline, select Playback > Fast Review.
Pressing K or the spacebar will return you to the normal JKL playback mode. If you use this
feature often you can bind Fast Review to a specific key in the Keyboard Customization window.
NOTE: Fast Review does not work for clips in the Source Viewer, only for timelines in
the Timeline Viewer.

Create Timeline Using an IMF or DCP
Composition Playlist (CPL) (Studio Only)
You can now create a timeline in DaVinci Resolve that exactly replicates the Composition
Playlist (CPL) of a DCP or IMF package.
To create a timeline using a Composition Playlist (CPL):
1 Import an IMF or DCP package into the Media Pool, like any other piece of media.
2

Right-click on the imported clip and choose “Create New Timeline Using Composition
Playlist” from the contextual menu.

3

In the New Timeline dialog box, choose a specific CPL from the package in the
“Composition Playlist” dropdown menu.

4

Make any other normal New Timeline adjustments you may need (such as Resolution,
Aspect Ratio, etc.), then click the “Create” button.
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Track Heights Independent of Thumbnail Settings
Track heights in the Edit page are now independent of the Thumbnail and Waveform view
settings in the Timeline View options. Previously, specific Timeline viewing options such as
Filmstrip or Thumbnail view had minimum track height settings. Now you can freely change
track height no matter what options you’ve chosen, and resizing one or more tracks below the
minimum height for filmstrips or thumbnails automatically collapses those tracks into Simple
view to avoid clutter.

Support for DCTL Based Transitions
DCTL based transitions are now supported in DaVinci Resolve, and can be found in the
Transitions section of the Open FX category of the Effects Library. See the DaVinci Resolve
Developer Documentation in the help menu for more details.

Improved Frame.io Marker Navigation (Studio Only)
You can now specifically navigate only markers created in Frame.io while in the comment dialog
of a Frame.io marker, using the Previous Marker (Shift-UpArrow) and Next Marker (ShiftDownArrow) commands. This allows you to skip directly from comment to comment in Frame.io
without having to either navigate all markers in-between, or double-click each Frame.io marker
individually to respond. Frame.io interoperability is a Studio Only feature.

Improved Take Selector and Retime Control Behavior
Active Retime and Take Selector controls can now be closed by pressing the Escape key or
toggled on and off by repeatedly pressing the control’s assigned keyboard shortcut.

Viewer Improvements
The Viewers in DaVinci Resolve have been updated with several usability improvements.

Ability to Monitor HDR and SDR From the Edit Page
You can now view HDR and SDR outputs of your timeline simultaneously from the Edit page.
The SDR signal will be mapped to the first output of your video I/O device, and the HDR signal
will be mapped to the second. This functionality was previously only available in the Color page.

Ability to Monitor Stereoscopic 3D From the Edit Page
You can now view a Stereoscopic 3D signal directly from the Edit page. Previously, the Edit
page was restricted to left eye for both outputs. The Edit Page Viewer now displays
Stereoscopic 3D identically to the Color Page Viewer. The 3D palette in the Color page has the
stereoscopic controls to select the stereo viewing options (Side by Side, Anaglyph, Line by
Line, etc.), as well as adjusting the convergence and other stereoscopic parameters.
For more information on setting up 3D output, see Chapter 172 “Stereoscopic Workflows” in the
DaVinci Resolve Reference Manual.

Ability to Copy and Paste Timecode in Viewers
Based on Timecode Mode
You can now copy and paste timecode values directly from timecode fields in the viewers
across the Media Pool, and Cut, Edit, and Deliver pages.
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To copy and paste between timecode fields:
1 Choose the appropriate timecode mode (Source/Record/Frames/KeyKode, etc.) by
right-clicking on the timecode field in the Viewer and choosing the mode you want to
copy from.
2

Right-click again in the timecode field and choose Copy Timecode.

3

Right-click on any other Viewer’s timecode field, and choose Paste Timecode to paste
that value.

Additional Viewer Wipe Modes for Offline Reference Clips
Three new wipe modes have been added to the Offline Viewer, that allow you to check the
sync between your current timeline and its Linked Offline Reference Clip. You can open the
Offline Viewer by choosing Offline in the Source Viewer Mode drop-down menu, and then
right-clicking in the Program Viewer to select the wipe type. These new modes are:
 Diagonal: Lets you compare both halves of the wipe via an adjustable diagonal border.
Dragging the pointer repositions the wipe to the left and right. Hold the option key
down and drag while moving the pointer around in a circle to rotate the border of the
wipe to any angle you like.
 Venetian Blind: Lets you compare both images being wiped via alternating horizontal
strips. Drag the pointer up or down to change the size of the alternating strips. Good for
quickly comparing vertical color uniformity, focusing on color and contrast changes that
occur from top to bottom.
 Checkerboard: Lets you compare both images being wiped via an alternating
checkerboard. Drag the mouse left or right to alternate between images by squeezing
each check horizontally. Good for comparing color uniformity across the width and
height of two images.

Editing Improvements
The following improvements aid everyday editing functionality.

Updated Selection Methods on the Timeline
Clip selection no longer automatically moves along with the playhead. Instead, a new set of
commands lets you create and move a selection by holding down the Command key and
pressing the Up, Down, Left, and Right Arrow keys. This allows you to select clips above and
below the current track and to the left and right, independently of the playhead.
You can return the Clip Selection mode back to its previous behavior of automatically selecting
the clip it’s intersecting by turning on the “Selection Follows Playhead” option in the
Timeline menu.

Scene Cut Detection on the Timeline
If you need to break down a previously edited video into its component clips for re-editing or
color correction, you can now do so directly in the timeline. Using the DaVinci Neural Engine,
DaVinci Resolve can automatically analyze and split up an edited video into individual clips.
Timeline Scene Cut Detection is also available in the Cut page. If you prefer, you can continue
to use the original Scene Cut Detection tool found in the Media Pool.
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To use Scene Cut Detection on the Timeline:
1 Select one or more clips you want to split on the Timeline. Alternately, you can limit
Scene Cut Detection to just a portion of a clip by setting In and Out points on the
Timeline around the section you want to analyze.
2

Choose Timeline > Detect Scene Cuts.
A dialogue box appears, “Detecting scene cuts in clips x of x.” This process can take
some time, depending on the length, number, and complexity of the clips you’ve
selected. When the Scene Cut Detection has finished, the clip you selected will be
broken up into a number of through edits that now can be used as independent clips.

Checking and Fixing Your Results
If the Neural Engine has made an error, you can fix it manually by navigating to the cut using
the Up and Down Arrow keys to go back and forth in the Timeline, and by then doing one of
the following:
 To remove a Cut: Click the through edit to select it, and press the “Delete” key.
 To make a New Cut: Place the timeline indicator at the cut point, and choose
Timeline > Split Clips (Command-\).

A single clip of a finished edit, consisting of multiple cuts before the Detect Scene Cuts command

Multiple individual clips extracted from the edited clip via Detect Scene Cut; the operation
has been contained by the In and Out points, and one of the resulting through edits has been
highlighted in green

Auto Align Clips
DaVinci Resolve now includes more advanced syncing features that are accessible directly from
the Timeline. Auto Align Clips slides one or more selected clips to align with the timecode or
audio waveforms of another clip that has matching timecode or audio. This function works for
video clips, which can be aligned using timecode, and for audio clips which can be aligned
using either timecode or waveform matching. Waveform matching can also be used if you’re
working with audio/video clips.
You can only select one clip per video or audio track to align, and they all will align to whichever
clip is on the lowest-numbered video or audio track. Clips selected that have no overlapping
timecode or audio waveform will not be moved and left in their original position on the Timeline.
For example, clip A on track V1 overlaps with clip B on track V2, but not with clip C on track V3,
or clip D on track V4. Selecting all clips and using Auto Align Edits will slide clip B to align with
clip A, but clips C and D won’t be moved because they don’t overlap with clip A.
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The original Timeline with Clip A (blue) and Clip B (orange) that
have some overlapping audio but are out of sync

The same Timeline after the Auto Align command; Clip B (orange) has been slipped to sync via audio
waveform with Clip A (blue). Clips C (tan) and D (green) were also selected, but because they had no
overlapping timecode or audio, they remained in place.

In another example, clip A on track V1 overlaps with clips B, C, and D on tracks V2, V3, and V4
respectively. Selecting all clips and using Auto Align Edits will slide clips B, C, and D to be
aligned with clip A.

The original Timeline with Clip A (blue), and Clip B (orange), C (tan)
and D (green) all have overlapping audio, but are out of sync.

The same timeline after the Auto Align command. All clips are now in sync
and the audio waveforms now all match. All the other clips moved to Clip A’s
(blue) position because it was the lowest clip on the Timeline.
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To use Auto Align clips:
1 Arrange the clips you want to align with one another on the Timeline so that there’s one
clip per track. All clips will sync to the clip on the lowest track number. All clips must
have overlapping timecode or audio waveforms.
2

Select every clip that you want to align (only one per track).

3

Right-click one of the selected clips, and choose an option from the Auto Align Clips
submenu, either “Based on Timecode,” or “Based on Waveform.”

If Timecode is selected, the operation will be instant. If Waveform is used, a progress bar will
appear showing you how long it will take DaVinci Resolve to analyze the selected audio
waveforms before your clips are aligned. If you’ve selected clips that can’t be aligned, a warning
box will appear and tell you which clips had errors.
For video, this can be useful for multi-camera editing situations where you want to align an
insert with the action of an alternate angle. For audio, this is useful for situations where you
have multiple recordings of the same audio that you want to align for further editing.
NOTE: Waveform matching won’t work for re-recorded audio, such as dialog that’s
been re-recorded using the ADR tools of the Fairlight page, as the correspondence
between two waveforms must be precise for a match to be found

Delete Gaps Within a Specified Range
The process of deleting gaps in your timeline can now be more targeted. The Edit > Delete
Gaps command now respects both In/Out ranges and clip selections on the Timeline.
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Chapter 6

Cut and Edit Page
Effects
DaVinci Resolve 17 brings several enhancements to working with effects
in the Cut and Edit pages. A new Burn Away transition, Edit Timeline
compositing tools, and many usability improvements are available in
this release.
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Render in Place
Render in Place allows you to render and bake in all effects that are applied to a single clip on
the Edit page Timeline. This command, which only works in the Edit page, creates an entirely
new media file that replaces the original clip on the Timeline. This new file is created in the
same directory as the original source file and is added to the Media Pool automatically.
You can use Render in Place to improve the playback performance of a computationally
intensive clip, or use it to create a new high-quality master media with effects that have been
finalized baked in. For example, perhaps you have created a clip with a complicated speed
ramp, and you want to pass it to another editor or vfx artist in a round-trip rendering scenario,
but you are worried about how other programs may interpret the speed effects. In this scenario
you could render the clip in place at master quality, and then render and deliver the program.
Render in Place is not a one way operation. Afterwards, you have the option to “Decompose to
Original” to bring back the original clip with the original effects, if you need to make a change
because the clip was not really as finalized as you were hoping.
To Render in Place:
1 Select one or more clips on the Edit Page timeline. Selecting multiple clips results in
each clip being individually rendered in place, but as a batch operation.
2

Right-click the selection, and choose “Render in Place” from the contextual menu.

3

Choose the appropriate Render Clip Options, and then click the “Render” button.
– Start Timecode: Sets the starting timecode value for the clip.
– Format: Selects the media file format.
– Codec: Selects the video codec.
– Type: Specifies the compression parameters of the selected codec.
– Include Handles: Gives you the option to specify the number of frames before and

after the clip In/Out points to be rendered.
– Include Video Effects: Turn on this checkbox to bake in all effects that have been

applied to the clip, including Fusion compositing, sizing, Open FX or Resolve FX,
speed effects, and grading. Turning this checkbox off renders the clip with speed
effects baked in, but no other effects applied.

The Render in Place options

4

Use the File dialog that appears to choose where you want to save the resulting media.
Choose a location and click Open.
A progress bar appears to show you how long this will take. When finished, your new
media is saved in the designated location, added to the Media Pool, and will replace
each corresponding source clip on the Timeline.
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If you’ve used Render in Place and end up having buyer’s remorse, or a late-breaking change
comes back to you later, you can easily decompose to the original clip with its editable effects
to make the change.
To Decompose to Original:
1 Select one or more clips that have already been Rendered in Place, on the
Edit Page timeline.
2

Right-click the selection, and choose “Decompose to Original” from the
contextual menu.
The original clip, along with all of its editable effects, will be returned to the Timeline.
The new media created in the Render in Place process will not be deleted from the
source folder, nor will it be removed from the Media Pool. It is effectively a new clip.

Smart Reframe (Studio Only)
The new Smart Reframe feature in DaVinci Resolve 17 makes it easier to quickly reframe
material across extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9
horizontal video and find yourself needing to create a vertically-oriented 9:16 version for mobile
phones and social media deliverables, or using 4:3 archival footage in a 2.39:1 widescreen
movie. Smart Reframe can be used manually, or automatically executed using the
DaVinci Resolve Neural Engine.

Smart Reframe in action, with the Reference Point bounding box active (right)

The Smart Reframe tool is found in the Sizing tab of the Inspector and is available in both the
Cut and Edit pages.
To use the Smart Reframe tool:
1 Duplicate your timeline, right-click the Timeline and choose Timelines > Timeline
Settings, and click Use Custom Settings to change the Timeline Resolution to the
aspect ratio needed for delivery. Make sure that “Mismatched resolution files” is set to
“Scale full frame with crop,” and click OK.
2

Select one or more clips you want to reframe, and open the Inspector to the Sizing tab.

3

Open the Smart Reframe controls, leave the Object of Interest drop-down menu set to
Auto (if you’ve selected more than one clip, Auto is the only setting available), and click
“Reframe.” DaVinci Resolve will analyze your footage and should automatically adjust
each individual clip’s position to a more aesthetically pleasing framing.
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4

(Optional) If the “Auto” setting does not give you desirable results for a particular clip,
you can manually select the main subject using the following steps.
a.	To manually select the subject area, choose “Reference Point” from the Object of
Interest drop-down menu, and click the target icon just to the right of the menu. This
automatically sets the Viewer mode to Smart Reframe, exposing the onscreen
controls for choosing a reference.
b.	Drag the Reference Point bounding box around the main subject of interest in the
frame. You may use the Transform controls directly above in the Inspector to move
the source clip around if your subject is outside the current framing.
c.	Click “Reframe.”

The Inspector’s Smart Reframe controls
showing the manual reference point selected

DaVinci Resolve locks onto and, if necessary, tracks your subject using the reference
you’ve selected, automatically panning and scanning the original clip as needed to
keep the reference within the new aspect ratio. While involving a bit of manual
adjustment, this function still dramatically reduces the time involved in pan and
scanning footage by manually adjusting and keyframing the sizing controls.

Edit Page Keying and Compositing Tools
The Edit page received a significant overhaul of its Compositing tools in this release. There
have been many usability improvements and refinements to its compositing features. For more
intricate and fine control, you may still want to look to the Fusion page, but simple compositing
jobs can be now be done right in the Timeline.

Resolve FX Keying in the Timeline
You can now pull keys directly in the Timeline using the Resolve FX Key filters. These are found
in the Resolve FX section of the Open FX category, of the Effects Library. The filter options are
3D Keyer, HSL Keyer, and Luma Keyer, and they are described in detail in the Resolve FX
chapter of this guide.
To set up a green screen composite, place your background video on a track underneath your
foreground video, and drag the 3D Keyer or HSL Keyer onto the foreground clip.
To adjust the key’s parameters, click on the Effects icon in the Inspector to reveal the Keyer’s
controls, and Select “Open FX Overlay” from the Transform Mode drop-down in the lower-left
of the Timeline Viewer, to allow the effect qualifiers to work on the Timeline Viewer.
To pull a Chroma Key in the Timeline using the 3D Keyer.
1 Superimpose your green screened foreground video on a track on top of your
background video.
2

Put the Timeline Viewer in Open FX Overlay mode, using the drop-down menu at the
lower left of the Viewer. This option allows you to use the effect GUI controls directly on
the Viewer.
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3

Drag the 3D Keyer from the Effects Library onto the foreground video. The 3D Keyer
is a fast and high-quality keyer that’s easy to use, drawing strokes to identify the
background and foreground of the image you’re trying to key.

4

Select the foreground video clip, and open the 3D Keyer from the Effects tab in the
Inspector.

5

Click the Pick eye dropper icon in the Controls section, and click and drag across the
green screen in the Timeline Viewer. A blue line will show you where you’ve selected,
and the green screen should mostly become transparent.

6

(Optional) Use the Add eye dropper (drawing blue lines), to click and drag over
any parts of the green screen that are still not transparent. Use the Subtract eye
dropper (drawing red lines) to add back any foreground elements that may have gone
transparent by mistake.

7

Turn on the Despill checkbox in the 3D Keyer to remove any green light (spill) that may
have reflected onto your foreground subject from the green screen.

Applying the 3D Keyer to the News Anchor clip on the V2 Timeline; note that the “Open
FX Overlay” mode on the Viewer is selected (circled), allowing you to use the Inspector
Effect Controls in the Viewer

Support for Resolve FX and Open FX Alpha
for Track Compositing
DaVinci Resolve 17 now allows the direct use of the Alpha Channel from Resolve FX and Open
FX plug-ins for compositing on the Timeline. If an effect creates transparency in the image, a
“Use alpha” checkbox appears at the bottom of the effects parameters in the Effects tab of the
Inspector. Checking this box immediately applies the alpha channel to the selected clip,
compositing it over any background elements that appear in lower tracks. If more than one
alpha-modifying effect is applied to a single clip, the alpha channels are mixed together.
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The Use Alpha checkbox at the bottom of
the Effects tab in the Inspector

Compositing Alpha Channels on the Timeline
You can now composite tracks directly in the Timeline with clips containing embedded alpha
channels. Clips that contain an embedded alpha channel (and whose Alpha mode is turned on
in Clip Attributes) will show the proper transparency properties when placed in the Timeline.

Improved Track Compositing Behavior for
Differently Sized Clips
Previous versions of DaVinci Resolve had an idiosyncrasy when compositing clips of different
sizes. When superimposing a clip that’s smaller than the Timeline resolution on top of a larger
clip in the Timeline, the rest of the larger clip underneath would not show through unless you
cropped or resized the smaller clip on top. In DaVinci Resolve 17, the expected transparency
around the edges of the smaller clip now happens automatically.

Burn Away Transition
DaVinci Resolve 17 adds a new Burn Away transition. This transition replicates the visual of a
film print burning up in the projector. Use this transition to achieve a classically retro effect, or to
strike terror into the hearts of projectionists everywhere. This transition can be found in the
Resolve FX Stylize category of the Transitions section of the Open FX category in the
Effects Library.

Burn Away transition showing two pirates concerned about the state of their release print

The Burn Away effect has the following parameters:
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Progression
This set of controls affects the type of movement the burn takes as it passes through the frame.
 Motion: Allows you to pick a type of burning effect. Each option reveals different
parameters.
– Directional: The burn moves linearly from one edge of the frame to another. This

setting replicates the film being torn away by the take-up reel as it burns. In this
mode, the OFX overlay in the Viewer lets you choose the direction.
– Hotspots: The burn erupts from one or more central points. This setting replicates

the film jamming in front of a projector bulb and melting away. In this mode, the OFX
overlay in the Viewer lets you move the burn points directly in the Viewer.
– Path: Creates a curved path that the burn follows. This setting allows you to specify

the burn direction precisely, to account for elements in the frame that you want to
burn first. In this mode, the OFX overlay in the Viewer lets you add points to a spline
with which to create any curved motion path you want the effect to use.
 Angle: (Directional Only) The angle that the burn moves along. You can also change
this in the Viewer directly in Open FX Overlay mode.
 Number of Hotspots: (Hotspots Only) The number of points that the burn erupts from.
The possible values are from 1 to 8.
 Randomize Hotspots: (Hotspots Only) Will pick a random distribution of the hotspots in
the frame.
 Number of Points: (Path Only) The number of points on the onscreen curve control.
The range is from 2 to 5. These points can be manipulated directly in the Viewer in
Open FX Overlay mode.

Adjust Timing
This set of parameters allows you to control the start and end progression of the burn.
 Adjust Start: Adjusts how far along in the transition the effect starts. Values are from
-1.000 to 1.000.
 Adjust End: Adjusts how far along in the transition the effect ends. Values are from
0.000 to 2.000.

Edge
These controls let you adjust the qualities of the edge of the film as it burns.
 Raggedness: How rough the edge of the burn is. Values are from 0.000 (perfectly flat)
to 1.000 (extremely rough).
 Scale: The scale of the raggedness. Values are from 1.00 to 10.00.
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Appearance
These controls adjust the look and color of the burn as it moves through the transition.
 Melt: Controls the amount of distortion in the image as it burns away. Values are from
0.000 to 1.000.
 Char: Controls the amount of darkened charring along the edge. Values are from
0.000 to 1.000.
 Char Color: Lets you select the color of the Char effect.
 Burn: Lets you set the thickness of the burn effect. Values are from 0.000 (no burn)
to 1.000 (maximum thickness).
 Burn Hue: Lets you select the hue of the Burn effect.
 Burn Sat: Lets you select the intensity of the color of the Burn effect.
 Burn Brightness: Lets you set the brightness of the Burn effect. At lower values, the
burning edge assumes a motley, irregular effect. Values are from 0.000 to 1.000.
 Glow Brightness: Lets you control the intensity of a glow effect emanating from the
Burn effect. Values are from 0.000 to 2.000.
 Glow Spread: Lets you control the width of the glow effect. Values are from
0.000 to 2.000.
 Ash: Controls how much ash trails behind the burn as it moves through the frame.
Values are from 0.000 to 1.000.
 Ash Color: The color of the Ash parameter.

Updated Motion-Blurred Transitions
The Barn Door, Push, Slide, and Split transitions have a new Motion Blur parameter to create
more organic looking transitions, as if the moving video frames were actually shot using a
camera with a shutter. To access this parameter, double click the transition in the Timeline to
open the Inspector. The “Motion Blur” slider has values between 0.000 (No Motion Blur) and
1.000 (Maximum Motion Blur).

ITU-R BT.2111-1 Color Bar Generators
DaVinci Resolve now includes a ITU-R BT.2111-1 specification Color Bar Generator for HDR
video. These are the color bars to use when calibrating, analyzing, or mastering a Rec.2100
(BT.2100) HDR signal.
These new color bars have saturation levels set at 100% at the top, and 75% in the middle
section. They also contain Rec.709 (BT.709) color bars in the lower corners for compatibility with
HD SDR signals. Commonly referenced levels are indicated on the image below. The full color
bar specification can be found on the ITU’s web site: https://www.itu.int/rec/R-REC-BT.2111/en.
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The BT.2111-1 color bars and some of the more commonly used levels

The BT.2111-1 color bars on the Vectorscope, hitting their targets at 100% levels on the outside,
75% levels in the middle, and with the Rec.709 bars represented in the interior

DaVinci Resolve has three different versions of BT.2111-1 color bars, depending on the
HDR video EOTF you need.
 BT.2111 Color Bar HLG Narrow: Use these bars if your HDR timeline is using a
Hybrid Log Gamma curve (HLG). This is most commonly used in broadcast for its simple
backward compatibility with SDR televisions.
 BT.2111 Color Bar PQ Narrow: Use these bars if your HDR timeline is using a format
with a PQ gamma curve (i.e., DolbyVision or HDR10). This is most commonly used for
video streaming services and Blu-ray discs..
 BT.2111 Color Bar PQ Full: While PQ Full is a part of the Rec.2100 (BT.2100)
specification, it is not commonly in use at this time. Use this setting only if you
know you need it.

Chapter – 6

Cut and Edit Page Effects

84

Data Burn-In Enhancements
Data Burn-In has the following enhancements.

Support for Text Opacity in Data Burn-In
As of DaVinci Resolve 17, the actual text of a Data Burn-In can now have variable transparency.
Using the Text Opacity slider in the Data Burn-In window you can control the degree of the
text’s opacity. 0.00 is fully transparent, and 1.00 is fully opaque.

Support for Source Frame Number in Data Burn-In
A new Source Frame Number metadata Burn-In option is now available. If “Source Frame
Number” is checked in the Data Burn-In window, the resulting text will display the frame count
of the source clip (starting from frame 0), preceded by the “SRC Fm:” prefix render text. For
example, SRC Fm: 110.

The new Source Frame Number burn-in, with fully transparent text
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Chapter 7

Fusion
Improvements
Considerable attention has been given to improving the integration of the
Fusion page with the rest of DaVinci Resolve. This includes audio
playback, shared markers, and the addition of more GPU-accelerated
Resolve FX in the Fusion page. The Fusion page and Fusion Studio gain
improvements to the User Interface including a customizable toolbar,
Node Editor bookmarks, and new vertical Node Editor layouts.
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General Improvements
The Fusion page in DaVinci Resolve 17 continues to be improved with even tighter integration
to the Edit and Cut pages.

Audio Playback and Waveform Display in the Fusion Page
Playing a composition in DaVinci Resolve’s Fusion page will play the audio from the Edit or
Cut page Timeline. You can choose to hear the sound from all the Timeline audio tracks or the
MediaIn node. The audio waveforms are displayed in the Keyframes Editor to assist in the timing
of your animations.

Audio with Single-Clip Comps
When you bring a single clip into the Fusion page, playing the Comp will play the audio tracks
that are enabled in the Timeline. If the Mute button is enabled on any Timeline tracks, audio
from those tracks will not be heard in Fusion.
While compositing in the Fusion page, you can use the speaker icon in the toolbar to
mute the audio if you don’t need to hear it. The Inspector for the MediaIn node contains a new
Audio Tab, where you can choose to solo the audio from the clip or hear all the audio tracks in
the Timeline.

The Audio tab in the MediaIn node is used
to select the track for playback, slip the
audio timing, and reset the audio cache.

If the audio is out of sync when playing back in Fusion, the Audio tab’s Sound Offset wheel
allows you to slip the audio in subframe frame increments. The slipped audio is only modified in
the Fusion page. All other pages retain the original audio placement.

Audio with Media Pool Clips
Audio from a clip brought in through the Media Pool is muted by default. Hearing the audio from
a Media Pool clip is a two step process.
To hear audio from a clip brought in through the Media Pool, do the following:
1 Select the clip in the Node Editor.
2

In the Inspector, click the Audio tab and select the clip name from the Audio Track
drop-down menu.
If more than one Media In node exists in the comp, the audio last selected in the
Inspector is heard. You can use the Speaker icon in the toolbar to switch between the
MediaIn node audio files.

3

Right-click the speaker icon in the toolbar, then choose the MediaIn for the clip you
want to hear.
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NOTE: Audio tracks from the Timeline are not heard when using a Fusion Composition
effect from the Edit or Cut page.

Purging the Audio Cache
The audio and its settings are cached for faster performance. If you change which audio tracks
you want to play back in Fusion, or you use the Sound Offset wheel to slip the audio tracks, you
need to purge the audio cache. Also, if you return to the Edit, Cut, or Fairlight page and modify
the audio levels, you need to purge the audio cache.
To purge the audio cache after any change to the audio playback:
– Click the Purge Audio Cache button in the Inspector.
The audio will be updated when you next playback the composition.

Using Audio Waveforms
You can display each MediaIn node’s audio waveform in the Keyframes Editor and use it as a
guide as you add and move keyframes.

Waveforms are displayed in the Keyframes Editor for all MediaIn nodes.

To display the audio waveform in the Keyframes Editor:
1 Open the Keyframes Editor.
2

Click the disclosure arrow next to the MediaIn node to view the
audio waveform for that clip.

To change the size of an audio waveform display:
1 Open the Keyframes Editor.
2

In the Keyframes Editor, select the audio track of the waveform you want to modify.

3

Right-click over the audio waveform and choose
Line Size > Minimum/Small/Medium/Large/Huge.

TIP: Right-clicking over a track in the Keyframes Editor and choosing All Line Size >
Minimum/Small/Medium/Large/Huge changes all the tracks and audio waveforms in
the Keyframes Editor.
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Audio Playback and Waveform Display in Fusion Studio
The audio functionality is included in Fusion Studio for scratch track (aligning effects to audio
and clip timing) purposes. Final renders should almost always be performed without audio.
Audio can be heard if it is brought in through a Loader node.
To hear the audio from a specific Loader node:
– Right-click over the speaker icon and choose the file name that contains the audio
you want to hear.

Audio Toolbar button
The Audio button in the toolbar is a toggle that can be used to enable or mute audio play back
associated with the clip. Additionally, right clicking this button displays a contextual menu that
can be used to select a WAV file, which can be played along with the composition, and to
assign an offset to the audio playback.

Using Audio WAV Files
You can also load audio-only files into Fusion Studio. Currently Fusion supports playback of
WAV audio files. The entire WAV file is loaded into RAM in order to quickly display the waveform
in the Keyframe Editor. That being the case, it is best to use the shortest possible audio file you
need for the Comp, so as not to use up more memory than necessary.
TIP: AIFF files can be loaded on macOS.

You can either load the audio file independent of any nodes, or load an audio file into the Saver
node. The benefit of using a Saver node to load the audio is that you can view the audio
waveforms in the Keyframes Editor.
To load a WAV audio file, do the following:
1 Right-click over the speaker icon and select Choose from the contextual menu.
2

In the file browser window, select the audio WAV file track to be used.

To load a WAV audio file using a Saver node, do the following:
1 Add a Saver node to the Node Editor.
2

In the Inspector, click the Audio tab and click the Browse button.

3

In the file browser window, select the audio WAV file track to be used.

To view the Audio Waveform in Fusion Studio, do the following:
1 Open the Keyframes Editor.
2

Expand the Saver track to view the audio waveform.
When you want to find the precise location of an audio beat, transient, or cue, you can
slowly drag over the audio waveform to hear the audio.

To change the size of an audio waveform display:
1 Open the Keyframes Editor.
2

Right-click over the audio waveform and choose Line Size > Minimum/Small/Medium/
Large/Huge.
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TIP: Right-clicking a track in the Keyframes Editor and choosing
All Line Size > Minimum/Small/Medium/Large/Huge changes all the tracks
and audio waveforms in the Keyframes Editor.

Sound Offset
If the audio is out of sync when playing back in Fusion, the Saver’s Audio tab includes a Sound
Offset wheel to slip the audio in subframe frame increments.

Shared Markers
In previous releases, Fusion’s guides and the Edit/Cut page markers were two different
functions performing the same fundamental service. In DaVinci Resolve version 17, guides and
markers have been merged.
Markers added to a clip or to the Time Ruler in the Edit page Timeline are displayed in Fusion’s
Keyframes Editor. Timeline Ruler markers are also displayed in the Spline Editor. Marker names,
notes, colors, and durations are also displayed in Fusion.
NOTE: Marker annotations made in the Edit page Timeline Viewer are not
displayed In the Fusion page Viewers.

Markers added to the Time Ruler are editable in Fusion, and the changes appear back in the
other DaVinci Resolve pages. Time Ruler markers can be added, moved, deleted, renamed, and
given descriptive notes from within Fusion’s Keyframes or Spline Editor.
You can open the Marker List to display and modify the Timeline Ruler markers in the Comp.

The Marker List is used to view all markers and hide them from
displaying in the Spline or Keyframes Editor.

To open the Marker List and see all time ruler markers:
1 Right-click over the Keyframes or Spline Editor’s Time Ruler.
2

Choose Show Marker List from the contextual menu, or activate the Keyframes or
Spline Editor and press Shift-G

For more information about using Fusion Markers, see Chapter 60, “Animating in Fusion’s
Keyframes Editor” in the DaVinci Resolve manual and Chapter 9 in the Fusion manual.
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NOTE: Markers attached to clips in the Edit page Timeline are visible on MediaIn nodes
in Fusion’s Keyframes Editor but not editable. They are not visible in the Spline Editor.

New Fusion Page Resolve FX
DaVinci Resolve 17 adds 27 new GPU accelerated Resolve FX to the Fusion page, including the
Color page’s Noise Reduction and Sharpening tools. The Resolve FX appear in the Open FX
category in the Effects Library and can be added to a custom toolbar. These effects work just
like other Open FX plug-ins. For more information on each effect’s controls, see Part 11,
“Resolve FX” in the DaVinci Resolve manual.

Resolve FX Blur
 Lens Blur: (Studio Only) Simulates a high-quality optical lens blurring. It offers several
technical and creative adjustments over the native Fusion Defocus node.

Resolve FX Color
 Contrast Pop: (Studio Only) Applies a sharp high-contrast look, or soft low-contrast
look to a selected tonal range.
 DCTL: (Studio Only) DCTL files are GPU native, color transformation scripts. Anyone
with the mathematical know-how can make and install a DCTL. For more information
about DCTLs, see Chapter 174 “Creating DCTL LUTs” in the DaVinci Resolve manual.
 Dehaze: (Studio Only) Used to reduce the visible effects of smog, airlight, and haze in
an image.
 False Color: (Studio Only) Generates user selectable color overlays which can
be used to replicate the look of Camera HUDs, thermal/Infrared cameras, and
posterization effects.
 Flicker Addition: Adds rapidly animated exposure changes to make the image
appear to flicker.

Resolve FX Key
 Alpha Matte Shrink and Grow: Shrinks and grows the edges of an alpha matte,
similar to Fusion’s Erode Dilate node.

Resolve FX Light
 Aperture Diffraction: (Studio Only) Models the starburst effect usually seen when
shooting bright lights with small apertures. Similar to the Highlight node in Fusion, but
with much more control.
 Lens Reflections: (Studio Only) Simulates intense highlights reflecting off the various
optical elements within a lens to create flaring and scattering effects.

Resolve FX Refine
 Beauty: (Studio Only) Allows you to selectively smooth detail that falls above a
particular threshold, while preserving detail falling below a specific threshold.

Resolve FX Revival
 Automatic Dirt Removal: (Studio Only) Uses optical flow to target and repair unwanted
artifacts lasting one or two frames, like bits of dust, dirt, and hair.
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 Chromatic Aberration Removal: (Studio Only) Lets you manually correct color fringing,
typically found in high contrast areas.
 Dead Pixel Fixer: Repairs dead camera sensor pixels. Now includes new patch shapes,
fill methods, and output modes.
 Deflicker: (Studio Only) Removes a wide variety of flickering artifacts, including those
caused by variable exposure in timelapse clips, fluorescent lighting, and archival film
sources.
 Noise Reduction: (Studio Only) Provides temporal and spatial noise reduction,
previously only available in the Color page.
 Patch Replacer: (Studio Only) Offers a quick alternative to the Paint tool when cloning
over an unwanted feature in an image.

Resolve FX Sharpen
 Sharpen: (Studio Only) Sharpens an image with an enormous amount of control,
by applying different amounts of sharpening to the fine, medium, and large structures
of the image.
 Sharpen Edges: (Studio Only) A variation of the Sharpen filter that’s streamlined to limit
sharpening to the selected edge details of an image.
 Soften Sharpen: (Studio Only) A variation of the Sharpen filter that’s streamlined to
smooth some details and add sharpness to other details based on small, medium, and
large structure sizes.

Resolve FX Stylize
 Burn Away: A Transition effect that takes two inputs. The transition simulates the
background image burning away to reveal the foreground clip.
 Pencil Sketch: (Studio Only) A highly customizable effect used for making an image
look like it was hand-drawn.
 Stylize: (Studio Only) Applies one of a variety of painterly styles to an image.
 Tilt-Shift Blur: (Studio Only) This effect simulates the depth-of-field of a Tilt-Shift lens.
An adjustable Z-depth map is used to generate the progressive blur that’s applied.

Resolve FX Temporal
 Motion Trails: (Studio Only) Like Fusion’s Frame Average node, the Motion Trails effect
is used to create a ghost-like trail when applied to moving images.
 Smear: (Studio Only) Blends frames to create artistic motion blur.

Resolve FX Texture
 Analog Damage: (Studio Only) This effect simulates different kinds of television signal
degradation resulting from analog transmission and recording.
 Detail Recovery: (Studio Only) This effect takes two inputs, typically of the same image.
It uses a relief filter applied to one image to add detail back into the other.
 Film Grain: (Studio Only) This effect applies a procedurally generated layer of “film
grain” over the image. Unlike Fusion’s native node, the Resolve FX Film Grain includes
presets based on film formats and speed.
 Texture Pop: (Studio Only) Texture pop is a frequency-based sharpening/softening
effect that divides the image into tonal regions. You can determine how different details
are softened or sharpened and then configure how much each tonal region is affected.
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Resolve FX Transform
 Transform: Almost identical to the native Fusion Transform, however it does
include unique interactive on-screen control modes for corner pinning and
perspective distortions. The Resolve FX Transform does not concatenate with native
Fusion transforms.
 Video Collage: Designed to create “video wall” and different split-screen effects,
where each MediaIn node appears within a “tile” that can be styled in different ways.
Although this node is covered in detail in the Resolve FX section of this document,
Fusion-specific setup instructions are covered below.
There are two ways to set up the Video collage node, which are chosen using the
Workflow drop-down menu.
– Create Background Workflow mode: This is perhaps the simplest way to create

a split-screen using this effect. This mode creates a frame with masks built into it.
These masks can be used to divide a single image or reveal multiple layers of video.

A single image is divided using the masks created from the Video Collage node.

The Video Collage node is added to the foreground input on the Merge node. The clips
is used as a “background” frame in the collage. The clip that fills the mask holes
connects to the Merge node’s background input.

The mask is filled using the background image to the Merge node.
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A Transform node must be added to each MediaIn node that you want to use to fill the
mask holes. The Transform node is used to scale and position each MediaIn correctly
within the mask holes. In the example above, the Video Collage effect is applied to the
foreground MediaIn 2. The MediaIn 1 node uses a transform node for resizing and
connects to the background input.

IMPORTANT: When using Create Background mode, set the Merge node to
Subtractive using the Inspector’s Subtractive/Additive control.

– Create Tile Workflow mode: This mode needs a bit more setup, as it requires you

to apply the Video Collage node to each MediaIn that you want to use as a tile in
the collage. However, it gives you more options, automatically transforming each
MediaIn in your string of Merge nodes to fit a layout you design.

Using Tile mode, multiple MediaIn nodes are assigned to a layout of your own design.

The best way to work in Create Tile mode is to connect all the clips you want to be
involved in the collage, with a series of Merge nodes, but this time if there’s a clip you
want to use as the background, it should be the initial background input to the first
Merge. Then, apply the Video Collage node to each MediaIn node connected to the
foreground inputs of the remaining Merge nodes. These are the MediaIn nodes that will
fill the tiles of the collage. On each Video Collage node, choose Create Tile from the
Workflow drop-down menu. The MediaIn nodes will fit inside the first rounded tile of
the default layout of four tiles.
Ultimately, you’ll need to choose which clip goes inside each tile; that’s what will create
the arrangement. Before you do that, however, you can customize the layout, if desired.

Each Mediain node is assigned to a tile using the Video Collage node.
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NOTE: Node Instances cannot be used with the Video Collage node.

You can preview the entire layout by enabling the Preview Layout checkbox in the
Inspector. This draws a preview of how all the tiles will be placed. Using this preview
and the Layout controls below, you can make whatever changes you want to set things
up before copying this plug-in to all the other clips in the tree.
When you decide on a layout, you can make tile specific adjustments by clicking the
Tile button and using the Tile controls below.
The Active Tile menu is used to determine which tile you further customize using the
Inspector’s tile-based controls. You should also note the Active Tile drop-down menu
becomes important later on when you apply this effect to multiple MediaIn nodes.
Finally, copy the Video Collage to each MediaIn node and for each copy, select a
different tile number from the Active Tile menu. Each MediaIn will be positioned and
scaled to fit a different tile location.
More information regarding the animation and other controls in the Video Collage node can be
found in the Resolve FX section of this document.

Resolve FX Warp
 Lens Distort: (Studio Only) A more straightforward Lens Distort filter than the native
Fusion Lens Distort node. It adds the ability to distort the image based on RGB
channels.
 Warper: (Studio Only) The Warper is a free-form image warper that uses points, rather
than a mesh or splines, to push and stretch features in an image as if they were on a
sheet of rubber.

Fusion Effect Templates
The integration of Fusion into DaVinci Resolve has enabled the creation of Fusion Titles,
Transitions, and Generators for use in the Edit page. In DaVinci Resolve v17, you can now create
Fusion Effect templates as well. Like other Fusion templates, you can create Effects on the
Fusion page or within Fusion Studio, save the effects as Macros, and then apply them to clips in
the Edit page. Fusion Effect templates are essentially Comps created in Fusion that create just
about any type of effect on an image (e.g., a rippling water effect, green screen keyer, or a retro
3D video cube). After saving the Macro, you can apply the effect onto any clip in the Edit
page Timeline.

Creating a Fusion Effect Template
You start building a Fusion Effect template by bringing a clip from the Edit page Timeline into
Fusion. This clip is only used for creating the template and will not be saved with the effect.
Once inside Fusion, you use Fusion’s nodes to create the effect you want. You can use a single
node or a hundred, depending on the effect you want to create. For instance, using Fusion’s
Color Correction nodes, you can create a simple color corrector you can use on the Edit page.
To create a simple Color Corrector effect, do the following:
1 Insert the Color Corrector node between the MediaIn and MediaOut nodes.
2

Select the Color Corrector node in the Node Editor, and then press Cmd-A
to select the remaining nodes.
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3

Right-click over any of the selected node and choose Macro > Create Macros from the
contextual menu. Enabling the checkboxes in this window determines the parameters
that appear in the Edit page Inspector.

4

The Macro Editor window opens. Here, you can enable the checkboxes for any
parameters you want to be shown in the Edit page Inspector.

5

Enter the name of your effects at the top of the Macro Editor window.

6

To save the Macro, click Close at the bottom of the window, then click Yes in the dialog
that appears asking you to save the changes.

The Macros must be saved into the correct folder for DaVinci Resolve to recognize the
Macro as an effect.
In the save dialog, save the Macro in the following locations:
 On macOS: Macintosh HD/Users/username/Library/Application Support/Blackmagic
Design/DaVinci Resolve/Fusion/Templates/Edit/Effects
 On Windows: C:\Users\username\AppData\Roaming\Blackmagic Design\
DaVinci Resolve\Support\Fusion\Templates\Edit\Effects
 On Linux: home/username/.local/share/DaVinciResolve/Fusion/Templates/Edit/Effects
To see the effect in the Edit page Effects Library, you’ll need to quit DaVinci Resolve and
relaunch the application.

Creating a Fusion Effect Template for Two or More Layers
If the effect you want to create requires multiple images like a video wall, you start by creating a
Fusion clip on the Edit page Timeline that includes the number of layers you want the effect to
have. The clips are only used to create the number of image inputs for the template and will not
be saved with the effect.
Once inside Fusion, use Fusion’s nodes to create the effect you want.
Save the Macro following the same steps you use for single clip effects. Enable any of the
parameters you want to control in the Edit page. To be able to switch the order of video layers
within the effect, make sure you have the Layer checkbox enabled for all the MediaIn nodes.
Once you’ve saved the Macro and relaunched DaVinci Resolve, to use the effect on multiple
timeline layers, you must create a Fusion clip. The Fusion clip should contain the same number
of layers the effect requires. The order of the Timeline layers, going from the bottom track to
the top, matches the MediaIn numbers. For instance, video track 1 will match the position and
appearance of MediaIn1, video track 2 matches MediaIn2 and so on. If you want to change how
tracks map to MediaIn nodes, you can change the Layer number in the Inspector, assuming you
enabled the MediaIn Layer checkbox when creating the Macro.

Animation Curves Modifier
The Animation Curves Modifier (Anim Curves) is used to dynamically adjust the timing, values,
and acceleration of an animation, even if you decide to change the duration of a Comp. Using
this Modifier, it becomes infinitely easier to stretch or squish animations, create smooth motion,
add bouncing properties, or mirror animations curves without the complexity of manually
adjusting splines.
When creating Fusion templates for the Edit and Cut page in DaVinci Resolve, the Anim Curves
Modifier allows the keyframed animation you’ve created in Fusion to stretch and squish
appropriately as the transition, title, or effect’s duration changes on the Edit & Cut page Timelines.
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Curve Shape Controls
The controls for the Anim Curves Modifier appear in the Modifier’s tab of the inspector.
The Curve Shape controls determine the acceleration or shape of the animation curve.
 Source: This drop-down menu has three options based on how the Comp is created
from DaVinci Resolve’s Edit page.
– Transition: This setting is automatically selected when the Comp is created from an

Edit page transition effect. If the duration of the transition is updated in the Edit page,
the timing of the animation updates as well.
– Duration: Use this setting when the Comp is created from a clip on the Edit page.

The animation timing will update if the clip’s duration changes by trimming.
– Custom: Displays an Input dial to manually control the timing.

 Input: This dial is only visible when Source is set to Custom. It is used to change the
input keyframe value.
 Curve: The Curve drop-down menu selects the interpolation method used between
keyframes. The three choices are linear, easing, or custom.
– Linear: The default linear interpolation method maintains a fixed, consistent

acceleration between keyframes.
– Easing: Displays interpolation menus for both the start of the curve (In) and the end

of the curve (Out).
– Custom: Opens a mini Spline Editor to customize the interpolation from the start of

the animation to the end.
 Mirror: Plays the animation forward, and after reaching the end, it returns to the starting
value. This causes the initial animation to be twice as fast since the second half of the
Comp is used for the reverse animation.
 Invert: Flips the animation curve upside-down, so that the values start high and end low.

Scaling
The Scale parameters modify the animation values using relative adjustments.
 Scale: This number is a multiplier applied to the value of the keyframes. If the Scale
value is 2 and a keyframe has a value of 0, it remains 0. If the Scale value is 2 and a
keyframe has a value of 10, the result is as if the keyframe is set to 20. This can be
thought of as the ending value for the animation. It is best to set this while viewing the
last frame in the comp.
 Offset: The offset is added to the keyframe values and can be thought of as the
starting value for the animation. It is best to set this while viewing the first frame
in the comp.
 Clip Low: Ensures the output value never dips below 0.0.
 Clip High: Ensures the output value never exceeds 1.0.

Timing
The Timing parameters adjust the animation timing using relative values.
 Time Scale: Stretches or squishes the animation, causing it to run faster or slower.
A value of 1.0 keeps the animation running for the Comp’s duration (unless you have
customized the animation using other controls in the Modifier).
 Time Offset: This value delays the animation, as a fraction of its total duration. A value
of 0.0 applies no delay. A value of 0.5 delays the animation starting point midway into
the Comp’s duration.
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Using the Anim Curves Modifier to Create a Custom Transition
To understand how to use the Anim Curves Modifier for a transition, let’s create a simple
scaling dissolve.
1

Add a standard cross dissolve in the Edit page Timeline.

2

Right-click over the transition and choose Convert to Fusion Cross Dissolve.

3

Right-click over the transition again and choose Open in Fusion page.

4

Add a Transform node to MediaIn1 and to MediaIn 2.

5

Select the Transform node attached to the MediaIn 2.

6

In the Inspector, right-click the Size control, then choose Modify With > Anim Curves
from the contextual menu. Adding this modifier to the Size control will cause the slider
to animate from 0 to 1 for the Cross Dissolve’s duration.

7

Select the Transform node attached to the MediaIn 1.

8

In the Inspector, right-click the Size control, then choose Modify With > Anim Curves
from the contextual menu.

9

At the top of the Inspector, click the Modifier tab and click the Invert button. Inverting
the animation curves causes MediaIn1 to scale opposite of MediaIn 2.

10 In the Modifiers tab, set the Curve drop-down menu to Easing, and experiment with the
different ease-in ease-out curve types from the In/Out drop-down menus.
Once you create a Macro from this Node Tree and save it as a Transition template, you can
apply it in the Edit page Timeline. If you change the transition duration in the Edit page, the
animation timing will update appropriately.

Using the Anim Curves Modifier with Paths
To understand how to use the Anim Curves Modifier’s with a path modifier, let’s use the
premise that you want to create text that falls from the top of the frame and bounces as it
reaches the bottom of the frame.
1

In Fusion, create two keyframes that cause text to start at the top of the frame and drop
to the bottom. This automatically creates a Path Modifier.

2

In the Inspector’s Modifier tab, right-click over the Displacement parameter and choose
Insert > Anim Curves. The animation is normalized to the duration of the Comp.

3

Set the Source menu to Duration since this is not a transition, and we are not
customizing the duration.

4

From the Curve menu, choose Easing, then for the Out menu, choose Bounce.

5

Play the animation to see the Bounce animation.

6

To make the bounce occur halfway down the frame, change the Scale to .05.

7

To make the animation run twice as fast, enter 2.0 in the Time Scale parameter.

Once you create a Macro from this Node Tree and save it as a Title template, you can apply it in
the Edit page Timeline. If you change the Title’s duration in the Edit page, the animation timing
will update appropriately.
TIP: To view the resulting animation curve in the Spline Editor, select the parameter
name in the Spline Editor’s header. The spline is updated as you change the controls.
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Shape Nodes
Fusion includes several vector Shape nodes that can be used to create animated graphical
elements in motion design projects. Shapes are located in the Shape category of the Effects
Library, and all the nodes begin with an s to differentiate them from other similarly named
general-purpose nodes. There are various types of shape nodes, including:
 Generators: sEllipse, sNgon, sRectangle, sStar
 Multipliers: sDuplicate. sGrid
 Modifiers: sExpand, sJitter, sOffset, sOutline, sTransform
 Combiners: sBoolean, sMerge
 Render node: sRender
To begin using Shape nodes, you start with one of the basic shapes, like sEllipse, sRectangle,
sNGon, or sStar, and then connect it to a sRender node. Technically, the shape nodes are
descriptions of the vector shapes, while the sRender node is responsible for rendering the
shapes in the defined frame size. That being the case, only the sRender node is viewable. You
can connect multiple shape nodes to create intricate designs, but any string of shape nodes
must always end with a sRender node. The sRender node can then be connected to larger
node trees for further compositing. The remaining Shape nodes modify the basic shapes to
create more complex compound shapes.

Shapes are used to create repetitive patterns with offsets.

Below is a list of the shape nodes with a brief description of each:
 sBoolean: Combines two shapes based on boolean operators, including Intersection,
Union, Subtract, and Xor. The color of each shape is either used or replaced based on
the Style mode menu.
 sDuplicate: Creates a user-defined number of copies of the connected shape.
The copies can be offset in position, size, and rotation.
 sEllipse: Creates a circular shape that can be color filled or displayed as an outline.
When the Solid checkbox is disabled, the Border Width modifies the thickness of
the outline.
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 sExpand: Similar to the border width parameter in the sEllipse, sRectangle, sStar, and
sNGon shapes, the Amount slider in the sExpand node grows the width of shape
outlines. This node can be used after a sMerge or sBoolean to expand the width of
multiple shapes simultaneously.
 sGrid: Creates a 3x3 grid of the shape connected to the input. The size of the grid can
be expanded using the Grid Cells X and Y controls. The X and Y Offsets determine the
spread between the cells in the grid.
 sJitter: Jitter has two modes; the Fixed mode is used to offset the different copies
of shapes generated by a sBoolean, sGrid, sDuplicate node, or any group of nodes
combined in the sMerge node. Setting the Jitter mode to Random auto-animates each
jitter parameter. The animation of each parameter Is limited to the values defined by
each parameter’s range control.
 sMerge: Used to combine multiple shape nodes. You can connect as many shapes
nodes into the sMerge, and each new shape node you connect will be the front-most
shape in the layer order.
 sNGon: Creates a shape with a variable number of sides that can be color filled or
displayed as an outline. When the Solid checkbox is disabled, the Border Width
modifies the thickness of the outline.
 sOffset: The vectors of the shape are scaled, divided, and moved horizontally
and vertically.
 sOutline: Although each basic shape can be rendered as an outline, the sOutline node
can create outlines from sBoolean or sMerge node results.
 sRectangle: Creates a rectangular shape that can be color filled or displayed as an
outline. When the Solid checkbox is disabled, the Border Width modifies the thickness
of the outline.
 sRender: The sRender node converts the shape vectors to an image. Controls in the
sRender node define the frame size and motion blur rendering.
 sStar: Creates a star shape where you can define the number of points on the star.
When the Solid checkbox is disabled, the star is displayed as an outline, and the Border
Width modifies the thickness of the outline.
 sTransform: The sTransform node can be used for simple 2D Transformations of
shapes, such as moving, rotating, and scaling.

Advanced Optical Flow Processing
The Optical Flow, Repair Frame, and Tween nodes include a faster GPU-based Optical Flow
algorithm. When you add the Optical Flow, Repair Frame, or Tween node to a Comp, the
Inspector now includes a Method drop-down menu where you can choose Advanced to enable
the GPU-based algorithm. This Advanced method is the same Optical Flow algorithm used in
other DaVinci Resolve pages.
By choosing Classic from the Method drop-down menu in the Inspector, you can use the older
CPU-based algorithm to maintain compatibility with Comps created in previous versions. This
method may also be better suited for some Stereo3D processing.
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Convert Standard Transitions into Fusion Cross Dissolves
You can convert any transition in the Edit page into a Fusion Cross Dissolve. Once you apply a
transition from the Edit page Effect Library, you can right-click over it and choose Convert to
Fusion Cross Dissolve. The transition is converted into a cross dissolve, which you can then
customize in Fusion by right-clicking on it to choose Open in Fusion page from the contextual
menu. The transition is displayed in Fusion’s Node Editor with the two MediaIn nodes and a
Dissolve node. Using any of Fusion’s other nodes, you can create any transition effect to
replace the cross dissolve. After making your changes, switching back to the Edit page
automatically updates the transition effect in the Timeline. The custom transition can be saved
as a Transition Preset in the Edit page and used in other projects.

Improvements to the Interface
Fusion has several updates to the User Interface that make it quick to jump to specific locations
in a node tree, access commonly used tools faster, and customize the layout with more
flexibility.

Node View Bookmarks
Bookmarks save the position and scale of the Node Editor, so you can quickly and precisely
jump from viewing one group of nodes to viewing another.
To add a bookmark, do the following:
1 Pan and scale in the Node Editor to view a group of nodes you are interested in.
2

From the Options menu in the upper right of the Node Editor, choose Add Bookmark,
or press Cmd-D.

3

In the Manage Bookmarks dialog that opens, enter a name for the bookmark and click
the Add button.

The first nine saved bookmarks are given keyboard shortcuts and listed in the Options menu.
They are also listed in the Go To Bookmarks dialog along with any saved bookmarks beyond
the initial nine.

The Node Editor Options menu with
nine bookmarks added
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TIP: You can return the Node Editor to the default scale by right-clicking in the Node
Editor and choosing Scale > Default Scale or pressing Cmd-1.

If your Node Tree changes and you want to update Bookmark names or delete bookmarks,
those tasks can be done in the Manage Bookmarks dialog.
To rename or delete a bookmark, do the following:
1 From the Options menu in the upper right of the Node Editor, choose Manage
Bookmarks.
2

In the Manage Bookmarks dialog that opens, right-click over the bookmark and choose
Rename or Remove.

3

Click OK to close the Manage Bookmarks dialog.

Using Bookmarks
You can jump to a Bookmark view by selecting a bookmark listed in the Options menu or
choosing Go To Bookmarks to open the Go To Bookmarks dialog. The Go To Bookmarks dialog
has all the bookmarks listed in the order they were created in the current composition. Double
clicking on any entry in the dialog will update the Node Editor to that view and close the Go To
Bookmarks dialog.
If you have a long list of bookmarks, you can use the search field at the bottom of the dialog to
enter the name of the bookmark you want to find.

Changing the Sort Order and Assigning Keyboard Shortcuts
Bookmarks appear in the Options menu and in the Go To Bookmarks dialog in the order they
were created. The top nine bookmarks listed are assigned keyboard short cuts. If you want to
change the sort order of the list you can do that in the Manage Bookmarks dialog. This can be
useful if you want some bookmarks to have specific keyboard shortcuts, or you want a
bookmark you made early in the process to not have a keyboard shortcut assigned to it.
To change the order of the listed bookmarks, do the following:
1 From the Options menu in the upper right of the Node Editor, choose
Manage Bookmarks.
2

In the Manage Bookmarks dialog drag a bookmark up or down in the list.

3

An insert line appears where the bookmark will be inserted. Release the mouse button
when the insert line is where you want the bookmark to be listed.

The keyboard short cuts will update to reflect the new order.
TIP: You can hold down the Shift key to select multiple bookmarks and move them
simultaneously up or down in the Manage Bookmark list.

Using Underlays as Bookmarks
Underlays added to the Node Editor are automatically added as bookmarks. They are listed in
the Options menu below the list of your custom bookmarks. You can omit Underlays from
showing in the list of bookmarks by opening the Go To Bookmarks dialog and disabling the
checkbox to Show Underlays. When the checkbox is disabled, Underlays will not show in the
Go To Bookmarks dialog, and they will not appear in the Options menu.
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Customizable Toolbar
You can add and remove tools from the Fusion toolbar and then save the custom toolbar as a
preset. New tools can be added by dragging them from the Effects library or the Node Editor,
and dividers can be added to group tool sets together.
To create a new toolbar, do the following:
1 Right click in an empty area of the toolbar and choose Customize >
Create Toolbar from the contextual menu.
2

Enter a name for the toolbar in the dialog box, and click OK.

To rearrange the tools in the toolbar, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2

Drag a node in the toolbar to a new location.

To add a tool to the toolbar:
1 Create a new custom toolbar or select an existing custom toolbar
2

Do one of the following:
– Drag a node from the Effects Library to the location

on the toolbar where you want it added.
– Drag a node from the Node Editor to the location

on the toolbar where you want it added.
To add a divider to a toolbar, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2

Right-click over any tool and choose Customize > Add Divider. A divider is
added to the right of the tool.

To remove a tool from a toolbar, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2

Right-click over any tool and choose Remove [name of tool].

To remove a group of tools between two dividers, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2

Right-click over any tool in a group and choose Remove Group.

To prevent a custom toolbar from being modified:
Right-click over the toolbar and choose Lock from the contextual menu.
To switch between toolbars:
Right-click over the toolbar and choose the custom toolbar name or choose
Default to return to Fusion’s default toolbar.
To delete a custom toolbar, do the following:
1 Right-click over the toolbar and choose the name of the custom toolbar
you want to delete.
2

Right-click over the toolbar again and choose Customize > Remove [toolbar name]
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Vertical Node Editor Layouts
Two new Fusion Layout presets in Workspace > Layout Presets allow for positioning the Node
Editor vertically, either alongside the Inspector, or along the left side of the screen. This can be
very helpful when animating in the Spline Editor or Keyframes Editor.
In either layout, the node tree can flow from top to bottom, leaving much more room along the
lower half of the screen for the Spline Editor or Keyframes Editor.

The Mid Flow Vertical layout preset used with the vertical flow direction setting

When using the new vertical layouts, enabling the Flow > Vertical Build Direction option in the
Fusion settings will cause all new Node Trees to build vertically, leaving maximum room for
Fusion’s animation tools.
You can then save alternative layouts based on these two vertical presets using the Workspace
> Layout Presets submenu.
When you want to return to the default horizontal Node Editor layout, just choose Workspace >
Layout Presets > Fusion Presets > Default.Onscreen Controls for Fusion Templates on
the Edit Page

Onscreen Controls for Fusion Templates on the Edit Page
Fusion templates added to the Timeline in the Edit page now show the onscreen controls for
Position, Rotation, and Gradient Angles, just as they would show in the Fusion page. By
enabling OFX Viewer overlays, onscreen controls can be used for modifying parameters in a
Fusion title, Generator, Effect, or Transition template.

Improvements to Text and Font Size Management
When using non-Latin characters, including Hebrew or Arabic script, in Text+ and Text3D
nodes, ligature groups (connected characters) are handled with more accuracy.Improvements
to Text and Font Size Management
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Automatic Fusion Comp Creation in DaVinci Resolve
When you switch to the Fusion page from an empty Timeline, adding a node or a clip from the
Media Pool will automatically add a MediaOut node and create a Fusion Composition effect in
the Timeline.

Fusion Studio Floating Frame
Fusion Studio includes a Floating Frame window that can be used to house any panel.
To place a panel in the Floating Frame window, do the following:
1 In Fusion Studio, choose Window > New Floating Frame.
2

Right-click in the floating frame and choose the panel from the Add View submenu.

When using multiple monitors, you can choose to have floating panels spread across your
displays for greater flexibility.
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Chapter 8

Color Page
Improvements
DaVinci Resolve 17 introduces some truly consequential new features to
the Color page, such as the next generation of Resolve Color
Management, and the all new HDR palette, Color Warper, and Magic Mask
palettes, all of which may change how you approach grading overall.
However, it also includes an impressive list of smaller improvements,
including a Sat vs Lum curve, custom LUT paths, and split screen display
of multiple playheads. No matter how you work, there will be something
new to like.
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Updated Resolve Color Management
DaVinci Resolve 17 introduces the biggest improvements to Resolve Color Management (RCM)
since it was originally introduced, adding numerous features to simplify setup, improve image
quality, and make the “feel” of your grading controls more consistent. Specific improvements
include improved metadata management for incoming media files that support color metadata,
a new wide gamut color space suitable for using as your default Timeline working color space
for any program, a new Input Tone Mapping option (Input DRT) that makes it easier to mix media
formats for SDR and HDR grading, improved Timeline to Output Tone Mapping (Output DRT)
that offers improved shadow and highlight handling, and select color space-aware grading
palettes that make controls feel and perform well no matter what you’re grading.

Simplified RCM Setup
One of the biggest color management improvements for many DaVinci Resolve users will be
the simplified presets that let you configure RCM with a single menu selection. Many of the new
color management features that have been added to version 17 are intended to enable better
visual results while using its new default settings. This being the case, no matter what your level
of expertise, you can now enable the full benefits of RCM with only two drop-down menus.
When you first choose DaVinci YRGB Color Managed from the Color science drop-down menu
of the Color Management panel in the Project Settings, you’re presented with a simple pair of
menus for setting up how you want to work with Resolve Color Management. The “Resolve
color management preset,” and the “Output Color Space.”

Resolve Color Management presets for fast, simple color management setup

Resolve Color Management Presets
The Resolve Color Management preset menu lets you choose how you want to use RCM to
grade your program. Each of these presets fully configures your project’s use of color
management, and the setting you select directly impacts how you’ll grade your program.
Because of this, once you choose a method of working and you grade every clip in your
program, those grades rely on the preset you used being selected in order to appear as
they should.
When it comes to choosing a preset, a good way to think about which to use is to choose an
SDR or HDR preset that corresponds to the primary deliverable you plan on outputting. Both
SDR and HDR presets have several variations that you can choose among.
While these presets correlate to how you plan on outputting your program, they don’t lock you
in, since you can always change the Output Color Space (described below). This makes it
possible to export multiple versions of your program, each intended for different venues, no
matter which color management preset you’re using.
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Whenever you choose a preset, a brief description explains the workflow that preset is
intended to facilitate. Here’s a list of the available presets, with slightly more detailed
explanations.
 SDR Rec.709: (default) Sets up a Rec.709 SDR grading environment. Your work can be
converted to HDR on output, if specified, but is limited to a Rec.709 gamut with out-ofbounds colors being clipped. Gamma 2.4 is not mentioned in the name because scene
versus display OOTF is managed automatically. Suitable for conventional streaming and
broadcast.
 SDR P3 Broadcast: Sets up a P3-D65 SDR grading environment. Your work can be
mapped to HDR for output, if specified, but is limited to a P3-D65 gamut with out-ofbounds colors being clipped. Gamma 2.4 is not mentioned in the name because scene
versus display OOTF is managed automatically. Suitable for wider gamut streaming and
broadcast at SDR levels.
 SDR P3 Cinema: Sets up a P3-D60 SDR grading environment. Your work can be
mapped to HDR for output, if specified, but is limited to a P3-D60 gamut with out-ofbounds colors being clipped. Suitable for conventional Cinema projection.
 SDR Rec.2020: Sets up a Rec.2020 SDR grading environment. Your work can be
mapped to HDR for output, if specified. Good for wide gamut streaming and broadcast.
 DaVinci Wide Gamut: Sets up an extra wide gamut grading environment that’s suitable
for grading either SDR or HDR. Capable of exporting with maximum image fidelity,
preserving highlight details of up to 10,000 nits. This is a log-encoded grading space,
for colorists wishing to work that way. Suitable for creating mezzanine intermediates or
final deliverables, or for grading HDR with high nit levels.
 HDR P3 Broadcast: Sets up a P3-D65 HDR grading environment. Output gamut is
limited to P3-D65, with out-of-bounds colors being clipped. Suitable for grading wide
gamut SDR or HDR up to 1000 nits.
 HDR Rec.2020: Sets up a Rec.2020 HDR grading environment. Suitable for wide
gamut SDR or HDR deliverables up to 1000 nits.
 Custom: If none of the available presets suits how you need to work, you can choose
Custom, which exposes the full set of RCM settings for you to set up to suit your needs.

IMPORTANT
For all presets, importing media that’s in an identical or smaller gamut maps the image
data into the larger color space of the preset without transforming it. Importing media
with a wider gamut than the color space of the preset remaps the image data to fit into
the smaller color space, while preserving as much image detail as possible.

Output Color Space
For most DaVinci Resolve installations and projects, you’ll set your Output Color Space to match
the needs of your program, according to your display’s capabilities (or the capabilities your
display is set to use for the project at hand). You’ll also typically use a Resolve Color
Management preset that matches those capabilities.
However, RCM gives you the flexibility of grading in one color space and then outputting to
others, when necessary. For example, it’s easy to grade an SDR Rec.709 version of a program
for streaming or broadcast, and then switch the Output Color Space to SDR P3 Cinema to
output an additional deliverable for theatrical exhibition.
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To facilitate this, you can set the Output Color Space to any setting, independent of the Resolve
Color Management preset you’ve selected, and DaVinci Resolve will automatically convert from
your Color Management Preset to the Output Color Space of your choice. When you do so,
here are the rules that govern the resulting image transform.
When going SDR to HDR:
 0-50 nits (18% mid-gray) in your program is mapped to 0-50 nits on output (no change)
 Everything from 51-90 nits in your program is remapped from 51 to 100 nits
(slightly expanded)
 Everything from 91-100 nits in your program is remapped from 101 to 1000 nits
(greatly expanded)

(Left) Original SDR grade seen within an HDR scale, (Right) After an automatic SDR to HDR conversion

When going from HDR to SDR, the reverse is done:
 0-50 nits (18% mid-gray) in your program is mapped to 0-50 nits on output (no change)
 Everything from 51 to 100 nits in your program is remapped from 51-90 nits
(slightly compressed)
 Everything from 101 to 1000 nits in your program is remapped from 91-100 nits
(greatly compressed)
While these methods of converting between SDR and HDR provide an effective starting point
for conversion, they’re not meant to be an automatic solution. It’s critical that you do a trim pass
whenever outputting a deliverable in a new color space and EOTF, so you can check every clip
and make adjustments to improve the result when necessary.

NOTE: When converting SDR to HDR, this behavior may exaggerate noise in imported
SDR media that happens to have large flat expanses of bright colors. If you see
particular clips that show this issue, you can disable this behavior on a clip by clip basis
in the Media Pool clip contextual menu, or the Thumbnail Timeline contextual menu in
the Color page, by toggling “Inverse DRT for SDR to HDR Conversion.”
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Advanced RCM Setup
Advanced users who need more detailed control over every aspect of RCM can choose
Custom from the Resolve Color Management preset menu. This exposes every control that’s
available, which opens a world of workflow possibilities for advanced users and post
production facilities.

Custom Color Management settings of Resolve Color Management as updated in DaVinci Resolve 17

NOTE: Older projects using RCM will have Color science set to Legacy, to preserve
the older color management settings and color transformations effect on your work.
For more information on how the previous generation of RCM works, see the
September 2020 version of the DaVinci Resolve 16 Manual.

Improved Metadata Management
When enabled, RCM better identifies the color space information of imported media that’s been
either transcoded or recorded directly to supported non-raw media formats, reading the NCLC
metadata of QuickTime-wrapped files, the color space metadata of .mxf-wrapped files, and the
XML sidecar files that track color management in ACES workflows. This behavior is automatic;
there are no visible controls governing this behavior aside from the individual Input Color Space
and Input Gamma settings associated with each clip in the Media Pool.

Color Space Metadata in QuickTime
DaVinci Resolve is capable of reading the NCLC metadata found within media files wrapped
within a QuickTime container for proper color management. This metadata consists of three
values formatted as (for example) 1-1-1. From left to right, these three digits specify the Color
Primary (or color space), Transfer Function (or gamma), and Color Matrix used by that media file.
These values are standardized in the SMPTE Registered Disclosure Document RDD 36:2015.
For your information, the different codes are listed in the following table. In the previous
example, the code of 1-1-1 indicates a standard dynamic range clip that uses the BT.709
primaries, transfer function, and color matrix.
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Color Primary

Transfer Function

Color Matrix

0

Reserved

0

Reserved

0

GBR

1

ITU-R BT.709

1

ITU-R BT.709

1

BT709

2

Unspecified

2

Unspecified

2

Unspecified

3

Reserved

3

Reserved

3

Reserved

4

ITU-R BT.470M

4

Gamma 2.2 curve

4

FCC

5

ITU-R BT.470BG

5

Gamma 2.8 curve

5

BT470BG

6

SMPTE 170M

6

SMPTE 170M

6

SMPTE 170M

7

SMPTE 240M

7

SMPTE 240M

7

SMPTE 240M

8

FILM

8

Linear

8

YCOCG

9

ITU-R BT.2020

9

Log

9

BT2020 Non-constant Luminance

10

SMPTE ST 428-1

10

Log Sqrt

10

BT2020 Constant Luminance

11

DCI P3

11

IEC 61966-2-4

–

–

12

P3 D65

12

ITU-R BT.1361
Extended Colour Gamut

–

–

–

–

13

IEC 61966-2-1

–

–

–

–

14

ITU-R BT.2020 10 bit

–

–

–

–

15

ITU-R BT.2020 12 bit

–

–

–

–

16

SMPTE ST 2084 (PQ)

–

–

–

–

17

SMPTE ST 428-1

–

–

–

–

18

ARIB STD-B67 (HLG)

–

–

Ability to Bypass Color Management Per Clip
When you right-click a clip in the Thumbnail Timeline of the Color page, a “Bypass Color
Management” setting appears underneath the Input Color Space and Input Gamma submenus
that let you identify a clip’s color characteristics. Choosing this option so that it appears
checked lets you exclude that clip from color management altogether, in the event you want to
manually manage that clip using LUTs, the Color Space Transform node, or simply by doing
manual grading.

The Bypass Color Management option for clips in
the contextual menu of the Thumbnail Timeline

Chapter – 8

Color Page Improvements

114

DaVinci Wide Gamut Color Space and
DaVinci Intermediate Gamma
DaVinci Wide Gamut (DaVinci WG) and DaVinci Intermediate are Timeline Color Space and
Gamma settings that provide a reliable universal internal working color space, which
encompasses a practical maximum of what image data any given camera can capture.
The DaVinci Wide Gamut color space is greater than BT.2020, ARRI Wide Gamut, and even
ACES, so you don’t ever lose image data no matter where your media is coming from.
Furthermore, the primary color values of the DaVinci WG color space are set such that the
process of automatically mapping source media from different cameras into this gamut is
extremely accurate as part of the Input to Timeline Color Space conversion, and tone and
saturation mapping from one color space to another can be done more accurately in the
Timeline to Output Color Space conversion. This also helps to produce greater consistency
among media from different cameras when making manual grading adjustments (though some
variations due to differences in camera and lens systems will remain).

(Left) The DaVinci Wide Gamut color space; (Right) The DaVinci Intermediate OETF

The DaVinci Intermediate OETF gamma setting has been designed to work with DaVinci Wide
Gamut to provide a suitable internal luminance mapping of high precision image data, in
preparation for mastering to either HDR or SDR standards, as your needs require, without losing
image data.
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The DaVinci Intermediate OETF seen encoding HDR levels

The DaVinci Intermediate OETF encoding SDR levels

Resolve Color Management is extremely flexible, so you don’t have to use DaVinci Wide
Gamut/DaVinci Intermediate as your Timeline color space if you don’t want. However, it
presents many advantages and is worth trying out to see if it can improve your workflow.
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Timeline Working Luminance
This control is only visible while the Resolve Color Management presets menu is set to Custom
Settings. The Timeline Working Luminance drop-down menu lets you choose how the Input
DRT (described below) maps the maximum level of a source image to the currently selected
Timeline Color Space. This setting also defines the maximum highlight level that’s possible to
output into the currently selected Output Color Space using the Output DRT.
While it’s typical to set this according to the mastering standard you’re grading to via a
collection of SDR and HDR labeled settings, there are additional settings available that make it
possible to add more automatic compression of highlights as you grade.
 SDR 100: The conventional setting for grading SDR material with a maximum level of
100 nits.
 HDR 500-4000: Conventional settings for grading HDR material at a variety of
maximum mastering levels. So long as output DRT isn’t set to None there will be some
manner of rolloff in the highlights, unless inverse DRT is enabled in which case there
will be no rolloff.
 SDR and HDR ER settings: These “extended range” settings each specify two
values and provide more headroom for aggressive grading of highlights by enabling
DaVinci Resolve to compress a greater range of out-of-bounds image data without
clipping, which can result in a smoother look.
Here’s how it works. Suppose you choose the setting “HDR ER 1000/2000.” In this
case, the Input DRT is used to map the maximum brightness of each source image to
the range specified by the first value, which is 1000 nits. Then, when you grade, the
signal isn’t clipped until it reaches the maximum range specified by the second value,
which is 2000 nits. This provides an additional 1000 nits of out-of-bounds headroom
before the image data is hard clipped by RCM’s image processing pipeline. The Output
DRT is then used to map from the maximum brightness specified by the second
number (2000 nits) to the output value defined by the currently selected Output Color
Space, in the process compressing this out-of-bounds headroom to preserve as much
highlight detail as is possible given the range you’ve selected.
 Custom: Exposes a field where you can enter a specific nit value.

Input DRT Tone Mapping
This control is only visible while the Resolve Color Management presets menu is set to Custom
Settings. RCM has always transformed the color primaries of different media formats to match
one another within the shared Timeline Color Space. In this updated version, the Input DRT
(Display Rendering Transform) drop-down menu provides a variety of different options to
enable DaVinci Resolve to automatically tone map the image data of SDR and HDR clips to
better match one another when they’re fit into the currently selected Timeline Color Space.
While each option varies in the details, they are all automated input-to-timeline color transforms
that do the following:
 Log-encoded media, or media using a 2.4 gamma transfer function, is mapped so
the black point, midtones at 18% gray, and white levels match those of HDR media.
Highlight data will be carefully stretched as necessary so that the highlights of all clips
in the timeline, whether SDR or HDR, are treated similarly.
 Raw formats such as BRAW, RED, and ARRI RAW, and media using HDR transfer
functions are minimally mapped along an HDR range of tonality.
 All color transforms into the Timeline Color Space are done without clipping.

Chapter – 8

Color Page Improvements

117

The idea is to distribute the image data of each clip in the timeline, be it SDR or HDR media,
along a similar histogram, with shadows, midtones, and highlights spread out in such a way as
to create an easier starting point for grading. One result of this is that grades made for one type
of media mostly work well with other types of media.
Different options are provided governing the details of how this Input to Timeline Color Space
transform is achieved. They all do the same thing but have different advantages.
 None: This setting disables Input DRT Tone Mapping. No tone mapping is applied to
the Input to Timeline color space conversion at all, resulting in a simple 1:1 mapping to
the Timeline Color Space.
 Simple: A good mapping for color transforms from HDR to SDR.
 Luminance Mapping: Same as DaVinci, but more accurate when the Input Color Space
of all your media is in a single standards-based color space, such as Rec.709 or
Rec.2020.
 DaVinci: This option tone maps the transform with a smooth luminance roll-off in the
shadows and highlights, and controlled desaturation of image values in the very brightest
and darkest parts of the image. This setting is particularly useful for wide-gamut camera
media and is a good setting to use when mixing media from different cameras.
 Saturation Preserving: This option has a smooth luminance roll-off in the shadows and
highlights, but does so without desaturating dark shadows and bright highlights, so
this is an effective option for colorists who like to push color harder. However, because
over-saturation in the highlights of the image can look unnatural, two parameters are
exposed to provide some user-adjustable automated desaturation.
– Sat. Rolloff Start: Lets you set a threshold, in nits (cd/m2), at which saturation will roll

off along with highlight luminance. Beginning of the rolloff.
– Sat. Rolloff Limit: Lets you set a threshold, in nits (cd/m2), at which the image will be

totally desaturated. End of the rolloff.

Output DRT Tone Mapping
This control is only visible while the Resolve Color Management presets menu is set to Custom
Settings. The Output DRT (Display Rendering Transform) drop-down menu provides
new options.
 None: No tone mapping is applied to the Timeline to Output color space conversion
at all, resulting in a simple 1:1 output with no softness or rolloff applied. All image data
outside of gamut will be clipped.
 Simple: A good mapping for color transforms from HDR to SDR.
 Luminance Mapping: Same as DaVinci, but more accurate when all your media is in a
single standards-based color space, such as Rec.709 or Rec.2020, set to the Timeline
and Output.
 DaVinci: This option tone maps your output with a smooth luminance roll-off in the
shadows and highlights, and controlled desaturation of image values in the very
brightest and darkest parts of the image. It’s been designed to give smooth, naturalistic
highlights and shadows as you push and pull the values of your images, without the
need for additional settings. This setting is particularly useful for wide-gamut camera
media and is a good setting to use when mixing media from different cameras.
 Saturation Preserving: This option has a smooth luminance roll-off in the shadows and
highlights, to prevent clipping. It does so without desaturating dark shadows and bright
highlights, so this is an effective option for colorists who like to push color a bit harder.
However, because over saturation in the highlights of the image can look unnatural,
two parameters are exposed to provide some user-adjustable automated desaturation.
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– Sat. Rolloff Start: Lets you set a threshold, in nits (cd/m2), at which saturation will roll

off along with highlight luminance. Beginning of the rolloff.
– Sat. Rolloff Limit: Lets you set a threshold, in nits (cd/m2), at which the image will be

totally desaturated. End of the rolloff.
 RED IPP2: This setting lets you use RED IPP2 tone mapping to output to an SDR format,
such as Rec.709; two settings are exposed with which to choose how your output will
be shaped.
– Output Tone Map: Lets you choose what kind of tone mapping you want to use for

your output. Options include None, Low, Medium, and High.
– Highlight Roll Off: Lets you choose what kind of highlight rolloff you want to use to

prevent clipping. Options include None, Hard, Medium, Soft, and Very Soft.
– HDR peak nits: A slider lets you choose the peak nit level you want to tone map to.

Defaults to 10,000 nits.

Use Inverse DRT for SDR to HDR Conversion
This control is only visible while the Resolve Color Management presets menu is set to Custom
Settings. A device rendering transform (DRT) is typically used when converting high dynamic
range media to a lower dynamic range color space/mastering standard. Thus, setting up a color
transform from SDR to HDR is an “inverse” operation to expand the dynamic range of SDR
media to HDR standards. The way this works is that levels at 100 nits are mapped to the
maximum value set for the Timeline Working Luminance parameter, and all other image levels
are strategically tone mapped in order to give yourself a good starting point for grading SDR
media into an HDR program.
This setting also has a secondary use. With this setting turned on, you can output Rec.709 clips
with color that’s identical to the input, with no compression in the highlights.

NOTE: Turning on “Use Inverse DRT for SDR to HDR Conversion” may exaggerate
noise in imported SDR media with large flat expanses of bright colors.

Color Space Aware Grading Tools
In DaVinci Resolve version 17, both Resolve Color Management and ACES enables “color space
aware” palettes, such as the new HDR palette, to have controls that feel consistent no matter
what color space the original media is from, or what Timeline Color Space you’re using.
Other palettes, such as the Qualifier and Curves palettes, become color space aware when you
turn on the “Use Color Space Aware Grading Tools” checkbox in the Color Management panel
of the Project Settings (this is turned on by default). When you’re using color space aware
grading tools, you should not turn on HDR Mode for the node you’re working on.
 In the case of the Qualifier palette, this enables Qualifiers to create high-quality keys
as you would expect, no matter what the color space of the original media is, or what
Timeline Color Space you’re using.
 In the case of the Curves palette, this makes the overall range of each curve better
fit the overall data range of the current clip, making curves adjustments easier and
more specific.
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NOTE: This control is only visible while the Resolve Color Management presets menu
is set to Custom Settings.

Apply Resize Transformations In
When you’re using Resolve Color Management, a new “Apply Resize Transformations In”
Project Setting is available in the Color Management panel while the Resolve Color
Management presets menu is set to Custom Settings. This setting lets you choose which color
space is used for resizing operations. Ordinarily, resizing is done in Linear, but certain specialty
workflows benefit from doing resizing in other color spaces, so this option lets you choose
which is best. The available options are:
 Timeline: Uses the Timeline Color Space to perform all resizing operations.
 Log: Uses a Log Color Space for resizing. Good for avoiding artifacts in certain
high‑contrast images such as titles and star fields.
 Linear: Usually provides the best results with most SDR media.
 Linear Mapped: Usually provides the best results with most HDR media.
 Gamma: Provided in case you find a need for this option.
 Gamma Mapped: Usually provides best results when mixing SDR media with wide
gamut and log-encoded media on the same timeline.

Graphics White Level
A new “Graphics white level” setting lets you define a shared maximum level in nits (cd/m2) for
titles, generators, and selected effects that generate color. Changing this setting lets you
change the maximum level of all DaVinci Resolve-generated titles, generator graphics, and
effects at once to accommodate different mastering and output requirements.

The RCM Image Processing Pipeline
To clarify the inner workings of Resolve Color Management for advanced users, the following
flowchart presents a rudimentary overview of how every parameter works together to
automatically manage the color of clips in your program.

Resolve Color Management’s image processing pipeline, illustrated
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HDR Palette
The HDR palette is specifically designed to enable fast and flexible primary grading of widelatitude media for either SDR or HDR output. It’s the first of a new generation of “color space
aware” palettes that work with Resolve Color Management to work with the known mapping of
source image data within the HDR palette’s own perceptually uniform operational color space,
using advanced color processing algorithms that enable more efficient color and contrast
adjustments, and perceptually uniform controls that make it easier to adjust all colors equally
across the spectrum, while maintaining careful control of image saturation.

The HDR palette

A set of global controls, at the right of the palette, let you make foundational adjustments to the
overall image, along with a set of Hue, Midtone Detail, Contrast/Pivot, and Black Offset controls
at the bottom. Additionally, a set of overlapping zone-specific controls let you make color and
contrast adjustments to specific ranges of image tonality. Altogether, the HDR palette lets you
make primary grading adjustments that are both photographically naturalistic, and as tonally
broad or specific as you require, while minimizing unwanted artifacts.
Despite its sophistication, the HDR palette uses color balance and slider controls that should be
familiar to any colorist or editor familiar with the more conventional Lift/Gamma/Gain controls.
Whether you’re a grading professional or just getting started with color, the HDR palette will
enable great results with less hassle once you learn how to harness its power.

The controls panel of the HDR palette

TIP: Due to the increasing ubiquity of HDR-capable media and HDR streaming
distribution workflows, the node HDR mode and HDR palette are both available
without restriction in the free downloadable version of DaVinci Resolve.
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What Makes the HDR Palette Special?
Before diving into the detailed use of the HDR palette’s controls, it’s important to understand a
bit more about how the HDR palette processes image data, so you can better understand what
advantages this tool presents.

Using the HDR Palette Without Color Management
While the HDR palette has been designed to work hand in hand with color management, you
can use it in non-color managed workflows so long as you set it up correctly. The HDR palette
option menu has Color Space and Gamma submenus that let you specify how you want to work.
By default, both submenus are set to “Timeline” to reflect the color space you’re choosing to
work within in display-referred workflows.

Color Space Aware Controls When Using Color Management
The HDR palette really shines when you enable Resolve Color Management or ACES, because
it’s a color space aware palette that uses color management to full advantage. Being color
space aware means that the color and contrast controls of the HDR palette conform themselves
to the range of each clip’s image data as mapped from the Input color space assigned to the
source clip to the Timeline color space your program is working within. Practically, this provides
two benefits:
 The controls of the HDR palette work and feel virtually identical no matter what type of
source clip you’re adjusting, and no matter which timeline color space you’re choosing
to work within.
 HDR palette adjustments made to one type of media will have a similar result when
copied to other types of media. This makes makes matching shots and copying looks
from one type of media to another easier than with previous tools.

NOTE: Because the HDR palette is color space aware, it’s not necessary to enable the
HDR setting on nodes for controls to work intuitively while working within a wide
gamut timeline color space, or delivering to an HDR format like ST.2084. The HDR
palette takes care of this for you, automatically.

Perceptually Uniform Adjustments
Furthermore, the image data of each clip is converted from the Timeline Color Space to an
operational color space used by the HDR palette, where the image is adjusted and then
converted back to the Timeline Color Space again, ready for the next operation. The
operational color space that’s used by the HDR palette is perceptually uniform, which means
that the range of values corresponding to each visible hue are distributed evenly throughout
this color space.
While the HDR palette works well grading standard dynamic range (SDR) material, the
underlying color science used by this palette also addresses issues that have inconvenienced
colorists grading high dynamic range programs using traditional controls. These
benefits include:
 Since the controls of this palette calculate all color transformations within a perceptually
uniform color space, you will experience finer control over color adjustments in a more
photographically intuitive way. For example, you may find that yellow hues are easier
to grade within this palette, since there’s a more even distribution of hues around the
circumference of the color wheels.
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 The HDR palette lets you make contrast adjustments without altering image saturation,
meaning that unlike when you use the master wheels of the Lift, Gamma, and Gain
panel, the HDR palette lets you raise image contrast without increasing image
saturation, and lower image contrast without decreasing image saturation. You’ll
find this is particularly useful while boosting highlights in HDR grades, since you can
now do so without causing extreme saturation increases in your highlights. In fact,
all adjustments you make to contrast with these controls will adjust the image while
keeping saturation unerringly constant (that is to say, perceptually speaking; you will in
fact notice small saturation changes in the Vectorscope). This, of course, excludes the
saturation controls.
 The HDR palette’s deep integration with Resolve Color Management also makes
matching shots and copying looks from one type of media to another easier than with
previous tools. Whether you’re a professional, or just getting started with color, the HDR
palette will enable better results with less hassle.

Superior Temp and Tint Controls
Because the HDR palette is color space aware, the Temperature and Tint adjustments in this
palette are themselves made using the same kind of XYZ to LMS color space transform used by
the Chromatic Adaptation Resolve FX plug-in. The result is that Temp adjustments are
photometrically accurate and create visual results similar to how the human vision system
perceives changes to a scene due to a change in the color temperature of lighting.

Customizable Zones
Another unique aspect of the HDR palette is how it can be customized to suit a wide variety of
working styles, specific tasks, and colorist preferences. Switching to the Zones panel reveals an
interface for adjusting the Range and Falloff of each currently defined zone, using graphical
controls overlaid onto a histogram of the current image, while a curve shows the user how the
contrast and color adjustments they’ve made mathematically affect the RGB channels of the
image within each zone. While the default zones preset provides an efficient starting point for
many kinds of scenes, the varying tonal range of image data in different scenes, whether
daytime, nighttime, interior, or exterior, will often require you to customize these zones to get
the best results from adjustments using these controls.

The Zones panel lets you customize the tonal ranges that each set of zone controls affect

Additionally, the sidebar at the left provides controls for adding and removing zones, so users
can customize this palette to work exactly the way they want. Any customized preset can be
saved for easy recall. This way, users have the freedom to work in whatever way suits them.
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The Option menu provides fast access to additional ways of customizing this palette’s
operation, including the selection and management of presets, a choice of methods for
numerically editing Color Balance adjustments, and a setting that determines whether or not
the Global controls are always exposed, or should be banked to like the other zone controls.

The HDR Palette Interface
The HDR palette is divided into two panels. The first, containing Color Balance controls and
custom sliders, is for making color and contrast adjustments. The second, containing the Zones
sidebar and Zones graph, is for customizing the range and falloff of each of the zones that
corresponds to each set of controls found on the controls panel. It’s these zones that are used
for making detailed image adjustments to tonally-specific areas of the picture.
By default, both panels appear within the same palette area, and you can switch between them
using buttons at the top-right of the palette. This is useful when you have limited screen real
estate, or you’re making simple adjustments. Alternately, you can click a button to expose both
panels side-by-side, occupying both the left and middle palette areas of the Color page.

From left to right, the Side-by-side view button, the
Controls panel, the Zones panel, the Reset control,
and the Option menu

This side-by-side mode makes it easy to see and customize how each zone is mapped to the
source image data, while making adjustments at the same time.

The HDR palette in side-by-side mode; at left, the Color/Exposure/Saturation controls; at right, the Zone
Customization controls

An Option menu at the far right of the title bar (shown as three dots) reveals the preset manager
for this palette, as well as different GUI options for customizing how you want to use this palette.

Navigating Multiple Zones in the Controls Panel
A row of buttons just under the HDR palette’s title bar show you, of all available zones, which
ones are currently adjustable using the visible controls below. While the default HDR palette
preset has six zone-specific Zone controls, plus the Global controls, most users will only have
room in the GUI for four sets of controls to be visible at any time. Meanwhile, grading control
panel users will constrained by how many trackballs their particular control panel has.

The Zone bank controls
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Since you’ll almost always have more zones available than you have room to adjust them, this
interface lets you see which zones you’re currently using, which zones are mapped to a control
panel, and which other zones are available for you to switch to. By default, there are three
active zones shown at the top, corresponding to the three sets of Zone controls to the left of
the Global controls. Zones that are available, but hidden, are shown in gray to the left and/or
right of the currently visible zones, which appear in color. This way, you can bank back and forth
among three zones at a time, while always having the Global controls available for adjustment.
There’s also a setting in the HDR palette’s Option menu, “Bank Global With Color Wheels,” that
lets you use all four GUI control clusters in this palette to show Zones controls, making it faster
to jump among tonally-specific adjustments. In this mode, there are four active zones shown at
the top, corresponding to the four sets of Zone controls being shown. However, in this mode
you must page all the way to the right to expose the Global controls, which are banked along
with all the other zones.

The Zone bank controls set to show four zones when the
Global controls are banked with all the other zones

Using these controls, you can switch your visible control among all available zones similarly to
how audio mixers switch among banks of tracks with a fader panel.
Methods of switching among different Zone controls:
 Click any gray zone button to the left of the currently visible zones to move all zones so
that the leftmost visible zone appears at that one.
 Click any gray zone button to the right of the currently visible zones to move all zones
so that the rightmost visible zone appears at that one.
 Click the left or right arrow buttons to either size of the zones indicators to move all
zones one to the left or one to the right.

Making Global Adjustments
Generally speaking, if you’re using the HDR palette to do primary grading, you’ll probably want
to begin with the Global controls. By default, these are found at the right of the Controls panel.

The graphical Global control cluster
at the right of the HDR palette
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These controls let you take the initial step of making an overall adjustment to the image.
To adjust color, you have a color balance wheel, temp and tint sliders (to the left and right of the
wheel, and also numerically below), and saturation adjustments. To adjust image contrast, a
Global Exposure control lets you stretch overall image contrast up to brighten the image, or
compress it down to darken it, relative to the current Black Offset level, which pins pixels
corresponding to minimum black in place. A pair of Contrast/Pivot controls at the bottom of this
palette let you manipulate overall color contrast by stretching highlights and shadows out or in
relative to the pivot point, expressed in stops.
While Global color adjustments are somewhat similar to the offset, temp, and tint controls found
in the Color Wheels or Log Wheels controls, there are important differences, described in detail
below. The Global Exposure control, on the other hand, operates very differently from
Master Offset.
Detailed Explanation of Global controls:
 Global Color Balance: A color balance control lets you simultaneously adjust the red,
green, and blue channels somewhat linearly throughout the tonal range of the image,
to freely rebalance the color. However, RCMv2 automatically maintains a smooth
saturation and exposure rolloff in the maximum highlights and minimum shadows,
so this effect becomes less pronounced in the blackest blacks and the whitest whites
of the image (this appears more pronounced in test gradients than real world images).
While adjustments made with this control won’t lower the value of the darkest pixels
in the image below the Black Offset level, individual color channels may dip below
this level in order to preserve colorfulness in darker shadows. The resulting color
adjustments made with this control are similar to how optical color filters placed over a
lens would affect an image.

(Top) The original image, (Bottom) A Global Color Balance adjustment affecting the overall image,
with a rolloff seen in the shadows and highlights of the superimposed ramp gradient

 Global Exposure: Brightens or darkens the entire image. Dragging to the right stretches
image contrast by raising the highlights while keeping the shadows pinned relative
to the Black Offset value. Dragging to the left lowers image contrast by lowering the
highlights while keeping shadows pinned relative to the Black Offset value. For more
explanation about the function of Black Offset, see the following section.
Keep in mind that all contrast adjustments in the HDR palette keep saturation constant
as contrast increases or decreases. This means that, when making large contrast
adjustments to HDR images, image saturation will remain perceptually the same.
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(Top) The original image, (Bottom) Raising Global Exposure

 Global Saturation: Raises or lowers the intensity of color throughout the image. Since
contrast adjustments don’t affect saturation, you must exercise manual control over any
desired changes to image saturation.
 Global Color Balance Value Fields: Two numeric values represent how the color
balance controls center handle position is represented. There are two ways of
numerically showing this: as X and Y, or as Angle and Strength. You can choose
either method from the HDR palette’s Option menu; whichever method you choose
determines how the center handle of all color balance controls is manipulated if you
adjust these values directly.
At the bottom of the HDR palette, additional Global Temp and Tint, Hue, Midtone Detail, and
Contrast/Pivot controls let you make other kinds of global adjustments to image color, detail,
and contrast, in ways that are very similar to the identically named controls in the Color Wheels
or Log Wheels controls. Additionally, there’s a Black Offset control that lets you set the minimum
allowable black level in the current shot.

Global controls found at the bottom of the HDR palette

Detailed explanation of additional Global controls:
 Temp: This global temp adjustment lets you warm or cool the image with a range from
-4000 to +4000 based on a kelvin scale. Adjustment follows the spectral locus line in
the CIE graph: the intensity of adjustment is naturalistic. To minimize visual artifacts, this
control is capable of warming the image more aggressively than cooling it.
 Tint: This global tint adjustment lets you add “plus green” or “minus green” adjustments
with a range from -100 to +100 on an arbitrary scale.
 Hue: Rotates all hues of the image around the full perimeter of the color wheel. The
default setting of 50 shows the original distribution of hues. Raising or lowering this
value rotates all hues forward or backward along the hue distribution as seen on a
color wheel.
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 Midtone Detail: When this parameter is raised, the contrast of regions of the image with
high edge detail is raised to increase the perception of image sharpness. The effect
is sometimes referred to as definition. When this parameter is lowered to a negative
value, regions of the image with low amounts of detail are softened while areas of high
detail are left alone. 0 is unity. The range is –100 through +100.
 Contrast: This one parameter lets you increase or reduce the distance between the
darkest and lightest values of an image, raising or lowering image contrast. The effect
is similar to using the Lift and Gain master controls to make simultaneous opposing
adjustments. Bright and dark parts of the image are pushed apart or brought together
about a center point defined by the Pivot parameter. Unlike the Contrast control in the
Primaries palette, the Contrast control in the HDR palette ignores the “Use S-curve for
contrast” setting in the General Options panel of the Project Settings.
Keep in mind that all contrast adjustments in the HDR palette keep saturation constant
as contrast increases or decreases. This means that, even when making large contrast
adjustments to HDR images, image saturation will remain perceptually the same to your
eye, with small changes made to the actual saturation of the image in order to maintain
this perception. Be aware that the tone mapping settings in RCMv2 will have an effect
on how much saturation is maintained in the top highlights and bottom shadows of the
image, versus being automatically rolled off at the outer boundaries of the signal.

(Left) The original image, (Right) Raising Contrast, saturation is kept perceptually constant, except at
the outer boundaries of the signal in the top highlights and bottom shadows (depending on how you
have your tone mapping set in RCM)

 Pivot: Changes the center of tonality about which dark and bright parts of the image
are stretched or narrowed during a contrast adjustment. This lets you change how
contrast is distributed among the shadows and highlights. The default value of 0
pushes highlights above 50% gray higher, and shadows below 50% gray lower, in equal
proportion to one another. Changing the pivot point changes the percentage of image
tonality about which contrast is either expanded or compressed.
Darker images may require a lower Pivot value to push more levels up and avoid
crushing the shadows too much when stretching image contrast, while lighter images
may benefit from a higher Pivot value to push levels down and increase
shadow density.
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(Top) Altering contrast by raising Pivot, which redistributes most of the contrast expansion down
towards shadows, (Bottom) Altering contrast by lowering Pivot, which redistributes most of the contrast
expansion up towards the highlights

 Black Offset: Defines the darkest allowable part of the image. No adjustment by any
other control in the HDR palette will ever go below this level, except for the occasional
color channel if the shadows become extremely saturated. For more detailed
information on this extremely important control, see the very next section.

Black Offset Explained
Of all the Global controls, the Black Offset control is one of the most deceptively important.
Black Offset lets you define the darkest pixels of the image. Adjustments made to Black Offset
do not offset the entire signal, they only affect the very darkest portion of the signal, letting you
raise or lower the black point of the image while smoothly blending the resulting adjustment
into the unadjusted portion of the image. The result is that you can compress or expand the
bottom of your signal.
If you raise Black Offset, you can add “flaring” to the image, similarly to how light flaring within a
lens might lighten the darkest part of the image.

(Left) The original image, (Right) Raising Black Offset in order to add flaring to the darkest pixels of the image

Alternately, you can lower Black Offset to lower the very darkest pixels in the image. If the
source image is dark enough, this control can lower the darkest pixels below 0, however this
image detail is preserved in the color image processing pipeline
The most important thing to understand about this control is that level to which you set Black
Offset becomes the new level at which Global exposure adjustments are made. In the following
example, the first image shows the original color of a clip that was exposed to be dark. In the
second image, Black Offset is adjusted to raise the darkest parts of the image, compressing
them relative to the midtones and introducing a pleasing flaring effect to the shadows.

(Left) The original image; (Right) The image with Black Offset raised
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In the following image, Global Exposure is raised, and you can see in the Waveform scope that
the exposure change stretches the contrast of the image up, with the darkest pixels “locked” to
the Black Offset you set.

(Left) Before, (Right) After raising Global Exposure to stretch image contrast out from the Black Offset level;
notice that the bottom of the signal continues “touching” the same level after global exposure is raised

The Black Offset level you set also becomes the minimum picture level when you lower
exposure, either using the Global Exposure changes, or when you use any of the “darkening”
zone controls such as Shadow, Dark, and Black. The following image shows the result of
lowering Global Exposure; the shadows of the image are compressed more heavily than the
highlights as exposure is lowered, with the result that the minimum value of the image remains
at the Black Offset level you set. With shadow detail impressively preserved, this compression
rolls off smoothly and nonlinearly through the midtones so that the image continues to look as
natural as possible.

(Left) Before, (Right) After lowering Global Exposure to compress image contrast down to the Black Offset level;
notice the signal never goes lower than the Black Offset level

This is also true when using other darkening zone exposure controls, such as the Shadow
control, which selectively pushes the exposure of the darker part of the image down, while
leaving the highlights alone. While reducing Shadow exposure, the darkest pixels still compress
so that nothing goes beneath the Black Offset level you set.
Bottom line, you can adjust Black Offset at any time, either before or after any other Global or
Zone adjustments, to fine tune the image as necessary.

Making Zone-Based Adjustments
After you’ve made whatever initial Global adjustments you want, you can optionally make more
tonally-specific adjustments to the image via the Zone-based color and contrast controls to the
left. These divide the image into multiple overlapping “zones,” which are somewhat similar in
principal to Ansel Adams’ zone system, which divides images into tonally-specific regions
based on image luminance, from pure black, through progressively lighter shadows, to 18% gray
as the middle value centering the midtones of most images, and then up through progressively
lighter highlights on the way to the last zone of pure white.
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Simplified illustration of Ansel Adams’ zone system

While Adams’ zone system was meant to teach people how to think about using the available
range of the photographic medium when exposing images, the zones of the HDR palette let
you put this concept into practice by allowing you to make tonally-specific Color Balance,
Saturation, and Exposure adjustments that only affect the range of shadows or highlights that
fall within that zone.
Using the default preset, the shadows of your image are divided into overlapping Shadow,
Dark, and Black zones, while the highlights of your image are divided into separate overlapping
zones for Light, Highlight, and Specular ranges. The chart below illustrates the relationship of
these zones to one another.

Approximation of the overlapping zones in the HDR palette that can be individually adjusted

NOTE: All of the examples in this section have Timeline to Output Tone Mapping set to
None, to keep the ramp gradient linear for purposes of this explanation.

Zone-Based Color Adjustments
Understanding how adjustments made using these overlapping zones interact with one another
is key to knowing what you can do using the HDR palette. Keep in mind that every zone is
customizable, but here’s how the default zone definitions work to let you make detailed image
adjustments. For clarity, Zone adjustments are shown made to a linear ramp gradient image, to
demonstrate exactly what tonal portion of each image is affected by each control.
 The Light and Shadow zones are the most broadly defined zones. Together, they cover
the entire tonal range of your image. They softly overlap one another by two stops at
the center of the tonal range (50% gray or 18% exposure); this is where adjustments
made to Light mix together with adjustments made to Shadow, resulting in both
adjustments softly blending together. Making exposure adjustments to these two zones
lets you manipulate overall image contrast by selectively compressing/expanding
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contrast in the shadows and/or highlights relative to one another. Using the color
controls lets you make broad color adjustments to the upper (highlights) and/or lower
(shadows) range of image tonality.

Color adjustments to a ramp gradient show the Light
(tinted green) and Shadow (tinted orange) zones

 The Dark and Black zones overlap two progressively lower luminance ranges of the
Shadow zone. Dark is useful for adjusting the color or contrast of the deeper shadows,
while Black is useful as a trim that lets you manipulate the very darkest parts of an image.
All adjustments you make to Dark are mixed with any adjustments made to Shadow,
and all adjustments made to Black are mixed with the adjustments made to Dark and
Shadow. In this way, all color adjustments you make to overlapping Shadow zones mix
smoothly together to produce the final result, as seen in the following ramp gradient.

Color adjustments to a ramp gradient show the Dark
(tinted blue) overlapping the Shadow (tinted orange) zone

 The Highlight and Specular zones overlap two progressively brighter luminance ranges
of the Light zone. Highlight lets you adjust the color and/or contrast of the brightest
highlights, while Specular is useful as a trim that lets you manipulate the very brightest
highlights of an image. All adjustments you make to Highlight are mixed with any
adjustments made to Light, and all adjustments made to Specular are mixed with the
adjustments made to Highlight and Light. In this way, all color adjustments you make to
overlapping Highlight zones mix smoothly together to produce the final result, as seen
in the following ramp gradient.

Color adjustments to a ramp gradient show the Highlight
(tinted yellow) overlapping the Light (tinted green) zone.
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As you can see, each one of these zones allow the specific adjustment of whichever
parts of the image fall within the luminance range of that zone (as defined on the Zones
panel), while providing control over how smoothly one adjustment fades into the next,
to prevent unwanted contouring. As you make adjustments to the Range and Falloff of
each zone using the different sets of zone controls, they work together to smoothly
manipulate the contrast and color of the image, similarly to if you were using a more
precise and constrained version of the Custom Curves. In fact, you can see the actual
adjustment you’re making by exposing the Zone graph.

(Left) Raising the Range of the Light zone to expand the Shadow zone’s range
of influence, (Right) The same adjustment seen in the Zone graph

Working this way allows a tremendous specificity of adjustment, without the need to
use curves or qualifiers. For example, zone-specific Color Balance controls allow you to
grade the highlights and shadows separately using the Shadow and Light zone controls
to quickly create a warm/cool split lighting effect. This makes the creation of dynamic
grades more efficient and more creative.

(Left) The original image, (Right) Using the HDR palette to warm
the highlights and cool the shadows (exaggerated for print)

In this next example, the Dark zone’s color balance control is used to add a splash of
green to the darker shadows of the image, while the Black control is used to neutralize
this green in the very blackest shadows.

(Left) The original image, (Right) Using the HDR
palette to add green to a narrow range of shadows
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Zone Based Exposure Adjustments
Each zone has its own Exposure control, that allows you to stretch image contrast from that
zone’s Min or Max range boundary either down towards the shadows, or up towards the
highlights. As seen on the Zone graph (found on the Zone panel), exposure adjustments are
made on a scale measured in stops, to provide a more photographic experience when grading
wide dynamic range material.

The scale of the Zone graph shows you the shadow and highlight ranges,
in stops, relative to 0 representing 18 percent photographic gray

On this scale, 0 stops corresponds to photographic 18% gray, at the center of each image’s
tonal range. Shadows then fall to the left over -8 stops, while highlights fall to the right over +8
stops, where each stop represents either twice the amount of light (stopping up) or half the
amount of light (stopping down).
In conjunction with Resolve Color Management, this range is designed to accommodate any
SDR or HDR range you’ll be mastering to. All HDR palette controls are designed to
accommodate up to 16 stops of exposure. By comparison, most modern digital cinema cameras
claim to be able to capture somewhere between 13-19 stops of dynamic range, while a white
paper from the ASC states that modern film negatives are capable of capturing 14 stops of
dynamic range.
Unlike the Lift/Gamma/Gain or Log master level controls, the Exposure adjustment of each zone
starts at a specific boundary of image tonality, and stretches all the way out through the
highlights or shadows, through the maximum or minimum signal level allowable. Since Shadow
and Light are the two zones that are centered on the midtones of the image, they’re the best
zones for seeing how this works. Because of this, these are also probably the first two zones
you’ll want to adjust if you’re making more specific exposure changes to the image.
Using the default preset, Shadow exposure adjustments affects everything in the image from
stop 1 down through absolute black.

(Left) The original image, (Right) Darkening all shadows by lowering the Shadow exposure adjustment
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Meanwhile, Light exposure adjustments affect everything in the image from -1 stops all the way
through maximum white.

(Left) The original image, (Right) Lightening all highlights by raising the Light exposure adjustment

This ability to make open-ended adjustments to image contrast in different overlapping ranges
of shadow and highlight tonality makes these controls uniquely suitable for HDR grading, while
also being completely suitable when grading at SDR levels. Also, keep in mind that all contrast
adjustments in the HDR palette keep saturation constant as contrast increases or decreases.
This is particularly useful when making large contrast adjustments to HDR images, for which a
300 nit expansion of highlight contrast using the Lift/Gamma/Gain or Log controls would create
a huge saturation increase. Using the HDR palette to expand highlight contrast keeps image
saturation perceptually the same, while offering zone-specific saturation controls that let you
choose whether to increase or decrease the saturation falling within that zone.
Exposure adjustments to zones that overlap other zones are smoothly combined to allow
targeted contrast adjustments while making it relatively easy to avoid unwanted artifacts, like
contouring or solarizing due to overzealous inversion of the curves caused by these operations.

An Example of Zone-Based Exposure Adjustment
To see this in action, let’s see what happens when we make some overlapping adjustments to
the Light, Highlight, and Specular zones in order to grade some HDR highlights, focusing our
attention on the Waveform scope, since it’s difficult to see HDR grades in print. Keep in mind
that you won’t usually be making Zone-based Exposure adjustments by themselves. This
example image has had a Contrast/Pivot adjustment to push the midtones and shadows down,
to give the shadows greater definition. Then, Black Offset is raised to lift the darkest shadows
up just a little bit, so they can breathe. This leaves us with an image that’s mostly under 200 nits
to begin with. A perfect starting point for us to begin sculpting those highlights.

(Left) The original image; (Right) After changing Contrast/Pivot, and raising Black Offset

Using the default preset, making an exposure adjustment to the Light zone smoothly raises
everything in the source image above -1 stops on the Zone graph. Practically, it’s stretching up
all levels above 10 nits on the HDR scope. This smoothly boosts the brighter part of the image,
while leaving the shadows down where we put them.
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(Left) The previous adjustment; (Right) After raising Light Exposure

At this point, making an exposure adjustment to the Highlight zone boosts all levels above 1.5
stops on the Zone graph. Again, practically speaking, all levels above 100 nits are being
boosted, brightening the top highlights. In the image, you can see that we’re creating a greater
differentiation between dimmer and brighter highlights in the image, creating highlight contrast
with greater detail where once there were simply flat pools of light.

(Left) The previous adjustment; (Right) After raising Highlight Exposure

Now, this might be a fine place to stop, but since we’re interested in turning the HDR in this
image up to 11, we can put the highlights over the top by making one more Exposure
adjustment, to the Specular zone. The Specular zone starts at 4 stops and is designed to let you
boost or attenuate only the very brightest, hardest highlights, likely corresponding to specular
details such as chrome reflections, eye glints, and directly photographed light sources. You
won’t always use this control, but it’s useful to know about.
In this example, the default Specular Zone Min Range control is outside of the available image
data in the image (seen as the right edge of the histogram in the Zone graph), so making
adjustments with this control won’t do anything. However, dragging the Min Range control to
intersect the end of the histogram will allow these controls to affect the very brightest pixels in
the image.

(Left) The original distribution of zones in the Zone Graph; (Right) Dragging the Specular
Min Range handle to intersect the brightest highlights in the image histogram, to allow the
Specular controls to affect that part of the image
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Now, the Specular Exposure control lets us push the very brightest pixels of our image up,
further differentiating them from the other highlights, and widening the audience’s sensation of
highlight contrast.

(Left) The previous adjustment; (Right) After raising Specular Exposure to bring the
very brightest highlights to 1000 nits

Now, having selectively boosted the Highlight and Specular zones, you might decide that you
like the differentiation that’s been created among different brightnesses of highlights, but the
overall highlights are too bright. This is easily fixed by lowering the Light zone’s Exposure
adjustment. As a result of this one adjustment, all of the highlights are scaled down, while the
adjustments you’ve made to the Highlight and Specular zones maintain a relative influence on
the parts of the image they’re brightening. The Shadow, Dark, and Black controls work similarly,
but for the shadows.

(Left) The previous adjustment; (Right) After lowering Light Exposure, all levels smoothly
scale down to reduce the brightness of the highlights while keeping the differentiation
you’ve created with the Highlight and Specular controls

Now that you’ve seen how all overlapping Zone adjustments work together to create a
seamless adjustment, it’s time to look at the Zone controls in more detail.

Zone Controls
Each individual zone also has controls for Color Balance and Saturation, which let you make
focused adjustments that fall within specific ranges of image tonality, all without needing to use
a qualifier. Using all of these zones together, you can make fast, precise, and smooth
adjustments to the image that feel incredibly natural. Despite the name of the palette, this
allows careful adjustment of SDR images, as well as creative adjustment of the spectacular
range of highlights that HDR enables. There are also Range and Falloff controls to the left and
right of each cluster of controls that let you redefine each zone’s area of influence, even if the
Zone graph is hidden.
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The Shadow and Light zone controls next to one another; you
can see the Min and Max indicators, along with the Range value
(in stops) at the upper left of each group of controls

 Range indicator: An icon and value at the upper-right-hand corner of each zone control
cluster shows that zone’s range. A numeric value shows the range value, which is the
Luminance level of image tonality at which that zone’s adjustment begins. This value is
expressed in stops, while an icon shows you whether it’s a maximum range (affecting
shadows) or a minimum range (affecting highlights).
Clicking the icon shows a temporary preview in the Viewer of which parts of the image
will be affected by the controls of that zone. Affected areas appear in full color,
unaffected areas appear black.
 Zone-specific Color Balance: A color balance control lets you readjust the relative
strength of the red, green, and blue channels within the current zone of image tonality.
 Zone-specific Exposure: Zone-specific Exposure controls work in conjunction with
an adjustable pivot that defines the Luminance level that each exposure adjustment
starts from. To accommodate both shadow and highlight adjustments, there are two
kinds of pivots, labeled Maximum and Minimum range, and indicated using an icon.
Max Range controls, such as the Shadow control, start at a maximum value with
exposure adjustments stretching image contrast downward towards the shadows.
Min Range controls, such as Light, start at a minimum value with exposure adjustments
stretching contrast upwards towards the highlights. Each zone also has a falloff that
specifies how much of that zone overlaps neighboring zones (starting at the pivot level)
in order to blend overlapping adjustments softly enough to prevent contouring.
 Zone-specific Saturation: Adjusts the intensity of color within the current zone
of image tonality.
 Min/Max Range: Defines the level of image tonality at which that zone’s adjustment
starts. This value is expressed in stops. Identical to the Min or Max Range slider in the
Zone panel. Useful for tweaking Range while the Zones graph is hidden.
 Zone Falloff: Defines how softly this zone fades into all overlapping zones. Identical
to the Falloff slider in the Zone panel, the value is visible in the virtual slider below.
Useful for tweaking Falloff while the Zones graph is hidden.
 Zone-specific Color Balance Values: Two values expose the current color balance
operation numerically. The option menu lets you choose between representing these
as X and Y, or as Angle and Strength.
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Customizing Zones Using the Zone Panel
Similarly to the controls of the Log palette, how these zones overlap can be adjusted in order to
make each zone’s controls work best for the tonal distribution of the images in any given scene.
Zone overlap is governed by individual pairs of Range and Falloff controls, so you can make
precise adjustments no matter what the distribution of tonality is in the image you’re grading. All
zones are organized and customized using the Zone panel, which is divided into the Zones
sidebar to the left, and the Zone graph to the right.

The Zone panel of the HDR palette

The Zone Sidebar
The Zone sidebar show a list of all the zones in the current preset. This list is sorted by range
values, with minimum range zones (affecting shadows) appearing at top and maximum range
zones (affecting highlights) appearing below. Clicking any zone in the list selects that zone,
which also selects that zone’s boundary handle in the Zone graph at the right.
Zone sidebar controls:
 Enable Zone toggle: Toggles let you turn each zone on and off. Disabled zones will not
be rendered.
 Max/Min button: Defines whether the adjustment of a particular zone affects the image
from the current range value and below (Max) or the current range value and higher
(Min). This setting is typically used when creating your own custom preset, to define
which zones stretch down towards the shadows and which zones stretch up towards
the highlights.
 Show/Hide Zone button: This button lets you hide sets of zone controls you don’t
want to adjust any further, leaving more room in the UI and on your control surface
for the zones you do want to adjust. For example, if you decide you don’t need to
use the default Black and Specular zones, you can hide them so that only the Dark,
Shadow, Light, and Highlight zones are available to switch among. Zone controls with
adjustments made to them continue to affect the image even if the controls are hidden.
 Delete Zone button: Deletes that zone. This is primarily useful when you’re creating
your own zone preset. At the time of this writing, you cannot delete any of the default
zones found in the default Zone preset.
Additionally, you have the option of adding zones, and saving zone presets to create your own
custom ways of adjusting the image.
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To create a new zone:
1 Open the Zones panel.
2

Click Create Zone, at the bottom of the Zones sidebar.

3

When the Create Zone dialog appears, choose the Zone type you want that zone to
have (Dark/Min Zone or Light/Max Zone), enter a Name, and define the Pivot and Falloff
values. Pivot, Falloff, and Zone type are editable later, so don’t worry if you don’t set
them up perfectly the first time.

The Create Zone dialog

4

Click Create. That zone appears added to the list, which is sorted in the order in which
Pivot is defined, with Dark Zones appearing at the top, and Light Zones appearing at
the bottom.

Zones Graph
The Zone graph is a key component of the HDR palette’s use. Along the bottom, a scale in
stops shows the range over which the HDR palette operates. At the top, handles let you adjust
the editable range boundaries that define the tonal range of each zone’s operation,
superimposed over a histogram showing the current image as input into the current node.
Running through the middle of the Zone graph, a curve shows you all the Global and Tonal
color and contrast adjustments being made by the HDR palette in the current grade.

The Zone graph

The relationship of the range boundaries with the source image histogram in this graph is
extremely important. The range boundary for a particular zone must intersect with the part of
the source histogram you want to adjust for the controls of that zone to have any effect. If any
zone boundaries lie outside of the histogram, that zone’s controls will do nothing. In the
screenshot above, the zone’s range boundaries all lie inside of the visible histogram, so each
zone’s controls will make a predictable adjustment to the image data in that part of
the histogram.
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In the following screenshot, the Zone graph shows that the Specular zone boundary lies
outside of the source histogram for the image, so adjustments made using the Specular
controls will have no effect. For this reason, it’s a good idea to check that the zone boundaries
intersect the parts of the image you want to adjust prior to manipulating the controls, but if you
notice that a particular zone’s controls aren’t having as much of an effect on the image as you’d
like, you can always move the zone boundary after the fact to expand the range of the image
that’s affected by that zone.

The Specular zone boundary lies outside of the source histogram,
excluding the Specular controls from affecting the image

Customizing zone boundaries in this way is one of the most powerful aspects of the HDR
palette, but don’t worry that you’ll be constantly dragging zone boundaries back and forth for
every shot you grade. Generally speaking, most well-photographed scenes have similar ranges
of image tonality in each shot, so zone boundaries that have been customized for one shot from
that scene will likely be good for most clips in that scene. That said, adjusting zone boundaries
is another powerful way of tailoring a grade specifically for a clip with a unique range
of contrast.
Zone Controls
 (Min/Max) Range: Defines the level of image tonality at which that zone’s adjustment
starts. This value is expressed in stops.
 Falloff: Adjusts how softly the adjustment in that zone will blend into the image. A value
of 0 results in an immediate transition to the adjustment created in the current zone,
with the color adjustment being a sharper effect. Higher values will blend the current
zone’s adjustment into the image more softly, resulting in a more gentle and seamless
transition into the effect.

Customizing and Saving Presets
If you’ve customized the Zone graph in a way that’s potentially useful for other grading
situations, you can save a preset of the Zone settings for future use. Saving, recalling, and
managing these presets is simple.
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Methods of managing presets:
 To save a preset: Customize the Zone graph to suit your needs, then choose
Save As New Preset from the HDR Palette option menu.
 To load a preset: Choose Presets > Name of Preset > Load Preset from the
HDR Palette option menu. A new preset will be saved.
 To update a preset: Load a preset, make any changes you need to from the
Zone graph, and then choose Presets > Name of Preset > Update Preset from the
HDR Palette option menu.
 To delete a preset: Choose Presets > Name of Preset > Delete Preset from the
HDR Palette option menu.

Resetting Color and Zone Adjustments
In the HDR palette’s Option menu, there’s a Reset submenu with three commands, Reset All,
Reset Color Adjustments, and Reset Zone Definitions, which are self-explanatory. These are
important because, during the course of developing a grade, there will be many times when
you’ll want to reset your color adjustments without changing how you’ve customized the zone
graph, or vice versa.
Additionally, each of the visible reset buttons in the GUI can be used with keyboard modifiers to
specifically target what to reset. The master reset button in the HDR palette’s title bar resets the
entire palette when clicked (similar to the Reset All command). However, using keyboard
modifiers while clicking this button changes what’s reset.
 Hold down Command+Shift while clicking the master reset button to reset only the
Zone graph’s Range and Falloff controls, without resetting your color adjustments.
 Hold down Command+Option while clicking the master reset button to reset only the
color adjustments, while leaving the zones alone.
Both of these modifiers also work with the zone-specific reset controls found in the Wheels
panel, letting you reset only the zone controls or only the color controls of each specific zone.

Using the HDR Palette With DaVinci Control Panels
To use the HDR palette with the DaVinci Advanced Control Panel, press SHIFT + AUTO COLOR.
All of the current control mappings will appear in the center panel soft buttons and rotaries, and
the trackballs and control rings will be mapped to the appropriate zones. The < and > soft keys
let you navigate among all the zones available in the current preset.
To use the HDR palette with the DaVinci Mini Control Panel, press the USER button, then press
the HDR soft button above the left-hand display. All of the HDR palette control mappings will
appear in the soft knobs and keys, and the trackballs and control rings will be mapped to the
color balance and exposure controls of the appropriate zones. The PREV ZONE and NEXT
ZONE soft keys let you navigate among all the zones available in the current preset.
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Color Warper
The Color Warper palette is a mesh-based warping tool that, instead of warping the spatial
location of pixels, warps one set of colors into another. Better yet, unlike the HSL curves, the
Color Warper lets you simultaneously adjust two color parameters at the same time, within
user-selectable regions of specific hues. These adjustments, made using a grid of draggable
control points, automatically have a smooth falloff from the colors you’re warping to other colors
that are locked into place. The smoothness of this falloff depends on the distance between the
warp points that are being adjusted and other warp points that are locked in place to
prevent change.

The Color Warper, located in the center palette area

There are two ways you can use this tool. You can drag the control points in the grid to make
highly specific image adjustments. More intuitively, you can click to sample the image, which
selects the closest grid point that affects that color, and then drag to make an adjustment with
that control point.

Clicking and dragging to sample skin tone in the Viewer to adjust
that color’s control point on the Hue-Saturation warping grid

You can use this tool to make extremely specific adjustments to colors in an image, similar to
what you might do with a Qualifier key or with the HSL curves. However, by warping the points
using a grid, you can manipulate two color characteristics at the same time, adjusting both Hue
and Saturation, or Chroma and Luma. In the following example, specific adjustments are being
made to refine the man’s shirt, to adjust his skin tone, and to manipulate the greens of the
foliage in the shot. All three of these naturalistic adjustments are smooth and artifact-free by
virtue of the Color Warper’s method of cleanly remapping color.
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(Top) The original image, (Bottom) Manipulating the hue and
saturation of the grass using the Chroma-Luma controls

You can also use this tool to create wide-ranging stylistic looks for the overall image, bending
the color in creative ways that other controls don’t. In the following image, the less saturated
and neutral colors of the image are all warped towards a bluish-cyan, while the more saturated
oranges are warped towards a saturated orange-red, to quickly create a stylistic treatment of
the image.

(Top) The original image, (Bottom) Stylizing the overall image using the Hue-Saturation controls
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The Color Warper Interface
You can either use the Color Warper as it appears docked into the middle palette area, or you
can click the Expand button to open the Color Warper into a floating window that you can make
as large as you like, giving you more detailed control of dense grids of control points. For
convenience, the examples in this chapter show the Color Warper side by side with the Viewer,
in a floating window. While the Color Warper is open in its own window, the Color Warper
palette button in the toolbar turns into a “re-docking” button, clicking it puts the palette back in
the palette area below.

(Left) Clicking the Expand button opens the Color Warper into a floating window,
(Right) Clicking the Re-docking button in the palette toolbar puts the palette back

There are two overall regions of the Color Warper palette. At the left, the grid area has the
actual warping grid with points you manipulate to make adjustments, while controls underneath
let you choose the resolution of the grid and the color space in which it works. At the right, the
control area provides all the tools, range controls, and feathering controls that are available for
manipulating the warping grid in a variety of highly specific ways.

Using the Grid Controls to Manipulate Color
This palette has two modes; each lets you manipulate the colors of the image in different ways,
and each has a different style of grid used for warping the different color channels that are
affected. Learning how to manipulate the color warping points of each of these grids is central
to understanding how this palette works.

(Left) The radial grid in Hue-Saturation mode, (Right) The two rectangular grids in Chroma-Luma mode

Dragging to Warp Colors
Despite the different shapes, each of these grids are manipulated in similar ways. Dragging a
control point alters whatever color corresponds to that point, while the colors that surround this
dragged point are also adjusted proportionally according to their location between the point
being dragged and surrounding points that either (a) aren’t affected, or (b) are locked into place.
Locked points prevent the colors at those points from being changed. By locking some parts of
a grid and dragging other parts, you can create sophisticated hue-specific adjustments.
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The orange control point has
been selected and dragged
to make an adjustment.
Control points with black
outlines are locked in place
and help prevent control
points on the opposite side
from being moved. All other
control points between the
selected and locked control
points are stretched or
squished depending on the
selected point’s adjustment.

The image above shows the three states of control points in the grid:
 Orange: Selected points appear orange. You can select multiple points by
Command‑clicking multiple points, by dragging a bounding box over multiple points,
or by using the draw selection tool to click and draw over any points you want to select.
Once you’ve selected and moved a control point, it becomes locked to keep that
adjustment in place.

Selected points appear
orange; in this example
four points are selected to
move them all together

 Outlined: White control points with a black outline are locked. Locked points do not
move automatically when nearby points are dragged, so locked points are important
for preventing specific colors you don’t want altered from being changed, as well as
for saving changes to points that you’ve adjusted. All adjusted points become locked.
The outer corners of the Chroma-Luma grid are locked, as is the outer ring and center
point of the Hue-Saturation web.

Locked points with black
outlines keeping other
colors in the image from being
adjusted by the selected point
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 White: White control points are neither selected nor locked, and will be stretched
or squished when adjacent control points are moved.

Unlocked control points
between a selected point
and locked points (in this
case the corners of the
grid) will squish and stretch
to warp an entire range of
color as you drag

While control points work much the same in either the Hue-Saturation or Choma-Luma
modes, there are some important differences. The radial “spokes” of the HueSaturation wheel don’t influence neighboring spokes, so any adjustment you make to a
control point on one spoke only affects the colors that fall between it and the two
neighboring spokes that surround it. This means it’s not necessary to lock control
points on neighboring spokes of this wheel-shaped grid to prevent them
from changing.

Adjustments made to control
points on one “spoke” of the
Hue-Saturation wheel grid don’t
affect those on neighboring
spokes, which act as if they’re
locked, even though they’re not

Both the Hue-Saturation and Chroma-Luma warper grids lock the outer boundary of the grid.
You can still drag these points to adjust them, but they can’t be unlocked and they won’t move
automatically when you adjust other control points. The Hue-Saturation grid has an additional
point locked right in the center, which keeps the neutral colors (black through gray and
white) neutral.

TIP: Dragging the locked center point of the Hue-Saturation grid lets you alter the
color of the white point, while proportionally warping all other colors in the image to
smoothly accommodate this change. This can be the starting point of a lot of
different looks.
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Previewing Which Colors Are Warped By Each Control Point
If you press and hold the Option key while you click on a control point in the warp grid, you get
a preview in the Viewer of which colors that control point will affect. Affected pixels appear in
color against black, which represents all pixels that will remain unaffected by that control point.

Holding the Option key down while clicking a Color Warper control
point shows a preview of affected pixels against black

Sampling to Warp Colors
While it’s important to learn how control points in the grid are manipulated, the most intuitive
way of working with this control is to use the pointer to click within the Viewer to sample a color
you want to adjust, hold the pointer button down, and then drag to adjust the color.
When moving the pointer in the Viewer, you’ll see a crosshairs moving around the warping grid
that shows you the exact color on the vectorscope graph, while a yellow box indicates the
control point that’s closest to the color you’re sampling that will be selected if you click. In the
following example, positioning the eyedropper over the sky shows that clicking will select a
control point close to the center of the grid.

Moving the pointer in the Viewer shows a preview in the warping
grid of which control point you’ll select were you to click

Clicking and dragging selects and then moves the control point corresponding to that color in
the Viewer. As you drag the pointer, you’ll see the selected control point move in the same
direction as the mouse while the colors of the image update in real time to show the adjustment
you’re making. Meanwhile, an arrow in the grid shows you the delta of the current adjustment.
Moving a selected control point to another hue in the grid warps the original color to the
new color.
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Clicking and dragging moves the control point corresponding to that color in
the grid to adjust the color and locks it into place

You can also lock control points by sampling the image. Hold the Command and Shift keys
down, and then click on the color or colors you want to lock in the warp grid to prevent them
from being changed. This makes it easy to work directly in the Viewer to lock colors you don’t
want to change, before adjusting other colors that you do want to change.
In the following example, Command-Shift-clicking on the woman’s shoulder locks the yellowish
highlights falling on her uniform in place. Then, clicking and dragging a highlight on her face lets
us push the highlights towards teal without losing the warmer highlights on her shoulder, all by
sampling directly in the Viewer.

(Top) Command-Shift-clicking to lock the closest control point to a color on the
warping grid you don’t want to change, (Bottom) Warping a neighboring color while
the control point you just locked keeps that part of the image from changing

Resetting Grid Points
If, at any point, you adjust a point that you want to reset, simply right-click on that point to
de-lock and reset it.

Grid Resolution Affects The Specificity and Quality of Adjustments
You can change the resolution of the grids in either Hue-Saturation or Chroma-Luma modes,
using the controls at the bottom of the Color Warper palette, underneath the grid itself.

Chapter – 8

Color Page Improvements

149

Separate drop-down menus let you choose the resolution of control points for Hue and
Saturation, or for Chroma and Luma separately, although by default they’re linked together.

The two resolution controls found underneath the grid controls

By default, the Hue-Saturation grid has a resolution of 6x6, which is the lowest resolution
available. The Chroma-Luma grid defaults to 6x6, but can be set lower, to 4x4. Low resolution
warping grids make it easy to create broad color adjustments affecting large ranges of
analogous color with smooth results. Additionally, lower quality media that’s 8-bit, with 4:2:0
chroma subsampling, and/or highly compressed benefits from lower resolution warping grids to
avoid artifacts and keep color adjustments smooth.

(Left) The Hue-Saturation grid set to a resolution of 6x6,
(Right) The Hue-Saturation grid set to a resolution of 24x16

On the other hand, higher resolution grids let you make more specific adjustments to tighter
ranges of color. However, this approach is more useful in projects using high quality media
(10- or 12-bit, 4:2:2 or 4:4:4 chroma subsampling, and minimally compressed) to avoid unwanted
artifacts. If you’re using high-quality media, you’ll find you can use the Color Warper to make
incredibly specific adjustments.

The Chroma-Luma grid set to a resolution of 6x6
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The Chroma-Luma grid set to a resolution of 24x24

NOTE: If you make adjustments with the grid at one resolution, it’s possible to change
the grid to a higher or lower resolution and your adjustment will be interpolated to fit
the new grid resolution, although the resulting adjustment may change a bit.

You Can Warp Color in Different Color Spaces
A drop-down menu at the bottom right of the warping grid lets you choose which color space to
use for manipulating the colors of the image. Different color spaces project the colors of the
image into the two-dimensional warping grid in different ways, and some may make it easier to
manipulate a particular image in the way you want by spreading out different ranges of color
more widely.

The color space found underneath the grid controls

The available color spaces are:
– HSV
– HSL
– HSY
– HSP

Hue —
 Saturation Controls
As the name implies, the Hue-Saturation mode lets you alter hue and saturation simultaneously.
For most people, this is likely the most intuitive mode in which to work as the range of hues and
saturation in the image is represented radially, just like the Vectorscope; in fact a Vectorscope
graph of the image appears underneath the “wheel” grid of control points used to
manipulate color.
By default, dragging any point of this grid changes the colors immediately surrounding that
point that are between the point being manipulated and adjacent “spokes” of the radial grid that
either aren’t influenced by that point, or are locked into place. In fact, you can pull these radial
control points well past the boundary of adjacent spokes of the grid to warp those colors to
entirely different hues.
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The selected control point
being adjusted doesn’t
affect points on adjacent
columns of control points that
stretch from the outer ring
to the center of this control,
even when the dragged point is
moved all the way past

When manipulating control points to alter color, adjustments are similar to pushing color around
a color wheel. Moving a control point radially around the circumference of the grid changes the
hue of the colors corresponding to that control point. Moving a control point closer to the center
desaturates those colors, while moving a control point closer to the edge of the grid increases
the saturation of those colors.
The following sections describe how the different tools available in this mode work to let you
manipulate these radial control points in different ways.

Tools
Each of the available tools let you manipulate control points on the warping grid in different
ways when you click on them.
 Selection Tool: The default tool mode. Selecting this tool lets you select control points
either individually (by clicking on a single point or command-clicking multiple points) or
collectively by dragging a bounding box over multiple points, and you can right-click
on control points to de-select, unlock, and reset them. You can also Shift-click with this
tool to lock points into place without moving them. This is the most useful tool to use
when manipulating the image by clicking and dragging in the Viewer to sample a color
and adjust it at the same time.
 Draw Selection: Selecting this tool lets you make a selection of control points by
clicking and dragging to draw over all the points you want to select. This is good for
making large but specific selections of points.
 Pin/De-Pin: Selecting this tool lets you pin multiple control points by either clicking on
them or by clicking and dragging to draw over all the points you want to pin/de-pin.
 Pull Points: Selecting this tool lets you make adjustments by clicking anywhere on the
warp grid, even between points, to pull all neighboring control points towards where
you clicked. This can be used to reduce color contrast within a specific range of colors.
 Push Points: Selecting this tool lets you make adjustments by clicking anywhere on
the warp grid, even between points, to push all neighboring control points within a
particular proximity away from where you clicked. This can be used to increase color
contrast within a specific range of colors.

Modifiers
Each of the modifier buttons let you manipulate selections and selected control points on the
warping grid in different ways immediately upon clicking each button.
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 Increase Falloff/Smooth Selection: If you’ve selected one or more control points,
clicking this button expands the selection to include all adjacent control points
surrounding the selection.
 Decrease Falloff/Smooth Selection: If you’ve selected a group of control points,
clicking this button shrinks the selection by deselecting the outermost ring of selected
control points, leaving the inner control points selected.
 Invert Selection: Clicking this button selects all unselected control points, and deselects all selected control points. This is useful when you want to make separate color
adjustments to both specifically selected halves of the warping grid.
 Convert Selection to Pin: Clicking this button pins all currently selected control points.
 Select/Pin Column: If you have one or more control points selected, clicking this button
expands the selection to include all points on every column that have at least one
selected point.
 Select/Pin Ring: If you have one or more control points selected, clicking this button
expands the selection to include all points on every ring around the center that have at
least one selected point.
 Select/Pin All, Deselect/Pin All: Clicking this button toggles the selected state of the
entire warping grid on or off.
 Reset Selection/Pins: If you have one or more control points selected, clicking this
button resets their position to the original default position in the warping grid, without
de-selecting them.

Range
The Range control is a fast method of selecting multiple control points corresponding to a
specific range of colors.
 Range: A gradient shows the range of hues currently being presented in the warping
grid. Dragging the left and right handles of the Range control selection box lets you
automatically select all control points corresponding to the hues that appear within
the selection box. This is a fast way of selecting all points within a range of colors for
uniform manipulation.

Auto Lock Controls
The Auto Lock controls enables DaVinci Resolve to automatically lock a border of control points
surrounding any control point you select and adjust, which makes highly-specific color
adjustments easier to accomplish.
 Auto Lock: Enables and disables this behavior.
 X Points Border: Lets you set how many points away from the control point you’re
adjusting the border of locked control points that restricts your adjustments is. How
large an area this ends up being depends on how many points you choose, and on
the resolution of the warping grid. At higher grid resolutions, the same points distance
isolates a smaller region of color.

Smoothing Controls
The smoothing controls let you “ease off” an adjustment you’ve made by progressively moving
one or more selected control points towards their original default position in the warping grid.
 Smooth Chroma: Each click of this button rotates the angle of selected control points
around the circumference of the circular warping grid towards their original position,
bringing the hue of the adjusted colors closer and closer to the original hues of the
image. Saturation is unaffected.
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 Reset Chroma: Resets the angle of all selected control points to the original hues of
those control points. Saturation adjustments are unaffected.
 Smooth Saturation: Each click of this button moves the position of a control point
closer to its original position relative the center of the circular warping grid, thus
bringing the saturation at that point closer to the original image saturation of the node’s
input. Hue is unaffected.
 Reset Saturation: Resets the distance from the center of all selected control points to
the original image saturation at those control points.
 Reset Luma: Resets Luma to the original image values.

Chroma — Luma Controls
The Chroma-Luma mode lets you alter the hue and lightness of colors in the image
simultaneously. This may not feel like a particularly intuitive way of working, as the grid controls
are overlaid on colors projected as different sides of an RGB cube. However, this enables some
powerful adjustments once you get the hang of how multiple adjustments interact in this mode,
as well as the power of locking control points to limit your adjustments to specific areas of the
two grids.
Whether you’re sampling the image or manipulating the control points of this grid directly,
dragging any point of this grid changes the color of the image corresponding to that point.
Vertical adjustments change lightness, where up makes that part of the image lighter, and down
makes that part of the image darker. Horizontal adjustments change hue, depending on which
range of hues are shown in the two Chroma-Luma warping controls, and which of these you’re
adjusting.
By default, only the outer four corners of this control are locked, so any adjustment you make to
any control point pushes and pulls all the other colors throughout the image, depending on
your adjustment. Working this way, multiple adjustments to multiple colors gradually pins
different colors into place, with each adjustment warping the colors falling in between to
maintain a smooth transformation from one adjustment to the next. This can be a good way to
make an overall stylistic adjustment to the image.

(Top) The original image, (Bottom) The result of making multiple
interacting color adjustments across the entire Chroma Luma grid
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Another approach to using this mode is to make more targeted corrections by manually locking
different colors in the image that you don’t want to adjust. You can do this by using the
Selection tool and Shift-clicking any value in the Viewer, or by Shift-clicking any control point on
the grid control. By locking colors you don’t want to change, you can focus on manipulating a
more specific range of colors without altering the entire image.
Alternately, this is where the Auto Lock controls really shine. When you turn these on, you can
choose the type of region you want to affect (vertical column, horizontal row, or a square
region), then choose how large a region of color you want to manipulate (one or two points
away from the point that’s selected). Keep in mind that the current resolution of the warping grid
also has an effect on how large the resulting region of color will be. Lower resolution grids will
let you manipulate larger regions of color, while higher resolution grids will let you adjust a more
narrow range of color.

The Auto Lock controls let you make highly targeted
adjustments to specific sections of the warping grid

Once these controls are enabled, simply clicking once on the image or warping grid selects a
control point and automatically locks off the region of the grid you want to focus your
adjustment on. In the following example, a medium-resolution grid is used in conjunction with
the Auto Lock controls set to lock a 2 point rectangular region. So, clicking on the skin of the
woman’s face and dragging adjusts a section of available reds within the locked-off region of
the grid.

Making a targeted color adjustment to a locked-off region of the Chroma Luma grid

The following sections describe how the different tools available in this mode work to let you
manipulate these radial control points in different ways.

Axis Angle
When you’re in Chroma-Luma mode, an additional control appears underneath the warping
grids, a slider named Axis Angle. Dragging this slider to the left or right changes the range of
hues in each of the two warping grids that’s presented. Letting you manipulate different
ranges of color.

Tools
Each of the available tools let you manipulate control points on the warping grid in different
ways when you click on them.
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The Tools buttons

 Grid 1/Grid 2 tabs: Since the Chroma-Luma controls expose two grids representing
two different ranges of Hue and Luma, these two tabs let you choose which grid will be
manipulated when you sample the image in the Viewer, as well as which grid the Tools
controls affect.
 Selection Tool: The default tool mode. Selecting this tool lets you select control points
either individually (by clicking on a single point or command-clicking multiple points) or
collectively by dragging a bounding box over multiple points. You can also Shift-click
with this tool to lock points into place without moving them, and you can right-click on
control points to de-select, unlock, and reset them. This is the most useful tool to use
when manipulating the image by clicking and dragging in the Viewer to sample a color
and adjust it at the same time.
 Draw Selection: Selecting this tool lets you make a selection of control points by
clicking and dragging to draw over all the points you want to select. This is good for
making large but specific selections of points.
 Pin/De-Pin: Selecting this tool lets you pin multiple control points by either clicking on
them or by clicking and dragging to draw over all the points you want to pin/de-pin.
 Pull Points: Selecting this tool lets you make adjustments by clicking anywhere on the
warp grid, even between points, to pull all neighboring control points towards where
you clicked. This can be used to reduce color contrast within a specific range of colors.
 Push Points: Selecting this tool lets you make adjustments by clicking anywhere on
the warp grid, even between points, to push all neighboring control points within a
particular proximity away from where you clicked. This can be used to increase color
contrast within a specific range of colors.

Modifiers
Each of the modifier buttons let you manipulate selections and selected control points on the
warping grid in different ways immediately upon clicking each button.

The Modifiers buttons

 Increase Falloff/Smooth Selection: If you’ve selected one or more control points,
clicking this button expands the selection to include all adjacent control points
surrounding the selection.
 Decrease Falloff/Smooth Selection: If you’ve selected a group of control points,
clicking this button shrinks the selection by deselecting the outermost ring of selected
control points, leaving the inner control points selected.
 Invert Selection: Clicking this button selects all unselected control points, and deselects all selected control points. This is useful when you want to make separate color
adjustments to both specifically selected halves of the warping grid.
 Convert Selection to Pin: Clicking this button pins all currently selected control points.
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 Select/Pin Column: If you have one or more control points selected, clicking this button
expands the selection to include all points on every column that have at least one
selected point.
 Select/Pin Row: If you have one or more control points selected, clicking this button
expands the selection to include all points on every row that have at least one
selected point.
 Select/Pin All, Deselect/Pin All: Clicking this button toggles the selected state of the
entire warping grid on or off.
 Reset Selection/Pins: If you have one or more control points selected, clicking this
button resets their position to the original default position in the warping grid, without
de-selecting them.

Range
The Range control is a fast method of selecting multiple control points corresponding to a
specific range of colors.

The Range control

 Range: A gradient shows the range of hues currently being presented in the warping
grid. Dragging the left and right handles of the Range control selection box, or
dragging within the range control to set both boundaries, lets you automatically select
all control points corresponding to the hues that appear within the selection box. Once
you’ve set a range, you can move the range to the left and right by dragging the center
of the selection. This is a fast way of selecting all control points within a range of colors
for uniform manipulation.

Auto Lock Controls
The Auto Lock controls enables DaVinci Resolve to automatically lock a border of control points
surrounding any control point you select and adjust, which makes highly specific color
adjustments easier to accomplish. These are particularly useful in the Chroma-Luma
warping grid.

The Auto Lock controls

 Auto Lock: Enables and disables this behavior.
 X Points Border: Lets you set how many points away from the control point you’re
adjusting the border of locked control points that restricts your adjustments is.
How large an area this ends up being depends on how many points you choose,
and on the resolution of the warping grid. At higher grid resolutions, the same points
distance isolates a smaller region of color.
 Lock Column: Lets you choose to restrict your adjustment to affect all control points
within a particular column of the rectangular Chroma-Luma graph. The width of this
column is defined by the border width controls. This is useful when you want to
primarily adjust the lightness of a range of colors, while making a small adjustment
to hues.
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 Lock Row: Lets you choose to restrict your adjustment to affect all control points
within a particular row of the rectangular Chroma-Luma graph. The height of this row is
defined by the border width controls above. This is useful when you want to primarily
adjust the hue of a range of colors, while making a small adjustment to lightness.
 Lock Region: Lets you choose to restrict your adjustment to affect all control points
within a rectangular region surrounding the selected point. The is useful when you want
to adjust a targeted region of color that corresponds to a well-defined feature of the
image, such as a specifically colored hat, shirt, foliage, or skin tone. Smaller regions will
make more specific adjustments than larger regions.

Smoothing Controls
If you’ve found that you’ve gone a bit too far with an adjustment and need to back off a little bit,
the Smooth controls let you do so gradually, or start over if necessary.

The Smoothing controls

 Smooth Chroma: Each click of this button moves selected control points left or right,
back towards their original position, bringing the hue of the adjusted colors closer and
closer to the original hues of the image. Luma is unaffected.
 Reset Chroma: Resets the position of all selected control points to the original hues of
those control points. Luma adjustments are unaffected.
 Smooth Luma: Each click of this button moves selected control points up or down,
back towards their original position, bringing the luma of the adjusted colors closer and
closer to the original luma of the image. Chroma is unaffected.
 Reset Luma: Resets the position of all selected control points to the original luma of
those control points. Chroma adjustments are unaffected.

Magic Mask
The Magic Mask palette uses the DaVinci Neural Engine to automagically create a mask to
isolate one or more people in the frame, guided by user-applied paint strokes to identify the
subject for isolation. Masks can be generated for either an entire person, or for specific features
of that person (their face, hair, arms, shoes, etc.). The following images show these two kinds of
masks with Highlight enabled in the Viewer. A red onionskin overlay lets you see what Magic
Mask is isolating.

(Left) Using Magic Mask to isolate an entire person, (Right) Using Magic Mask to isolate someone’s face
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Once the Magic Mask palette has generated a mask, Matte Finesse controls let you adjust the
mask’s size and feathering. This lets you deal with difficult edges that might tip your hand
depending on the kind of adjustment you’re trying to make.
While the masks generated by Magic Mask can often be good enough to use directly for
making high quality isolated adjustments, it won’t always give perfect results. Keep in mind that
Magic Mask is as much for the fast creation of detailed garbage masks as it is for doing
direct isolation.
In these cases, the Matte Finesse controls let you make the resulting mask softer and looser as
necessary to clear the edge of a difficult subject you’re isolating with the help of another mask
generation technique, such as a Qualifier key or window. When you use the Magic Mask palette
within the same node in which you’re also creating a key in the Secondary palette, or a window
in the Window palette, the key or window and Magic Mask are combined to output a boolean
intersection. This means the isolation is limited to areas where both kinds of masks overlap
one another.

(Left) Using Magic Mask to create a mask, (Right) Combining the Magic Mask
with a circular window, the resulting mask is an intersection of the two

If you’re isolating specific features of a person, you can also mix and match what you’re isolating
to create exactly the type of mask you require. For example, you might isolate the face, along
with exposed skin on the torso, arms, and legs, to create a mask for creating an overall skin
tone adjustment that doesn’t include the subject’s hair or clothes.

(Left) Using Magic Mask to isolate a face, (Right) Using Magic Mask to isolate all exposed skin

As described earlier, this whole process is guided by strokes you draw to identify the subject. In
a typical workflow, you’ll draw short positive strokes (colored blue) over the person or feature
you want to isolate. Then, if necessary, you can also paint short subtractive strokes (colored red)
over parts of the image that are not the person or feature you’re isolating, to correct any
problems you see in the generated mask.
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Blue strokes identify a person or feature to
isolate, while red strokes identify things that
shouldn’t be included in the mask

Ideally, both positive and subtractive guidance strokes should be relatively short, and centered
on the part of the person you’re trying to add to the mask. Stroke position is usually more
important than stroke length, and in fact if you don’t like the result you’re getting in the mask
with a particular stroke you’ve drawn, you can drag it to another position without redrawing it;
strokes are live and can be selected using the pointer to move or delete them.

Selecting a stroke with the pointer; selected
strokes become highlighted

Very long paint strokes aren’t usually that useful, and can be counterproductive later on when
you’re trying to track strokes to follow motion in the clip. This is particularly true if a stroke
needs to follow something that’s changing shape as it moves, like an arm. Furthermore, while
you can make as many strokes as you like, fewer strokes work better than many strokes, and as
a general rule you shouldn’t use more than five strokes to isolate a particular person or feature
(nor should you need to).
As you work, each stroke shows up in the Stroke list, which lets you select, enable/disable,
delete, and otherwise manage the different strokes you create to guide automatic mask
generation.

(Left) Multiple strokes in Features mode isolating exposed skin,
(Right) The Stroke list keeps track of all strokes you’ve made
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But what about camera and/or subject motion, you ask? After you’ve painted one or more
strokes to guide the analysis, you can motion track these strokes to follow the subject
throughout that shot using the stroke tracking controls within this palette. If you’ve made
multiple strokes, they’re all tracked at once, and each stroke automatically follows along with
whatever image details immediately surround that stroke, so there’s no setup necessary. You
simply draw one or more strokes, then click the track forward or backward button. When you
track a stroke, the tracking bar for that stroke in the Stroke list shows you which frames have
been tracked (tracked frames are blue).

Controls let you track all mask analysis strokes forward and backward through the shot

Once you’ve added the strokes that are necessary to isolate the subject, and you’ve motion
tracked them to follow along with the motion of the shot, a mask is automatically generated live
for each frame of the shot. This is important to know because any change you make, adding or
removing strokes or moving them manually, will alter the resulting mask on the fly.

What Magic Mask Is Good For, and What It’s Not
Keep in mind that the Magic Mask tool does not specialize in soft translucent mask edges, such
as those created by the HSL, Luma, or 3D Keyers (when they’re used carefully). On the other
hand, it excels at creating form-fitting masks that isolate human features in situations where a
typical keyer does poorly. For example, Magic Mask can isolate exposed skin in shots where
that person is standing in front of a background with wood, stone, or soil that inhabits the same
ranges of color as that person. It can isolate beige clothes against a beige background. It can
even isolate a person within a black and white clip.
Once you’ve drawn one or more strokes to isolate a mask, a variety of controls let you adjust
the resulting mask to better fit the subject, if necessary. Depending on the adjustment you’re
making to the subject at hand, you may find that the keys generated using Magic Mask are
sufficient to convincingly isolate the person you’re grading, particularly if you’re working in
Better mode.
However, real world projects pose plenty of unexpected challenges. Keep in mind that,
depending on what you’re trying to do, the resulting automated mask isn’t always going to be
perfect enough to replace precise rotoscoping for intensive secondary color adjustments.
However, it’s been designed to easily create tight-fitting garbage masks to use in conjunction
with secondary keys or windows, with which to exclude the background around a difficult-toisolate subject.
If you’re using Magic Mask to create a garbage mask, keep in mind that the Faster mode has
been optimized to create looser masks more quickly for situations where you’ll be using it in
conjunction with a keyer or window to isolate a specific area for special grading.
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TIP: The Magic Mask palette can even isolate people in photos and paintings.
However, figurative representations must have a minimal level of shadow rendering
and anatomical detail for a figure or feature to be recognized. For this reason, cartoony
or abstract representations won’t isolate very well.

The Magic Mask Interface
The Magic Mask palette is divided into three sets of controls: the Toolbar, the Stroke list, and
the Mask Finesse panel. When you first open the Magic Mask palette, it’s empty, and you’re told
to draw a stroke in the Viewer to create a mask.

The controls of the Magic Mask palette, in Features mode

Magic Mask Toolbar
A toolbar at the top contains most of the interactive controls of the Magic Mask palette.
 Target Selection: A tab control at the left lets you choose the type of mask you want
created. There are two choices:
– Person: For creating a mask to isolate as much of a person is visible, given the

framing of the shot.
– Features: For creating a mask isolating just someone’s face, or hair, or arms, for

example. In Features mode, you can also combine multiple specific features into a
single mask.
 Tracking Controls: The following controls let you track all available strokes to follow
camera or subject motion in the frame. From left to right, these include:
– Jump to Start of Track: Moves the playhead to the first tracked frame of a range of

tracked frames, in preparation for tracking backwards if there are untracked frames
at the beginning of the clip.
– Track One Frame Backwards: Tracks one frame backwards and stops. Useful if

you’re tracking frame by frame to watch the progress of a particularly complicated
bit of motion. If something goes wrong, you can back up to the last frame where the
stroke was able to properly track the subject, and drag the stroke to a better location
using the pointer to make it follow the subject properly. If necessary, you can go a
frame at a time, dragging the stroke to a better position every time it fails to follow
the feature you’re using it to isolate.
– Track All Frames Backwards: Continuously tracks from the current frame all the way

to the beginning of the clip.
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– Stop Tracking: Stops tracking, in cases where there’s a problem with the track and

you want to make a change.
– Track All Frames Forwards: Continuously tracks from the current frame all the way

to the end of the clip.
– Track One Frame Forwards: Tracks one frame forward and stops. Useful if you’re

tracking frame by frame to watch the progress of a particularly complicated bit of
motion. If necessary, you can go a frame at a time, dragging the stroke to a better
position every time it fails to follow the feature you’re using it to isolate.
– Jump to End of Track: Moves the playhead to the last tracked frame of a range of

tracked frames in preparation for tracking forwards if there are untracked frames at
the end of the clip.
 Stroke tools: Two tools at the right lets you choose whether to draw strokes to identify
the feature you want to isolate, or identify things that aren’t the feature in order to
eliminate unwanted excursions in the resulting mask.
 Invert Mask: A button lets you invert the resulting mask in cases where you want to use
the feature analysis of this palette to isolate everything except the feature or features
being analyzed.
 Mask Overlay: Turns on an onion-skinned overlay with which to see what parts of the
image are being masked alongside which aren’t, so you can continue to refine the
result by adding, moving, or deleting strokes. The isolated part of the mask is tinted
translucent red.

Stroke List
Once you start drawing strokes to identify features for mask generation, they appear in this
Stroke list.
 Stroke list header: The header, at the left of the Stroke list, has controls for selecting,
enabling/disabling, and naming each stroke (if you need that level of organization).
Right-clicking any stroke in its header reveals controls to Reset Tracking Data and
change the mask type (feature or not feature).
– In Person mode, this is just a flat list of strokes, each of which help to either define

the person you want to isolate, or the background.
– In Features mode, an additional drop-down menu lets you choose which specific

feature you want to identify with a guidance stroke. All strokes are sorted
hierarchically by the feature they correspond to, so for example each Face stroke
appears underneath a Face title bar. The title bar for each feature has a toggle
control that lets you turn that feature off and on. When off, you disable that feature’s
contribution to the overall mask being generated.
 Stroke timeline area: A timeline ruler shows the duration of the current clip you’re
creating a mask for. Each stroke in this list has a track that displays how many frames
of each stroke have been tracked. As you track each stroke, these tracks fill up with
colored bars to show which frames have tracking data.
Tracks of strokes that identify a person or features are blue, while tracks for strokes
identifying things that aren’t the feature are red. Using this timeline, you can keep track
of which strokes need to be tracked, and manipulate the tracking data as necessary to
obtain a useful result.
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Mask Adjustment Controls and Matte Finesse
There are two sets of controls for refining the mask that’s output by the Magic Mask palette. The
first set of controls, at top, let you adjust how the mask is generated based on the analysis data,
which lets you refine the mask result based on characteristics of the image. These include:
 Quality: Two options let you choose a tradeoff between quality and performance.
Faster lets you generate a lower quality mask more quickly, that’s suitable for garbage
matting. Better generates a higher quality mask with more detail, that’s more processorintensive.
 Smart Refine: This control lets you expand or contract the resulting mask based on
the analysis of the image, such that expanding the mask doesn’t expand it deeply into
surrounding parts of the image that aren’t connected to that person. This operation
does not introduce softness. Instead, it enlarges or shrinks the overall mask generated
by this palette. 0.5 is unity, 0 is the maximum amount of expansion, while 1 is the
maximum amount of contraction.
A second set of mask manipulation controls are for manipulating the mask after it’s
been generated. Most of these are the same Matte Finesse controls that are available
in the Qualifier palette, which are useful for trying to fix issues with problem masks, or
soften the edges when you need to have a more feathered result. For more information
about the Matte Finesse controls, see Chapter 119, “Secondary Qualifiers,” in the
DaVinci Resolve User Manual. There is one additional control, however, that’s unique to
the Magic Mask palette.
 Consistency: After you’ve tracked each stroke to follow the subject over the duration
of the clip, this setting lets you choose how much temporal smoothing is necessary
to ameliorate jitter in the edges of the resulting mask in areas of low confidence, such
as frizzy hair or translucent clothing. Higher settings apply more smoothing to the
edges of the mask, but are more processor intensive and may affect how closely the
mask follows motion in the image. Lower settings will be faster and more accurate,
but may allow more edge jitter in the resulting mask, which can be distracting in the
final adjustment you’re making. This parameter defaults to 0, so your first application
of Magic Mask will always begin with the most accurate (and potentially most active)
application of this feature’s analysis.

IMPORTANT
Consistency requires a stroke to have a duration of at least a few frames in order to
function correctly. This requires you to track each stroke to follow the motion of the
camera and subject in order to extend the duration of each stroke. Because
Consistency is trying to eliminate one or two frame “noise” in the shape of the mask,
strokes of short duration may end up having their effect eliminated.

Choosing What to Isolate
This section elaborates on the different choices that are available for isolation, and offers tips
for what each choice is good for.

Person Mode
When you choose Person, every stroke you draw over someone helps to isolate that person’s
entire body, or however much of that person is visible onscreen. This includes all clothes that
person is wearing, including their shirt, pants, shorts, dress or skirt, bathing suit, knickers,
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jumpsuits, hat, shoes, even armor or space suit (yes, we’ve tested both), whatever. Most clothing
should be correctly identified as part of the isolation mask you’re creating. However,
excessively flowing garments may need an extra stroke or two to identify them in complex
visual compositions.
Drawing negative strokes, when in Person mode, will identify everything that’s not the person
you’re isolating; this omits both the background and/or other people from the mask being
generated. Drawing negative strokes isn’t mandatory; you only need to draw a negative stroke
if you see a problem such as part of the background being included in the isolation mask.

Features Mode
When you choose features, a drop-down menu appears at the top of the Stroke list. You must
first choose the feature you want to isolate from this menu, and then draw strokes over the
selected feature (face, hair, etc.) you want to isolate. Each feature’s collection of strokes can be
turned on or off to add that feature to the overall mask being created.
 Face: Isolates just the face and ears, including eyes and glasses. This omits hair and
the neck (which is considered part of the Torso). Facial hair, particularly bigger beards,
will usually be omitted from an initial stroke made on exposed skin of the face, so you
can work on just the skin if you want. However, an additional stroke on the beard will
include it in the face isolation.
 Hair: Isolates just the hair, stopping at the bangs and ears, and omitting as much of the
face as possible. Curly, frizzy, or wispy hair will produce oversized masks encompassing
as much of the hair detail as possible. This tool does not create fine transparency. Fine
and irregular hair detail can cause jittery edges, but this can be ameliorated using the
Consistency control.
 Torso (Exposed Skin): Isolates exposed skin above the waist and below the face,
excluding the arms. This is the selection you want to enable if you want to isolate the
neck, neckline, and any part of the chest that’s exposed when wearing v-necks, plunge
necks, tank tops, crop tops, or bikini tops.
 Clothing (Top): Any clothing above the waist. Exposed skin is omitted.
 Clothing (Bottom): Any clothing below the waist. Exposed skin is omitted.
 Arms (Exposed Skin): The exposed parts of arms or hands. Shirt and dress sleeves are
omitted, as are sun sleeves.
 Shoes: Most styles of shoes will be isolated.
 Legs (Exposed Skin): Isolates exposed skin below the torso, excluding socks and
leggings.
 Hat: Most styles of hats will be isolated, although thin accessories such as streaming
ribbons or feathers might not be included.
Remember, no matter what feature you’ve selected to isolate, you can always draw negative
strokes to omit other parts of the person or their clothing that are erroneously being included
in the mask.

IMPORTANT
When you’re drawing strokes in Features mode, accidentally drawing a stroke over a
feature other than the one that’s selected in the drop-down menu at the top of the
Stroke list will result in a completely incorrect mask. If you see this happen, delete the
stroke you just made, double-check which feature is currently selected, and either redo
the stroke or choose the correct feature you want to isolate.
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Identifying More Than One Person
In both Person and Feature mode, you can add strokes to identify more than one person, or
more than one person’s features. There’s nothing special you need to do, simply draw strokes
over each person you want to isolate, or over the same feature of each person you want to
include (for example, drawing stroke over three people’s faces in Face mode).

You can draw strokes over multiple people to
isolate them together in the same mask

Using Matte Finesse Controls
There are plenty of situations where a seemingly problematic mask can be improved using the
Smart Refine and Matte Finesse controls at the right of the Magic Mask palette. If the mask is
only a few pixels off, and the color adjustment you want to make is reasonably subtle, you can
probably use Blur Radius and In/Out Ratio to create a soft edge that falls off just at the outer
edge of the subject (so as not to create a halo effect) with which to make your adjustment.

(Left) The hard edges of the initial mask aren’t quite close enough to the edges of the
woman’s arm to make a a subtle adjustment, (Right) Using the Blur Radius and In/Out Ratio
controls to create soft edges that don’t extend past the subject to make a useful mask

Using Magic Mask as a Garbage Matte
In situations where the outer edge of a person is not being detected closely enough for Magic
Mask to give a useful result for a more extreme color adjustment, you’re probably better off
expanding the result into a closely-fitting garbage matte to use for isolating the person or
features using other techniques, such as a keyer in the Qualifier palette. Even for this purpose,
you’ll find using Magic Mask is typically faster than rotoscoping a relatively close garbage matte
over a moving figure using windows.
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(Left) The initial mask isn’t quite close enough to the edges to make an extreme
adjustment, (Right) Using the Mode/Shape/Radius/Iterations/Blur Radius controls to
expand the matte to be a garbage matte for use with other keys

Dealing With Hair
Wispy or frizzy hair, individual strands of hair being thrown back, and tips of dreadlocks or
heavily moussed hair that comes to points will often require special handling with this tool. Keep
in mind that the Magic Mask tool does not specialize in soft translucent mask edges like a keyer
does. When it comes to hair styles that are loose and free, in many situations you may be able
to finesse an acceptable result using the Matte Finesse controls to expand a softened version
of the matte to encompass the entire hairstyle.
If this interferes too much with the edges of other features of the subject you’re isolating, you
can create a dedicated hair mask in Features mode by drawing Hair strokes. You can then use
the Matte Finesse controls at the right of the palette to create softened edges that work well
with the outer boundary of the hair style you’re isolating.

Creating a soft edged hair mask

At this point, you can try doing different color adjustments using two different correction nodes,
one for the subject’s hair, and another using Magic Mask to isolate everything but the hair.
Alternately, if you want a single matte with which to isolate the entire subject, you can then use
additional instances of the Magic Matte tool (one per node), using one node to isolate just the
face and body without the hair, and a third node to isolate the entire subject but with a very soft
edge. Then, you can use a Key Mixer node to combine all these masks together with the
original hair mask you created, with which to feed a complete key to another node used to
make the correction.
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(Left) Nodes 2, 3, and 4 are creating three different masks that are combined using a key mixer and connected to
the KEY input of node 5 to make an adjustment, (Right) The final result of this three-mask approach

While hair with soft edges can be a challenge, Magic Mask excels at many elaborate hair styles
with detailed shapes and hair accessories, including jewelry and ribbons. For example, the
stylized hairstyles found in European and Chinese period movies and shows give the
DaVinci Neural Engine no trouble at all, particularly as these styles are usually tightly bound
with no wispy hair.
Asymmetrical hairstyles may require extra strokes to identify hair that’s significantly longer on
one side of the face. This may also be true for unorthodox hair styles, such as hair that’s been
sculpted into distinct sculptural shapes. Lastly, tight braids that expose skin on the scalp are
also challenging for the kind of hard masks that Magic Mask produces, so you’re better off
using Magic Mask as a garbage matte and using a keyer to create a detailed soft mask to use in
these instances.

About Hats
Magic Mask works with an incredibly wide variety of hats from all time periods. On hats, tassels
or details like feathers can be a problem (in testing, the feather on Errol Flynn’s cap in Robin
Hood couldn’t consistently be included, even though the cap itself was no problem).
Additionally, veils that are part of hats may or may not be easily identified, but an additional
stroke usually solves the problem.

Dealing With Accessories
Things that people are holding, such as handkerchiefs or umbrellas, can pose problems.
Sometimes, something that’s obvious like the blade of a sword will be omitted, while the hilt
that’s being held in a hand is included with the figure. In these instances, you can choose
whether you want to draw another stroke to include the item in the mask, or try to draw a
negative stroke to omit it. Your results will vary with the size of the item.
Jewelry and watches pose a special problem, as they’re typically so thin and small that
they can be difficult to omit, but you may not want to include them depending on the
adjustment you’re trying to make. Your results will vary with the thickness of the items and the
framing of your subject, but in general your results will probably be better if you simply add a
stroke or two to include these items in the isolation, since omitting fine detail like a necklace
can be problematic.
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Adding Strokes to Guide Mask Creation
Here are some tips for how to draw strokes to analyze the image. To identify people, try starting
with a single short positive stroke (blue), centered on the face or body.

Drawing the first stroke to identify an entire person

Depending on the result, more strokes may be needed to differentiate an arm or frizzy hair from
the background. If you’re adding a stroke to an arm or hair, don’t put it right at the edge; the
goal is not to trace the subject, but to use strokes within the body of the subject to clarify what
features belong to the subject, and which do not.

Adding a stroke to the arm to include it as well

As you do this, resist the urge to use too many strokes. One stroke might well be all you need,
or you might need two or three, but using more than five strokes for any subject or feature may
cause more problems than it solves.

Adding negative strokes to the reflection to remove
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To identify faces, try starting with a single short stroke in the middle of the face, along the nose,
or from eyes to the lips. Depending on the result, you may need additional strokes to identify
the chin, a beard, or to distinguish the forehead from wispy hair.

Drawing strokes to identify a face; notice that additional
strokes are needed to include the beard

It’s a good idea to start with a single stroke, then track the stroke through the duration of the
clip (described later in this section). Over the entire clip, you’ll see which parts of the mask may
exhibit problems. This will guide where you put additional strokes, in order to more clearly
identify the person versus the background, in order to clean up the resulting mask. As you add
additional strokes, track those as well and see how things go.
If you notice parts of the background that are erroneously added to the mask, you can add a
negative stroke (red) to clarify that those parts of the image should not be isolated. Short
strokes, longer strokes, and zig zags are good for backgrounds. Since strokes just help the
analysis update the mask, you can try different types of strokes to see what works best, and
delete any stroke that doesn’t give good results. As with positive strokes, don’t use more
strokes than are absolutely necessary to get the result you want.

(Left) The microphone incorrectly identified as part of the woman being interviewed, (Right) Drawing negative
strokes to identify the microphone as background, using a zig-zag pattern to tag the entire microphone

Similarly, if you’re isolating features such as a face, and you find other features, such as hair,
getting in the way, you can draw a negative stroke on the hair to identify it as not part
of the face.
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If there’s a “hole” in the resulting mask that’s actually part of the background and not the
subject, you can try drawing a stroke connecting that hole to the rest of the background.

Drawing strokes to connect the background with itself, to remove part of the mask that’s not part of the person

If there’s an “island” in the mask that’s actually part of the subject and not the background, you
can try drawing a stroke across the island that connects one solid part of the mask to itself.

Drawing strokes to fill an island in the subject being isolated

Of course, extracting a mask using strokes is only the first part of creating a useful mask. The
Quality, Consistency, and Smart Refine controls let you refine the stroke analysis of the image
to create the best tradeoff between performance and quality for the type of mask you need.
These controls work hand in hand with the strokes you draw to extract a mask. A set of Mask
Finesse controls then let you adjust the resulting mask to manipulate and soften it, to better suit
whatever adjustment you’re trying to make. All of these controls are described earlier in
this section.

Managing Strokes in the Stroke List
When you draw a stroke, it appears in the Stroke list. By default, all strokes last for the duration
of the clip to which they’re applied, so if you draw a stroke to identify a figure that’s not moving,
there’s no requirement to motion track or keyframe the stroke. Strokes in Person mode appear
in one long list, while strokes in Features mode appear hierarchically, with the strokes for each
feature separated by the title of each feature. Once a stroke appears in this list, it has the
following controls.
 Enable/disable feature: In Features mode, once you draw at least one stroke to identify
that feature, the title of that feature appears, underneath which is organized all the
strokes for that feature. A toggle next to the feature name lets you turn that feature’s
contribution to the overall mask on and off.
 Enable/disable stroke: Each individual stroke in this list has a blue dot that lets you turn
that stroke’s contribution to the overall mask on or off.
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 Stroke Timeline Area with Stroke Tracks: The stroke track for each stroke lets you
keep track of and manipulate the animation of strokes to follow camera and subject
motion. Blue or red frames in this track let you see at a glance how much of each stroke
has been motion tracked; blue frames for positive strokes, red frames for negative
strokes. You can also use these tracks to identify frames where you’d like to mute that
stroke’s contribution to the final mask, and to keep track of which frames have been
muted. You can draw a bounding box within the stroke track around however many
frames of however many strokes for which you want to delete motion tracking, delete
keyframes, or mute stroke contributions to the mask.

Stroke Duration
When you first draw a stroke, that stroke has a duration of one frame, located at the timecode
position of the playhead when you drew it. If you move the playhead to the left or right, you’ll
see the stroke disappear. If you want one or more strokes to continue analyzing the subject for
the duration of that shot, you need to use the Motion Tracking controls to track the stroke to
follow along with the motion of whatever it’s drawn on top of. As a stroke is tracked, its duration
increases to cover the entire range of tracked frames. If at any point a stroke outlasts its
usefulness, such as when a person walks off frame, you can stop tracking that stroke when it’s
no longer necessary and it will stop contributing to the analysis.
This is useful, because often you’ll want to place strokes to deal with analysis issues that only
last for a few frames, to fix a hole in the mask that only appears briefly. Just be aware, you can’t
simply draw a stroke and move on to the next shot; you must track at least one stroke to last for
the duration of a subject’s time on screen for that subject to be continuously masked.

Tracking and Keyframing Strokes to Follow Subject Motion
You can think of each stroke you’ve drawn as a persistent eyedropper that samples the image
that overlaps it. The mask that results from all strokes’ collective analysis of the image is
generated live over each frame of the clip. This means that if the camera or the subject moves,
you need to motion track or otherwise adjust the position of each stroke to follow along with
the motion so the subject continues to be correctly identified. You also need to make sure that
each stroke is able to analyze what it’s supposed to, and turn off strokes that can’t for
whatever reason.

TIP: Magic Mask is a processor-intensive operation, so to accommodate users of less
powerful workstations, there is a Use Fast Tracking option available in the Magic Mask
palette’s Option menu, which speeds up the process of tracking at the expense of
potentially less accurate tracking for fast or erratically moving subjects.

Methods of Moving Strokes to Follow Subject Motion
For these reasons and more, there are multiple methods of manipulating strokes to refine the
final analysis.
 Motion Tracking: A set of tracking controls at the top of the Magic Mask palette let you
motion track one or more strokes to follow the camera and subject motion in a clip.
Every frame that’s motion tracked effectively has a motion tracked keyframe placed on
it that moves the stroke to a new position.
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 Manual Keyframing: Any time you drag a stroke from its original position in the
timeline, you create a static keyframe at that frame that instantly moves the stroke from
its previous position to the new position at that frame. Because these are static
keyframes, there’s no motion interpolation from one keyframe to the next in order to
create animation. Instead, keyframing in the Magic Mask palette is a simple frame-byframe operation. Every time you move a stroke at a new frame, you change the stroke’s
position at that frame, without changing stroke position on any other frame that’s been
previously tracked.
If this seems simplistic, keep in mind that the goal is not to create beautiful stroke
animation with this tool. You only need to move each stroke to follow along with
whichever subject or background feature it’s supposed to be sampling in each frame.
The only important thing is that, in every frame, the stroke overlaps a suitable part of
the feature you’re isolating to create the appropriate mask. If the stroke itself jumps
around abruptly, that doesn’t matter so long as the mask that’s generated is good.
This means that even if you’re stuck doing a limited amount of frame-by-frame
animation to make a stroke follow along with a troublesome feature (such as a veil
flapping in the wind), it’ll go pretty fast, because in each frame you’re just dragging the
stroke to overlap the feature wherever it happens to have moved. This repositioning
doesn’t have to be smooth, just accurate.
 Combining Tracking and Manual Keyframing: Since each frame that’s motion tracked
is effectively keyframed, manually dragging a stroke on a frame that’s already been
tracked overrides the tracking data at that frame with a static keyframe that records the
new position of the stroke at that frame. If there’s no more tracking data either before
or after that keyframe, then the stroke disappears until you do more tracking. If there’s
tracking data immediately after a keyframe, then the stroke jumps to the position
dictated by that tracking data.
 Deleting Stroke Tracking at Specific Frames: To accommodate cases where a subject
you’re isolating moves behind something and becomes hidden for a range of frames,
you have the ability to delete stroke tracking for one or more frames. This lets you
eliminate the stroke for however many frames the subject you’re tracking is obscured
and cannot be sampled. This makes it easy to deal with features that come and go over
the duration of a clip, since you can delete stroke tracking over however many ranges
of frames the feature disappears. If you’ve muted frames by mistake, you can either
undo, or re-track the stroke over those frames.
To delete tracking frames, draw a bounding box on the stroke tracks over the range
you want to delete, and then choose Clear Selected Track Data from the Magic Mask
option menu.

Option Menu Commands for Removing Strokes and Tracking
The option menu of the Magic Mask palette presents a number of commands for clearing either
strokes or stroke tracking data.
 Clear All Strokes: Deletes every stroke in the Stoke list, along with tracking.
 Clear All Strokes of Current Frame: Deletes the tracking data at the current position of
the playhead on all strokes in the list.
 Clear All Strokes from In to Out: If you use the I and O keys to set In and Out
points in the Stroke Timeline, this command deletes all tracking data on all strokes
within that range.
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 Clear Selected Stroke from In to Out: If you select a stroke in the Stroke list, and then
use the I and O keys to set In and Out points in the Stroke Timeline, this command
deletes the tracking data of selected strokes within that range.
 Clear Selected Track Data: If you drag a bounding box around tracking data for one or
more strokes, this command deletes all tracking data within the box.

An Example Stroke Tracking Workflow
By combining motion tracking, manual keyframing, and stroke muting, you’ll be able to make
short work of isolating most moving subjects. The following procedure illustrates how you might
use these techniques together to make the strokes you’ve drawn follow along with the features
you’re isolating.
To track one or more strokes to follow a subject:
1 If necessary, move the playhead to the frame where you want to begin isolating the
subject you want to mask. For example, if you’re isolating a person walking into the
room through a door, you probably want to begin your work on a frame where the
person is already in the room, and work your way backwards and forwards from that
frame. If your subject is already fully visible at the first frame of the shot, you can
start there.
2

Draw at least one stroke identifying the subject or feature you want to isolate. You
cannot track a stroke to follow the features unless there’s at least one stroke.

3

Choose whether you want to track all strokes, or only selected strokes. By default, all
existing strokes with at least one frame in the Stroke Timeline at the position of the
playhead will be tracked. However, you can choose to track only selected strokes in
the Stroke list by choosing Track Selected Stroke Only in the Magic Mask palette’s
Option menu.

4

Click the Track Forwards to End or Track Backwards to Beginning buttons if you want to
motion track the strokes over the remaining duration of the clip.
By default, each stroke is tracked to follow whatever image detail immediately
surrounds it; you don’t have to define a tracking region, this is done automatically. As
tracking proceeds, the tracking bar for each stroke will fill up showing you which frames
have been tracked, and which have yet to be tracked. Meanwhile, each stroke being
tracked will transform to follow along with simple position and rotation changes in the
subject. However, things that obscure the subject, as well as more extreme
movements, may cause problems.
Strokes that are tracking a feature that moves off screen are automatically excluded
from tracking at the frame where the feature is completely off screen, even if that
feature returns onscreen in a later frame.

5

(Optional) If a problem occurs during the track, such as the subject being occluded
behind something else in the frame (for example, a person’s face moves behind a tree
as they walk), click the Pause Track button. You can deal with problems in the track in
the following ways:
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a.	If a stroke has completely moved off of the subject: For example, you’re tracking a
stroke to follow a person and they turn around 180 degrees, so the stroke moves off
onto the background. To fix this, pause the track, move the playhead to the first
frame where the stroke hasn’t followed the subject properly, then use the pointer to
drag the stroke onto another part of the subject that’s clearly visible. On each frame
where you drag the stroke to a new position, it will be automatically keyframed.
Continue this process until the subject’s motion is consistent enough to be
trackable again, and you can then resume tracking.
b.	If a stroke has moved onto something that’s partially obscuring the subject:
Pause the track, drag a bounding box over the frames where the track is having a
problem, and choose Delete Selected Tracking from the Magic Mask option menu
to clear the bad tracking data. Then, move the playhead to the first frame of the
deleted tracking data, and use the pointer to drag the stroke onto any part of the
subject that’s visible to either side of the occlusion. Move the playhead to each
successive frame, and drag the stroke onto whichever part of the subject is visible
from behind the occlusion, until the subject moves past the occlusion. At that point,
you can use the Track Forwards to End or Track Backwards to Beginning buttons to
continue tracking as usual.
c.	If the subject becomes completely hidden: Clips where the subject appears and
disappears over the duration of a clip can be resolved by deleting the stroke or
strokes on that subject over all frames where the subject is obscured, so that
strokes only sample the image when the subject is visible and thus able to be
isolated. You can delete one or more strokes by dragging a bounding box over a
range of frames, and then choosing Clear Selected Track Data from the Magic Mask
option menu.
d.	If a stroke is having trouble following the subject: If the subject you’re tracking is
moving too fast, too irregularly, or is changing shape too greatly for the tracker to
give a good result (for example, someone lifts their arm towards the camera), you
can track through the problem area of the clip one frame by frame using the Track
Forward 1 Frame or Track Backward 1 Frame buttons, and then use the pointer to
manually drag the stroke to follow along with the subject as you go. Once the
problem motion stops and the motion of the subject becomes more regular, you can
use the Track Forwards to End or Track Backwards to Beginning buttons to continue
tracking as usual.
e.	If the subject is moving off the frame: If you’ve drawn a stroke in the middle of
someone’s face, and their face is moving off screen, you can manually reposition
the stroke on the last few frames before the subject completely exits so that stroke
continues to identify what parts of the face are still visible even though the part of
the face it was originally following becomes hidden. Once the face completely exits
the frame, you can mute the stroke for the rest of the shot.
6

(Optional) If you only tracked the stroke’s movement over part of a shot, you can click
the Jump to Start or Jump to End buttons to move the playhead to the first or last
tracked frame, in preparation for tracking from that frame onward.
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Sat vs. Lum Curve
The inverse of the Lum vs. Sat curve, Sat vs. Lum lets you quickly adjust the luminance of pixels
that falls within a particular range of saturation. This is useful for cases where regions of the
image you want to make lighter or darker happen to coincide with an identifiably consistent
range of saturation.
To help guide your adjustment, the histogram drawn for this curve lets you see how many pixels
there are at each level of saturation found within the image, with the leftmost part of the curve
representing minimum saturation, and the rightmost part of the curve representing maximum
saturation. Seeing where the levels of saturation lie in the current image help you to quickly
make targeted luminance adjustments when you sample the region of the image you want to
adjust to add points to this curve.

The Sat vs. Lum curve

In the following example, the right side of this curve is lowered so that the most saturated parts
of the image become darkened. You might want to make an adjustment like this to emulate one
of the properties of film, where highly saturated colors block more light from passing through
the emulsion than less saturated colors. Or, you may do this in an effort to desaturate bright
colors in highlights that might otherwise clip past maximum white. Or, you might do this to
quickly darken highly saturated skies.

(Top Left) The original image, (Top Right) The highly saturated blue sky and sea reflections are
darkened to a more intense blue by lowering the right part of the Sat vs. Lum curve (Bottom)
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LUT Improvements
DaVinci 17 includes numerous improvements to the management and use of LUTs.

Support for Custom LUT Paths
A list in the General panel of the DaVinci Resolve System Preferences lets you add multiple file
paths for loading LUTs that you want to use in DaVinci Resolve. This works for network volumes
for facilities where multiple workstations are accessing a central collection of LUTs to be shared
among multiple artists. Clicking the Add button lets you add a file path to this table from a
dialog. Selecting a location in this list and clicking Remove removes that location.

A list in the General panel of the System Preferences lets you add
multiple locations where LUTs you want to use from within DaVinci
Resolve are located

Support for Generating 17 Point 3D LUTs
The Generate LUT submenu that’s available when you right-click a clip thumbnail in the Color
page has a new option, Generate LUT > 17 Point Cube. While 17 point LUTs are not
recommended to use for grading, they are useful when exporting LUTs for on-set monitoring, to
accommodate different display, calibration, and signal conversion devices.

Support for Video Range LUTs
DaVinci Resolve 17 adds support for importing LUTs that include additional metadata specifying
them as processing image data in Video Range, rather than Full Range. More information about
how to format LUTs as Video Range is included in the Developer Documentation available from
the Help menu. Being able to specify whether a LUT is meant to be Video or Full Range allows
LUT processing to automatically accommodate DaVinci Resolve’s data range setting pipeline for
clip attributes, project settings, and output settings.
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Improvements to Existing Tools
DaVinci Resolve 17 features updated video scopes with greater performance and more options.

Updated Look and Feel of Primaries Palette
The Primaries palette, including the Lift/Gamma/Gain controls, Color Bars, and Log Wheels, all
have an updated look and feel that matches the new controls of the HDR palette.

The Updated Color Wheels panel of the Primaries palette

Additionally, the Temperature, Tint, Contrast, Pivot, and Midtone Detail controls have been
moved to a bar at the top of the palette, while the Color Boost, Shadows, Highlights, Saturation,
Hue, and Luminance Mix controls are located at the bottom, for simultaneous display and
control of all of these parameters.

The Updated Color Bars panel of the Primaries palette

Improved Power Curve Window Drawing
Power Curve window drawing has been refined to be smoother and more responsive. While
drawing a curve, an unfinished curve segment no longer automatically connects to the current
pointer position. Also while drawing, you can select previously drawn points to move them, to
adjust their spline handles, or to delete previously added points, without the need to finish the
window first.
Additionally, the Inside and Outside softness splines are visibly thinner than the center spline,
making them easier to differentiate.
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Split Screen Previews of Multiple Playheads
A new split screen mode lets you set up simultaneous comparisons in the Color page Viewer of
up to four playheads displayed in the mini-timeline. This is useful both for comparing multiple
clips, as well as for comparing different frames within the same clip.

Placing three playheads in the mini-timeline

When you choose multiple playheads from the Color > Active Playhead submenu, you have the
option of selecting the Playheads mode when you enable Split Screen in the Color page
Viewer. For every playhead you expose (up to 4), the frame at each playhead will be displayed
in a 2-up, 3-up, or 4-up grid. An outline in the Viewer (if enabled) shows which playhead is
currently active.

Additional Wipe Modes in the Color Viewer
Three additional Wipe modes have been added to choose from when doing a Gallery or
Timeline wipe to compare two frames. These provide substantial additional flexibility for
comparing images in different ways.

The Wipe modes available in the Viewer Options bar of the Color page Viewer

The three new modes are:
 Diagonal: Lets you compare both halves of the wipe via an adjustable diagonal border.
Dragging the pointer repositions the wipe to the left and right. Hold the option key
down and drag while moving the pointer around in a circle to rotate the border of the
wipe to any angle you like.
 Venetian Blind: Lets you compare both images being wiped via alternating horizontal
strips. Drag the pointer up or down to change the size of the alternating strips. Good for
quickly comparing vertical color uniformity, focusing on color and contrast changes that
occur from top to bottom.
 Checkerboard: Lets you compare both images being wiped via an alternating
checkerboard. Drag the mouse left or right to alternate between images by squeezing
each check horizontally. Good for comparing color uniformity across the width and
height of two images.
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Ability to Copy and Paste Entire Grades or Single Nodes
The Edit > Copy and Paste commands can be used in one of two ways, depending on which
part of the Color page UI you select when copying, and which part you select when pasting.
 To copy and paste an entire grade: Select a clip in the Thumbnail Timeline with a
grade you want to copy, and press Command-C. Then choose another clip in the
Thumbnail Timeline you want to past the grade to, and press Command-V to paste the
entire grade.
 To copy and paste a single node: Select a node in the Node Editor you want to
copy, and press Command-C. Then select another node for another clip, and choose
Command-V to paste the settings of the node that you copied to that node.

NOTE: At the time of this writing, copying and pasting grades in All mode only works
for Clip grades, not Pre-Clip or Post-Clip Group grades. To copy a Group grade, you
must save a still first, and then apply the still’s grade to the group.

Paste Value
This, in fact, is not a new feature at all, but it’s one this author had no idea existed prior to this
version as it was added so stealthily, so it’s new to me. The Edit > Paste Value (Shift-Option-V)
lets you paste only the value from a specific parameter of a copied grade into the node of
another clip.
To paste only a specific value:
1 Select a Corrector node with a parameter you want to copy, and press Command-C to
copy it. You’re really copying the entire grade, but that’s okay.
2

Choose any other node in any grade, and open the palette that contains the parameter
you want to paste into.

3

Double-click the number field of the specific parameter you want to paste the copied
value into.

4

Choose Edit > Paste Value (Shift-Option-V) to paste that value.

NOTE: Paste Value only works for parameters within palettes; it does not work for OFX
or Resolve FX in the Inspector.

Smart Filter Options for Marker Metadata
When creating Smart Filters with which to filter the contents of the Thumbnail Timeline, the
MediaPool Properties category now contains settings for choosing Marker Name, Marker Notes,
and Marker Keywords as filtering criteria. Using these criteria, you can filter the Thumbnail
Timeline based on marker contents.
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Show Clip Flags on Video Output
The “Show clip flags on video output” checkbox option in the Color page Viewer’s Option
menu enables drawing one or more small colored flag overlays in the bottom left corner of
video output. This way, you can always see which clips are flagged on your grading hero
display as you work, if that helps you to keep track of whatever you’re using flags to stay on top
of. This is off by default.

Support for Fast Review on the Color Page
The Fast Review playback command (Playback > Fast Review) is now available on the Color
page. Intended to help you watch through long sequence of clips quickly, clicking this button
begins accelerated playback through the Timeline, where the speed of playback is relative to
the length of each clip you’re playing through. Long clips play faster, whereas shorter clips play
closer to real time.

Override Input Color Space of Clips in
Preconform Workflows Using Color Management
When you preconform a flattened master media file using an EDL with the File > Import Timeline
> Pre-conformed EDL command, and your project has Resolve Color Management or ACES
enabled, you can now change the Input Color Space of each clip in the resulting timeline
independently. To do so, open the Color page, right-click the clips you want to customize, and
choose an option from the Input Color Space submenu of the contextual menu.
This is useful in workflows where you’ve received a flattened media file that was output with
clips in different color spaces, for example mixing Rec.709 media with log-encoded clips of
different kinds.

Video Scopes Improvements
DaVinci Resolve 17 features numerous enhancements to the video scopes.

Support for Multiple Instances of the Same Scope
Users can instantiate more than one of each kind of video scope in multi-scope layouts, for
instances where users want to view variations on a particular type of scope with different
settings. For example, you might want to expose three Vectorscopes, setting each to a different
tonal range so you can simultaneously view Vectorscope analyses of Low (shadows), Mid
(midtones), and High (highlights).

Three Vectorscopes set to analyze the shadows, midtones, and highlights independently
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3x3 Layout Available for the Video Scopes Window
To accommodate users who want to use the Scopes window to its fullest capabilities, there’s
now a 3x3 layout that lets you show 9 different scopes and scope variations simultaneously.

Different layout options in the Scope window

Ability to Open Separate Video Scopes
Window in Dual Screen
If you have three computer displays and you choose Workspace > Dual Screen > On to enable
dual screen layouts, you can now open the Scopes window (Workspace > Video Scopes > On)
and place it on your third display, as large as you need.

Customizable Waveform Scales
A Waveform Scale Style submenu in the Video Scopes option menu (the three dots menu) lets
you choose how you want the numeric scale at the left of Waveform and Parade scopes to be
represented. There are options for 10-bit display (the default), 12-bit display, Percentage
(0 to 100), millivolt (mV), and HDR (ST.2084/HLG). Aside from the added flexibility this gives you,
this also means that it’s no longer necessary to go to the Preferences to change the scope to
have an HDR scale shown in nits (cd/m2).

Waveform scale options

Customizable Vectorscope Scales
A Vectorscope Scale Style submenu in the Video Scopes option menu (the three dots menu)
lets you choose how you want the hue reference indicators to be displayed.

Vectorscope scale options
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There are four available graticule options:
 Off: Disables all graticule overlays in the Vectorscope, giving you a clean view of the
Vectorscope graph against black.
 Standard: The default layout. Cross hairs indicate the center of the scope, while boxes
indicate the center target of each primary and secondary hue (red, magenta, blue, cyan,
green, yellow). An outer circle provides a a general frame of reference for the angle that
any part of the graph might fall along.
 Simplified: Shows a crosshairs to indicate the center of the scope, and smaller
crosshairs to indicate each primary and secondary hue. Useful when you want
references without extra complications.
 Hue Vectors: A graticule designed to provide a more useful colorist reference for
creative decisions and image comparison. This isn’t simply decorative. Graticule lines
stretch along the reference angle of each primary and secondary hue from the hue
targets to the center, providing a more immediately useful frame of reference when
comparing different vector scope graphs to one another. These reference lines fade
out within the region of average saturation in most images, so they don’t get in the
way of discerning faint details. The center crosshairs are aligned with the red-cyan and
yellow-blue axes, indicating the naturalistic warm to cool axis that lies between them.
Tic marks indicate both the 75% and 100% levels of image saturation for each hue.
You also have the option of choosing whether or not the primary and secondary hue targets are
shown for 75% image saturation, 100% image saturation, or both, and whether or not you want
to show the text labels for each hue.

Updated Order of Operations
The addition of the HDR palette and Color Warper necessitates an updated diagram of the
order of all image processing operations in DaVinci Resolve, from input through output. A truly
detailed breakdown now requires two charts; the first chart details the overall order of
operations taking place on every page, while the second zooms into the specific order of
operations occurring within each node of the Pre-Clip, Clip, Post-Clip, and Timeline grades that
you create on the Color page.

Overall Image Processing
In the following chart, each image processing operation in DaVinci Resolve is shown in the
order in which it’s processed. Operations are color-coded to indicate the page on which those
controls appear, because in many cases page order does not determine image processing
order. Why? Either to make sure each operation is processed as cleanly as possible, or to give
the user the maximum control over the image. For both of these reasons, image processing
order is carefully considered, and in some cases the best result requires operations on different
pages to alternate with one another.
Most of the time, this order of operations is irrelevant to the user who’s only interested in the
end result. However, if you’re trying to achieve something very specific, or if you’re wondering
why you see a particular result when you use the features of the Cut, Edit, Fusion, and Color
pages together all at once, this chart should help make things clear. Finishing artists in
particular should find this chart illuminating.
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The overall order of image processing operations in DaVinci Resolve, from input through output
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Image Processing Within Grades
For Pre-Clip, Clip, Post-Clip, and Timeline grades on the Color page, most Color page
operations are available within each Corrector node you add to the Node Editor. Within each
node, these operations take place in the following specific order.

The order of image processing operations that takes place within each Corrector node in the Color page

Thanks to the modular operation of the Node Editor, if a pair of image processing operations
you need to use isn’t in the ideal order for what you’re trying to do, you can apply each
operation using two different nodes in order to force those operations into the order you want.
Similarly, when using Layer, Parallel, or Key mixer nodes, the order of operations can be seen
in the visible arrangement of nodes in your node graph.
That said, most colorists tend to spread different operations across multiple nodes whether
they need to or not, for organizational purposes or to “sandbox” certain volatile decisions
that might need to be easily revised later. However, nothing’s keeping you from using multiple
operations within a single node if you prefer a simpler node structure for your grading.
Thanks to the flexibility of the Color page, it’s your choice.
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Chapter 9

DaVinci Resolve
Advanced Panel
Update
In late 2020, an updated key layout was released for the DaVinci Resolve
Advanced Panel. Existing customers can purchase a new set of keys
to replace the previous key caps on their panels. This section provides a
comprehensive description of all new functionality with this flagship
control panel for unleashing the full potential of the Color page for
DaVinci Resolve colorists.
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Using the DaVinci Resolve
Advanced Control Panel (2020 Layout)
In late 2020, an updated and radically re-imagined key layout was introduced for the
DaVinci Resolve Advanced Control Panel. This updated layout accounts for new features and
controls, updates command terminology, eliminates redundancy, and takes fuller advantage of
every key on every panel. The result is to provide maximum functionality, so you can work
faster and more efficiently.
1

2

1. T-bar panel 2. Trackball panel

3

3. Search Dial panel

All three panels have LCD panels that display menus for the soft knobs and buttons

Three Panels Working Together
The Advanced control panel set consists of three modular panels that work together to provide
full functionality. The biggest panel with the trackballs is meant to sit in the center, while the two
smaller panels are interchangeable depending on operator preference. These three panels are:
 Trackball panel: This central panel is where the majority of controls for the colorist are
found. In addition to the trackballs, fixed keys, and fixed rotary knobs on the bottom
portion, there are soft keys and rotary knobs on the top angled portion. The Trackball
panel also includes a slide-out keyboard underneath.
 T-bar panel: Shown at the left, this smaller panel has a greater concentration of fixed
keys and a T-bar Mix/Wipe control that can be used for a variety of different functions
on the bottom portion, and a smaller set of soft keys and rotary knobs on the top
angled portion.
 Search Dial panel: Shown at the right, the bottom portion of this smaller panel also
has a greater concentration of fixed keys, a Jog/Shuttle control with fixed Timeline
Transport buttons underneath, and a fixed button numeric keypad that can be used
for node and shot navigation, timecode entry, and which can also be used for whole,
half, and quarter Printer Points adjustments when the P/Lite mode is activated. The top
angled portion has a smaller set of soft keys and rotary knobs.
The smaller two panels connect to the center panel via an integrated USB hub, and the center
panel connects to your workstation via USB 2.
On all three panels, the fixed keys and specialized mechanical/optical controls are located on
the bottom flat area. The operator-facing top area has all of the dynamically assigned soft keys
and rotary controls, located atop an LCD panel which provides dynamic labeling and visual
references for each soft control, all angled to be visible to the operator without parallax errors.
These soft control displays also provide real-time feedback where you can see the relative
settings of each variable control knob at a glance.
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The Trackball panel includes a slide-out keyboard

Using Fixed Keys and Shift Up/Shift Down Functions
As the name implies, fixed keys offer unchanging functionality for frequently used functions.
They’re arranged in clusters of like-minded functionality in an effort to make it easy to access a
variety of related controls in one place that’s easier to remember. For example, all the
keyframing controls are clustered together at the bottom-right of the Search Dial panel, next to
the fixed transport controls which are clustered together at the bottom-left of the Search Dial
panel (under the Jog/Shuttle wheel).
However, just because they’re fixed doesn’t mean they’re limited. Many if not most of the fixed
keys offer one or two alternate functions, appearing above and below the primary function.

Each fixed key can list as many as three different functions; the main function appears at the center, the SHIFTUP function appears at the top of the key, and the SHIFT-DOWN function appears at the bottom of the key.
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The primary function of each fixed key, which is what happens when you simply press it, is
displayed at the center in slightly larger text. Every key has at minimum one primary function. In
the key shown above, ADD GROUP is the primary function that will be executed when you
press the key once, so selecting a number of clips in the Thumbnail Timeline and then pressing
this key would create a new group containing all selected clips.
For keys that have them, the alternate commands of fixed keys are accessed using SHIFT UP
and SHIFT DOWN keys, a pair of which are located on each of the three panels.

Shift keys shown under the left-most trackball let you access secondary
functions; the T-Bar and Jog/Shuttle panels each have shift keys.

Pressing SHIFT UP gives you access to whichever alternate fixed key commands are displayed
at the top. To help you see which keys have SHIFT UP functionality, pressing SHIFT UP
illuminates all keys having an alternate function with a different color. In the key shown
previously, pressing SHIFT UP will illuminate this key with another color to let you know it’s
ready to use, and then pressing this key executes the JOIN function, adding the currently
selected clip in the Thumbnail Timeline to the current group.
Pressing SHIFT DOWN works similarly, to illuminate and give access to alternate fixed key
commands displayed at the bottom of buttons that have them. In the key shown previously,
pressing SHIFT DOWN and then this key would execute the REMOVE function, removing the
currently selected clip in the Thumbnail timeline from whichever group it belonged to.
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The default lit keys of the Search Dial panel

Pressing SHIFT DOWN highlights all keys with alternate SHIFT DOWN
functions so you can instantly see which keys are selectable
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In many cases, including the previous examples, the multiple functions assigned to a particular
fixed key are related to one another to make them easier to remember. The primary function of
each key is usually the most common function you’d want to perform, while the alternate
functions are related to it.
In other cases, alternate functions aren’t directly related to the primary function, but they’re in
the same general category of activity. This is true of the “Pages and Layout” group of buttons at
the top-left of the T-bar panel, for which the primary function of each button gives access to the
main pages of DaVinci Resolve you might want to switch among (this is particularly useful if
you’re hiding the bottom button bar of the user interface in order to get more screen real estate
while working), while the SHIFT UP and SHIFT DOWN functions let you access specific GUI
panels or page customization options that are related to those pages.

Soft Menus, Including Soft Keys and Soft Rotary Controls
Each of the three panels have soft controls. These controls appear on top of an LCD display that
provides a top-most two-line title/description of each soft menu’s main function, along with two
lines of text above each soft rotary control or soft key that describes that control’s specific
function.
The soft controls on the center trackball panel typically update to show context-specific
controls for whichever mode and palette is currently selected. The buttons and rotary controls
are designed to offer simultaneous control over multiple related functions in each palette. They
also provide a logical way to navigate among multiple sets of controls in palettes that have
many modes or in modes that have more controls than can be represented on the center
panel’s 24 rotary and 12 key controls.

(Top) The Trackball panel’s soft menu controls corresponding to the Primaries palette, (Bottom) the soft menu
controls corresponding to the Motion Effects palette; note how all the controls update to be contextual to the
palette that’s currently in use
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The T-bar and Search Dial panels each have soft controls consisting of four rotary and eight key
controls, plus one additional unlabeled “More” key at the bottom right of the LCD. Ordinarily, the
More key toggles between the default layout for that panel and additional sets of controls that
there isn’t room for.

The unlabeled “More” key found to the bottom left of each of
the side panel soft menu controls lets you choose an alternate
or second set of controls for that panel’s current menu

One of the nicest aspects of the soft controls is that the T-bar and Search Dial panels provide
simultaneous access to the controls of other palettes than the currently selected palette
displayed in the Trackball panel. For example, the T-bar panel’s default soft menu is the Sizing
palette, while the default soft menu for the Search Dial panel is the Curves palette. These
defaults let you make adjustments to image sizing or contrast curves at any time, regardless of
what’s currently displayed on the Trackball panel’s soft controls, giving you access to multiple
palettes worth of controls at once for the ultimate in efficiency.

Changing Which Palettes Appear in the Side Panel Soft Controls
However, there’s another benefit to the soft controls on these side panels; you can choose
which Color page palette’s controls appear on each side panel, directly from the
control surface.
To change a side panel’s soft controls to another palette:
1 Press SHIFT UP on any panel.
2

Press the MORE key on the T-Bar panel or the Search Dial panel.
Once you do so, the fixed keys corresponding to palettes that can be displayed on the
side panels are highlighted on the Trackball and T-bar panels. This shows you which
palettes can be assigned.

3

Press the key corresponding to the palette you want to assign. For example, if you want
to expose the controls of the Qualifier palette, press the QUALIFIER button.

The selected side panel soft menu updates to show the controls of the palette that you
assigned. If there are more controls on that palette than can be displayed at once (which is
likely), press the MORE key to cycle among all of the available controls in that palette.
For example, if you want to assign the Motion palette’s controls to the T-bar panel because
you’re adding a lot of noise reduction to the clips of the program you’re working on, simply
press SHIFT UP, then the T-bar panel’s MORE key, then the MOTION key on the Trackball panel.
Now the Motion palette’s controls appear on the soft menu of the T-bar panel, and you can use
the MORE button to cycle among each page of available controls. If you want to go back the the
default arrangement, the two default assignments are the Sizing palette on the T-bar panel, and
the Curves palette on the Search Dial panel.
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Why Aren’t the Soft Panels Specifically Documented
Because of their dynamically remappable nature, the soft controls will continue to
evolve over subsequent versions of DaVinci Resolve along with the palettes and
functions they control. For this reason, soft control assignments are not presented
in-depth as the fixed keys are. Instead, you’re best off referring to the Color page
documentation in the Color Page section of the DaVinci Resolve User Manual to figure
out what each identically named control is used for. All you need to know for now is that
the soft controls change depending on which palette is selected, the mode of each
palette, and the operation being performed.

The Trackball Panel
The focus of the center panel is four trackballs that work as color balance controls in various
palettes of the DaVinci Resolve Color page. Their functionality depends on which palette is
currently open. Each trackball has a surrounding control ring that has no end stop in either
direction, letting you do continuous rotary adjustment. The rings typically are for adjusting
image lightness and contrast in different ways but are sometimes used for other functions
depending on which Color page palette you have selected.
Additional buttons above and below the trackballs, and fixed-function rotary controls to the left
and right, complete the center control cluster that provide a predictable set of central controls
for making color and contrast adjustments.

The controls surrounding the trackball/ring controls of the center panel
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Using Trackballs
The principal palettes you’ll use the trackballs with are the Color Wheels and Log Wheels
modes of the Primaries palette, and the Global and Zones controls of the HDR palette.
Whichever of these modes and palettes is selected will determine the functionality of the
trackballs and rings.
However, keep in mind that whichever color controls the trackballs are assigned to, the top
most soft controls on the Trackball palette can be switched to work with other palettes, such as
the Motion, Curves, or Qualifier palettes, for example. This means you can adjust the controls of
a second palette while simultaneously making color and contrast adjustments with the
trackballs and ring controls. This is exceptionally useful when making two kinds of adjustments
that interact with one another.

Summarizing the Top Fixed Keys
Each of the four trackball/ring controls has three fixed keys above it. Individually, these keys
provide separate Y and RGB reset controls for each trackball/ring pair. However, the first nine of
these keys also collectively serve as a fast and convenient way of navigating the principal
panels of grading functionality in the Color page.
Additionally, the left-most trackball has a pair of shift keys underneath it for choosing which
button function to trigger, giving you fast access.

Shift keys under the left-most trackball
let you access secondary functions

Trackball and Ring Reset Controls
Each trackball’s reset controls are protected by having to press SHIFT UP to use them. This may
feel like an extra step at first, but now that this top row of keys is also used to quickly switch
among different palettes on the Color page, using SHIFT UP protects you from accidentally
pressing a reset when you meant to switch to another palette. If you’re used to the prior layout,
this will take a bit if getting used to, but it isn’t so bad once you’ve built up the muscle memory.
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Reset controls above each trackball when pressing SHIFT UP:
 RGB: Resets red, green, and blue channel adjustments while leaving master level
(luminance or Y) adjustments alone.
 All: Resets both RGB channel and master level adjustments.
 Level: Resets master level adjustments while maintaining the differential between the
RGB channels (aka color balance).

Navigation controls above each trackball (primary and SHIFT DOWN functions)
One of the biggest departures from the previous layout is the introduction of palette switching
functions on the top row of fixed keys. This makes it faster to switch among different sets of
controls as you work, and frees up additional buttons on the T-bar panel to do other things,
adding to the utility of the DaVinci Resolve Advanced panel.

The first nine fixed keys above the trackballs work together to provide palette and mode switching.

Key

Shift Up

Primary Function

Shift Down

RAW/USER

(RGB) Resets red,
green, and blue channel
adjustments only
leaving master level
adjustments alone

(RAW) Opens the
Camera Raw palette

(USER) Not yet
implemented at the time
of this writing

LOG/S3D

(ALL) Resets all
YRGB adjustments

(LOG) Opens the
Log mode of the
Primaries palette

(S3D) Opens the Stereo
3D Palette for Stereo
3D timelines

PRIMARY/>SDR

(LEVEL) Resets master
level adjustments,
leaving the differential
between red, green, and
blue channels unchanged

(PRIMARY) Opens the
Color Wheels mode (Lift,
Gamma, and Gain) of the
Primaries palette

(>SDR) Opens the
Dolby Vision™ palette
if it’s enabled in the
Project Settings
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Key

Shift Up

Primary Function

Shift Down

HDR/MIXER

(RGB) Resets red,
green, and blue channel
adjustments, only
leaving master level
adjustment alone

(HDR) Opens the
High Dynamic Range
(HDR) palette

(MIXER) Opens the
RGB Mixer palette

MOTION/
OPEN FX

(ALL) Resets all
YRGB adjustments

(MOTION) Opens the
Motion Effects palette

(OPEN FX) Opens the
Magic Mask palette

CURVES/WARPER

(LEVEL) Resets master
level adjustments,
leaving the differential
between red, green, and
blue channels unchanged

(CURVES) Opens the
Curves palette to the
last used curve (all other
curves can be accessed
via soft menu buttons)

(WARPER) Opens the
Color Warper palette

QUALIFIER/BLUR

(RGB) Resets red,
green, and blue channel
adjustments, only leaving
luminance channel
adjustment alone

(QUALIFIER) Opens
the Qualifier palette to
the last used Qualifier
(you can choose which
qualifier to use via soft
menu buttons)

(BLUR) Opens the
Blur palette

WINDOW/
TRACKER

(ALL) Resets all YRGB
adjustments

(WINDOW) Opens the
Window palette

(TRACKER) Opens the
Tracker palette to the
last used mode

SIZING/KEY

(LEVEL) Resets master
level adjustments,
leaving the differential
between red, green, and
blue channels unchanged

(SIZING) Opens the Input
Sizing mode of the Sizing
palette (Edit and Output
Sizing can be accessed
via soft menu buttons)

(KEY) Opens the
Key palette

The Tools Button
A TOOLS button at the bottom center of the left-most trackball provides fast access to a soft
menu that provides addition options using the soft controls. This is a future-proofing feature and
exposes no additional functionality at the time of this writing.

The TOOLS button under the left-most trackball
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The Fourth Trackball
Depending on which palette you’re using in the Color page, the rightmost (fourth) trackball can
be used for color adjustment in conjunction with the first three when acting as an Offset control
in the Color Wheels and Log Wheel mode of the Primaries palette, or it can be toggled between
Global controls or being the fourth Zone color control in the HDR palette.

The fourth trackball gives access to additional
functionality via the fixed keys above and below it.

However, the fourth trackball can also be set to perform many other functions using the three
keys above and three keys below it. By choosing the appropriate palette and mode, it can be
used as an eyedropper when sampling colors for qualification, it can be used to create, select,
and adjust the control points of adjustment curves, or it can be used to adjust the position and
rotation of Power Windows. All of these functions are described in the following table.
Key

Shift Up

Primary Function

Shift Down

RGB/ADJ WIN/SDI ZM”

(RGB) Resets red,
green, and blue channel
adjustments, only
leaving master level
adjustments alone

(ADJ WIN) Lets the
trackball adjust the
position of the selected
window, while the
ring adjusts window
angle. This key remains
illuminated as long as
this mode is enabled

(SDI ZM) Toggles
“Gang viewer zoom
with video output”
on and off, letting the
SDI output mirror pan
and zoom being done
in the Viewer
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Key

Shift Up

Primary Function

Shift Down

ALL/OVERLAY/VIEWER

(ALL) Resets all
YRGB adjustments

(OVERLAY) Toggles
onscreen control
overlays, such as
window outlines on
and off for the Viewer
and for video output.
This key remains
illuminated as long as
this mode is enabled

(VIEWER) Sets onscreen
control overlays, such as
window outlines to be
GUI only, so they only
appear in the Viewer
and not on video output

LEVEL/CURSOR/
CURVE

(LEVEL) Resets master
level adjustments,
leaving the differential
between red,
green, and blue
channels unchanged

(CURSOR) Toggles the
eyedropper on and off
for supporting palettes.
In the Qualifier palette,
the cursor lets you
sample the image to
create a key by pressing
the SELECT button. In
the Curves palette, you
can sample the image
to add a control point
to the currently visible
curve. This key remains
illuminated as long as
this mode is enabled.

(CURVE) Opens the
Custom Curve and
selects a control point
to be freely adjusted
(up, down, left and
right) using the fourth
trackball as you would
the pointer in the GUI.
Turning the ring to the
left selects the next
control point to the left,
turning it to the right
selects the next control
point to the right.

SELECT/ALL

–

(SELECT) Used in
conjunction with the
CURSOR mode of
the fourth trackball
to sample a value for
keying or for adding a
control point to a curve

(ALL) Selects all clips in
the Thumbnail Timeline

GLOBAL OFFSET

–

(GLOBAL OFFSET) In
the Primaries palette,
this sets the fourth
trackball to adjust
Offset color balance
and Master levels. In
the HDR palette, this
sets the fourth trackball
to adjust the Globals
controls. This key
remains illuminated
as long as this
mode is enabled.

–

AFTER/ENABLE/
BYPASS

(AFTER) Disables/
re-enables all nodes
after the currently
selected node

(ENABLE) Toggles the
currently selected node
(or nodes) off and on

(BYPASS) Toggles
Bypass Grade on
and off
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Hard-Coded Rotary Knobs
There are an additional six rotary knob controls to either side of the trackballs, arranged three
to the left and three to the right.

Six Rotary
Knob Controls

Two sets of three rotary controls to the left and right of the trackballs provide additional functionality

On the left side, from top to bottom, the rotaries control Y-only luminance Gain, Gamma, and Lift
settings of the the Color Wheels and Color Bars modes of the Primaries palette that control Lift,
Gamma, and Gain. If you have any other palettes or modes open, using these three knobs will
continue to affect the Lift, Gamma, and Gain controls of the currently selected node.
On the right side, from top to bottom, the rotaries control Saturation, Hue, and Luminance Mix.
If you have any other palettes or modes open, using these two knobs will continue to affect the
Saturation and Luminance Mix controls of the the Color Wheels and Color Bars modes of the
Primaries palette. The Hue knob will affect the Hue of either the Primaries Palette mode or HDR
palette, whichever was selected last.

Keyboard
The center panel also offers a slide-out keyboard for naming files, stills, and nodes, triggering
keyboard shortcuts, and writing novels about the innocence of newly hired colorists lost in the
maelstrom of the film, television, and streaming industries.

The T-bar Panel
The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with
four variable controls and nine soft keys. The lower section of the panel houses the T-bar
control and six groups of hard keys. Each group and their keys are described below.

Pages and Layout Group
The Pages and Layout control group at left provides navigation to a number of the GUI pages
and a few commonly used methods of opening and closing different panels to customize the
Color page UI.
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Pages and Layout Keys

The Pages and Layout keys make it easy to open different pages and panels of the graphical interface.

Key

Shift Up

Primary Function

Shift Down

SETTINGS/PROJECT/NOTES

(SETTINGS) Opens
and closes the
Project Settings

(PROJECT) Opens
and closes the
Project Manager

(NOTES) Opens and
closes the Project
Notes window

STORAGE/MEDIA/METADATA

(STORAGE) Opens
and closes the Disk
Storage panel of the
Media page

(MEDIA) Opens
the Media page

(METADATA) Opens
and closes the
Metadata Editor on
any page it appears

INSP/CUT/MEDIA

(INSP) Opens and
closes the Inspector
on any page it
appears

(CUT) Opens the
Cut page

(MEDIA) Opens and
closes the Media
Pool on any page it
appears

INDEX/EDIT/LIBRARY

(INDEX) Opens and
closes the Edit Index

(EDIT) Opens
the Edit page

(LIBRARY) Opens
and closes the Sound
Library on any page it
appears
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Key

Shift Up

Primary Function

Shift Down

K/FM/FX/SPLINE

(K/FM) Opens and
closes the Keyframe
Editor on any page it
appears

(FX) Opens
and closes the
Effects Library.

(SPLINE) Opens and
closes the Spline
Editor on any page it
appears

DUAL VIEW/FUSION/NODES

(DUAL VIEW) Toggles
between dual
viewers mode and
single viewer mode

(FUSION) Opens
the Fusion page

(NODES) Opens and
closes the Node
Editor

GALLERY/COLOR/LUTS

(GALLERY) Opens
and closes the
Gallery

(COLOR) Opens
the Color page

(LUTS) Opens
and closes the
LUT Browser

MIXER/FAIRLIGHT/METERS

(MIXER) Opens and
closes the Mixer
panel on any page it
appears

(FAIRLIGHT) Opens
the Fairlight page

(METERS) Opens
and closes the Audio
Meters panel on any
page it appears

BURN/DELIVER/REMOTE

(BURN) Opens and
closes the floating
Data Burn In window

(DELIVER) Opens
the Deliver page

(REMOTE) Turns on
Remote Rendering
for the current
workstation

OFX/SCOPES/INFO

(OFX) Opens and
closes the OFX
Library/Settings
panel on the Color
page; when an
effect is applied to
the current node,
toggles between the
Library (list of OFX)
and Settings (for the
currently applied
OFX)

(SCOPES) Opens
and closes the
Video Scopes
window

(INFO) Opens the
Clip Info palette

Layout and Modes Group
The Layout and Modes control group at right provides access to additional ways of customizing
the UI and toggling different modes of functionality while you work.
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Layout and Modes Keys

The Layout and Modes keys give quick
access to specialized Color page functions

Key

Shift Up

Primary Function

Shift Down

CLIPS/CLIP FILTER/–

(CLIPS) Turns the
Thumbnail Timeline
on and off in the
Color page

(CLIP FILTER) Toggles
the Thumbnail
Timeline’s clip
filtering between
All Clips and
whichever filter is
currently selected;
for example, if you
choose “Selected
Clips,” this toggles
between All Clips and
Selected Clips

–

PROXY/CACHE/OPTIMIZE

(PROXY) Toggles
“Use proxy media if
available” off and on

(CACHE) Toggles the
effects cache among
Smart Cache, User
Cache, and Off

(OPTIMIZE) Toggles
“Use optimized
media if available”
off and on

ACTUAL/DISPLAY MODE/FIT

(ACTUAL) Sets the
size of the image in
the Viewer to 100%
so you can see
the actual size of
the image

(DISPLAY MODE)
Toggle Display
Mode switches
between hiding and
showing the Viewer
to make more room
for the Color page
Node Editor

(FIT) Fits the entire
image into the current
size of the Viewer,
zooming down or up
as necessary
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Key

Shift Up

Primary Function

Shift Down

–/SWITCH TIMELINE/LOCK

–

(SWITCH TIMELINE)
Cycles among all
available timelines in
the current project

(LOCK) Not yet
implemented at the
time of this writing

–/MIX UNMIX/HIDE TRK

–

(MIX UNMIX) Toggles
Unmix on and off;
when Unmix is on,
each clip in the
Color page is shown
without transitions
or compositing
effects, making it
easier for you to see
your grade in effects
heavy programs

(HIDE TRK) Hides all
clips on whichever
timeline track is
currently displayed
from the Thumbnail
Timeline, so they’re
ignored by the
playhead, but
continue to appear
in video out; to show
clips on that track
again, you must
Option-click the
number of the track
in the Mini Timeline
to turn it back on

–/SCOPES MODE/SCALE

–

(SCOPES MODE)
Cycles among all
the available video
scopes when the
scopes are docked in
the palette area

(SCALE) Toggles
the video scopes
between showing
graphs with Video or
Data levels

–/DUAL MON/PICKER

–

(DUAL MON) Turns
the Workspace > Dual
Screen option on
and off

(PICKER) Toggles
the RGB color
picker value option
between 8- and
10-bit (View > Show
RGB Picker Values In
> 8- or 10- bit)

ENHANCED/LIGHTBOX/
SDI OUT

(ENHANCED) Turns
on Enhanced Viewer
mode in the Color
page, with the Viewer
shown atop the
palette controls

(LIGHTBOX) Toggles
the Thumbnail
Timeline Lightbox
mode on and off

(SDI OUT) Toggles
video output of the
thumbnail Lightbox
on and off

FLAGS OP/A/C MODE/SAFE

(FLAGS OP) Toggles
the display of clip
flags on SDI output

(A/C MODE) Toggles
between A-sort and
C-sort mode in the
Thumbnail Timeline;
in C-sort mode,
clips are sorted by
source timecode so
similar clips appear
together, in A-sort
mode clips are sorted
by record timecode
so they appear in
program order.

(SAFE) Toggles title
safe on and off in the
Viewer; options for
title safe appear in
the soft menu of the
trackball panel
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Key

Shift Up

Primary Function

Shift Down

–/HANDLES/CODEC

–

(HANDLES) Turns
“Show current clip
with handles” on
and off; this lets you
see the currently
specified handles
for the current clip in
the Timeline, so you
can track windows
and other effects into
the handles of media
being rendered for
round-trip workflows.

(CODEC) Cycles
among clips in
the Thumbnail
Timeline, showing
the File Name, the
Codec, and the
Version number

Utility Functions Group
This group of keys offers quick access to commonly used commands for saving,
3D functionality, Macros, and copy/paste functions for grading.

Utility Functions Keys

The Utility Functions keys provide access to a variety of frequently
used utilitarian grading, Stereo 3D, and Macro commands.

Key

Shift Up

Primary Function

Shift Down

ESCAPE/SAVE/SAVE AS

(ESCAPE) The
Escape key on a
computer keyboard

(SAVE) Issues the
Save command for
the current project;
this is identical to
pressing Command-S

(SAVE AS) Opens the
Save Current Project
As dialog, so you can
save a duplicate of
the currently open
project; change the
name and click Save
when you’re done.
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Key

Shift Up

Primary Function

Shift Down

TAB/MUTE/DIM

(TAB) The Tab key on
a computer keyboard

(MUTE) Mutes audio
monitoring; often
useful when grading
terrible programs

(DIM) Toggles
between reducing
and boosting the
volume by 10dB;
useful when the client
wants to describe
their next vacation

LINK ZM/LEFT/RIGHT/OTHER

(LINK ZM) For Stereo
3D timeline, toggles
Convergence
between Linked
Zoom and Opposite

(LEFT/RIGHT) For
Stereo 3D timelines,
toggles between
monitoring the Left or
Right eye images

(OTHER) For Stereo
3D timeline, to
“use the other eye”

L>R/GANG/SOLO/R>L

(L>R) For Stereo 3D
timelines, copies
the left-eye grade to
the right eye

(GANG/SOLO)
For Stereo 3D
timelines, toggles
between ganging
left- and right-eye
grades together so
changes to one are
made to both, or
soloing the left- and
right-eye grades to
make independent
adjustments to each

(R>L) For Stereo 3D
timelines, copies the
right-eye grade to the
left eye

LEARN/RECALL MACRO/–

(LEARN) Not yet
implemented at the
time of this writing

(RECALL MACRO)
Not yet implemented
at the time of
this writing

–

START/END MACRO/–

(START) Not yet
implemented at the
time of this writing

(END MACRO) Not
yet implemented
at the time of
this writing

–

COPY

–

(COPY) Copies the
grade of the current
clip in its entirety,
including all parts
of group grades;
you control what
part of the copied
grade is pasted using
different commands.

–

GRADE/PASTE/APPEND

(GRADE) Pastes the
entire copied grade
to overwrite the
previous grade; if
you copied a group
grade, the Pre-Clip,
Clip, and Post-Clip
grades are all pasted.

(PASTE) Pastes
whichever node
was the current
node when the
grade was copied to
overwrite the current
node’s settings;
the current node is
outlined orange.

(APPEND) Appends
every node of the
entire copied grade
after the last node
of the current grade;
if you copied a
group grade, the
Pre-Clip, Clip, and
Post-Clip grades are
all appended as a
flattened collection
of nodes.
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Clip and Version Group
These keys, at the bottom left of the T-bar panel, are used to manage clips and their grades in
different ways, by creating and managing group assignments, clip attributes, and
grade versions.

Clip and Version Keys

The Clip and Version keys let you manage groups and grade versions with ease.

Key

Shift Up

Primary Function

Shift Down

JOIN/ADD GROUP/REMOVE

(JOIN) Adds the
current clip (or
currently selected
clips) to the current
group (which is
based on whichever
group the last
“grouped clip” you
selected belonged to)

(ADD GROUP)
Creates a brand new
group and opens the
Group Name dialog
for you to type into
(click OK to save the
new group)

(REMOVE) Removes
the current clip (or
currently selected
clips) from whichever
group it belongs to

–/CLIP ATTRIB/DETAILS

–

(CLIP ATTRIB) Opens
the Clip Attributes
window for the
currently selected
clip

(DETAILS) Toggles
the floating Clip
Details window
open and closed,
with which you can
see various clip and
grade properties for
reference

–/FIND IN M/POOL/LIST

–

(FIND IN M/POOL)
Selects the source
clip in the Media Pool
that corresponds to
the current clip in the
Timeline; opens the
Media Pool to show
the clip

(LIST) Switches the
Media Pool to List
view; the Media
Pool does not
automatically open if
closed.
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Key

Shift Up

Primary Function

Shift Down

PREV VERSION

–

(PREV VERSION)
Cycles the grade
of the current clip
to the previously
numbered version

–

NEXT VERSION

–

(NEXT VERSION)
Cycles the grade of
the current clip to
the next numbered
version

–

LABEL/ADD VERSION/≥LOCAL

(LABEL) Opens the
Version Name dialog,
so you can rename
the current version
of the current clip;
click OK when you’re
done.

(ADD VERSION) Adds
an additional version
of the grade for the
current clip; you
can create multiple
versions of a grade
to save variations for
future recall.

(>LOCAL) Toggles
between Use Local
Grades and Use
Remote Grades;
switching between
Local and Remote
grades doesn’t
change or copy either
set of grades.

Utility Group
This group of keys, in the center of the T-bar panel, includes commands for tracking and
stabilization, enabling/disabling grades and nodes and OFX, and bypassing Fusion effects and
Grades. These keys can also function as a numeric keypad for future features.

Utility Keys

The Utility keys provide controls for tracking and stabilization,
as well as disabling and bypassing various grading controls
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Key

Shift Up

Primary Function

Shift Down

SHIFT UP

–

(SHIFT UP) Enables
use of any of the
SHIFT UP key
functions at the top of
various keys

–

1/CLIP/FM/+KF

(1) The one key;
can be used in
conjunction with
SELECT NODE to
jump to a particular
node

(CLIP/FM) Switches
the mode of
motion tracking
or keyframing of
window shape
and position in
the tracking graph
between Clip mode
(where adjustments
are made globally to
the entire duration
of a window) and
Frame mode (where
adjustments are
made at specific
frames, adding
keyframes to the
Tracker graph to
animate a window)

(+KF) Adds a
keyframe to the
tracking graph,
typically used while
in Frame mode where
keyframes are added
while rotoscoping
image movement
with a window

2/TRACK REVERSE/COPY

(2) The two key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(TRACK REVERSE)
Initiates motion
tracking in reverse
for the currently
selected window

(COPY) Copies
track data from the
currently selected
window

3/TRACK FORWARD/PASTE

(3) The three key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(TRACK FORWARD)
Initiates motion
tracking forward
for the currently
selected window

(PASTE) Copies track
data to the currently
selected window

–/STEP REVERSE/SHOW

–

(STEP REVERSE)
Initiates window
tracking in reverse by
one frame and then
stops, giving you time
to evaluate the result

(SHOW) Toggles
Show Track on
and off; shows the
motion path of the
currently selected
motion tracking data
in the Viewer

4/STEP FORWARD/RESET

(4) The four key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(STEP FORWARD)
Initiates window
tracking forward by
one frame and then
stops, giving you time
to evaluate the result

(RESET) Resets all
motion tracking in the
Tracking graph

5/PREV TRK K/FM/DEL KF

(5) The five key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(PREV TRK K/FM)
Moves the playhead
to the previous
keyframe in the
Tracker graph

(DEL KF) Deletes
the keyframe at
the position of the
playhead in the
Tracker graph
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Key

Shift Up

Primary Function

Shift Down

6/NEXT TRK K/FM/CL ALL

(6) The six key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(NEXT TRK K/FM)
Moves the playhead
to the next keyframe
in the Tracker graph

(CL ALL) Deletes all
keyframes in the
Tracker palette

AUTO/MODE/SEARCH

(AUTO) Performs
an Auto Balance
function in the
Primaries palette

(MODE) Turns on the
Modes soft menu on
the Trackball panel,
so you can choose
different functions
including OBJECT
TRACKING, PROXY
ON/OFF, POTS,
RIPPLE mode, WIPE
mode, SWITCH
SESSION, SAFE
AREA, CACHE mode,
CUE mode, SCROLL
mode, and 3D

(SEARCH) Not yet
implemented at the
time of this writing

7/STABILIZE/BYPASS

(7) The seven key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(STABILIZE) Initiates
image stabilization
for the current clip,
using the current
settings in the
Tracking palette’s
Stabilizer mode

(BYPASS) Toggles
image stabilization
off and then on again,
so you can compare
the stabilized image
to the original

8/DISABLE OFX/DEL

(8) The eight key;
can be used in
conjunction with
SELECT NODE
to jump to a
particular node

(DISABLE OFX)
Toggles OFX on
and off if one has
been applied to the
current node

(DEL) Removes an
OFX effect that’s
been added to a
node

9/DISABLE ALL/–

(9) The nine key;
can be used in
conjunction with
SELECT NODE to
jump to a particular
node

(DISABLE ALL)
Toggles all nodes for
the current clip off
and then on

–

SHIFT DOWN

–

(SHIFT DOWN)
Enables use of any
of the SHIFT DOWN
key functions at the
bottom of various
keys

–

*/BYPASS FUSION/EXTRACT

(*) The Asterisk key

(BYPASS FUSION)
Toggles all Fusion
page effects off
and then on for the
current clip

(EXTRACT)
Disconnects the
selected node from
the node graph,
but leaves it in the
Node Editor, ready
to be reconnected
somewhere else
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Key

Shift Up

Primary Function

Shift Down

0/BYPASS TRIMS/CLEAN UP

(0) The zero key;
can be used in
conjunction with
SELECT NODE to
jump to a particular
node

(BYPASS TRIMS)
Toggles all Color
page effects off
and then on for the
current clip

(CLEAN UP) Cleans
up unruly node
graphs to be more
ruly

#/BYPASS ALL/–

(#) The Hash key (or
Pound sign)

(BYPASS ALL)
Toggles both Color
and Fusion page
effects off and then
on for the current clip

–

Node Control Group
This group of keys, at the bottom center of the T-bar panel, lets you quickly create the many
different kinds of nodes that are available with which to organize your grades in the Node Editor
of the Color page.
The DaVinci Resolve Color page is a node-based grading system, where the adjustments you
make appear as nodes in the Node Editor. Each node contains one or more adjustments that
work together. This is similar to the layers that appear in other applications, however nodes
provide the flexibility to route image data nonlinearly within a grade, connecting the output of
one node to the input of any other node farther down the tree of nodes, branching image
processing operations or recombining them via parallel or serial layer nodes to combine Color
page functions in creative ways to create sophisticated operations.

Node Control Keys

The Node Control keys let you create a wide variety of nodes for grading.
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Key

Shift Up

Primary Function

Shift Down

+INPUT/ADD OUTSIDE/
OFX ALPHA

(+INPUT) Lets you add
inputs to any mixer node,
including the Parallel
Mixer, the Layer Mixer, and
the Key Mixer

(ADD OUTSIDE) Adds a
Corrector node in serial
that connects both its
RGB and KEY inputs to the
outputs of the node before
it, with the KEY input
inverted, so you can make
adjustments to parts of an
image that are outside the
preceding node’s qualified
or windowed area.

(OFX ALPHA) Turns on
“Use OFX Alpha” to enable
the selected node to
output whatever

SWAP/>SHARED/KEY MIXER

(SWAP) Does “Morph into
Layer Mixer Node” or
“Morph into Parallel Mixer
Node” if a relevant Mixer
node is selected; Changes
a Parallel Mixer into a
Layer Mixer and vice versa

(>SHARED) Turns the
currently selected node
into a Shared node; Shared
nodes automatically ripple
adjustments other grades
that use the same Shared
node.

(KEY MIXER) Adds a Key
Mixer node with its first
KEY input attached to the
currently selected node’s
KEY output; Key Mixer
nodes let you combine
multiple keys.

–/NODE+POLYGON/+POLY

–

(NODE+POLYGON) Adds
a Corrector node in serial
with a polygon window
automatically enabled
for fast isolation; you can
begin drawing a polygon
immediately in the Viewer.

(+POLY) Turns on the
polygon window for the
currently selected node.

PRECLIP/CLIP/TL/POSTCLIP

(PRECLIP) Opens the PreClip group grade mode
of the Node Editor; only
works when a clip is part of
a group

(CLIP/TL) Toggles between
the Clip and Timeline
grade modes of the Node
Editor

(POSTCLIP) Opens the
Post-Clip group grade
mode of the Node Editor;
only works when a clip is
part of a group

NODE+CIRCLE/+CIRCLE

–

(NODE+CIRCLE) Adds a
Corrector node in serial
with a circular window
automatically enabled for
fast isolation

(+CIRCLE) Turns on the
circular window for the
currently selected node

NODE+LINEAR/+LINEAR

–

(NODE+LINEAR) Adds a
Corrector node in serial
with a linear window
automatically enabled for
fast isolation

(+LINEAR) Turns on the
linear window for the
currently selected node

NODE+CURVE/+CURVE

–

(NODE+CURVE) Adds a
Corrector node in serial
with a circular window
automatically enabled
for fast isolation. You can
begin drawing a custom
curve shape immediately
in the Viewer.

(+CURVE) Turns on the
curve window for the
currently selected node
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Key

Shift Up

Primary Function

Shift Down

NODE+GRADIENT/
+GRAD

–

(NODE+GRADIENT) Adds
a Corrector node in serial
with a gradient window
automatically enabled for
fast isolation

(+GRAD) Turns on the
gradient window for the
currently selected node

–/APPEND CIRCLE/LABEL

–

(APPEND CIRCLE)
Appends a Corrector node
in serial with a circular
window enabled at the
end of your node tree

(LABEL) Lets you type a
label above the selected
node to identify what it
does

+SPLIT/APPEND LINEAR/–

(+SPLIT) Adds a Splitter
node to your node tree,
which splits the red, green,
and blue image channels
into separate outputs for
separate processing

(APPEND LINEAR)
Appends a Corrector
node in serial with a linear
window enabled at the
end of your node tree

–

+COMB/APPEND CURVE/POLY

(+COMB) Adds a Combiner
node to your node tree,
which combines red,
green, and blue image
channels that have been
split back into a single
image

(APPEND CURVE)
Appends a Corrector node
in serial with a Custom
Curve window enabled at
the end of your node tree.
You can begin drawing
a custom curve shape
immediately in the Viewer.

(POLY) Appends a
Corrector node in serial
with a custom curve
window enabled at the end
of your node tree. You can
begin drawing a polygon
shape immediately in the
Viewer.

APPEND GRADIENT

–

(APPEND GRADIENT)
Appends a Corrector node
in serial with a gradient
window enabled at the
end of your node tree

–

ADD SERIAL/+BEFORE

–

(ADD SERIAL) The most
common way of adding
Corrector nodes is in
serial, where each new
node’s input is connected
to the previous node’s
output, one after
another. Adjustments
in preceding nodes will
be the starting point for
subsequent nodes, so
they all work together to
combine different sets of
adjustments in serial order,
similar to layers in a layeroriented system.

(+BEFORE) Adds a
corrector node in serial
prior to (before) the
currently selected node
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Key

Shift Up

Primary Function

Shift Down

ADD PARALLEL/+FIRST

–

(ADD PARALLEL) Adds a
Corrector node in parallel
underneath the currently
selected node, with both
connected to a multiinput Parallel Mixer node
(creating one if necessary)
so that all input images
are mixed together. Each
node in parallel shares
the same input image, so
you can perform multiple
operations to the same
image and combine them
back together.

(+FIRST) Adds a Corrector
node before the currently
selected parallel node, so
that both nodes sit within
the same parallel branch
of the node tree, with the
new node preceding the
original one.

ADD LAYER

–

(ADD LAYER) Adds a
Corrector node as a layer
underneath the currently
selected node, connected
to a multi-input Layer
Mixer node (creating
one if necessary) so that
its output has higher
mix priority than any
other nodes previously
connected to the same
Layer Mixer. The Layer
Mixer node combines
the outputs of multiple
nodes such that the image
output by lower nodes
takes priority over images
output by higher nodes.
Layer Mixer nodes can
also be set to use different
composite modes to
combine images together
in different ways.

–

APPEND NODE

–

(APPEND NODE) Adds a
corrector node serially to
the very end of the node
graph.

–
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The T-Bar Control
The T-bar control is a vertical lever that you can push and pull up and down. Functioning as a
fader, it’s mainly used to control the mix or wipe of a reference image against the current clip
being evaluated.

The T-Bar Control

Viewer and Reference Keys

The T-bar control is a vertical lever that controls Reference Wipes or Split
Screen comparisons and the Viewer and Reference keys let you choose
how to set up comparison wipes and split-screen effects to help you grade.

Which reference is being compared, and the method of comparison, is controlled by the Viewer
and Reference Group of fixed keys immediately below it.

Viewer and Reference Group
This area below the T-bar includes six keys that let you choose among different reference
modes for the Viewer, different Viewer modes, and the Highlight mode. When an appropriate
mode is active, the fader bar controls the mix or wipe position for that mode.
Key

Shift Up

Primary Function

Shift Down

MENU/SPLIT SCREEN/CLEAN

(MENU) Press to
show a row of Split
Screen view options
in the Trackball panel
soft buttons, with
which to compare
multiple clips

(SPLIT SCREEN)
Toggles a split screen
comparison on and
off, with which to
compare multiple
clips in different ways

(CLEAN) Toggles
Video Clean Feed on
and off (Workspace >
Video Clean Feed)

ENHANCED/FULL SCREEN/
CINEMA

(ENHANCED)
Sets the Viewer to
Enhanced mode

(FULL SCREEN) Sets
the Viewer to Full
Screen mode

(CINEMA) Sets
the Viewer to
Cinema mode
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Key

Shift Up

Primary Function

Shift Down

B&W/HIGHLIGHT/DIFF

(B&W) Toggles the
Highlight between
high-contrast Black
and White mode
and the regular
gray modes

(HIGHLIGHT) Toggles
the Highlight on and
off; used to see the
resulting matte when
adjusting a Qualifier
or Window isolation

(DIFF) Toggles the
Highlight between
Difference and the
regular gray modes

GALLERY/REF INVERT/RGB

(GALLERY) Sets the
currently selected
clip in the gallery as
the reference image

(REF INVERT) Inverts
the left and right
halves of the images
being compared

(RGB) Shows an
individual red, green,
or blue channel in
the Viewer; press
SHIFT DOWN, then
REF INVERT, then the
1 (labeled Green), 3
(labeled Blue), or 5
(labeled Red) buttons
on the Search Dial
panel. Press REF
INVERT to go back to
viewing RGB.

TIMELINE/REF STYLE/–

(TIMELINE) Lets you
compare the current
still in the Gallery to
the Timeline image

(REF STYLE) Cycles
among all the
different split-screen
wipe styles, so you
can choose how to
compare the current
and reference images

–

OFFLINE/REF ON

(OFFLINE) Compares
the current frame at
the playhead to the
currently assigned
Offline Reference
Movie frame at the
same timecode

(REF ON) Toggles a
Gallery wipe on and
off, with which to
compare a saved still
to the current clip

–

The Search Dial Panel
The Search Dial panel, typically located on the right for a right-handed colorist, has an LCD
display with four variable controls and nine soft keys. The lower section of the panel houses the
Jog/Shuttle knob and six groups of hard keys. Each group and their keys are described below.

Memories Group
The first group of keys is the Memories group. These include the grade reset controls, buttons
for storing and recalling memories (by letter), and controls for grabbing and browsing stills,
applying grades, and controlling looping for playback.
The letter keys in this group are called “memories” or MEMs, which save stills and grades that
you can quickly apply to another clip to overwrite its previous grade. There are 26 MEMs,
labeled with letters from A to Z. To apply a MEM to another clip, simply press the letter
corresponding to the MEM with the grade you want to apply. To save a grade to a MEM, press
CRNT and then the letter of the MEM you want to save to. More information appears in the table
of key functionality below.
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Memories Keys

The Memories keys let you save and recall memories for quick grade
propagation, grade reset buttons, and other grade management functions.

Key

Shift Up

Primary Function

Shift Down

ALL/RESET NODE/GRADES

(ALL) Reset All
Grades and Nodes;
resets the entire
grade of the current
clip back to the
default of one
unadjusted node

(RESET NODE) Reset
Selected Node
Grade; resets all
adjustments that
have been made
to the currently
selected node

(GRADES) Reset
Grades and Keep
Nodes; resets each
node of the current
clip’s grade but
keeps the node
structure intact

Q/A/I

(Q) Loads or saves
memory Q

(A) Loads or saves
memory A

(I) Loads or saves
memory I

R/B/J

(R) Loads or saves
memory R

(B) Loads or saves
memory B

(J) Loads or saves
memory J

S/C/K

(S) Loads or saves
memory S

(C) Loads or saves
memory C

(K) Loads or saves
memory K
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Key

Shift Up

Primary Function

Shift Down

T/D/L

(T) Loads or saves
memory T

(D) Loads or saves
memory D

(L) Loads or saves
memory L

CRNT

–

(CRNT) Press
CRNT and then any
letter key to save
the image and grade
at the current frame
to that memory
for recall

–

INFO/DISPLAY GRAPH/MEMS

(INFO) Toggles
the Still Properties
window open
and closed; the
Still Properties
window shows
information about the
currently selected
still in the Gallery

(DISPLAY GRAPH)
Displays the node
graph of the selected
still in the Gallery
(only while the
Gallery is open) or
hides a displayed
node graph

(MEMS) Toggles
open and closed
the memories section
of the Gallery

U/E/M

(U) Loads or saves
memory U

(E) Loads or saves
memory E

(M) Loads or saves
memory M

V/F/N

(V) Loads or saves
memory V

(F) Loads or saves
memory F

(N) Loads or saves
memory N

W/G/O

(W) Load or save
memory W

(G) Loads or saves
memory G

(O) Loads or saves
memory O

X/H/P

(X) Loads or saves
memory X

(H) Loads or saves
memory H

(P) Loads or saves
memory P

+POWER/+PAGE/LABEL

(+POWER) Adds
another Power Grade
album to the Gallery

(+PAGE) Adds
another project
album to the Gallery

(LABEL) Selects the
name of the currently
selected album of the
Gallery so you can
change it
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Key

Shift Up

Primary Function

Shift Down

INSERT/APPLY GRADE/LABEL

(INSERT) Not yet
implemented at the
time of this writing

(APPLY GRADE)
Applies the grade
of the selected still
in the Gallery to
overwrite the grade
of the current clip

(LABEL) Selects the
label of the selected
still in the Gallery so
you can add one or
change it

APPEND GRADE/DEL

–

(APPEND GRADE)
Appends all nodes
from the grade of the
selected still in the
Gallery after the last
node of the grade of
the current clip

(DEL) Deletes the
selected still in
the Gallery

-2/PREV PAGE/MATCH FM

(–2) Copies grade
from two clips before
the current clip to
overwrite the grade
in the current clip

(PREV PAGE) Selects
the previous Album
in the Album list of
the Gallery

(MATCH FM)
Performs a Match
Frame operation
that moves the
playhead to the
frame of the Timeline
that matches the
currently selected
still in the Gallery

-1/NEXT PAGE

(–1) Copies grade
from the clip
just before the
current clip to
overwrite the grade
in the current clip

(NEXT PAGE)
Selects the next
Album in the Album
list of the Gallery

–

NONE/USE SRC TC/START FM

(NONE) Changes the
“Apply Grades Using”
option in the Gallery
to No Keyframes

(USE SRC TC)
Changes the
“Apply Grades Using”
option in the Gallery
to Keyframes Aligning
Source Timecode

(START FM) Changes
the “Apply Grades
Using” option in the
Gallery to Keyframes
Aligning Start Frames

GROUP/RIPPLE SEL/APPEND

(GROUP) Ripple Node
Changes to Group,
when you select a
clip that’s part of a
group and make a
change to one node,
that change is rippled
to the same node
of every clip in the
group

(RIPPLE SEL) Ripple
Node Changes to
Selected Clips, when
you select multiple
clips and make a
change to one node,
that change is rippled
to the same node of
every selected clip

(APPEND) Append
Node to Selected
Clips, when you
select multiple clips
and make a change
to a new node, that
node is appended to
the end of the grade
of every selected clip

MISSING/GRAB STILL/MIDDLE

(MISSING) Saves a
still for every clip in
the timeline that does
not already have a
still in the currently
selected Album of
the Gallery

(GRAB STILL)
Saves the currently
displayed still in
the Viewer, and
its grade, to the
currently selected
Album of the Gallery

(MIDDLE) Saves one
still for every clip in
the timeline at the
middle of each clip
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Key

Shift Up

Primary Function

Shift Down

P/PONG/LOOP/PLAYHEAD

(P/PONG) Toggles
looping mode
between ping-pong
and loop forward

(LOOP) Toggles
playback looping on
and off

(PLAYHEAD) Press
to add an Active
Playhead to the
Mini Timeline using
the highlighted
the A/B/C/D keys
above; once added,
pressing PLAYHEAD
and a letter switches
playback control to
that playhead

 Duration: To define a duration, first select the time using the numerical keypad (the
colon separates the hours, minutes, seconds, and frames), and then select Duration.
 Cue: Selecting Cue will force the transport to the preroll position.

Management and Modes Group
This group of keys gives access to a wide variety of functions that, due to their diversity, are
difficult to generalize. They include everything from the all-important Undo and Redo
commands, to splitting and rejoining clips, setting and clearing In and Out points to control
playback and looping, and commands for reverting to the Original Memory, using Preview
Memory, and using Scroll (which is described in more detail later in this chapter).

The Manamenent
and Modes Keys

The Management and Modes keys provide Undo/Redo, range, Flag and
Marker, printer lights, and grade management functionality.
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Key

Shift Up

Primary Function

Shift Down

SCENE/UNDO/NEXT CLIP

(SCENE) Opens
the Scene Detect
Window

(UNDO) Triggers
one step of undo;
DaVinci Resolve
supports unlimited
steps of undo

(NEXT CLIP) Not yet
implemented at the
time of this writing

SPLIT/REDO/JOIN

(SPLIT) Splits one
clip into two at
the frame under
the playhead, so
each split clip
can be graded
independently

(REDO) Triggers
one step of redo;
DaVinci Resolve
supports unlimited
steps of undo

(JOIN) The reverse
of the Split key;
move the playhead
to an edit point with
contiguous timecode,
and press JOIN
to merge the clips
into one.

IN/CLEAR I

–

(IN) Sets a timeline
In point to use when
looping playback

(CLEAR I) Clears the
timeline In point

DUR/OUT/CLEAR O

(DUR) If you’ve set In
and Out points, this
key lets you create a
marker with duration.

(OUT) Sets a
timeline Out
point to use when
looping playback

(CLEAR O) Clears the
timeline Out point

SHOW/FLAG/CLIP

(SHOW) Press to
show a row of flag
colors in the Trackball
panel soft buttons
with which to filter
the Thumbnail
Timeline by. < and >
buttons let you page
among all 16 colors,
and EXIT lets you
finish. Press SHOW
ALL CLIPS in the soft
menu to stop filtering.

(FLAG) Press to
show a row of colors
with which to flag
the current clip in
the Trackball panel
soft buttons. < and >
buttons let you page
among all 16 colors,
and EXIT lets
you finish.

"(CLIP) Press to show
a row of colors with
which to color code
the current clip in
the Trackball panel
soft buttons.

SHOW/MARKER/NODE

(SHOW) Press
to show a row of
marker colors in the
Trackball panel soft
buttons with which to
filter the Thumbnail
Timeline by. < and >
buttons let you page
among all 16 colors,
and EXIT lets you
finish. Press SHOW
ALL CLIPS in the soft
menu to stop filtering.

(MARKER) Press to
show a row of colors
with which to mark
the current frame in
the Trackball panel
soft buttons. < and >
buttons let you page
among all 16 colors,
and EXIT lets you
finish.

(NODE) Press to show
a row of colors with
which to color code
the current node
in the Node Editor
using the Trackball
panel soft buttons.
< and > buttons let
you page among all
16 colors, and EXIT
lets you finish.
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Key

Shift Up

Primary Function

Shift Down

1/2/P/LITE/1/4

(1/2) Sets printer
points adjustments
to be made in
“half-point”
increments

(P/LITE) Toggles
“Printer Lights” on
or off. When on, the
Jog/Shuttle panel’s
number keys are
used to make printer
point adjustments
in “whole points”
increments (shown
on each number
key’s “shift up”
position). This key
remains highlighted
while P/LITE is on.

(1/4) Sets printer
points adjustments
to be made in
“quarter-point”
increments

FLAG/DELETE/MARKER

(FLAG) Deletes
all flags on the
current clip

(DELETE) Deletes
the currently
selected node in the
Node Editor

(MARKER) Deletes
any marker at the
position of the
playhead

ORIG MEM

–

(ORIG MEM) If you
select a graded clip,
then change the
grade and decide
you don’t like the
change, press ORIG
MEM to return to
original state (or
memory) of that
clip when you first
selected it.

–

PVW MEM

–

(PVW MEM) To
preview how a
saved memory looks
when applied to the
current clip, press
PVW MEM and then
any memory key. If
you don’t like the
result, press PVW
MEM again to toggle
the grade to how it
was before.

–

SCROLL

–

(SCROLL) The Scroll
key opens a row
of controls on the
Trackball panel soft
buttons that lets you
preview how grades
on neighboring clips
would look on the
current clip, with the
option to then copy
a grade (EXIT AS IS)
or cancel without
doing anything
(EXIT AS WAS).

–
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Key

Shift Up

Primary Function

Shift Down

SAME/SELECT NODE/
LAST ADJ

(SAME) Changes
the “Switching Clips
Selects” option
to “Same Node”
so that moving to
another clip selects
the same node in
the Node Editor that
was selected in the
previous clip

(SELECT NODE)
Press after typing
a node number to
change the currently
selected node

(LAST ADJ) Changes
the “Switching
Clips Selects”
option to “Last
Adjusted Node”
so that moving to
another clip selects
whichever node in
the Node Editor was
previously adjusted
for that clip

Jog/Shuttle Control
The Jog/Shuttle control is actually two controls in one. The Shuttle control is the outer knob,
which rocks to the left and right and controls real-time or fast playback. The Jog control is an
inner wheel that spins freely and controls the playhead in slow motion, a frame or two at a time.
 Shuttle: The Shuttle control is the outer knob, which rocks to the left and right. This
knob has a detent at the center position which stops playback. Turning this control
counter-clockwise shuttles among a variety of reverse speeds, with reverse playback
going faster the farther left you turn. Turning this control clockwise shuttles among a
variety of forward speeds, with playback going faster the farther right you turn.
 Jog: The Jog control is an inner wheel that spins freely. Rotate the Jog control to step
forward or backward a few frames at a time.

Jog/Shuttle Control

Transport Control Keys

The Jog/Shuttle control lets you control playback and playhead position. and the Transport Control keys let you
control playback, navigate stills in galleries, and navigate nodes in the Node Editor.
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Transport Control Keys Group
This group of keys is found beneath the Jog/Shuttle control. These keys are all about
controlling playback and moving the playhead around your timeline.
Key

Shift Up

Primary Function

SHIFT UP

–

(SHIFT UP) Enables use of any of
the SHIFT UP key functions at the
top of various keys

SHIFT DOWN

–

(SHIFT DOWN) Enables use of any
of the SHIFT DOWN key functions
at the bottom of various keys

FLAG/PREV STILL

(FLAG) Go to previous flagged
still; not yet implemented at the
time of this writing

(PREV STILL) Selects the previous
still in the currently selected
Album of the Gallery

FLAG/NEXT STILL

(FLAG) Go to next flagged still; not
yet implemented at the time of
this writing

(NEXT STILL) Selects the next still
in the currently selected Album of
the Gallery, for use with the REF
ON or SPLIT SCREEN keys

CUE/FIRST FRAME

(CUE) Go to first frame of pre-roll;
not yet implemented at the time of
this writing

(FIRST FRAME) Selects the first
frame of the current clip

CUE/LAST FRAME

(CUE) Go to last frame of pre-roll;
not yet implemented at the time of
this writing

(LAST FRAME) Selects the last
frame of the current clip

FIRST/PREV NODE

(FIRST) Selects the first node in
the Node Editor

(PREV NODE) Selects the
previously numbered node in the
Node Editor

LAST/NEXT NODE

(LAST) Selects the last node in
the Node Editor

(NEXT NODE) Selects the next
numbered node in the Node
Editor
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Key

Shift Up

Primary Function

MARKER/PREV FRAME

(MARKER) Moves the playhead
back to the last previous marker

(PREV FRAME) Moves the
playhead backward a single
frame in the Timeline

MARKER/NEXT FRAME

(MARKER) Moves the
playhead forward to the next
existing marker

(NEXT FRAME) Moves the
playhead forward a single frame
in the Timeline

START/PREV CLIP

(START) Moves the playhead to
the first frame of the current clip

(PREV CLIP) Selects the first
frame of the previous clip

END/NEXT CLIP

(END) Moves the playhead to the
last frame of the current clip

(NEXT CLIP) Selects the first
frame of the next clip

FAST REVERSE

–

(FAST REVERSE) Shuttles
backward along the Timeline
at fast speed; pressing multiple
times increases speed.

SLOW/REVERSE

(SLOW) Plays in slow motion
reverse (Edit page only)

(REVERSE) Plays the Clip/Timeline
in reverse at 100%.

REVIEW/STOP

(REVIEW) Initiates Review
playback; not yet implemented at
the time of this writing

(STOP) Stops the current
transport operation

SLOW/FORWARD

(SLOW) Plays in slow motion
forward (Edit page only)

(FORWARD) Plays the Clip/
Timeline forward at 100% speed

FAST FORWARD

–

(FAST FORWARD) Shuttles
forward along the Timeline at fast
speed; pressing multiple times
increases speed.
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Numeric Entry Group
On the center right-hand side of the Search Dial panel is the Numerical Entry key group. Here
you will find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You
will notice the numbers you type are displayed in a scratchpad area at the bottom of the
Keyframe palette.

Numeric Entry Keys

The number keys group provides access to multiple overlapping functions,
including Printer Points adjustment when the P/LITE mode is enabled.

Key

Shift Up

Primary Function

Shift Down

+R/NUM LK

+R (Plus Red in
P/LITE mode)

(NUM LK) Locks
these keys to
their numeric
functions, useful for
entering timecode
for navigation

–

+G/ /

+G (Plus Green in
P/LITE mode)

(/) The Forward
Slash key

–

+B/ *

+B (Plus Blue in
P/LITE mode)

(*) The Asterisk key

–

Chapter – 9

DaVinci Resolve Advanced Panel Update

226

Key

Shift Up

Primary Function

Shift Down

+MASTER/BACKSPACE

+MASTER (Plus
Master RGB in P/LITE
mode)

(BACKSPACE)
Moves the text or
numeric cursor
one character left
so you can correct
numeric entries

–

–R/7/CHR LT

–R (Minus Red in
P/LITE mode)

(7) The seven key

(CHR LT) Loads
the Chroma Light
Qualifier preset

–G/8/CHR DK

–G (Minus Green in
P/LITE mode)

(8) The eight key

(CHR DK) Loads
the Chroma Dark
Qualifier preset

–B/9/LT DARK

–B (Minus Blue
in P/LITE mode)

(9) The nine key

(LT DARK) Loads the
Chroma Light and
Dark Qualifier preset

–MASTER/ ‘

–MASTER (Minus
Master RGB in P/LITE
mode)

(‘) The Apostrophe.
When pressed by
itself, copies the
grade from one clip
to the left to the
current clip

–

+C/4/MAGENTA

+C (Plus Cyan or
Green+Blue in
P/LITE mode)

(4) The four key

(MAGENTA) Loads
the Magenta Qualifier
preset

+M/5/BLUE

+M (Plus Magenta
or Red+Blue in
P/LITE mode)

(5) The five key

(BLUE) Loads the
Blue Qualifier preset

+Y/6/CYAN

+Y (Plus Yellow
or Red+Green in
P/LITE mode)

(6) The six key

(CYAN) Loads the
Cyan Qualifier preset
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Key

Shift Up

Primary Function

Shift Down

:

–

(:) The Apostrophe
key. When pressed
by itself, copies
the grade from two
clips to the left to
the current clip.
When used after
typing numbers,
delineates timecode
number positions
(hr:min:sec:frm).

–

–C/1/GREEN

–C (Minus Cyan
or Green+Blue in
P/LITE mode)

(1) The one key

(GREEN) Loads the
Green Qualifier
preset

–M/2/YELLOW

–M (Minus Magenta
or Red+Blue in
P/LITE mode)

(2) The two key

(YELLOW) Loads
the Yellow Qualifier
preset

–Y/3/RED

–Y (Minus Yellow
or Red+Green in
P/LITE mode)

(3) The three key

(RED) Loads the Red
Qualifier preset

CLOSE/CLEAR

(SHIFT UP CLOSE)

(CLEAR) Clears
all numbers you
were typing in case
of mistakes

–

+

–

(+) The Plus key, use
for entering relative
timecode, such as +10
to move the playhead
forward 10 frames

–

0

–

(0) The zero key

–

–

–

(–) The Minus key,
use for entering
relative timecode,
such as –10 to
move the playhead
backward 10 frames

–
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Key

Shift Up

Primary Function

Shift Down

ENTER

–

(ENTER) The Enter
key, use after you’ve
typed a timecode
value to execute
moving the playhead

–

Keyframing Group
The Keyframe keys are on the bottom right-hand side of the Search Dial panel. The functions
are replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe
timeline for the current clip in the Timeline. The Keyframe group of keys is used in association
with the Keyframe timeline and controls the selection of keyframes for the start and end of
dynamic transitions of the grade.

Keyframing Keys

The number keys group provides access to multiple overlapping functions,
including Printer Points adjustment when the P/LITE mode is enabled.

Key

Shift Up

Primary Function

Shift Down

–/RIPPLE VALUE/APPEND

–

(RIPPLE VALUE) Lets
you ripple a change
made to the currently
selected node to the
same node within
a specified range
of clips; for more
information see
“Rippling Changes
Using the Advanced
Control Panel” later
in this chapter

(APPEND) Lets you
ripple a change
made to the currently
selected node as
an appended node
to a specified range
of clips; for more
information see
“Rippling Changes
Using the Advanced
Control Panel” later
in this chapter
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Key

Shift Up

Primary Function

Shift Down

LOCK/KEYFRAME MODE/
AUTO

(LOCK) Locks the
keyframe track
of the currently
selected node

(KEYFRAME MODE)
Toggles among
restricting keyframing
to All (every keyframe
track in a grade),
Color (the currently
selected Corrector
node), or Sizing
(sizing only). The
Keyframe mode also
determines which
adjustments are
copied when you
copy grades from one
clip to another.

(AUTO) Toggles Auto
Keyframing on and
off for the keyframe
track of the currently
selected node

EXPAND/LIFT KF/DEL KF

(EXPAND) Toggles
the height of the
Keyframe Editor
while in Color or
Sizing modes to show
or hide all internal
Corrector node
keyframing tracks.
Doesn’t work in
All mode.

(LIFT KF) Not yet
implemented at the
time of this writing

(DEL KF) Deletes any
and all keyframes at
the playhead

–/PREV KF/ATTRIB

–

(PREV KF) Moves the
playhead to the next
previous keyframe in
the Node Editor

(ATTRIB) Opens
the Dissolve Type
window that lets
you add easing to a
selected keyframe

ZOOM/ADD
KEYFRAME/+STATIC

(ZOOM) Zooms into
the Keyframe Editor;
not yet implemented
at the time of
this writing

(ADD KEYFRAME)
Adds a dynamic
keyframe to the
currently selected
corrector node, for
creating a gradual
animated change to
a grade

(+STATIC) Adds a
static keyframe to the
currently selected
corrector node, for
creating an abrupt
one-frame change
to a grade

NEXT KF

–

(NEXT KF) Moves
the playhead to the
next keyframe in the
Node Editor

–
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Auto Color Using the DaVinci Resolve
Advanced Control Panel
To make an automatic correction to a clip, you can simply press SHIFT UP and then AUTO/
MODE/SEARCH on the T-bar panel. This will use the the advanced algorithms of the DaVinci
Neural Engine to automatically analyze the image and adjust color balance and contrast to
produce a nice, neutral starting point.
However, if you crave a bit more control over how the automatic color adjustment is made, and
you have a DaVinci control panel, you can use the cursor to choose which color values to
sample when making an automatic color balancing and contrast adjustment. It’s like a cross
between the Auto Color control and the White and Black Point controls found in the GUI. This
additional bit of guidance can make the results a lot more predictable.
To use Auto Grade to sample a feature using the DaVinci control panel:
1 Press the CURSOR button, on the trackball panel.
2

Use the fourth trackball to move the cursor to a feature you want to use to define
the automatic correction. Whichever color you move the cursor over will be sampled
to form the basis of the resulting color and contrast adjustment. Ideally, you should
place the cursor over a feature that’s supposed to be neutral, such as a black shadow,
gray wall, or white T-shirt. Don’t place the cursor over a feature that actually consists
of saturated color, or that happens to be overexposed, as DaVinci Resolve will
overcompensate and you’ll get poor results.

3

With the cursor placed over the desired neutral feature, press SHIFT UP and AUTO/
MODE/SEARCH on the T-bar panel.
DaVinci Resolve calculates an appropriate correction, which is applied to the
selected node.

Legacy Auto Color
The previous methods for doing Auto Color and Shot Match are available from the
Color panel of the User Preferences, via two checkboxes named “Use Legacy Auto
Color/Shot Match.” With these enabled, DaVinci Resolve looks for the darkest levels in
the image to neutralize the RGB color balance in the blacks, and the brightest levels to
neutralize the RGB color balance in the highlights. Furthermore, Master Lift and Master
Gain are adjusted to maximize image contrast at the outer boundaries of 0 and 100
percent. Using this control with the Primaries Bars mode open makes it easier to see
what’s been changed after these automatic adjustments are made.

Adjusting Curves using the DaVinci Resolve
Advanced Control Panel
The DaVinci Resolve Advanced panel can be used to adjust curves in many different ways,
keeping your hands on the control panel for fast and efficient adjustment.

Custom Curves Adjustments
The controls that correspond to the Custom curves on the DaVinci control panel are available
when you press the CURVES button on the Trackball panel. They’re also the default mapping of
the right-hand side Search Dial panel soft menu.

Chapter – 9

DaVinci Resolve Advanced Panel Update

231

To open the Primary Curve controls of the DaVinci Resolve Advanced control panel:
– Press the CURVES soft key on the Trackball panel.
The rotary knobs on the Center panel update to show the 0% LUM, 20% LUM, 40% LUM, 60%
LUM, 80% LUM, and 100% LUM rotary knobs. These controls correspond to the following
default control point positions on the Curve controls.

Each rotary curve control on the DaVinci control surface
corresponds to one of these six default control point positions

By default, all adjustments you make using these controls are ganged across all four YRGB
curve controls. However, if you turn Custom curve ganging off by pressing the GANG soft key,
then these controls only affect the curve you select using the LUM CURVE, RED CURVE,
GREEN CURVE, and BLUE CURVE soft keys.
You also have the option of using the fourth trackball from the left to adjust individual control
points on curves to any position you like. This works for all curves in DaVinci Resolve that have
control surface mappings.
Methods of selecting and adjusting curve points using the fourth trackball:
1 Press SHIFT DOWN and LEVEL/CURSOR/CURVE.
2

Do one of the following to make adjustments:
– To select a control point to adjust: Spin the fourth ring control to the left or right to

select the next control point in that direction (it takes about half of a turn to select
another control point). Selected control points are highlighted in cyan.
– To move a selected control point: Adjust the fourth trackball to move the control

point up, down, left, or right. Selected control points are constrained between
whichever control points are to the left and right..
To adjust the Curve Intensity sliders:
Adjust the MASTER INTENSITY, RED INTENSITY, GREEN INTENSITY, or BLUE
INTENSITY soft knobs.
To make YSFX adjustments:
1 Press the SOFT CLIP soft key.
2

Adjust the LUM YSFX, RED YSFX, GREEN YSFX, or BLUE YSFX soft knobs.
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Soft Clipping Adjustments
The soft clipping controls can also be manipulated using the DaVinci Resolve Advanced control
panel, which provides separate controls for ganged and individual color channels.
To open the soft clipping control on the DaVinci Resolve Advanced control panel:
Press the CURVES key on the Trackball panel, then press the SOFT CLIP soft key.
To exit the soft clipping controls:
Press the MAIN soft key on the Center panel.
To make a ganged soft clipping adjustment:
– Adjust the MASTER CLIP or MASTER SOFT soft knobs of the SCENE BLACK CLIPS
or SCENE WHITE CLIPS control groups.
– These controls adjust all four corresponding Master-RGB High Soft, High Clip, Low

Soft, or Low Clip parameters simultaneously.
To adjust soft clipping for individual color channels:
Adjust the MASTER/RED/GREEN/BLUE CLIP or MASTER/RED/GREEN/BLUE SOFT
rotary knobs of the SCENE WHITE CLIPS or SCENE BLACK CLIPS control groups (there
are 12 individual knobs).

HSL Curves Controls
The HSL curves can also be adjusted using the DaVinci Resolve Advanced panel.
To open the soft clipping control on the DaVinci Resolve Advanced control panel:
1 Press the CURVES key on the Trackball panel.
2

Press the CURVES soft key on the soft menu.

3

Press the soft key that corresponds to the HSL curve you want to adjust, HUE•HUE,
HUE•SAT, HUE•LUM, LUM•SAT, SAT•SAT, SAT•LUM.

4

Use the RED, YELLOW, GREEN CYAN, BLUE, and MAGENTA, or the LOW, LOW-MID,
MID-HIGH, and HIGH soft knobs to adjust the particular slice of hue or image tonality
you want, using the method you’ve selected.

The Advanced Panel Number Pad Does Many Things
The number keys serve a wide number of uses. This section describes them all in one place.

Navigating Clips by Clip Number
You can move the playhead to the first frame of any clip in the Timeline by typing that clip’s
number (listed above the upper left-hand corner of each thumbnail in the Thumbnail Timeline)
using the number keys, and then pressing ENTER.

Navigating Clips by Timecode
To type timecode instead of a clip number, you need to add colons to signify that you’re
entering hours followed by a colon, then the minutes followed by a colon, the seconds with a
colon, and finally the frames followed by the ENTER key. As you enter timecode on the Color
page, the timecode values you type appear in the lower right-hand corner of the
DaVinci Resolve window, to the left of the Project Manager and Project Settings buttons.
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DaVinci Resolve does not need to have leading numbers entered where they offer no value
and the default value is 0, so to type one hour, three minutes, zero seconds, and sixteen
frames, you do not need to type 01:03:00:16. Simply type 1:3::16 and then press Enter. This
speeds timecode entry.

Moving the Playhead Using Relative Frame Numbers
If you type a + or – and a number of frames, the playhead will move forward or backward by
that number of frames relative to its prior position.

Selecting Specific Nodes in the Node Editor
You can select specific nodes in the current node tree by typing the node’s number and then
pressing SELECT NODE.

Making Printer Points Adjustments
You can use the number keys to make controlled Printer Points adjustments by pressing the P/
LITE button (found in the group of keys just above the number keys). The P/LITE button remains
highlighted as long as printer points adjustment using the number keys is active. Press P/LITE
again to toggle printer points mode off.
The P/LITE button toggles printer points mode on and off in the default “whole point” mode.
You can also press SHIFT UP P/LITE 1/2 to work in “half point” mode, or SHIFT DOWN P/LITE 1/4
to work in “quarter point” mode.
In Printer Points mode, you have three sets of controls:
 Plus and minus Red, Green, and Blue to adjust color balance in the additive manner, by
raising or lowering specific color channels
 Plus and minus Master to raise or lower RGB equally to adjust luminance
 Plus and minus Cyan, Magenta, and Yellow to adjust color balance in the subtractive
manner, by raising or lowering pairs of color channels corresponding to Cyan (Blue and
Green), Magenta (Red and Blue), and Yellow (Red and Green)

Viewing Individual Red, Green, and Blue Channels in the Viewer
You can use the number keys to choose individual channels to evaluate in the Viewer, in order
to more closely evaluate noise or image quality on a per-channel basis.
First, press SHIFT DOWN, then press the GALLERY/REF INVERT/RGB button on the T-bar panel
to trigger the RGB function. Three number keys are then highlighted, 1 (labeled GREEN), 3
(labeled BLUE), AND 5 (labeled RED). Pressing any of these keys sets the Viewer to show only
that channel as a grayscale image.
To go back to viewing full-color RGB, press REF INVERT.

Adding Tracking Points in Interactive Mode
The DaVinci Resolve Advanced control panel has a full set of tracking controls. However,
there’s also the ability to manually add tracking points one by one while in Interactive Object
Tracking mode.
To add a single tracking point:
1 Select a window you want to track.
2

Press SHIFT DOWN and ALL/WINDOW/TRACKER.

3

Press the INTERACTIVE soft key.
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4

Using the DaVinci Resolve Advanced control panel, press the CURSOR button above
the fourth trackball of the Center panel, and move the onscreen cursor to the detail of
the image that you want to add a tracking point to.

5

Click the SET TRACK POINT soft key, within the Interactive mode controls of the
Tracker palette.
This adds a tracking point corresponding to the feature of the image that you clicked,
and you’re ready to start tracking.

Copying Grades Using the Advanced Control Panel
There are a number of procedures for copying grades that have specific implementations on
the Advanced Control Panel.

Copy Forward Keys
The simplest way of copying grades using the control panel is to use the comma and colon
keys on the keypad of the Search Dial panel, or the –1 and –2 SHIFT UP functions on the
memory keys area of the Search Dial panel, to copy grades from one or two clips behind the
currently selected clip. This is a great way to copy grades in scenes with a shot-reverse-shot
structure, where you’re cutting between two angles of coverage, each of which uses the
same grade.
 To copy a grade from one clip back: Press the Comma (,) or –1 buttons.
 To copy a grade from two clips back: Press Colon (:) or –2 buttons.

Scroll
Scroll mode lets you quickly preview how different grades on a variety of other clips in the
Timeline would look on the currently selected clip. As you preview the grade of each other clip,
you have the option to either accept or reject the previewed grade to which you’ve “scrolled.”
Accepted grades (EXIT AS IS) overwrite the previous grade of the current clip, while rejecting
the scrolled grade (EXIT AS WAS) cancels the entire operation.
Scroll mode can be useful for checking to see if any of the previous grades you’ve created in a
scene will work for the currently selected clip.
To use the Scroll mode:
1 Move the playhead to the clip to which you potentially want to copy a new grade. You
can use the PREV SCENE and NEXT SCENE buttons to move around neighboring clips,
or you can use the number keys to jump to a specific clip number or timecode value of
the Timeline.
2

Do one of the following to enter Scroll mode:
– Press SCROLL on the Search Dial panel.
– Press MODE on the T-bar panel, then press the SCROLL MODE soft key.

Once you’re in Scroll mode, the center panel soft menu displays a row of commands
with which to control scrolling through previews of possible grades to copy.
3

Now, do one of the following to preview different grades from other clips:
– Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in

the Timeline, previewing each grade to the current clip.
– Turn the SCROLL SCENES knob to scroll smoothly along multiple

clips in the Timeline.
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– Turn the SCROLL FRAMES knob to scroll along different frames of any clip,

previewing the effects of keyframed grades at different points in time.
– Press the TOGGLE DECK KEYS soft key to use the transport controls on the Search

Dial panel to play through the Timeline, previewing grades as you go.
– Enter a number on the keypad of the Search Dial panel, and then the SCENE # soft

key, to jump to a clip and preview its grade.
As you scroll from clip to clip, a purple outline indicates the clip with the grade being
previewed and an orange outline indicates the current clip to which you’re previewing
each scrolled grade.
4

When you’re finished, do one of the following to either accept or reject the currently
previewed grade that you’ve scrolled to:
– Press EXIT AS WAS if none of the grades you scrolled through was suitable. This

exits Scroll mode and leaves the clip as it was previously.
– Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits

Scroll mode and copies the scrolled grade.
When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport Control
buttons on the Search Dial panel functions as a means of previewing the grades of other clips
in the Timeline.
 NEXT CLIP: Move to the next clip and preview its grade.
 PREV CLIP: Move to the previous clip and preview its grade.
 FWD: Plays (scrolls) forward at 1 scene per second, previewing each
new grade as it appears.
 REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing
each new grade as it appears.
 FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second,
previewing each new grade as it appears.
 RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second,
previewing each new grade as it appears.

Rippling Changes Using the Advanced Control Panel
DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of
other clips in the Timeline. This is only possible using the controls of the DaVinci Resolve
Advanced control panel.
The general idea of the ripple function is that you select a clip, make a change to one or more
nodes in its grade, and then ripple that change to a range of other clips. This rippled change
can be applied to the same node in each clip, or the change can be applied as an appended
node within each rippled clip.
The following procedure describes in detail how you can use the control panel to ripple a
change to a range of other clips. While this procedure may appear complicated, it’s just that
there are several options. Once you learn the sequence of commands, this process is actually
quite fast.
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To ripple a change using the Ripple Mode soft key commands:
1 (Optional) On the T-Bar panel, press MODES, then in the soft menu of the Trackball
panel press RIPPLE MODES. Four selectable modes appear mapped to the soft keys
of the Trackball panel, which can be used later to execute different types of ripple
operations. Press the mode you want to use for rippling.
– Ripple Static: (Exact values changed) Changes made to the current clip are rippled

to the specified clips using the exact parameters that were changed. For example,
if Lift in the current clip is changed to 0.75 of its range, each clip you ripple will have
a Master Gain setting of 0.75. Only parameters you adjust are rippled.
– Ripple Relative: (Percent value changed) Changes made to the current clip are

rippled to the specified clips by the percentage of change you made to the altered
parameters. For example, if the current clip has a Lift level of 1.00 and is changed to
0.90 units, then the Lift setting of each clip you ripple will have a relative reduction
of 10% relative to its previous value.
– Ripple Absolute: (Unit value changed) Changes made to the current clip are rippled

to the specified clips by the same delta of change, using whichever units make
sense for the affected parameter. For example, if the current clip had a Lift of 0.80
and you increased it to 0.90, each rippled scene’s master gain level increases by
0.10.
– Ripple Forced: (All values are copied) The current clip’s grade is rippled to the

specified clips in its entirety. No comparison is made with the original clip’s
parameters, and all memory parameters are rippled.
2

Move the playhead to the clip you want to adjust.

3

Adjust the grade of the current clip in the manner you want to ripple to other clips in
the Timeline.

4

Now, you must define the range of clips you want to ripple to using the number pad on
the Search Dial panel. The following combinations will work:
– An absolute range of clips is defined by entering two clip numbers separated by a

comma. For example, if you want to ripple the current change to clips 10 through 15,
you’d press “10, 15”
– To specify every clip from the beginning of the Timeline, use the Minus (–) key. For

example, to specify a range of clips from the beginning to clip 20, you’d press “–, 20”
– To specify every clip to the end of the Timeline, use the Plus (+) key. For example, to

specify a range of clips from the clip 50 to the end, you’d press “50, +”
– To specify every clip in the whole Timeline, press “–, +”

5

(Optional) You can control whether the rippled change is applied in an appended
node, or an existing node, in every rippled clip by pressing the SHIFT DOWN key of
any panel.
If you don’t press SHIFT DOWN, the rippled change will be applied to the same node in
every rippled clip that was adjusted in the current clip. In other words, if you made a
change to Node 4, it will be rippled to Node 4 of all clips specified for rippling to. If one
of the rippled clips doesn’t have the same number of nodes (in this case if there’s no
node 4), you may get an error.
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6

To execute the ripple, do one of the following:
– Press RIPPLE VALUE on the Search Dial panel to ripple a change to the selected

node in each clip’s grade, using the currently selected Ripple Mode in the Color
panel of the User Preferences.
– Press SHIFT DOWN and APPEND to ripple to add the change via an appended node

at the end of each clip’s grade
– Press one of the Center panel soft keys corresponding to the ripple function you

want to perform. There are four soft keys:
a Static Ripple: Changes made to the current clip are rippled to the specified clips
using the exact parameters that were changed. For example, if Lift in the current clip
is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of
0.75. Only parameters you adjust are rippled. Identical to the “Exact values changed”
ripple setting.
b Relative Ripple: Changes made to the current clip are rippled to the specified clips
by the percentage of change you made to the altered parameters. For example,
if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift
setting of each clip you ripple will have a relative reduction of 10% relative to its
previous value. Identical to the “Percent value changed” ripple setting.
c Absolute Ripple: Changes made to the current clip are rippled to the specified clips
by the same delta of change, using whichever units make sense for the affected
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to
0.90, each rippled scene’s master gain level increases by 0.10. Identical to the “Unit
value changed” ripple setting.
d Forced Ripple: The current clip’s grade is rippled to the specified clips in its entirety,
overwriting all previous nodes and parameters in the rippled clips.
Now, the adjustment you made in step 4 is applied to the designated range of clips.
Admittedly, that was a long and detailed procedure when spelled out in text, but the actual
button sequences are straightforward once you put them together. Here are some examples of
button sequences that ripple an adjustment you’ve just made in different ways:
 “10, 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to
the current clip and applies it as a new node that’s appended to the end of clips ten
through fifteen.
 MODES then RIPPLE MODES then “34, 45” then FORCED RIPPLE: Copies the entire
grade of the current clip, using it to overwrite the grade of clips 34 through 45.
 MODES then RIPPLE MODES then “–, +” then SHIFT DOWN then RELATIVE RIPPLE:
Copies the change you’ve made to the current clip as a relative percentage and applies
it as a new node appended to the end of every single clip in the entire Timeline.

WARNING
Since undo is a per-clip operation, there is no global undo for changes made to the
entire Timeline. This means that once you ripple a change in this manner, there is no
going back. Proceed with caution.
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Chapter 10

Resolve FX
Improvements
Every new release of DaVinci Resolve ships with new and improved
Resolve FX, and version 17 is no exception.
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Brand New Resolve FX
DaVinci Resolve 17 adds several new effects that are useful for a wide variety of creative and
corrective tasks.

Texture Pop (Resolve FX Texture, Studio Only)
Texture Pop is a more sophisticated and flexible version of the Midtone Detail control found in
the Primaries and HDR palette. Using the controls of this effect, you can either remove texture,
or exaggerate it. There are two modes of operation that determine how specific a result you
can achieve.
 In Simple mode, you can apply more extreme versions of the Midtone Detail effect
found in the Primaries and HDR palette. A single Details slider lets you soften or
sharpen midtone detail in the image with a greater range of operation, while a Strength
slider lets you exaggerate the effect further or attenuate the effect to back it off.
 In Advanced mode, you can fine-tune the softness or sharpness of high, medium, and
low-frequency image detail with great specificity via seven individual “details” sliders,
labeled Rough, Coarse, Medium, Small, Fine, and Tiny. This lets you adjust the textural
characteristics of multiple frequencies of image detail in different ways, for example
softening Fine detail while intensifying Medium detail. The Strength slider lets you
exaggerate or attenuate the overall effect caused by all sliders.
In either mode, the Details/Range sliders default to 0.000, which causes no change to the
image. This is the level to choose to preserve the original quality of detail in the image. They
range from -1.000 (maximum softening) to +1.000 (maximum sharpening). Additionally, a set of
Tonal Range controls (described later) lets you choose how much of this effect is applied to the
Shadows, Midtones, and Highlights of the image, giving you even more specific control over
which parts of the image are softened and/or sharpened.

Understanding Advanced Mode
Advanced mode is the most exciting way to use this effect. The best way to learn what
Advanced mode does is to set all of the Details sliders to -1.000, and then raise each one
individually to see what kind of image detail get reintroduced, and ultimately enhanced if you
raise each slider above 0.000. In the following image, each of the Details sliders has been set
to -1, which is the maximum smoothing for each setting. The result is an image with
minimal detail.
In the following example, a person and the mechanical details of a helicopter shot are
smoothed by setting each detail slider to -1.000. You can see that the resulting images both
retain the broad strokes of color and contrast that define each region of color, but outside of
high-contrast edges, all textural detail has been smoothed to a clean gradient.

(Left) An image of a person with all detail smoothed,
(Right) An image of mechanical detail with all detail smoothed
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Then, by raising each of the Details sliders back to 0 or even +1 one at a time, you can see
exactly what kind of detail that slider is affecting. As you can see in the example of the person,
the Tiny and Fine sliders are affecting only the smallest details, hairs, lines, and pores of the
skin. In the helicopter detail, you can see the kind of small textures, tiny lines and rivet details
that come back.

(Left) The same image of the person with the Tiny and Fine sliders raised to add subtle detail back
to the image, (Right) The helicopter detail with Tiny and Fine detail added back to the image

Here are two sets of generalizations that hold true if you’re thinking about the detail of a
human face.
 Tiny, Fine, and Small controls affect the smallest details in an image, including the pores
(tiny), blemishes (fine), and wrinkles (small) of average closeup shots. Other features
affected would include high-frequency edge detail of strands of hair, leaves on a tree,
or text on a page of paper or screen.
 Rough, Coarse, and Medium tend to affect progressively smaller shadow contouring of
faces, bodies, and objects.
Of course, the granularity of a particular type of image detail depends on how much of a
closeup or long shot the clip is. When the camera is closer to the subject being adjusted, you’ll
be able to adjust much finer details. When the camera is distant, then even large details on the
subject are affected by the Tiny, Fine, and Small controls. This means when you create an
adjustment for a subject in a closeup, you’ll need to make changes to the adjustment if you try
and apply it to a long shot.

Mode Controls
 Operating Mode: Lets you choose between the Simple and Advanced modes of this
plug-in.
 Color Mode: Lets you choose between working in RGB and Luma/Chroma mode. In
RGB, a single set of parameters affect all three color channels at once. In Luma/Chroma
mode, two sets of controls let you fine-tune the luma and the chroma separately.
 Output Mode: Lets you choose between outputting the Final Result, Differences mode
which lets you see the effect differenced against the original image, and Difference
Magnitude, which shows a high-contrast differencing comparison.

Details Controls
 Strength: Lets you exaggerate the effect of the other Details sliders further, or
attenuate the effect to back it off.
 Details: (Simple mode only) Lets you soften or sharpen midtone detail in the image with
a greater range of operation.

Chapter – 10

Resolve FX Improvements

242

 Rough/Coarse/Medium: (Advanced mode only) These three sliders affect
progressively larger contours of the image, appearing to affect the shadows and
structure of the image.
 Small/Fine/Tiny: (Advanced mode only) These three sliders affect progressively
smaller details and texture of the image, adjusting medium to tiny details, lines,
and specks.

Tonal Range Controls
 Shadows: Lets you reduce the effect you’ve created in the shadows of the image, as
defined by the Low Range parameter.
 Midtones: Lets you reduce the effect you’ve created in the midtones of the image, as
defined by the Low and High Range parameters.
 Highlights: Lets you reduce the effect you’ve created in the highlights of the image, as
defined by the High Range parameter.
 Low Range: Lets you define the image value that defines the transition from Shadows
to Midtones.
 High Range: Lets you define the image value that defines the transition from Midtones
to Highlights.

Detail Recovery (Resolve FX Texture, Studio Only)
Detail Recovery is a utilitarian effect that lets you extract image detail from the second input, in
order to re-add it to the image coming in the first input. In this way, you can selectively add
detail back to an image in which it’s been removed. Because of how it works, this is an effect
that’s intended to be used on the Color page.
To use Detail Recovery, you must add it to the node tree as a Resolve FX node (dragging it
directly from the Open FX library into the node tree as its own node), in order to expose both of
the RGB inputs that appear on the node when you do this. By default, the first RGB input is for
the image you want to add detail to, and the second RGB input is for the image you’re
extracting image detail from.
In the following example, Node 1 is the base grade, and Node 2 is a grade in which the
highlights are being blown out for stylistic effect. The Detail Recovery node is then being
added to add specific image detail from Node 1 back to the output of Node 2.

Setting up the Detail Recovery effect to add image
detail from Node 1 to the image coming from Node 2
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The result, compared with the image in Node 2, is an image that’s still harshly exposed, but that
has traces of fine image detail so it doesn’t look so clipped.

(Left) The image with highlights compressed harshly, (Right) The image with high-frequency detail added back

Detail Recovery has the following parameters.

Detail Recovery
 Transfer Direction: This drop-down menu lets you choose which input provides the
detail, and which input the detail is combined with.

Details Extraction
 Frequency Cutoff: A slider that lets you choose how much detail you want to
extract for recovery. Lower values isolate finer details: higher values include
progressively larger details.
 Strength: This slider lets you exaggerate or attenuate the detail that’s
extracted for recovery.
 Detail Mix: At a value of 1.000, this slider blends the extracted detail with the image
you’re adding it to so that both layers blend together. At a value of 0.000, the extracted
detail replaces whatever overlapping pixels are in the image you’re adding it to. Using
this slider, you can choose the best blend for your purposes.
 Preview Detail checkbox: Turning this checkbox on lets you see the detail that’s being
extracted using the Frequency Cutoff and Strength sliders.

Video Collage (Resolve FX Transform)
Video Collage is designed to make it easier to create grid-based layouts of multiple video
layers to create different kinds of split-screen effects, where each video layer appears within a
“tile” that can be styled in different ways. Layout controls let you choose how many rows and
columns there are, which determine how many tiles are available to arrange tiles of video next
to one another in different ways, with additional controls for creating offsets, changing the
margins around and spacing between the tiles, and rounding the corners of each tile.
This effect is designed to be used in the Cut and Edit page, and there are two ways that you
can set this up, which are chosen using the Workflow drop-down menu.
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Create Background
The Create Background option is perhaps the simplest way to create a split-screen using this
effect. This mode creates a frame with holes in it, behind which you can position multiple layers
of video. These clips are placed on tracks underneath the background clip in the Timeline, and
use each clip’s individual sizing controls in the Inspector (which can be used via on-screen
Transform controls in the Viewer) to scale and position them correctly within the holes. The
Video Collage effect is applied to the topmost superimposed video or still image clip in the
Timeline, in order to use that clip as a background for the frame.
In the following example, the Video Collage effect is applied to the clip on track 5, which has
four other clips underneath it in a stack, each of which has been positioned to fit in one of the
holes of the frame.

A stack of clips to create a split-screen effect; the top-most clip is used as
the background by the Video Collage effect in Create Background mode,
while the stack of clips underneath are all positioned to fit into the holes
created in the top clip

Create Background mode makes it easy to create a split-screen layout of different clips without
having to resize them with precision to align the edges and sizes of each clip. The width of the
frame that’s created gives some wiggle-room to reposition and animate each individual clip
within the hole it shows through. You can see the resulting effect created in the previous
example below.

The resulting split-screen effect, with four clips arranged to show through
the holes created in the top “background” clip that’s creating the frame; you
can see the onscreen controls corresponding to the clip on track 4 that have
been used to position and resize it to fit
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Create Tile
This mode of operation is a bit more work to set up, as it requires you to create a layout in one
instance of this effect, but it gives you more options, automatically transforming each layer of
video in your stack of clips in the Timeline to fit a layout you design. The best way to work in
Create Tile mode is to edit a stack of superimposed clips in the Timeline, but this time if there’s
a clip you want to use as the background, it should go at the bottom of the stack.

A stack of clips to create a split-screen effect in Tile mode; the
bottom clip is going to be used as the background

Then, apply the Video Collage clip to the topmost clip, and set the Workflow drop-down menu
to Create Tile. Immediately you’ll see that the current layer has been fit inside the first rounded
tile of the default layout of four tiles. For clarity, video tracks 4, 3, and 2 have been muted so
you can see the current clip turned into a tile against the bottom clip that serves as the
background for this arrangement.

The topmost clip set to create the first tile in a layout; video tracks 4, 3, and
2 are disabled to show the top clip against the bottom clip that’s being used
as the background

Ultimately, you’ll use Paste Attributes to apply a copy of this effect to each clip on the Timeline
that’s supposed to fit inside a tile, and once you choose which clip goes inside each tile, that’s
what will create the arrangement. Before you do that, however, you need to customize
the layout.
To get a preview of the entire layout, for further customization, turn on the Preview Layout
checkbox in the Inspector. This draws a preview of how all the tiles will be placed using the
current layout. Using this preview, you can make whatever changes you want to set things up,
before you copy this plug-in to all the other clips in the stack.
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Turning on Preview Layout to customize the layout

With Preview Layout enabled, you can use the Layout controls below to choose how many
columns and rows of tiles there are, to stagger the tiles horizontally or vertically, to round or
square off each tile by a variable amount, and to alter the margins and spacing. In this way, you
can create a wide variety of different symmetrical layouts really easily. In this example, we’ll
create a layout with one row, three columns, that’s staggered vertically.

Our new customized layout, shown next to the Inspector controls for this effect

Now that this is done, we’ll turn off Preview Layout to focus on the current clip’s integration into
our layout, and we can see that it doesn’t quite fit into the box. Click the Tiles button in the
Inspector. This reveals the Tile-specific controls, which include the Resize Content controls.
Click the disclosure control to open these up, and use the Pan, Tilt, and Zoom controls to make
this image fit into the tile full screen.

Tiles controls in the Inspector with Preview Layout disabled, so we can focus on customizing the current tile
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You should also note the Active Tile drop-down menu. This menu serves two purposes. First, it
defines which tile the current clip is displayed within. This becomes important later on when you
apply this effect to multiple superimposed clips. However, it also determines which tile you
further customize using the Tile-based controls of the Inspector. If needed, tiles can be
individually styled.
The Manual Tile Management checkbox is off by default, which enables DaVinci Resolve to
automatically update the number of tile entries in the Active Tile drop-down menu with items
equal to the number of grid positions (or grid nodes) defined by the rows and columns you’ve
set, without you needing to do anything. For simple symmetrical layouts, this is easiest.
However, if you turn Manual Tile Management on, you gain the ability to add and delete tile
positions manually, which enables other options. For now, we’ll leave this turned off.

(Left) The Active Tile drop-down with Manual Tile Management turned off, (Right) The Active Tile controls with
Manual Tile Management turned on, and additional controls for manual tile management displayed

So, now we’ve created a custom overall layout, and we’ve tailored the top clip in the stack to fit
the first tile in the layout. Now it’s time to apply this effect to the next two clips in the stack
(remember the bottom clip will be used as a background, so it doesn’t need this plug-in applied
to it). Select the top clip with the effect applied to it in the Timeline, and press Command-C to
copy it. Then, select the next two clips, right-click one of them, and choose Paste Attributes
(Option-V). When the Paste Attributes window appears, turn on the Plugins checkbox, in Video
Attributes and click Apply. Those two clips disappear as they receive the Video Montage effect
and fit themselves into Tile 1, just like the top clip.

Using Paste Attributes to apply the copied effect from the top clip to the
other clips in this arrangement

To assign each clip to the correct tile in the layout, select each clip in the arrangement, one at a
time, open the Effects panel of the Inspector, click the Tiles button in the Inspector
(if necessary), and set each clip to be the next available tile in the Active Tile drop-down menu.
In this example, the top clip was in Tile 1, the second clip down will be in Tile 2, and the third clip
down will be in Tile 3.
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Assigning the Active Tile for each layer in the Timeline

TIP: If you enable the Open FX Overlay of the Timeline Viewer, each tile has an
overlay that lets you click a tile in the Viewer to make that the Active Tile.

If you like, you can rearrange which clips go into which tiles using this control, but for now we’ll
keep things simple. As you do this, each tile becomes populated, and the final layout is
revealed, with the background clip showing behind everything. If necessary, you can use the
Resize Content controls (in Tiles mode) to resize each tile’s contents to fit the tile better.

The current layout, with each clip in the stack assigned to a different tile

NOTE: If you’ve customized a layout, copied and pasted attributes to the other clips
you want to use in that layout, and have assigned each clip to its position in the layout,
and you then decide you need to make a change to the Globals layout controls, you’ll
need to go through the process of copying the updated effect, pasting attributes to
the other clips, and reassigning each clip to the appropriate position in the layout to
make that update to the other clips as well.

So, these are the overall workflows of the Video Collage effect. There is, of course, much more
you can do, but this is the basis of how you create your initial layout.

Animating Tiles and Advanced Layouts
One of the more powerful aspects of the Video Collage effect is the ability to quickly and easily
create animated intros and outros for each tile. These effects can be fully automated over a
customizable duration, or their duration can be manually keyframed. All animations can be
automatically eased, and you can also enable motion blur for the Fly, Shrink, and Rotate
animations.
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When you use these controls in Create Background mode, the transparent holes through which
other clips in the background show through are animated to “open or close” to reveal the
contents. When used in Create Tile mode, the actual tile and its contents are animated to fly,
shrink, rotate, and/or fade to appear or disappear.

Tile Animation controls let you create
automatic Intro and/or Outro animations

Additionally, you have the ability to keyframe the Mute, Start and End Column and Row
parameters, Tile Styling and Drop Shadow parameters, and other aspects of tiles in Tiles mode,
either individually or all together.
In particular, the Start and End Column and Row parameters let you create tiles that span
multiple grid positions, and also move tiles from one grid position to another. Without
keyframing, this lets you create more kinds of layouts with asymmetric arrangements of large
and small tiles. With keyframing, you gain the ability to easily create sophisticated grid-based
animations to move tiles from position to position, and to have tiles expand and contract to
encompass neighboring tiles in the layout, all with a minimum of keyframing.

Tile Animation controls let you create automatic Intro and/or Outro animations

Keep in mind that, when using multiple instances of the Video Collage effect on superimposed
clips in the Timeline, once you’ve defined your overall layout and used Paste Attributes to copy
a particular instance of this effect with your layout to the rest of the clips, you need only
keyframe each instance of each tile within the clip it’s applied to. Furthermore, since Intro and
Outro animations are applied to the entire duration of the clip, you can easily offset each Intro
and Outro animation by offsetting the clips in the timeline.
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TIP: If you change the duration of clips in a stack that are creating a Video Collage
effect, you can use the Synchronize Keyframing controls in Globals mode to offset all
keyframes applied to that instance of the Video Collage effect by the same amount.
You could do the same thing by opening the keyframe track or Curve Editor for all
Video Collage parameters in the Timeline and offsetting them that way, but this
provides a quick shortcut.

Video Collage Controls
Here’s a detailed explanation of all the parameters found in the Video Collage effect.
 Workflow: Defines what the output of Video Collage is, depending on how
you want to use it.
– Create Background: Outputs a frame with holes, behind which you can position

individual layers of video to show through.
– Create Tile: Outputs a single tile, transformed and styled to be one element of a

multi-tile layout
 Preview Layout: Turning on Preview Layout lets you see a graphical preview the entire
layout, and how each tile fits together. In Create Tile mode, this lets you configure how
you want the layout to look before you copy the clip and use paste attributes to apply
this effect to the rest of the video layers you want to arrange into a split-screen.
 Globals / Tile buttons: Choose between the Globals controls, which exposes controls
that let you adjust the overall layout, and the Tiles controls, which let you choose the
currently active tile and style it.

Layout
These controls appear in Globals mode.
 Columns: Choose how many vertical columns worth of tiles there are.
 Rows: Choose how many horizontal rows worth of tiles there are.
 Stagger Horizontally: Lets you create an offset from one row from the next in a
balanced way, so that the rows are all staggered from one another.
 Stagger Vertically: Lets you create an offset from one column from the next in a
balanced way, so that the columns are all staggered from one another.
 Rounding: Rounds the edges of each tile in the layout. A value of 0.000 sets the edges
to be square. Increasing rounding increasingly curves the corners of each tile, until a
value of 1 sets the tile to be perfectly round.

Margins and Spacing
These controls appear in Globals mode.
 Left/Right Margins: Alters the spacing from the edge of the frame to the left and right
edges of the group of all tiles. Increasing this parameter makes all tiles progressively
more narrow, as they squeeze in towards the center of the frame.
 Top/Bottom Margins: Alters the spacing from the edge of the frame to the top
and bottom edges of the group of all tiles. Increasing this parameter makes all tiles
progressively shorter, as they squeeze in towards the center of the frame.
 Horizontal and Vertical Offset: These two sliders let you offset the group of all tiles
from the center however you like.
 Horizontal and Vertical Spacing: These two sliders increase or decrease the spacing
between each tile, making them narrower or wider as a result.
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Synchronize Keyframing
These controls appear in Globals mode. They’re basically a built-in utility that lets you offset all
Globals and Tiles parameter keyframes that are applied to the current effect, to account for
times when you’ve done elaborate keyframing to create animated split-screen effects, and you
then need to change the duration of the clip this effect is applied to. Instead of forcing you to
expose the keyframes of each parameter in the Timeline in order to move them, these controls
let you move all keyframes for all parameters forward or backward by a particular number of
frames, all at once.
 Offset Frames: Lets you specify how many frames you want to offset all keyframes
applied to this effect forward. Negative values move keyframes to the left.
 Apply Keyframing Offset: Executes the offset.

Manage Tiles
These controls appear in Tiles mode.
 Active Tile: This menu serves two purposes. First, it defines which tile the current
clip is displayed within. This becomes important later on when you apply this effect to
other superimposed clips you want to use together in a layout. However, this control
also determines which tile you further customize using the Tile-based controls of the
Inspector. If you enable the Open FX Overlay of the Timeline Viewer, each tile has its
own overlay that lets you click a tile in the Viewer to make that the Active Tile.
 Bring Tile Forward/Send Tile Back: These two buttons let you rearrange the order of
tiles in the Active Tile drop-down menu.
 Manual Tile Management: While this checkbox is turned off (the default), changing the
Columns and Rows parameters automatically updates the Active Tile drop-down menu
with one tile per node on the resulting grid arrangement. Turning this checkbox on lets
you Add and Delete tiles manually, which lets you create more advanced layouts with
overlapping tiles and asymmetric spacing between tiles.

Mute Tiles
These controls appear in Tiles mode. A single checkbox parameter, Mute Tile, lets you enable
and disable the visibility of the active tile. This checkbox is keyframable, so you can animate the
appearance and disappearance of different tiles to create different effects.

Custom Size/Shape
These controls appear in Tiles mode. They let you further customize layouts on a tile by tile
basis and can also be used to quickly and easily animate a single tile to move and resize itself
around the grid of the overall layout.
 Start/End Column and Row: These four controls serve two purposes, letting you
change a tile’s position by row and column number, or enlarge a tile to encompass
multiple tile row or column positions (“spanning”). To use these parameters, you must
first choose which tile you want to adjust from the Active Tile drop-down menu. With
the tile you want to edit tile active, you can then drag the appropriate sliders to create
either effect, as explained below.
– To change Tile Position: When adjusted together so that the Start and End values

are identical, they let you manually adjust the position of each tile in the grid that’s
defined by the number of rows and columns you’ve set. This is particularly useful
when you want to quickly keyframe animated changes to tile position, in order to
jump a tile around the grid of the layout.

Chapter – 10

Resolve FX Improvements

252

– To make a tile span multiple positions: Setting the Start and End Row and/or

Column parameters to different values, changes the currently active tile to span
multiple grid positions in the layout, making that tile bigger in order to create
asymmetric arrangements of larger and smaller tiles. You can also keyframe these
values to easily animate the effect of a tile expanding to occupy more grid positions,
or shrinking from occupying several grid positions to occupying a single position.
Choose how many rows/columns and in which directions you want that tile to span.
Note that if you span multiple rows or columns that have been offset, the resulting
tile is enlarged to encompass the entire rectangular region defined by the outer
boundaries of both offset tiles.
 Custom Size/Shape: Turning this checkbox on enables the rest of the controls
in this group, enabling you to set individual scale and rounding for the active tile
that’s selected.
 Custom Scale: Lets you adjust the size of the active tile independently
of the other tiles.
 Custom Rounding: Lets you adjust the rounding of the active tile independently
of the other tiles.

Resize Content
These controls appear in Tiles mode. They let you resize the image being fit within each tile to
show exactly what you want shown.
 Pan/Tilt/Zoom: These three sliders let you move and resize the video layer shown
inside of the active tile to fit however you need it to.
 Edge Behavior: These settings allow you to control how the edges of the video layer
respond inside the tile.
– Transparent: Any positioning that goes past the edge of the video is transparent,

showing the Tile Color set in the Tile Styling options.
– Reflect: Any positioning that goes past the edge of the video mirrors back on itself.
– Wrap: Any positioning that goes past the edge of the video repeats itself.
– Replicate: Any positioning that goes past the edge of the video shows a duplicate of

the edge stretched to the boundary of the control, essentially filling in the remaining
space with the pixels used at the extreme edges of the video clip.
 Move With Tile: Defines how the image is fit into the tile when the tile size changes due
to other parameters of the Video Collage effect.
– Position Only: The video content in the tile only is sized using Pan and Tilt,

Zoom is ignored.
– Position and Scale: The video content in the tile is sized using Pan, Tilt, and Zoom.

Tile Styling
These controls appear in Tiles mode. They let you add a colored border, and adjust the opacity
of all tiles, or just the currently active tile. These parameters are animatable.
 Apply to All Tiles: When checked, this applies any changes made in the Tile Styling
parameters to all tiles in the Video Collage, regardless of which tile is currently active.
 Tile Border: This slider controls the width of the tile’s border. It has a possible range of
values from -0.250 to 0.250, where negative numbers expand the size of the border
inside the tile, and positive numbers expand it outside the tile.
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 Tile Color: Allows you to chose the background and border color of the tile.
 Tile Opacity: This slider changes the transparency of the tile itself; it does not effect
the video clip inside the tile. The possible ranges are 0.000 (fully transparent) to 1.000
(fully opaque).

Drop Shadow
These controls appear in Tiles mode. They let you add and customize a drop shadow, either to
all tiles, or just to the currently active tile. These parameters are animatable.
 Apply to All Tiles: When checked, this applies any changes made in the Drop Shadow
parameters to all tiles in the Video Collage, regardless of which tile is currently active.
 Strength: This slider controls drop shadow transparency. The possible ranges are
0.000 (fully transparent) to 1.000 (fully opaque).
 Color: Allows you to choose the color of the Drop Shadow.
 Drop Angle: Lets you set the angle that the shadow is cast from. The slider represents
360 degrees of movement from -180.0 to 180.0.
 Drop Distance: Allows you to set the distance that the shadow appears from its source
tile. The possible values are from 0.000 to 0.200.
 Expand: This slider controls how far the shadow expands from its origin. The possible
values are from 0.900 to 1.250.
 Blur: Allows you to control the amount of diffusion of the Drop Shadow. The possible
ranges are 0.000 (no blur) to 1.000.

Tile Animation
These controls appear in Tiles mode. They make it easy to create simple intro/outro animations
to bring all or some tiles onscreen, and to push all or some tiles offscreen, in different ways.
The Animate drop-down menu determines whether this animation will be automatic or manually
created using keyframes.
 Apply to All Tiles: When enabled, any animation that’s set up will be applied to all tiles
in the layout simultaneously.
 Animate: This drop-down menu lets you choose between Manually Keyframing intro or
outdo animations, or automatically creating animations to introduce or conclude a tile.
The options are:
 Manually Keyframe: In this mode, you must manually keyframe the four progress
sliders below to create animated Intro and Outro animations.
 Intro Only: Animation is automatically created to bring each tile onscreen according to
the types of animation you choose from four checkboxes below. Options include Fly,
Shrink, Rotate, and Fade, in any combination. A Duration slider appears that lets you
choose how long the Intro will be.
 Outro Only: Animation is automatically created to send each tile offscreen according
to the types of animation you choose from four checkboxes below. Options include Fly,
Shrink, Rotate, and Fade, in any combination. A Duration slider appears that lets you
choose how long the Outro will be.
 Intro & Outro: Animation is automatically created to bring each tile onscreen and then
send each tile offscreen, according to the types of animation you choose from four
checkboxes below. Options include Fly, Shrink, Rotate, and Fade, in any combination.
A Duration slider appears that lets you choose how long the Intro and Outro will be.
 Fly Animation: Lets you choose a direction for tiles to fly in from and fly out to.
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 Shrink Animation: Lets you choose a method of shrinking out or in when the Fly
Progress slider is animated.
 Fly Progress: (manual key framing only) A slider that, when animated, lets you fly a tile
into or out of the frame. A value of 0.000 positions the tile in its default grid position.
A value of 1.000 positions the tile entirely off screen.
 Shrink Progress: (manual key framing only) A slider that, when animated, lets you shrink
a tile down to nothing or up to the current size. A value of 0.000 sizes the tile at its
largest state. A value of 1.000 shrinks the tile to nothing.
 Rotate Progress: (manual key framing only) A slider that, when animated, lets you
fly a tile into or out of the frame. A value of 0.000 positions the tile in its default grid
position. A value of 1.000 positions the tile entirely off screen.
 Fade Progress: (manual key framing only) A slider that, when animated, lets you fly
a tile into or out of the frame. A value of 0.000 positions the tile in its default grid
position. A value of 1.000 positions the tile entirely off screen.

Easing & Blur
These controls appear in Tiles mode. They let you adjust the easing of the tile animation
created in the previous group of controls.
 Motion and Size Ease: These controls set the curve used for simulated momentum in
animating the Tile Position and Size keyframes of the tiles.
– None: No curves are applied. The animation snaps immediately from

keyframe to keyframe.
– Linear: No easing curves are applied, motion is neither accelerated or decelerated.
– In: The animation curve starts slower and ends faster.
– Out: The animation curve starts faster and ends slower.
– In & Out: The animation curve starts slower, accelerates in the middle, and slows

down at the end.
 Animation Effects Ease: These controls set the curve used for simulated momentum in
animating the Tile Animation keyframes of the tiles.
– None: No curves are applied. The animation snaps immediately from

keyframe to keyframe.
– In: The animation curve starts slower and ends faster.
– Out: The animation curve starts faster and ends slower.
– In & Out: The animation curve starts slower, accelerates in the middle, and slows

down again at the end.
 Ease Amount: The relative strength of the animation curve in speeding up and slowing
down. The values range from 0.000 to 1.000
 Motion Blur: This slider controls the amount of motion blur added to the animation, in
order to make it smoother and more organic looking. The values range from 0.000 (no
motion blur), to 1.000 (maximum motion blur).

Global Blend
 Blend: This slider controls the overall opacity of the entire Video Collage effect. The
values range from 0.000 (completely transparent) to 1.000 (completely opaque).
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3D Keyer (Resolve FX Key)
Based on the 3D Qualifier in the Color page, the 3D Keyer offers a fast, simple way of pulling a
key to isolate a range of color in the image by dragging your mouse pointer over the parts of
the image you want to key. Each time you drag over the image you add to or subtract from the
cloud of values you’re carving out of a three-dimensional representation of all available colors;
you don’t see this representation, but this “under the hood” functionality is what gives the 3D
Keyer its name.

TIP: If you’re looking to isolate a range of luma values in the image, you should use the
HSL or Luma keyer.

The 3D Keyer is a good one to start with if you’re trying to key a blue screen or green screen
background. Its interface of dragging the mouse pointer over the screen color you want to
remove, coupled with its high quality and extreme specificity, makes it a fast and accurate tool
to use in a variety of circumstances. The 3D Keyer’s greatest strength is the speed with which
you can sample areas of the picture to extract from the final key. However, this can also be a
weakness if your initial samples aren’t giving you satisfactory results because, unlike the Delta
Keyer in the Fusion page, there aren’t many ways to fine-tune the key as it’s being generated.
On the other hand, for well-lit subjects you want to key, two or three samples is all you need.

General
The top set of controls allows you to set up the 3D Keyer for the initial sampling.
 Colorspace: This pop-up menu lets you choose whether you’re sampling colors in YUV
colorspace or HSL colorspace. YUV is the default, but if you find you’re not getting
satisfactory results, you can reset the 3D Keyer and switch to HSL to see if that works
any better.
 Softness: A single parameter lets you adjust the overall softness of the matte created
by the 3D Keyer. The default value is 50. Raising this value increases matte softness,
lowering it decreases matte softness.
 Despill: If you’re using the 3D Keyer to pull a blue or green screen key to create
transparency, this checkbox lets you turn on an automatic color correction that
eliminates blue or green spill from the image while retaining the image’s original color.
 Show Paths: A checkbox that lets you turn the visibility of the lines you’re drawing to
sample the image on and off. Turning lines off does not affect the key in any way.

Selection Range Controls
The Selection Range buttons in the Inspector let you define a key by sampling pixels in the
Viewer with the mouse pointer.

3D Keyer Selection Range controls
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 Sample Eyedropper: This is the first control you use whenever sampling the image. It
defines the initial range of the keyer; you must use this tool before any of the others.
In the Edit page, the Timeline Viewer Overlay must be set to Open FX. Clicking once
with this tool selects a single pixel value, while clicking and dragging selects a range of
image values that add together.

3D Sample Picker button

 Add/Subtract Color Range: These two controls let you add samples to, or subtract
them from, the currently selected screen color range that defines the core of the key.
As with the eyedropper, you can drag over a range of colors.

Add and Subtract
Color Range buttons

 Invert: Inverts the sampled screen color to become opaque, and areas not sampled
transparent.
 Reset: Resets all the sampled colors while retaining the general control settings.

Matte Finesse
You may find that sampling the screen color is not enough to overcome some problems. Issues
such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte
Finesse controls. These controls filter the output of the Keyer and are adjustments that are
made to the matte itself, so they may work well in some instances and poorly in others,
depending on what you’re trying to do.
 Denoise: Denoise provides a distinct way to selectively reduce the noise in a key,
getting rid of stray areas of screen color and softly filling “holes” in a matte.
 Clean Black: Clean Black is a specialized operation that eliminates noise (seen as
white speckling when viewing a high-contrast highlight) in the black area of a key that
omits the regions of the image you don’t want to isolate, and shrinks the key by making
the dark parts of a key darker the higher you raise this parameter, pushing dark gray
areas of the key toward black. The practical result is that raising Clean Black lets you
“fill holes” in the background portion of a key and erode translucent edges.
 Clean White: Clean White is another specialized operation that eliminates noise
(seen as black speckling when viewing a high-contrast highlight) in the white portion
of a key that include areas of the image you’re isolating, and expands the key by
making light parts of a key lighter the higher you raise this parameter, pushing light gray
areas of the key toward white. The practical result is that raising Clean White lets you
“fill holes” in the foreground portion of a key and grow translucent edges.
 Blur Radius: In small amounts, blurring a key does well to take the edge off problem
edges. However, blurring a key can also feather the edges of a key past the border of
the subject you’re keying, with the result being a visible “halo” around your subject,
depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the
default. With such a large maximum blur radius, combined with the capabilities that the
In/Out Ratio provides in customizing the direction of spread, you can turn some pretty
precarious mattes into surprisingly smooth and useful results.
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 In/Out Ratio: Controls whether the “Blur Radius” is applied equally to the inside
and outside of the edge of the matte (zero), applied only within the matte (negative
values), or applied only outside the matte (positive values). Using In/Out Ratio can help
eliminate fringing when using the Blur Radius parameter. However, you can also use
In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out
Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will
eliminate speckling by pushing small white bits of the matte toward black.
 Black Clip: Raising Black Clip applies a “lift” adjustment such that translucent areas of
the matte (gray areas when viewing a high-contrast highlight) are pushed toward black.
The range is 0 to 100, with 0 being the default setting.
 White Clip: Lowering White Clip applies a “gain” adjustment such that translucent areas
of the matte (gray areas when viewing a high-contrast highlight) are pushed toward
white. The range is 0 to 100, with 100 being the default setting.
 Operation: This menu lets you choose how you want to modify the alpha channel/key.
You can choose Shrink or Grow to dilate or erode the edges of the matte with great
accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a
ragged matte.
 Shape: This menu lets you choose how corners and angles in the edges of the key are
handled when you grow or shrink it. Circle is the default and results in even expansion
around the surface of the key that eventually averages all angles into a circular shape
if you use extreme radius settings. Square averages all angles into a more rectangular
shape if you use extreme radius settings. Diamond averages all angles into a diamond
shape if you use extreme radius settings.
 Radius: Adjusts how much to shrink, grow, open, or close the key.
 Inters: The Iterations slider alters the effect of the Operator Radius setting to create
more extreme adjustments.

Garbage Matte
These controls let you crop out unwanted things in the frame that are also being keyed, such as
lighting fixtures, boom microphones, tracking patches, etc.
 Matte Shape: You can choose either a Rectangle or Ellipse with which to crop around
the subject you’re keying. Choosing None turns off Garbage Matte. When a garbage
matte is enabled, the Open FX Overlay mode of the Viewer shows an on-screen
control for adjusting the shape and position of the garbage matte.
 Edge Softness: Lets you soften the edges. Defaults to 50; the range is 0 (no softening)
to 100 (maximum softening).
 Invert: Inverts the garbage matte.

Garbage Matte Location
These controls provide numeric parameters for adjusting and keyframing garbage mattes.
 Center X and Y: Lets you adjust and keyframe the position of a garbage matte.
 Bounding Width and Height: Lets you adjust the width and height of the
garbage matte.
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Output
The Output controls let you choose how the image is output, composited, and displayed in
the Viewer.
 Output: This menu offers three options for which channels are output from the effect.
– Alpha Highlight: Displays the transparent part of an alpha channel as gray

and the solid part of an alpha channel in full color.
– Alpha Hilight B/W: Displays the black and white alpha channel, which is

often helpful when sampling additional areas to key.
– Final Composite: The keyed image is displayed composited over any

video track below it.
 Use Alpha: A common control in many Resolve FX and 3rd party Open FX plug-ins;
this checkbox determines if the alpha channel is used when compositing over another
video track. It can be used instead of choosing RGB Only (Blank Alpha) from the Output
menu.
To use the 3D Keyer in the Edit page:
1 Apply the 3D Keyer to a green screen or blue screen clip that’s on a higher track than
the background.
2

In the Inspector, enable the Show Paths checkbox to view the sampled areas once
you begin.

3

From the Viewer Overlay menu in the lower-left corner of the Timeline Viewer, choose
Open FX Overlays.

4

In the Viewer, click and drag to draw a sampling stroke across the screen color you
want to remove.

5

The transparency immediately takes effect, showing the keyed subject against
whatever clip appears on the video track underneath it in the Timeline as a composite.
To see the matte you created for further adjustment, choose Alpha Highlight or Alpha
Highlight B/W from the Output drop-down menu.

6

If necessary, you can add or subtract areas from the screen color selection using the
add/subtract Color range controls. Alternatively, with the default Sample eyedropper
selected, you can hold down Shift to add to the screen color selection or hold down
the Option key to remove from the screen color selection.

Ordinarily, it’s a good idea not to select more than two or three times. If you make too many
selections in the image, the result can be a key with hard, jagged edges that can sometimes be
more difficult to adjust later on.

HSL Keyer (Resolve FX Key)
Based on the HSL Qualifier in the Color page, the HSL Keyer is a general-purpose keyer that
uses three color components, hue, saturation, and luma, to define a key. In many instances, the
HSL Keyer is not as immediately accurate as the 3D Keyer and will include a broader portion of
the image for any given sample. On the other hand, if the 3D Keyer is not giving you satisfactory
results for a particular shot, the HSL Keyer can sometimes do a better job. The HSL Keyer also
gives you the option of disabling color components that you don’t want to contribute to the final
key. You can pull a saturation-only key, or a hue-only key, for instances where that may solve
the issue at hand.
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The most straightforward way to use any keyer is to sample the image in the Viewer. When you
sample one or more pixels, the Hue, Saturation, and Luma values are analyzed and set different
ranges. There are several eyedropper controls available to sample color and soften the
selection.

Selection Range Controls
The Selection Range buttons in the Inspector let you define a key by sampling and softening
pixels in the Viewer with the mouse pointer.

HSL Keyer Color Range controls

 Sample Eyedropper: This is the first control you use whenever sampling the image.
It defines the initial range of the qualification; you must use this tool before any of
the others. Clicking once with this tool selects a single pixel value, while clicking and
dragging selects a range of image values that add together.
 Add/Subtract Color Range: These two controls let you add areas of the image to, or
subtract them from, the currently selected inner range of values that define the core of
the key. As with the eyedropper, you can click on single pixels or drag over a range of
color.
 Add/Subtract Softness: These two controls let you redefine the softness that
transitions from the inner range of the key, falling off towards the outer edge of the
key. Like the other sampling controls, you can click on single pixels or drag over a
range of color.
 Invert: Inverts the sampled color to become opaque, and areas not
sampled become transparent.
 Reset: Resets all the sampled colors while retaining the general control settings.

Keyer Options
One of the HSL Keyer’s strengths, and one of its most underutilized features, is that you can
enable or disable each of the three HSL components using the Hue, Sat, and Lum checkboxes.
This lets you ignore specific color components while focusing on others that may be more
important. For example, if you’re trying to key the saturated parts of an image, regardless of the
hue or brightness, you can turn off Hue and Lum so that only Sat is used to sample it.

HSL Keyer options
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Matte Finesse
You may find that sampling the screen color is not enough to overcome some problems. Issues
such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte
Finesse controls. These controls filter the output of the Keyer and are adjustments that are
made to the matte itself, so they may work well in some instances and poorly in others,
depending on what you’re trying to do.
 Denoise: Denoise provides a distinct way to selectively reduce the noise in a key,
getting rid of stray areas of screen color and softly filling “holes” in a matte.
 Clean Black: Clean Black is a specialized operation that eliminates noise (seen as white
speckling when viewing a high-contrast highlight) in the black area of a key that omits
the regions of the image you don’t want to isolate, and shrinks the key by making the
dark parts of a key darker the higher you raise this parameter, pushing dark gray areas
of the key toward black. The practical result is that raising Clean Black lets you “fill
holes” in the background portion of a key and erode translucent edges.
 Clean White: Clean White is another specialized operation that eliminates noise (seen
as black speckling when viewing a high-contrast highlight) in the white portion of a key
that include areas of the image you’re isolating, and expands the key by making light
parts of a key lighter the higher you raise this parameter, pushing light gray areas of the
key toward white. The practical result is that raising Clean White lets you “fill holes” in
the foreground portion of a key and grow translucent edges.
 Blur Radius: In small amounts, blurring a key does well to take the edge off problem
edges. However, blurring a key can also feather the edges of a key past the border
of the subject you’re keying, with the result being a visible “halo” around your subject
depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the
default. With such a large maximum blur radius, combined with the capabilities that the
In/Out Ratio provides in customizing the direction of spread, you can turn some pretty
precarious mattes into surprisingly smooth and useful results.
 In/Out Ratio: Controls whether the “Blur Radius” is applied equally to the inside
and outside of the edge of the matte (zero), applied only within the matte (negative
values), or applied only outside the matte (positive values). Using In/Out Ratio can help
eliminate fringing when using the Blur Radius parameter. However, you can also use
In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out
Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will
eliminate speckling by pushing small white bits of the matte toward black.
 Black Clip: Raising Black Clip applies a “lift” adjustment such that translucent areas of
the matte (gray areas when viewing a high-contrast highlight) are pushed toward black.
The range is 0 to 100, with 0 being the default setting.
 White Clip: Lowering White Clip applies a “gain” adjustment such that translucent areas
of the matte (gray areas when viewing a high-contrast highlight) are pushed toward
white. The range is 0 to 100, with 100 being the default setting.
 Operation: This menu lets you choose how you want to modify the alpha channel/key.
You can choose Shrink or Grow to dilate or erode the edges of the matte with great
accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a
ragged matte.
 Shape: This menu lets you choose how corners and angles in the edges of the key are
handled when you grow or shrink it. Circle is the default and results in even expansion
around the surface of the key that eventually averages all angles into a circular shape
if you use extreme radius settings. Square averages all angles into a more rectangular
shape if you use extreme radius settings. Diamond averages all angles into a diamond
shape if you use extreme radius settings.
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 Radius: Adjusts how much to shrink, grow, open, or close the key.
 Inters: The Iterations slider alters the effect of the Operator Radius setting to create
more extreme adjustments.

Garbage Matte
These controls let you crop out unwanted things in the frame that are also being keyed, such as
lighting fixtures, boom microphones, tracking patches, etc.
 Matte Shape: You can choose either a Rectangle or Ellipse with which to crop around
the subject you’re keying. Choosing None turns off Garbage Matte. When a garbage
matte is enabled, the Open FX Overlay mode of the Viewer shows an on-screen
control for adjusting the shape and position of the garbage matte.
 Edge Softness: Lets you soften the edges. Defaults to 50; the range is
0 (no softening) to 100 (maximum softening).
 Invert: Inverts the garbage matte.

Garbage Matte Location
These controls provide numeric parameters for adjusting and keyframing garbage mattes.
 Center X and Y: Lets you adjust and keyframe the position of a garbage matte.
 Bounding Width and Height: Lets you adjust the width and height of
the garbage matte.

Output
The Output controls let you choose how the image is output, composited, and displayed in
the Viewer.
 Output: This menu offers three options for which channels are output from the effect.
– Alpha Highlight: Displays the transparent part of an alpha channel as gray and the

solid part of an alpha channel in full color.
– Alpha Hilight B/W: Displays the black and white alpha channel, which is often helpful

when sampling additional areas to key.
– Final Composite: The keyed image is displayed composited over any

video track below it.
 Use Alpha: A common control in many Resolve FX and 3rd party Open FX plug-ins;
this checkbox determines if the alpha channel is used when compositing over another
video track. It can be used instead of choosing RGB Only (Blank Alpha) from the Output
menu.
To use the HSL Keyer in the Edit page:
1 Apply the HSL Keyer to a clip on video track 2 or higher.
2

From the Viewer Overlay menu in the lower-left corner of the Timeline Viewer choose
Open FX Overlays.

3

Click and drag across the screen color you want to remove.

4

The transparency immediately takes effect, showing the keyed subject against
whatever clip appears on the video track underneath it in the Timeline as a composite.
To see the matte you created for further adjustment, choose Alpha Highlight or Alpha
Highlight B/W from the Output drop-down menu.
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5

To add or subtract from the matte, click the plus or minus Color Range control, and click
or drag across the portion of the keyed image.

6

To add softness to the outer range of the key you’re creating, click the plus Softness
control and then click or drag across the portion of the image you’d like to include as a
soft edge.

Luma Keyer (Resolve FX Key)
Based on the Luma Qualifier in the Color page, the Luma Keyer pulls a key from the Luma
channel. It’s identical to the HSL Keyer with H and S turned off. Although not often used by
itself, the Luma Keyer can produce very dramatic effects when used in conjunction with
Composite modes.

Selection Range Controls
The Selection Range buttons in the Inspector let you define a key by sampling pixels in the
Viewer with the mouse pointer.

Luma Keyer Selection Range controls

 Sample Eyedropper: The first control you use whenever sampling the image. It defines
the initial range of the keyer; you must use this tool before any of the others. In the Edit
page, the Timeline Viewer Overlay must be set to Open FX. Clicking once with this
tool selects a single pixel value, while clicking and dragging selects a range of image
values that add together.
 Add/Subtract Luma Range: These two controls let you add areas of the image to, or
subtract them from, the currently selected Luma range that defines the core of the key.
As with the eyedropper, you can click on single pixels, or drag over a range of color.
 Add/Subtract Softness: These two controls let you redefine the softness that
transitions from the inner range of the key, falling off towards the outer edge of
the key. Like the other keying controls, you can click on single pixels, or drag over a
range of color.
 Invert: Inverts the sampled luma range to become opaque, and areas not sampled
become transparent.
 Reset: Resets the sampled luma range while retaining the Output control settings.

Matte Finesse
You may find that sampling the screen color is not enough to overcome some problems. Issues
such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte
Finesse controls. These controls filter the output of the Keyer and are adjustments that are
made to the matte itself, so they may work well in some instances and poorly in others,
depending on what you’re trying to do.
 Denoise: Denoise provides a distinct way to selectively reduce the noise in a key,
getting rid of stray areas of screen color and softly filling “holes” in a matte.
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 Clean Black: Clean Black is a specialized operation that eliminates noise (seen as white
speckling when viewing a high-contrast highlight) in the black area of a key that omits
the regions of the image you don’t want to isolate, and shrinks the key by making the
dark parts of a key darker the higher you raise this parameter, pushing dark gray areas
of the key toward black. The practical result is that raising Clean Black lets you “fill
holes” in the background portion of a key and erode translucent edges.
 Clean White: Clean White is another specialized operation that eliminates noise (seen
as black speckling when viewing a high-contrast highlight) in the white portion of a key
that include areas of the image you’re isolating, and expands the key by making light
parts of a key lighter the higher you raise this parameter, pushing light gray areas of the
key toward white. The practical result is that raising Clean White lets you “fill holes” in
the foreground portion of a key and grow translucent edges.
 Blur Radius: In small amounts, blurring a key does well to take the edge off problem
edges. However, blurring a key can also feather the edges of a key past the border
of the subject you’re keying, with the result being a visible “halo” around your subject
depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the
default. With such a large maximum blur radius, combined with the capabilities that the
In/Out Ratio provides in customizing the direction of spread, you can turn some pretty
precarious mattes into surprisingly smooth and useful results.
 In/Out Ratio: Controls whether the “Blur Radius” is applied equally to the inside
and outside of the edge of the matte (zero), applied only within the matte (negative
values), or applied only outside the matte (positive values). Using In/Out Ratio can help
eliminate fringing when using the Blur Radius parameter. However, you can also use
In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out
Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will
eliminate speckling by pushing small white bits of the matte toward black.
 Black Clip: Raising Black Clip applies a “lift” adjustment such that translucent areas of
the matte (gray areas when viewing a high-contrast highlight) are pushed toward black.
The range is 0 to 100, with 0 being the default setting.
 White Clip: Lowering White Clip applies a “gain” adjustment such that translucent areas
of the matte (gray areas when viewing a high-contrast highlight) are pushed toward
white. The range is 0 to 100, with 100 being the default setting.
 Operation: This menu lets you choose how you want to modify the alpha channel/key.
You can choose Shrink or Grow to dilate or erode the edges of the matte with great
accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a
ragged matte.
 Shape: This menu lets you choose how corners and angles in the edges of the key are
handled when you grow or shrink it. Circle is the default and results in even expansion
around the surface of the key that eventually averages all angles into a circular shape
if you use extreme radius settings. Square averages all angles into a more rectangular
shape if you use extreme radius settings. Diamond averages all angles into a diamond
shape if you use extreme radius settings.
 Radius: Adjusts how much to shrink, grow, open, or close the key.
 Inters: The Iterations slider alters the effect of the Operator Radius setting to create
more extreme adjustments.

Garbage Matte
These controls let you crop out unwanted things in the frame that are also being keyed, such as
lighting fixtures, boom microphones, tracking patches, etc.
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 Matte Shape: You can choose either a Rectangle or Ellipse with which to crop around
the subject you’re keying. Choosing None turns off Garbage Matte. When a garbage
matte is enabled, the Open FX Overlay mode of the Viewer shows an on-screen
control for adjusting the shape and position of the garbage matte.
 Edge Softness: Lets you soften the edges. Defaults to 50, the range is
0 (no softening) to 100 (maximum softening).
 Invert: Inverts the garbage matte.

Garbage Matte Location
These controls provide numeric parameters for adjusting and keyframing garbage mattes.
 Center X and Y: Lets you adjust and keyframe the position of a garbage matte.
 Bounding Width and Height: Lets you adjust the width and height of
the garbage matte.

Output
The Output controls let you choose how the image is output, composited, and displayed in
the Viewer.
 Output: This menu offers three options for which channels are output from the effect.
– Alpha Highlight: Displays the transparent part of an alpha channel as gray and the

solid part of an alpha channel in full color.
– Alpha Hilight B/W: Displays the black and white alpha channel, which is often helpful

when sampling additional areas to key.
– Final Composite: The keyed image is displayed composited over any

video track below it.
 Use Alpha: A common control in many Resolve FX and 3rd party Open FX plug-ins;
this checkbox determines if the alpha channel is used when compositing over another
video track. It can be used instead of choosing RGB Only (Blank Alpha) from the Output
menu.
To use the Luma Keyer in the Edit page to key a subject:
1 Apply the Luma Keyer to a clip on video track 2 or higher.
2

From the Viewer Overlay menu in the lower-left corner of the Timeline Viewer choose
Open FX Overlays.

3

Either click a pixel in a bright or dark part of the image you want to key out, or click and
drag across a range of pixels within that subject.

4

The transparency immediately takes effect, showing the keyed subject against
whatever clip appears on the video track underneath it in the Timeline as a composite.
To see the matte you created for further adjustment, choose Alpha Highlight or Alpha
Highlight B/W from the Output drop-down menu.

5

To add or subtract from the matte, click the plus or minus Luma Range buttons, and
then click or drag across the portion of the keyed image.

6

To add softness to the outer range of the key you’re creating, click the plus Softness
button and then click or drag across the portion of the image you’d like to include as a
soft edge.
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Smear (Resolve FX Temporal, Studio Only)
The Smear effect simulates motion blur in a clip by blending a user-definable number of frames.
 Frames Either Side: Determines the number of frames that are blended on either side
of the current frame. For instance, entering a value of 2 uses two frames before and
two frames after the current frame to create the effect.
 Luma Threshold: This control sets how bright a pixel must be to contribute to the smear
effect. A lower value causes only darker pixels to be smeared. A higher value includes
brighter pixels in the effect.
 Chroma Threshold: This control sets how saturated a pixel must be to contribute to the
smear effect. A lower value causes only low saturated pixels to be smeared. A higher
value includes more saturated pixels in the effect.

Motion Trails (Resolve FX Temporal, Studio Only)
The Motion Trails effect copies the image to create ghost-like trails on moving images.
This effect can be used to simulate clips shot with long shutter speeds and analog video
feedback effects.

General
The first two sliders control the number and strength of the copied frames.
 Trail Length: Determines the number of copies that are used to create the trails.
 Dropoff: Sets the fade applied to each copied frame. The Dropoff value is
compounded. For instance, using a value of .5 applies 50% opacity to the first copy,
25% to the second, 12.5% to the third, and so on.

Advanced Options
The advanced options are used to control how the overlapping copied frames are blended.
 Composite Gamma: The Composite Gamma menu provides four options for controlling
the brightness of the overlapping frames.
– Timeline: Uses the Timeline Color Space setting in the Project Settings to control

the overlapping brightness. This setting, by default, is Rec. 709, Gamma 2.4.
– Rec. 709: Uses a Rec. 709 color space with Gamma 2.2 to control the

overlapping brightness.
– Linear: Uses Linear Gamma often producing much stronger highlights.
– Custom: Provides a custom gamma slider which defaults to Gamma of 2.4. Setting

this to a value of 1.0 is the same as setting the menu to Linear.
 Input Alpha: There are three choices in the Input Alpha menu that determine how the
alpha channel is used for blending the frames. All three options assume there is an
alpha channel present on the clip that has the Motion Trail applied.
– Ignore: This is the default option and will cause the alpha channel to be ignored.

Disabling the Use Alpha checkbox when Ignore is selected will cause the alpha to
act as a stencil effect for the trails.
– Onto Current: Uses the alpha channel for the trails, but instead of compositing it

over the lower video track, the trails are composited over themselves using the
current frame.
– Onto Black (Alpha Out): This option uses the alpha channel for the trails

and compositing over the lower video track, assuming the Use Alpha checkbox
is enabled.
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Move Trail
This group of controls determines the offset, direction, size, and rotation of the copies.
Adjustment amounts are applied as offsets from one copy to the next. For instance, if rotation is
set to 5 degrees, the first trail copy is rotated 5 degrees, the second trail copy is rotated
10 degrees, the third copy is rotated 15 degrees, and so on.
 Pan: Adjusts the offset of the trail copies from the original image.
 Pan Angle: Changes the angle at which the trails are offset from the original image.
The values are shown in degrees.
 Zoom: Adjust a scale adjustment, successively, to each copy.
 Rotate: Applies an angle of rotation, successively to each copy.
 Reuse Current Frame: When this checkbox is disabled (the default), each copy uses
the frame after the copy before it. For instance, the first copy is the current frame -1,
and the second copy is the current frame -2. When this checkbox is enabled, all copies
use the same frame as the current frame in the clip.
 Border Type: This menu determines how edges of the frame are handled when the
copies are scaled smaller than the timeline resolution.
– Black: The area outside the image is set to black.
– Soften: This control blends the edges of the rectangular frame borders to give the

images a more organic appearance.
– Replicate: Duplicates the outermost pixels along the edge of the image. The pixels

are stretched out from each side to reach the timeline resolution boundary.
– Reflect: The image is flipped and flopped to create a mirrored image that extends to

the timeline resolution frame boundary.
– Wrap-Around: Duplicates the image to create a video wall effect, used to fill in the

space to the timeline resolution frame boundary.

Global Blend:
 Blend: The Blend slider controls the mix between the effected image and
the original image.
 Use Alpha: If an alpha channel exists in the image, this checkbox determines if the
alpha channel is used when compositing over another video track. When using
an image with an alpha channel, this checkbox must be enabled, and the Input
Alpha menu must be set to Onto Black (alpha out) for the trails to be composited over a
lower video track.

Noise Reduction (Resolve FX Revival, Studio Only)
Based on the Noise Reduction controls in the Color page, the Resolve FX Noise Reduction is
divided into two types of GPU-accelerated noise reduction designed to subdue noise in
problematic clips. Both methods of noise reduction can be used separately or together, in
varying amounts depending on the needs of the particular material you’re working on.

Temporal NR Controls
The Temporal NR controls analyze images across multiple frames to isolate noise from detail.
Motion estimation settings let you exclude moving subjects from this operation to prevent
unwanted motion artifacts.
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 Frames Either Side: The number of frames on either side of the current frame that
you want averaged to separate detail from the noise. You can choose between 0 and
5 frames. 0 applies no frame averaging; higher values apply more frame averaging,
at the expense of being significantly more computationally intensive. A higher frame
setting may yield a better analysis, but may also yield unwanted artifacts if there are
fast-moving images in the frame. A value of 1 may yield better results for fast-moving
images. If you need to use higher frame values, but see artifacts, you can also try
adjusting the Motion Threshold to fix the issue.
 Motion Est. Type: Picks the method DaVinci Resolve uses to detect motion in the
image. The default, Faster, is less processor intensive, but less accurate. Choosing
Better can effectively exclude motion more accurately, but is more processor intensive.
None lets you disable motion estimation altogether, resulting in the application of
Temporal NR to the entire image.
 Motion Range: Three settings, Small, Medium, and Large, let you set the speed of
motion that Motion Estimation should expect to exclude. A Small setting assumes
slow-moving subjects with little or no motion blur, allowing Temporal NR to affect more
of the image at a given Motion Threshold setting. A Large setting assumes fast motion
with blur occupying a larger area of the image, which excludes more of the image from
Temporal NR at the same Motion Threshold setting. Choose the setting that gives you
the best compromise between reducing noise and the introduction of motion artifacts
when adjusting the Motion Threshold parameter.

Temporal Threshold Controls
The Temporal Threshold parameters allow you to control which image characteristics get more
or less noise reduction.
 Luma Threshold: Lets you determine how much or how little Temporal NR to apply
to the luma component of the image. The range is 0–100, where 0 applies no noise
reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine
detail from the image.
 Chroma Threshold: Determines how much Temporal NR os applied to the chroma
component of the image. The range is 0–100, where 0 applies no noise reduction at all,
and 100 is the maximum amount. Too high a setting may eliminate fine color detail from
the image. However, you may find you can raise the Chroma Threshold higher than the
Luma Threshold with less noticeable artifacting.
 Gang Luma Chroma: Ordinarily, the Luma and Chroma Threshold parameters are
ganged together so that adjusting one adjusts both. However, disabling this checkbox
ungangs these parameters, allowing you to adjust different noise reduction amounts to
each component of the image, depending on where the noise happens to be worst.
 Motion: Defines the threshold separating which moving pixels are in motion (above
this threshold) versus which moving pixels are static (below this threshold). Using
Motion Estimation, Temporal NR is not applied to regions of the image that fall above
this threshold, to prevent motion artifacts by not applying frame-averaging to parts of
the image that are in motion. Lower values omit more of the image from Temporal NR
by considering more subtle movements. Higher values apply Temporal NR to more
of the image by requiring faster motion for exclusion. You can choose between 0 and
100, where 0 applies Temporal NR to no pixels, and 100 applies Temporal NR to all
pixels. The default value is 50, which is a suitable compromise for many clips. Be aware
that if you set too high a Motion Threshold, you may see artifacts in moving parts of
the image.
 Blend: Lets you dissolve between the image as it’s being affected by the Temporal NR
parameters (at 0.0) and the image with no noise reduction (100.0). This parameter lets
you easily split the difference when using aggressive temporal noise reduction.
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Spatial NR Controls
The Spatial NR controls let you smooth out regions of high-frequency noise throughout the
image, while attempting to avoid softening by preserving detail. It’s effective for reducing noise
that Temporal NR can’t.
 Mode: The Mode drop-down menu lets you switch Spatial NR between three different
algorithms. All three modes of operation use the same controls, so you can switch
between modes using the same settings to compare your results.
 Faster: Uses a computationally lightweight method of noise reduction that’s good at
lower settings, but may produce artifacts when applied at higher values.
 Better: Switches the Spatial NR controls to use a higher quality algorithm that produces
greatly superior results to Faster, at the expense of being more processor intensive to
render and not allowing you to decouple the Luma and Chroma Threshold sliders for
individual adjustments to each color component.
 Enhanced: Does a significantly better job preserving image sharpness and detail when
raising the Spatial Threshold sliders to eliminate noise. This improvement is particularly
apparent when the Spatial Threshold sliders are raised to high values (what constitutes
“high” varies with the image you’re working on). At lower values, the improvement may
be more subtle when compared to the “Better” mode, which is less processor intensive
than the computationally expensive “Enhanced” setting. Additionally, “Enhanced” lets
you decouple the Luma and Chroma threshold sliders so you can add different noise
reduction amounts to each color component, as the image requires.
 Radius: Options include Large, Medium, and Small. A smaller radius offers greater
real-time performance and can provide good quality when using low Luma and Chroma
Threshold values. However, you may see more aliasing in regions of detail when using
low NR Threshold values.
Setting Radius to be progressively larger results in higher quality within areas of greater
visual detail at high Luma and Chroma Threshold values, at the expense of slower
performance. An NR Radius of Medium should provide suitable quality for most images
when using medium NR Threshold settings. As with many operations, there’s an
adjustable tradeoff between quality and speed.

Spatial Threshold Controls
The Spatial Threshold parameters allow you to control which image characteristics get more or
less noise reduction.
 Luma: Lets you determine how much or how little noise reduction to apply to the
luma component of the image. The range is 0–100, where 0 applies no noise reduction
at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from
the image.
 Chroma: Lets you determine how much or how little noise reduction to apply to the
chroma component of the image by smoothing out regions of high-frequency noise
while attempting to preserve the sharpness of significant edge details. The range is
0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount.
Too high a setting may eliminate fine color detail from the image. However, you may
find you can raise the Chroma Threshold higher than the Luma Threshold with less
noticeable artifacting.
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 Gang Luma Chroma: Ordinarily, the Luma and Chroma Threshold parameters are
ganged together so that adjusting one adjusts both. However, you can ungang these
parameters to adjust different amounts of noise reduction to each component of the
image. For example, if an image softens too much at a certain level of noise reduction,
but you find more color speckling than luma noise, you can lower the Luma Threshold
to preserve detail while raising the Chroma Threshold to eliminate color noise.
 Blend: Lets you dissolve between the image as it’s being affected by the Spatial NR
parameters (at 0.0) and the image with no noise reduction (100.0). This parameter lets
you easily split the difference when using aggressive spatial noise reduction.

Global Blend
 Blend: Lets you dissolve between the image with no noise reduction (1.0) and the
image with both Spatial NR and Temporal NR at their current settings (0.0).

Using Noise Reduction
The following procedure suggests a method of using the Noise Reduction (NR) parameters to
achieve a controlled result.
Applying noise reduction to an image:
1 Enable Temporal NR by choosing 1 to 5 frames from the Number of Frames pop‑up
menu. Keep in mind that more frames dramatically increase the render time of
this effect, while it may or may not significantly improve the result, depending on
your material.
2

Choose options from the Motion Est. Type and Motion Range drop-down menus
corresponding to how much motion is in the image. If there’s a lot of motion, you may
need to choose Better and Large. If there’s not very much motion, lesser settings
may suffice.

3

With Luma and Chroma Threshold linked, slowly raise either parameter until you
just start to see a reduction in noise within nonmoving areas. Then make smaller
adjustments to determine the maximum amount you can add without creating artifacts
or overly softening detail.

4

If there’s obviously more chroma than luma noise in the image, you can disable Luma/
Chroma linking at a satisfactory level of luma noise reduction, and then raise the
Chroma Threshold to address color speckling in the picture.

5

Suppose you’re not satisfied with the tradeoff between the maximum possible
threshold of noise reduction and the prevention of motion artifacts. In that case, you
may want to adjust the Motion Threshold setting, lowering it to omit more of the motion
from the noise reduction operation, or raising it to include more motion. If you’re still not
satisfied, you can also try better Motion Est. Type and Motion Range settings.
Keep in mind that the strength of Temporal NR is to reduce noise in unmoving parts of
the image. When you’ve achieved the best tradeoff between noise reduction in the still
areas and avoidance of motion artifacts in the moving areas of the image, it’s time to
turn to Spatial NR to further eliminate noise throughout the rest of the picture.

6

Enable Spatial NR by raising either the Luma or Chroma Threshold parameters, which
are linked by default, until you strike a suitable balance between the reduction of noise
and an unwanted increase in image softness.

7

It’s recommended to choose the Enhanced option from the Spatial NR mode pop-up,
as it will yield the best possible results. However, this can be processor-intensive,
so if you need better real-time performance, you can switch the mode to Faster and
compare results.
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8

If there’s obviously more chroma than luma noise in the image, you can disable Luma/
Chroma linking at a satisfactory level of luma noise reduction, and then raise the
Chroma Threshold to apply more aggressive Spatial NR to address color speckling in
the picture.

9

If you’ve had to use a high Spatial NR Luma or Chroma Threshold setting to reduce
noise visibly, and areas of detail look a bit chunky or aliased, you can choose a larger
setting from the Radius pop-up menu to enable a more detailed analysis of the scene.
This will result in higher visual quality, but larger NR Radius settings are more
processor-intensive and may reduce real-time performance if you don’t have adequate
GPU resources available to your system.

10 If you’ve found suitable noise reduction settings, but the result is too aggressive and
makes the image appear too processed, you can try raising the Spatial NR and/or
Temporal NR Blend parameters to fade between the noise reduction added by each
set of controls, and the image as it was before you added noise reduction.

Try Applying Temporal NR First, then Applying Spatial NR
Because Temporal NR analyzes multiple frames for its noise isolation, it tends to be better at
preserving detail accurately in regions of the image where there’s little motion. If you try
applying Temporal NR first and get a successful result, even if only in part of the image, you
may reduce how much Spatial NR you have to apply, thus improving the overall quality of your
final result.
Keep in mind that while Temporal NR does a great job in unmoving parts of an image but is less
effective when dealing with subjects in motion, Spatial NR can reduce noise everywhere in the
frame falling below its threshold, even when there’s motion. Ultimately, a combination of the two
is almost always going to be a winning combination.

Spatial NR Radius, How Large Should You Go?
Larger NR Radius settings can dramatically improve the quality of high-detail regions in shots
where you’re using aggressive Spatial noise reduction, but it’s not necessary to always jump to
the large Radius setting, which provides the highest precision. In many cases, when evaluating
an image that you’re applying noise reduction to, you may not be able to perceive the additional
quality. You’ll waste processing time on an unnecessary level of correction.
It’s a good idea to evaluate the full-frame image on a large enough display to see the noise
you’re working on within the viewing context of the intended audience. Zooming really far into a
clip while applying noise reduction may encourage you to use higher quality settings than are
necessary because an excessively enlarged detail of an image lets you see subtle changes that
you wouldn’t notice at actual size.

Transform (Resolve FX Transform)
The Transform Resolve FX adds considerable control over the standard transforms in the
Inspector’s Sizing or the Color page Sizing Palette. This effect includes all the standard Position,
Tilt, Zoom, and Rotate controls but adds corner pinning, two kinds of on-screen controls, motion
blur, and Edge behavior controls.

Chapter – 10

Resolve FX Improvements

271

General
 Control Mode: This drop-down menu includes three methods for controlling the
transforms. One is based on sliders in the Inspector while the other two are based on
manipulating the Viewer’s image.
– Sliders: Uses sliders and checkboxes in the Inspector to control the transforms. This

method has no Viewer overlays with which to control the position, scale, or rotation
but provides exact control using numeric values.
– Interactive-Canvas: Choosing this mode moves the controls from the Inspector to

the Timeline Viewer. The Viewer’s controls are shown as a bold white outline and
four vertices, one at each corner. You can drag on any part of the white outline
for stretching, squeezing, and corning pinning. Dragging the center of the image
repositions the frame. The red subdivision overlays make it easy to create shearing
effects by dragging line segments to move two corners simultaneously.
– Interactive-Pins: Adjusting the image in this mode is done by manually placing

control points, called pins, in the timeline viewer. Adding one pin only gives you
position control. At least two points are required for scaling and rotation. Dragging
on one of the pins scales or rotates the image around the other pin. Using three pins,
you can create perspective distortions by dragging any one of the pins. You can add
up to four pins for unique corner pinning distortions.

TIP: You can Option-Click on a pin to remove it or use the Reset Canvas button to
remove all the pins.

Resolve FX Transform Interactive Canvas mode (Left) and Interactive Pin mode (Right)

Only one Control mode can be active at a time. For instance, you cannot make adjustments
with the sliders and then switch to one of the interactive methods. The sliders will be reset to
once a different method is selected. However, can you apply two Transform effects to a clip,
adjusting one with Sliders and the other using an interactive method.

Control Options
 Canvas Keyframe: Only displayed when the Control mode is set to Interactive-Canvas
or Interactive-Pins. The Canvas Keyframe has no control except for a keyframe button
allowing you to keyframe the changes you make in the Viewer.
 Reset Canvas: Resets any interactive changes made in the Viewer, and any keyframes
created from those changes.
 The following parameters are only displayed when the Control Mode is set to Sliders.
 Position X and Y: Moves the image within the frame, allowing pan and scan
adjustments to be made. X moves the image left or right, and Y moves the image
up or down.
 Zoom: Allows you to blow the image up or shrink it down.
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 Rotate: Rotates the image around the center.
 Flip Horizontal/Vertical: Two checkboxes let you flip the image in different dimensions.
– Flip Horizontal: Reverses the image along the X-axis, left to right.
– Flip Vertical: Reverses the clip along the Y-axis, turning it upside down.

 Width: Stretch or squeeze the image in one direction only.
 Height: Stretch or squeeze the image in one direction only.
 Pitch: Rotates the image toward or away from the camera along an axis running through
the center of the image, from left to right. Positive values push the top of the image
away and bring the bottom of the image forward. Negative values bring the top of the
image forward and push the bottom of the image away. Higher values stretch the image
more extremely.
 Yaw: Rotates the image toward or away from the camera along an axis running through
the center of the image from top to bottom. Positive values bring the left of the image
forward and push the right of the image away. Negative values push the left of the
image away and bring the right of the image forward. Higher values stretch the image
more extremely.

Advanced Options
 Edge Behavior: This menu determines how edges of the frame are handled when the
transforms are scaled smaller than the timeline resolution.
– Black: The area outside the transformed image is set to black.
– Reflect: The image is flipped and flopped to create a mirrored image, which extends

to the timeline resolution frame boundary.
– Wrap-Around: Duplicates the image to create a video wall effect, which is used to fill

in the space to the timeline resolution frame boundary.
– Replicate: Duplicates the outermost pixels along the edge of the image. The pixels

are stretched out from each side to reach the timeline resolution boundary.
 Motion Blur: Keyframing the transform so the frame moves rapidly will create a blurring
effect. The amount of the blur is controlled using the Motion Blur slider.

Global Blend
 Blend: Lets you dissolve between the image with no Transform applied and one with
the Transform fully applied.

False Color (Resolve FX Color, Studio Only)
False Color is a creative effect that can be used for replicating camera HUDs, infrared sensors,
and custom posterization looks by defining a set number of colors for the clip. The color set can
either match the False Color setting in a specific Blackmagic Design camera or be picked from
a list of creative style presets. The presets can be modified by setting the number of colors
used and defining the tonal range each color represents.
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Resolve FX False Color Thermal Preset and Legend

General
 Plugin Mode: This menu is used to switch between using a specific Blackmagic Design
Camera’s False Color setting or accessing creative presets. When Specific Camera
Model is chosen, the Camera Model section is displayed for selecting the camera
and settings you want to use. When Creative is chosen, the Color bands section is
displayed for choosing and customizing the preset.

Camera Model
The Camera Model controls are displayed when Specific Camera Model is chosen from the
Plugin Model menu. These menus allow you to match the False Color from a camera
configuration.
 Camera: Selects the exact Blackmagic Design camera sensor.
 Camera Mode: Selects the dynamic range setting.
 ISO Level: Sets the ISO or light sensitivity setting.

Color Bands
These controls are displayed when Creative is chosen from the Plugin Model menu. The Color
Bands group of controls are used to select and modify the appearance of the False
Color presets.
 Camera: Selects the exact Blackmagic Design camera sensor.
 Camera Mode: Selects the dynamic range setting.
 ISO Level: Sets the ISO or light sensitivity setting.

Preprocessing
This group of controls is used to apply tonal and blur processing to the image.
 Blur: Applies a blur filter to the False Color.
 Black Level: Increases or decreases the shadow range assigned to colors that fall
lower on the False Color legend.
 White Level: Increases or decreases the highlight range assigned to colors that fall
higher on the False Color legend.
 Gamma: Shifts the mid-tone range towards colors that fall lower or higher on the
False Color legend.
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Scale/Legend
This section is used to control the visibility and appearance of the False Color Legend.
The Legend is displayed to help viewers understand the color representation. Whenever you
apply False Color, the Legend is generated and displayed. When you modify a preset, the
Legend automatically updates to represent the new color scheme.
 Show Scale: Shows or hides the Legend on the left side of the frame.
 Show Values: Shows or hides numeric values on the Legend. These numeric values
represent different scales based on the Value Style menu.
 Show Labels: Shows or hides data point labels on the Legend. The labels identify
important data points along the tonal range, such as black clipping, white clipping,
and middle gray.
 Contrast: Increases or decreases the transparency of the Legend’s
background underlay.
 Value Detail: Increases or decreases the number of axis value labels
displayed on the Legend.
 Value Style: This menu includes three options for the scale used for the Legend’s
numeric values.
– Percentage: Uses a percentage scale for the Legend, going from 0% at the bottom

to 100% at the top.
– Hundredths: Uses a Hudrenths scale for the Legend, going from 0 at the bottom

to 100 at the top.
– Normalized: Uses a Normalized scale for the Legend, going from 0.0 at the bottom

to 1.0 at the top.

Global Blend
 Blend: Lets you dissolve between the image with no False Color applied (0.0) and the
image with False Color fully applied (1.0).

Improvements to Existing Resolve FX
There are also numerous improvements to previously existing Resolve FX.

Improved Object Removal (Resolve FX Revival, Studio Only)
The Object Removal effect has been improved to be more automatic when it’s applied to a
node in which you’re use a window, qualifier key, matte, or some other kind of key to isolate the
object to be removed. In this case, the node’s Use OFX Alpha option (seen in the contextual
menu when you right-click on the node) is automatically turned on, so the internal key is
automatically used.
Quality has also been improved. There’s better spatial positioning of the textures that are
generated to remove the object, and there’s better temporal consistency in the resulting clean
plate that’s created. Bottom line, the synthesized clean plate used to “fill the hole” where the
object you’re removing was is higher quality than before.
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Lastly, a new Scene Mode drop-down menu provides different methods of analyzing the scene,
for improving the analysis of how the area that needs to be replaced moves, to best determine
how to fill the hole left by the object being removed. Background analyzes the entire image
except for the object region. Boundary analyzes the boundary area surrounding the object
region. Object is for analyzing an object that moves with the background, like a sticker that’s on
a window while the camera moves.

Improved Dead Pixel Fixer (Resolve FX Revival, Studio Only)
The Dead Pixel Fixer has been significantly improved, with more ways of identifying and
eliminating not just dead pixels, but other kinds of larger blemishes in the frame of an image.
There are new ways of defining areas to fix, new modes with which to execute the fix, and new
fill methods and patch options for finessing the results of the fix.
In many respects, the Dead Pixel Fixer is similar to the Dust Buster, however the Dust Buster
effect is designed to repair transient bits of dust and dirt that only last for a frame or two,
whereas the Dead Pixel Fixer is designed to work on blemishes that are fixed in place for the
duration of a clip.

Dead Pixel Fixer
These top level controls let you choose how to draw patches with which to repair blemishes in
the frame, whether or not to show their on-screen controls, and how.
 Patch Style: There are three different kinds of patches you can draw to deal with
different kinds of blemishes in the frame.
– Draw Rect: Click and drag to place a rectangular patch of any size from one corner

to the opposite corner. Once drawn, you can click on any edge of the overlay and
drag to reposition it.
– Draw Ellipse: Click and drag to place an elliptical patch of any size from one corner

to the opposite corner. Once drawn, you can click on any edge of the overlay and
drag to reposition it.
– Place Patch: Lets you place small patches specifically for tiny details such as dead

pixels. When you choose this option, a New Patch Size slider appears that lets you
adjust the size of the patches you’re about to place prior to placing them. Once
drawn, you can click on the edge of any patch and drag to reposition it.
 New Patch Size: (only when Place Patch is selected) Lets you choose how large of a
patch to place using the Place Patch tool.
 Show Patches: This checkbox lets you show or hide the onscreen outline of every
patch in the Viewer.
 Hide During Interaction : Hides the onscreen outline of every patch in the Viewer while
you’re moving a patch; this makes it easier to see the effect of moving the patch on the
image, without the outline getting in the way.
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Patch Type
There are three methods you can use to attempt to fix the contents of a selected patch. When
drawing new patches, the currently selected Patch Type will determine what the next patch will
be. When you’ve selected an existing patch, changing the Patch Type will change how that
patch works.
 Spatial: Automatically fills the interior of the selected patch with pixels drawn from the
surroundings of the patch, using the Fill Method. This works well for small blemishes,
but for large blemishes a pattern might be discernible, which gives away the effect.
 Clone: Clone mode copies part of the image to fill a shape or patch placed over the
thing you want to remove. In this mode, clicking and dragging to place a Rect or Ellipse
over an imperfection is followed by a second click to place the sample region you want
to clone. Clicking once to place a Patch will be followed by a second click to place the
sample region. Selecting an existing shape or patch and choosing Clone lets you click
on the shape to position the clone region. The sample region is indicated by a dotted
shape that’s connected to the original shape.
 Blend Clone: Operates similarly to Clone mode, except the copied part of the image
that fills the Rect, Ellipse, or Patch is blended with the image to integrate it more softly.
 Fill Method: When using the Spatial Patch Type, the fill method determines how the
blemish in the image is repaired.
– Grid: Samples the pixels surrounding the Rect, Ellipse, or Patch, and blurs them

inward both horizontally and vertically. Extremely effective for tiny blemishes. For
larger blemishes, a grid-like pattern may emerge.
– Horizontal: Samples the pixels to the left and right of the Rect, Ellipse, or Patch, and

blurs them inward.
– Vertical: Samples the pixels to the top and bottom of the Rect, Ellipse, or Patch,

and blurs them inward.
– Patchy: Samples pixels from all around the Rect, Ellipse, or Patch, and expands

and blurs them together to create a soft, non-uniform region with which to repair
the blemish. Doesn’t have the patterning of the grid methods of fill, but produces an
extremely smooth result.
– Smooth: Simply uses a gaussian blur to repair the blemish.

Patch Options
These options let you customize the effect of a patch filling over a blemish.
 Mute: Lets you turn a particular patch on or off via keyframing. Useful for blemishes
that only show up for a few pixels of a shot.
 Variability: (Spatial patches only) Raising this parameter lets you make the
Fill Method less uniform.
 Soft Edges: Lets you soften the edges of the patch.
 Size Adjust: Lets you change the size of a patch after its creation.
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Advanced Controls
These controls let you customize the UI of this effect.
 Clone Sticks to Mouse: When enabled, drawing or placing a Rect, Ellipse, or Patch in
Clone or Blend Clone mode immediately switches to positioning the sample region,
making it faster to use.
 New Patches Stay Selected: When enabled, patches stay selected after you draw
them, in preparation for further customization.
 UI Line Thickness: Lets you choose how thick the on-screen outlines should be.
 Patches Stick to: This parameter lets you deal with fixing dead pixels or blemishes on
clips that have been stabilized.
– Source: Patches you place stay put, unless you apply motion stabilization to the

shot, in which case the patches are transformed along with the image so they remain
“stuck” to the feature in the source clip they’re fixing.
– Scene: If you’re eliminating a blemish on a moving subject, you can use the

FX Tracker to track the thing you’re fixing, so the patch follows along with it.
 Output Mode: This lets you see different representations of the patched effect you’re
creating. There are four options.
– Patched Result: The final result, with each patch repairing the blemish it’s covering.
– Patch Locations: Shows a key where each placed patch is white against black.
– Differences: Shows the difference of each patch against the original image.
– Difference Magnitude: Shows a more pronounced Differences representation.

Improved Dust Buster (Resolve FX Revival, Studio Only)
The Dust Buster Resolve FX plug-in has been improved to provide more options for isolating
dust and blemishes with Ellipses and Patches, and with the option to repair dust and dirt using
the Clone and Blend Clone methods. In many respects, the Dust Buster is similar to the Dead
Pixel Fixer, however the Dust Buster effect is designed to repair transient bits of dust and dirt
that only last for a frame or two, whereas the Dead Pixel Fixer is designed to work on blemishes
that are fixed in place for the duration of a clip.

Dust Buster
These top level controls let you choose how to draw patches with which to repair temporally
unstable dust and dirt in the frame, whether or not to show their on-screen controls, and how.
 Navigation Controls: Four buttons let you jump to frames on which you’ve drawn
patches. There are four buttons:
– First Modified Frame: Jumps the playhead to the first frame of that clip with a patch.
– Last Modified Frame: Jumps the playhead to the last frame of that clip with a patch.
– Next Modified Frame: Jumps the playhead to the next frame forward with a patch.
– Last Modified Frame: Jumps the playhead to the last frame back with a patch.

Chapter – 10

Resolve FX Improvements

278

 Patch Style: There are three different kinds of patches you can draw to deal with
different kinds of blemishes in the frame.
– Draw Rect: Click and drag to place a rectangular patch of any size from one corner

to the opposite corner. Once drawn, you can click on any edge of the overlay and
drag to reposition it.
– Draw Ellipse: Click and drag to place an elliptical patch of any size from one corner

to the opposite corner. Once drawn, you can click on any edge of the overlay and
drag to reposition it.
– Place Patch: Lets you place small patches specifically for tiny details such as dead

pixels. When you choose this option, a New Patch Size slider appears that lets you
adjust the size of the patches you’re about to place prior to placing them. Once
drawn, you can click on the edge of any patch and drag to reposition it.
 New Patch Size: (only when Place Patch is selected) Lets you choose how large of a
patch to place using the Place Patch tool.
 Show Patches: This checkbox lets you show or hide the onscreen outline of every
patch in the Viewer.
 Hide During Interaction : Hides the onscreen outline of every patch in the Viewer while
you’re moving a patch; this makes it easier to see the effect of moving the patch on the
image, without the outline getting in the way.

Patch Type
There are six methods you can use to attempt to fix the contents of a selected patch. When
drawing new patches, the currently selected Patch Type will determine what the next patch will
be. When you’ve selected an existing patch, changing the Patch Type will change how that
patch works.
 Auto: The default method. Once you’ve drawn a bounding box, the two frames prior
to and the two frames after the current clip will be analyzed and compared to the
current image. The best of these 5 frames will be sampled to remove the imperfection
in the current frame. Images two frames away are prioritized since that will avoid the
appearance of frozen grain, but only if they’re a suitable match to the content of the
current frame.
 +/- 1 Frame: In this mode, if you draw a bounding box from left to right, the next frame
will be drawn upon to remove the imperfection. If you draw a bounding box from right
to left, the previous frame will be used.
 +/- 2 Frames: If you draw a bounding box from left to right, the image two frames
forward will be drawn upon to remove the imperfection. If you draw a bounding box
from right to left, the image two frames back will be used.
 Spatial: Automatically fills the interior of the selected patch with pixels drawn from the
surroundings of the patch, using the Fill Method. This works well for small blemishes,
but for large blemishes a pattern might be discernible, which gives away the effect.
 Clone: Clone mode copies part of the image to fill a shape or patch placed over the
thing you want to remove. In this mode, clicking and dragging to place a Rect or Ellipse
over an imperfection is followed by a second click to place the sample region you want
to clone. Clicking once to place a Patch will be followed by a second click to place the
sample region. Selecting an existing shape or patch and choosing Clone lets you click
on the shape to position the clone region. The sample region is indicated by a dotted
shape that’s connected to the original shape.
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 Blend Clone: Operates similarly to Clone mode, except the copied part of the image
that fills the Rect, Ellipse, or Patch is blended with the image to integrate it more softly.
 Fill Method: When using the Spatial Patch Type, the fill method determines how the
blemish in the image is repaired.
– Grid: Samples the pixels surrounding the Rect, Ellipse, or Patch, and blurs them

inward both horizontally and vertically. Extremely effective for tiny blemishes.
For larger blemishes, a grid-like pattern may emerge.
– Horizontal: Samples the pixels to the left and right of the Rect, Ellipse, or Patch, and

blurs them inward.
– Vertical: Samples the pixels to the top and bottom of the Rect, Ellipse, or Patch, and

blurs them inward.
– Patchy: Samples pixels from all around the Rect, Ellipse, or Patch, and expands and

blurs them together to create a soft, non-uniform region with which to repair the
blemish. Doesn’t have the patterning of the grid methods of fill, but produces an
extremely smooth result.
– Smooth: Simply uses a gaussian blur to repair the blemish.

Patch Options
These options let you customize the effect of a patch filling over a blemish.
 Mute: Lets you turn a particular patch on or off via keyframing. Useful for blemishes
that only show up for a few pixels of a shot.
 Variability: (Spatial patches only) Raising this parameter lets you make the
Fill Method less uniform.
 Soft Edges: Lets you soften the edges of the patch.
 Size Adjust: Lets you change the size of a patch after its creation.

Advanced Controls
These controls let you customize the UI of this effect.
 Clone Sticks to Mouse: When enabled, drawing or placing a Rect, Ellipse, or
Patch in Clone or Blend Clone mode immediately switches to positioning the sample
region, making it faster to use.
 New Patches Stay Selected: When enabled, patches stay selected after you draw
them, in preparation for further customization.
 UI Line Thickness: Lets you choose how thick the on-screen outlines should be.
 Output Mode: This lets you see different representations of the patched effect you’re
creating. There are four options.
– Patched Result: The final result, with each patch repairing the blemish it’s covering.
– Patch Locations: Shows a key where each placed patch is white against black.
– Differences: Shows the difference of each patch against the original image.
– Difference Magnitude: Shows a more pronounced Differences representation.
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Improved Directional, Radial, and Zoom Blurs
(Resolve FX Blur, Studio Only)
Additional options are available for creating more photo-realistic directional, radial and
zoom blurs.

Directional
 Blur Type: When Blur Type is set to Realistic, the blur effect emulates a photographic
motion blur. When set to Stylized, the blur effect is a simple and smooth digital blur.
 Symmetric Blur: When the Symmetric checkbox is turned on, the blur effect appears
to be created from both directions, with the result being more of a double-image that’s
blurring along the blur angle, simulating motion blur in a camera. When off, the blur
effect appears to be moving in a single direction, from the original position out along
the blur angle.

Radial Blur
 Blur Type: When Blur Type is set to Realistic, the blur effect emulates a photographic
motion blur. When set to Stylized, the blur effect is a simple and smooth digital blur.
 Blur Symmetry: Three options are available.
– Symmetric: The blur effect appears to be created in both directions, with the result

being more of a double-image that’s blurring in an arc around the X/Y Position,
simulating motion blur in a camera.
– Clockwise: The blur effect appears to be moving in a single, clockwise direction.
– Anti-Clockwise: The blur effect appears to be moving in a single,

counter-clockwise direction.

Zoom Blur
 Blur Type: When Blur Type is set to Realistic, the blur effect emulates a photographic
motion blur. When set to Stylized, the blur effect is a simple and smooth digital blur.
 Zoom Amount: When Blur Type is set to Realistic, this slider becomes bi-directional.
The center is 0, or no blur at all. Dragging to the right expands the blur effect outward
from the position. Dragging to the left shrinks the image towards the Position, blurring
outward from there.

Improved Film Grain (Resolve FX Texture, Studio Only)
Film Grain has a new Optimized Mode checkbox, located in the Advanced Controls. With this
checkbox turned on (the default), performance should improve substantially.
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Chapter 11

Fairlight Page
Improvements
DaVinci Resolve 17 continues to expand and evolve the Fairlight page.
The completely redesigned Fairlight Audio Engine allows for simultaneous
playback of up to 1,000 tracks with no additional hardware and
2,000 tracks when used with the Fairlight PCI Audio Accelerator. The new
Flexbus structure completely upgrades Fairlight’s bus capabilities, offering
users the option for bus-to-bus, track-to-bus, or bus-to-track signal routing.
All of these additional tracks and Flexbus features have expanded
Fairlight’s Dolby Atmos capabilities to include the import, export, and
manipulation of Atmos ADM files.
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New Format Support
DaVinci Resolve 17 introduces the following audio format support.

Ability to Decode and Encode MP3 Audio on Linux
Linux users have the added ability to encode and decode MP3 files in Fairlight.

Expanded Dolby Atmos Capabilities
DaVinci Resolve 17 significantly improves Dolby Atmos mixing. The traditional surround sound
experience outputs a specific set of monitoring channels that requires a specific number of
monitor speakers placed in particular areas of a room, which can position sound approximately
within a ring around the listener. Dolby Atmos improves upon this by being an object-based
sound system operating within a 3D immersive space that can accommodate a wider variety of
different speaker configurations using more speakers positioned around the listener. This
increases dimensionality with more precise sound placement, adding height channels to
produce sound that comes specifically from above.
A practical example of this difference can be heard when panning in a 7.1 mix; since you’re
sending signals to specific points in a speaker array, those points are fixed. Although the
physical size of rooms can be larger or smaller, the mix is always sent to those assigned point
speakers, so the experience from room to room may be inconsistent. By comparison, Dolby
Atmos gives re-recording mixers a way to mix to an idealized space instead of fixed speaker
positions. This means a Dolby Atmos mix, when played in a Dolby Atmos room, takes into
account the actual dimensions of the space, as well as the number of speakers that are used,
to recalculate audio playback to suit that exact space and playback equipment, giving a more
faithful recreation of the mix with much more specific sound placement, when necessary.
To give a clear example of the benefits of Dolby Atmos, think of a small theatre that has
standard left, center, and right front-screen speakers. It then has four left surround and four right
surround, four overhead left, and four overhead right. For this example, let’s say you have sent
a sound to the surround left in Atmos, positioned at about one-half of the distance from
the screen.
Now move the Atmos mix to a much larger room with twice as many monitor speakers. The new
theatre has eight left surrounds, eight right surrounds, eight overhead left, and eight overhead
right. Playing in this new configuration, Atmos automatically calculates the ratio of the room and
the new speaker array. In this example, when that sound is reproduced at one-half of the
distance from the screen, Dolby Atmos calculates the ratio of the sound in relation to the new
playback setup, so the listener hears exactly what the re-recording mixer intends.
For this example, let’s say to have that audio playing back at one-half of the distance from the
screen in the small room, the audio is played on the second surround speaker on the left. When
this same audio is played in the larger room, Atmos determines that the fourth surround speaker
is one-half the distance from the screen. The importance is not what speaker sounds are
assigned to but rather where in space the sound should be heard. Atmos calculates the ratio of
the playback spaces and monitor speakers to faithfully reproduce a mix, rather than assign
sounds to a fixed speaker position.
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Dolby Atmos Speaker Configurations
It is important to understand that the term Dolby Atmos isn’t restricted to describing any
particular speaker layout. Dolby Atmos is a complex metadata-driven system that interprets the
audio from a configured Atmos mix, determines the playback system of the end user, and
calculates the mix to fit each particular space and system. Assuming the possession of a Dolby
Atmos compatible system, if a 9.1.6 Atmos mix is played by someone with only a two channel
playback system, then it will intelligently down mix the 9.1.6 Atmos to stereo. If a user has a
standard 5.1 monitor system, then the 9.1.6 Atmos soundtrack will down mix to five channel
surround with a subwoofer.
The naming of the channel configurations in the Dolby Atmos format includes the height
channels in the nomenclature. Channel configurations are presented as three digits separated
by periods, such as 7.2.4, which is a typical speaker configuration. The first digit describes the
number of main, or ear-height monitoring channels that surround the listener. The second digit
describes the number of subwoofer channels. The third digit describes the number of height
channels, which are speakers positioned on, or in the case of a soundbar pointed to, the ceiling.
An example of a 7.2.4 Atmos monitor speaker configuration:
 Seven surround channels
– Left
– Center
– Right
– Left Surround
– Right Surround
– Left Back Surround
– Left Right Surround

 Two Subwoofers
 Four height channels

Enabling Dolby Atmos
Atmos must be enabled by going into Project Settings > Fairlight tab > Immersive Audio and
turning on Enable Dolby Atmos. When enabled, the Change Track Type contextual menu when
right-clicking on a track will then include the additional Atmos track types.

The Components of a Dolby Atmos Mix
Mixes created in Atmos have several specifically identified components. These work together
to create an immersive mix, but each element allows the Dolby Atmos system to fit the sound
specifically to the space and speaker configuration during playback. These consist of:
 The Bed track: Contains the bulk of mixed audio, including dialog, ambient sound
effects, and music. These sorts of sounds will contain panning information, but the
panning will be general. Wind, traffic in the distance, room tones, and sync dialog
would all most likely fall within the bounds of a standard bed track of 7.1.2 or 9.1.6.
These are tracks with fixed monitor locations.
 Object tracks: Pinpoint the placement of sounds moving specifically across the
immersive space. Users can use these specific tracks to create panning anywhere in
the room. Sounds can fly through space, around a room from height channels, to side
and back back channels, mimicking the motion of objects on the screen. Object tracks
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use the Atmos metadata to do the calculations discussed in the last example. ADM files
are Atmos exports used with the IMF file type as master deliverables, which are in the
broadcast wave file format.
It’s up to users to define which tracks are Bed tracks, and which are Object tracks; these track
designations, are descriptions of what the tracks you create are going to be used for. Ultimately,
it’s up to the mixer which audio is organized on Bed tracks, and which is organized on Object
tracks. Theoretically, users can create a mix consisting entirely of Object tracks if desired, but
typically the mix would be split into beds consisting of generally panned sounds, and Object
tracks for sounds requiring specific room placement.
Object tracks and height channels open up possibilities that were never possible prior to
Atmos. Imagine a scene where a man is hiding from Police while a helicopter circles overhead,
or a scene where kids are in a basement and are startled to hear loud footsteps above them.
With Atmos, the audience can now experience these immersive sounds along
with the characters.
These are real-world examples, but sound in animation, science fiction, and fantasy can explore
space in ways that are only limited by the creator’s imagination. Flying fairies or creatures can
move about the space front to back, high and low. Perhaps there’s a scene with a ship moving
full speed ahead underwater, breaking up and out into the sky, flying and dodging weapons
coming from all sides. Object tracks are ideal to pinpoint sound effects requiring spatial
specificity, but more importantly, Atmos assures the re-recording mixer that the final choices
made in the mix will be faithfully recreated from theatre to theatre, and from room to room.

ADM Authoring and Export to IMF Deliverables
DaVinci Resolve 17 adds Dolby Atmos ADM file creation and manipulation, as well as the ability
to export Atmos masters as IMF deliverables. IMF (Interoperable Master Format) is a SMPTE
standard for a single master file format that incorporates all the media and metadata necessary
to deliver what’s necessary. Atmos mixes in Fairlight use all the same controls and effects as
any other surround sound mix; EQ, dynamics, effects, and automation all work much the same.
The biggest difference is you’ll be using the 3D Space panner, rather than the Surround panner.

ADM Import
Importing an ADM file into a project will open the Bed mix or mixes and any associated Object
tracks into a timeline. They will be imported onto corresponding track types of the audio files
embedded into the ADM. For instance, if a Bed file is 7.1.2, then on import that file will open in a
7.1.2 track in Fairlight. Object files will be created as separate tracks in Fairlight containing all of
their panning data. Object tracks can only be mono or stereo files due per the Dolby Atmos
specification.

New Surround Buses in Fairlight
The new Flexbus structure in Fairlight enables user-definable buses. Atmos mixes call for
several bus formats that are now available in DaVinci Resolve 17.
– 9.1.4
– 22.2
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New Features and Enhancements
DaVinci Resolve 17 adds numerous improvements to Fairlight editing and mixing.

Updated Fairlight Engine Supports 2,000 Audio Tracks
The completely redesigned Fairlight Audio Core engine allows for simultaneous playback of up
to 1,000 tracks with no additional hardware, and up to 2,000 tracks when used with the Fairlight
PCI Audio Accelerator. The new engine also utilizes self-learning load balancing for maximum
plug-in support.
It’s tempting to think, “What would I possibly do with up to 2,000 tracks?” However, Fairlight’s
increased track count meets the demanding needs of both clients and immersive formats, such
as Dolby Atmos. Major studio films and series television requires high track counts to
accommodate complex mixes and the export of multiple deliverables. On top of that, immersive
formats, such as Dolby Atmos, multiply the necessary track counts with their demands for
deliverables from 7.1 up to 22.2.

Bus to Bus Routing and Mixing
The new Fairlight audio engine has unleashed advanced capabilities in the bus structure within
Fairlight. The new Flexbus structure offers complete user flexibility for bus types and signal
routing, which changes the prior Main, Sub, and Auxiliary bus formats to be completely userdefinable. This new structure makes it possible to patch outputs and/or sends in any way you
need, as dictated by your project. Each track can now output to up to ten buses and sends with
additional level and pan controls to a further ten buses. Buses can be sent to other buses up to
six layers deep, facilitating complex stem building, processing, and allowing discrete
deliverables.
User-definable buses allow for bus-to-bus, bus-to-track, or track-to-bus routing, with each bus
having the ability to pass signals from mono to fully immersive formats, such as Dolby Atmos, at
the user’s discretion. As with any and all of the tracks in Fairlight, these bus types can be
changed at any time by the user if needed,

The Flexbus structure allows for many different bus
track types to be created or changed
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The power of the Flexbus system is that it allows users to direct signals to many different places
at one time to achieve complex mixing scenarios. Perhaps you need to generate two mixes that
are identical in content but need to be of different output levels. You can designate two mix
buses, one with an output level of -2db true peak and one with an output level of -10db true
peak. The final mix signal is sent to one bus that is then broken into two more buses, one with a
limiter set to -2bd and one set to -10 db creating these two different mixes at one time.

Using Legacy Fixed Busing
If you want to work using the previous method of fixed bus mapping, you can do so for
new projects by opening the Fairlight panel of the Project Settings, and turning on the
“Use fixed bus mapping” checkbox. This checkbox can only be enabled in new
projects in which no timelines have yet been created. Once you’ve created one or
more timelines, this option is locked to whatever it was set to. Older projects have this
setting enabled by default to preserve the previous mix.

Picture lock can be an elusive thing, eventually devolving into multiple timelines named
final_final_no_really_final_mix. Because editing will always be necessary while projects are in
the mixing phase, users now have the option to have their edits retain all of the automation data
that has been added to audio clips after mixing. To enable this, choose Fairlight > Automation >
Follows Edit.
This is also extremely useful when doing an initial edit of audio clips that contain automation
data. For instance, if you have a recurring sound effect that pans left to right, automate that
panning to the audio clip. New copies of this audio clip copied through the Timeline will retain
the same panning automation. This can save time for a variety of edits that require the same
automation data for audio clips in a timeline. Be aware, however, that it will need to be turned
off when automation applied is not relevant to the new edits.
In a larger edit change you might have a whole sequence move from one place in the edit to
another. For instance, if there is an exterior car scene with lots of passing cars, dialog, and
music, all mixed to picture; if this scene is lifted in its entirety, it will continue to have all of the
mix automation attached.
The automation data is embedded into the clips themselves. Any of that data, for instance
volume or panning, will travel with the clips. So if a complete section has been removed, all of
the automation inside of the clips contained in that section are also removed. If a section of
clips changes its location in the Timeline, all of the automation embedded in those clips move in
the Timeline with them.

Shortcuts for Changing Clip Gain on Fairlight Page
The Clip Gain menu commands were previously only available on the Edit page, but now they’re
available to the Fairlight user as well. To change clip gain in the Fairlight page, choose an option
from the Clip > Audio submenu where you have commands to increase or decrease clip gain by
either 1db or 3db. Keyboard shortcuts make these commands considerably more useful.
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Waveform Display Has Been Improved
Waveforms now have a zero crossing indicator line. A waveform is an image representation of
sound continually moving positive to negative, and the zero crossing point is the level at which
that fluctuation occurs. When zooming into a waveform at the sample level, the waveform now
displays the zero crossing line to enable precise editing.
Seeing the zero crossing is useful when editing audio, since clean edits are made at the zero
crossing to avoid inducing clicks or pops. A cross-fade between two audio clips automatically
brings both sides of the fade to the zero crossing.

The center line in the waveform indicator is the zero crossing

Linked Clips in the Fairlight Page
Clips can now be linked together right in the Fairlight page. When multiple clips are linked,
Fairlight editing commands treat all linked clips as if they were a single clip. Anything you would
do to a single clip is done to all linked clips at once. Selecting one item of a linked clip selects
all items. Editing the In point of one item of a linked clip edits them all.
To link two or more clips together:
1 Select all clips you want to link together.
2

Right-click one of the selected clips, and choose Link Clips from the contextual menu.

A link indicator at the bottom left of every clip you’ve just linked shows their new linked status.

Track Names Can Be Edited in the Mixer
DaVinci Resolve 17 adds the ability to edit track names within the mixer window on the channel
strip itself. Simply double-click the default name above the fader, and type the new name into
the text field. The new track name appears across the project, so track name changes appear
on both the Fairlight page Timeline and the Edit page Timeline.
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It’s common to add tracks as you’re building a mix and focusing on the Mixer interface.
The ability to name new tracks directly on each channel strip offers a quick way to organize
new or changed tracks and/or buses, since you no longer need to display the Track view to
rename newly created tracks.

Editable VCA Group Names
VCA Group names can now be easily changed in the Mixer panel by clicking into the text field
of a VCA track.

Each group is assigned to a
different audio type seen in
the Group window

Absolute Scales and Dialog
While some users prefer to measure their levels to correspond to a relative scale of “0,” similar
to a VU meter where the needle rides above the “0,” others want to see the absolute measure
of the amplitude in LUFS and true peak. By default, the Loudness meter is set to relative scale,
but you now have the option to choose between relative scale and absolute scale in the
Loudness meter.
Relative scale in the Loudness menu is relative to the selected scale, so a loudness unit of
0 corresponds to the target of the chosen measure type. For instance, if EBU R128 is selected,
whose target measure is -23db LUFS, the “0” LU (Loudness Unit) is -23db. If ATSC A/85 is
chosen, whose target is -24db, then that becomes the corresponding equivalent of the
relative LU of 0.
When using the absolute scale, the Loudness meter displays the increments to reflect the the
chosen measure type. In absolute scale the EBU R128 meter will display -23 instead of the
relative scale’s 0.
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The option in the Loudness panel reveals the various
measure types as well as the option for absolute scale

Offline Loudness Analyzer
Users now have the ability to analyze an audio file’s loudness offline. This is a fast way to
measure loudness in imported audio files or bounced mixes.
To initiate offline loudness analysis:
 Right-click the file in the Timeline, and choose Analyze Audio Level from the contextual
menu. A dialog box displays the available options for measurement.
All of the measurements available in the real-time loudness meter are accessible in the dropdown menu inside the Analyze Audio Level panel. When the analyzer mode is chosen, the
target measurements for that mode will display next to the reading in parenthesis. Once you
have clicked the analyze button, the results will display in the panel next to the chosen mode’s
target measurement values.

Select the audio file, choose the desired analyzer
mode, in this case EBU R128, and click analyze

Multi-Channel Exporting
Audio clips linked in the Timeline can be exported to a multi-channel file.
To link clips:
 Right-click the files in the Timeline and choose Link Clips from the contextual menu.
 Right-click the linked clips and choose Bounce to disk from the contextual menu,
making sure to set the bounce to multi-channel.
 The Bounce to Disk dialog box allows for choosing Bit Depth, File Name, Tag, and
Folder destination.
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The Bounce Clip to File dialog box offers naming,
destination, and user-defined bit depth

Multiple Selection of Mixer Tracks
Fairlight now offers the option to select multiple channel strips in the Mixer panel, which in turn
selects those tracks in the Timeline. These selections can be made by command-clicking each
track you want to add to the selection, or by clicking on one track and then dragging a
bounding box around all other tracks you want to select.

Reversing Audio Clips
You can quickly reverse clips in the Fairlight page Timeline. To do so, select one or more clips,
right-click one of the selected clips, and choose Reverse Clip from the contextual menu.
Reversing an audio clip that’s linked to a video clip will reverse them both. If you don’t want this
to happen, open the Edit page, select the audio/video clip you want to work on, and choose
Clip > Link Clips (Option-Command-L) to unlink them. Keep in mind that unlinked clips will not
move together on the Timeline, so after you’ve reversed and unlinked an audio clip, you can
relink it to the accompanying video clip by selecting both on the Edit page and using the
same command.

Ability to Delete All Empty Tracks
You can now remove all empty audio tracks in the Fairlight timeline by right-clicking any track
header and selecting Delete Empty Tracks from the contextual menu.
Typically, as a sound edit progresses, audio files are swapped between tracks and/or deleted
altogether. With this new function, you can remove all tracks that no longer contain audio clips
with a single click. With the highly increased track count now available, this will definitely
simplify the clutter after an intense sound-edit session.

Right-clicking on a track or the track field reveals
the Delete Empty Tracks function
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Per Timeline Views
Each Timeline in the Fairlight page now maintains its own zoom level, selections, range, and
playhead position, independently of all other timelines.

Change Track Type for Multiple Selected Tracks
Typically, when sound editing, the edit will require the creation of additional tracks and buses.
Sometimes this requires changing a series of tracks from stereo to mono, or to any of the
available immersive formats. You can now change the track type of multiple selected tracks all
at once by right-clicking one of the selected tracks, and choosing an option from the Change
Track Type To submenu. You can do this to tracks regardless of whether or not they have audio
clips edited into them.

Right-clicking on a single track of multiple tracks selected changes
all highlighted tracks to the new track type

Mute and Solo Can Be Set For Multiple Selected Tracks
You can now Mute and Solo multiple selected tracks using commands in the Timeline menu
(Mute Track, Solo Track, Clear Solo). These commands don’t have keyboard shortcuts by
default, but you can assign them using the Keyboard Customization window, available form the
DaVinci Resolve menu.

Menu Command for Initiating Recording
You can initiate recording by choosing Playback > Record. This command doesn’t have a
keyboard shortcut by default, but you can assign it using the Keyboard Customization window,
available form the DaVinci Resolve menu.

Dock, Float, or Cinema Viewer on Fairlight Page
Sometimes when you need to verify lip sync, sound effects sync, or simply review a new
section of a mix you’ve been working on, it helps to watch the visuals of the program full screen
as you listen to your mix. You can now set the Fairlight page Viewer to Cinema Mode by
choosing Workspace > Viewer Mode > Cinema Mode (Command-F).
Prior versions of DaVinci Resolve only allowed access to the Cinema Viewer when in either the
Cut page, Edit page, or Color page. Under the Menu option, Workspace, you can access the
Cinema Viewer mode.
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AES31 Audio Timeline Import
The AES31 standard is an open file interchange format, developed by the Audio Engineering
Society, that allows you to transfer projects from one workstation to another, retaining time
positions of events, fades, etc.
AES31 uses the widely used Microsoft FAT32 file system with Broadcast Wave as the default
audio file format. You can transfer AES31 files to digital audio workstations that support AES31,
regardless of the type of hardware and software used.

Updated Inspector Design With a New Tabbed Layout
The Inspector on the Fairlight page has been updated to match the layout of the Inspector on
the Cut and Edit pages. For more information, see Chapter 1, “General Improvements,” in this
New Features Guide.

Tooltip Shows Monitoring Level
When hovering the pointer over the monitor volume level slider, a tooltip displays the
level in dB.

Hovering over the slider indicates
the monitor level being output from
Fairlight to your playback system

Pro Tools Keyboard Customization Preset
Fairlight has added Avid Pro Tools keyboard commands that can be selected, in addition to the
custom command sets that already exist for Avid Media Composer, Adobe Premiere Pro, and
Apple Final Cut Pro. You can choose a new keyboard command set from the Keyboard
Customization window.

Support for Analyzing and Navigating to
Audio Transients in a Track
DaVinci Resolve 17 adds the ability to automatically identify transients inside of audio clips.
Transients are abrupt, high-amplitude beginnings of sounds that are good for identifying
points-of-interest such as the start of words, the beginnings of sound FX, and beats.
Once detected, transient markers are drawn for both visual reference, for use in playhead
navigation and selection, and for alignment of multiple sections of music by the beats that have
been detected.

Transient button on the toolbar
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Methods of detecting and using audio transients:
 To Detect Audio Transients: Click on the Transient button, the double diamond icon on
the toolbar, located next to the Timeline Options button. Alternately, you can click on
the Transient Detection button on the Track Header.

Transient button on the Track Header

 To Use Audio Transients for Navigation: To navigate from transient to transient, press
the Up or Down Arrow keys on your keyboard to move the playhead back and forth
among each Transient marker.

Transient markers on a clip with dialog detected

Improved Editing and Selection Behavior in the
Fairlight Timeline
The Fairlight page now automatically scrolls when dragging clips past the current page
boundaries. Nudging clips now moves the cursor. When clicking a timeline marker, the playhead
immediately navigates to that new position, and when performing timecode entry, the playhead
moves to the new timecode position.

Previewing Video When Sliding Clips, Markers and Ranges
When moving markers and sliding clips in the Fairlight page, the Viewer updates as you
move them.

Improved Metering Displays for Timelines with a
Large Number of Audio Tracks
With a thousand tracks of audio or more, metering can be a challenge. DaVinci Resolve 17 adds
stacked metering to watch audio levels. Double-clicking in the Track or Bus area of the Meters
panel toggles between one row and two row views.
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The new double row metering view

Improved Keyboard Mappings for Edit Selection Mode
The Fairlight timeline is listed as a module in the keyboard customization window, with new
default keyboard shortcut assigned to them.

Support for Talkback Microphone in the Fairlight
Audio Interface
Users now have access to phantom power, gain levels, and input selection when the Fairlight
Audio Interface microphone in is used for talkback in the Talkback Settings dialog box.

New Fairlight FX
DaVinci Resolve 17 introduces an important new Fairlight FX.

Loudness Analyzer
The Surround Analyzer is a graphical meter that shows a spatial image of the audio being
measured, rather than a typical bar graph meter. Due to its changing shape because of the
signal being played, sometimes it is referred to as the “jellyfish meter.”
This type of metering is very useful; rather than relying on bars to indicate the directions in
which audio is radiating, you can clearly see the relationship of all of the channels to
one another.

The signal here is radiating more to the
right, indicating the panning of the audio
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Chapter 12

Using The Fairlight
Desktop Console
The Fairlight Desktop console is the newest member of the Fairlight
console family and offers professional mixing controls for editors and
audio professionals alike. This compact desktop console has enhanced
mixing controls for both the Edit and Fairlight pages in DaVinci Resolve.
This chapter provides details and functional descriptions of each section
of the Desktop Console and should be read in conjunction with the
Fairlight chapters in the DaVinci Resolve Reference Manual to get the best
from your console.
NOTE: To set up a Fairlight Desktop Console or Desktop Fairlight Audio Editor to work
with your DaVinci Resolve system, you ﬁrst must perform a custom installation of
DaVinci Resolve and check the box to include the DaVinci Control Panels utility.
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About the Fairlight Desktop Console
Fairlight Desktop Consoles offer traditional and enhanced mixing controls for both the Edit
page and Fairlight page in DaVinci Resolve. All that you need to connect a Fairlight Desktop
Console to your DaVinci Resolve computer is a standard USB-3 or Ethernet cable. Once
connected to your workstation, you can use the transport controls and search dial on the
Desktop Console for timeline navigation, recording, playback, and more.

Fairlight Desktop Console Sections in Clockwise Order
On the upper-left of the Desktop Console there is a set of 10 control buttons that are used to
map the 12 adjacent encoder knobs and select buttons to focus mode mixing parameters.
Moving to the upper-right of the Desktop Console, you’ll find the Automation section with six
buttons used to control the automation system. Below the Automation section are the channel
and monitoring controls. The channel controls include three buttons that work in conjunction
with the channel select buttons above the faders and two bank buttons for banking faders in
groups of 12 in the relative direction. To the right of the Channel section are the monitoring
controls complete with an encoder knob and four buttons to target the Control Room
monitoring. Additional TALK and CANS buttons add studio controls and can be pressed and
held for talkback and re-targeting the monitoring controls for studio monitoring. The lower-right
of the Desktop Console includes an electronic search dial for full shuttle and scroll transport
control, along with a set of transport keys. A handy Zoom Icon button below the dial lets you
use the dial for quick timeline zoom functions including: horizontal, vertical, and
waveform zoom.
The center of the Desktop Console includes 12 fader channel strips, each with a weighted
touch-sensitive fader, Mute, Solo, and Select (SEL) buttons, as well as an encoder knob for
panning in default mode and controlling additional parameters in Focus modes. At the top of
each channel strip you’ll find an LCD screen that displays information for that channel in default
mode or alternative parameter information in Focus modes.
Arrow and Modifier keys are located in the lower-left of the Desktop Console and can be used
in conjunction with the Transport, Channel, and Automation buttons for expanded functionality.
Directly above the Arrow keys is the User section, containing six sequentially numbered
buttons that can be used in combination with other keys to change the current operation
depending on the mode and task at hand.
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12 LCD Displays
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Connecting to a Monitor via HDMI
For additional visual feedback, you can add an HDMI display to the Fairlight Desktop Console.
There’s no configuration needed, simply plug in an HDMI monitor and start working! This allows
you to see an extensive graphical display of everything happening on the console. The screen
automatically switches between Strip, Channel, and Master layouts depending on the current
control mode. Along the top of the HDMI screen you’ll always see a fixed display that includes:
timecode, monitoring controls, automation toolset, and the Bus, Control Room, and Loudness
meters. While at the bottom of the screen you’ll see 12 sets of Channel Extension Buttons for
quickly identifying channel status while you work.

Optional HDMI monitor displaying Strip mode layout with an identical set of parameters in-line
with each of the 12 channel strips, including from the top down: Track color, Name. Level, Status,
EQ, Dynamics, Panning controls, and Channel Extension buttons.
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Optional HDMI monitor displaying the Channel Control mode layout, which includes
192 different parameters for the active channel. Parameter controls currently
mapped to the LCD displays, knobs, and SEL buttons are highlighted with blue text.

Optional HDMI monitor displaying the Master Control mode layout
with bus meters, level, and mute for each of the master buses.

HDMI Fixed Monitoring section with timecode, monitoring controls,
Automation toolset, Bus, Control Room, and Loudness meters.
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Channel extension buttons along the bottom of each HDMI layout showing 6 highly-visual status
switches for each of the 12 channels, including in clockwise order from the top: Insert, Solo Safe,
Select, Record (Arm), EQ and Dynamics. In this example you can see that A1 is selected and
armed for recording, A2 is in Solo Safe mode and both EQ and Dynamics processing are on,
A3 had plug‑ins applied (Insert) as well as EQ and Dynamics.

Desktop Console Functional Overview
At a glance, you can guess most of the default functionality of the Fairlight Desktop Console,
however when it comes to Fairlight, there is always more than meets the eye. So before you
dive in and start working with the Desktop Console, let’s take a moment to look at the
expanded operational functions within so you can fully exploit the multi-faceted power available
in this user-friendly desktop controller. This section offers a rundown of the various types of
controls, operational modes, transport, and modifier keys, as well as pointing out the multipurpose track selection buttons, encoder knobs, and LCD display screens within the console.

Types of Controls
The Fairlight Desktop Console comes loaded with an assortment of 111 physical controls that
you can use to record, monitor, mix, and sweeten your soundtracks. Some buttons serve a
single purpose, while others serve multiple functions, therefore it’s a good idea to understand
the different types of controls before moving on to the specific button, knob, and fader details.
 Search Dial: To quickly navigate, scroll, and zoom, this fully integrated, highlyresponsive electronic dial offers smooth free rotation control.
 Knobs: When you want to make fast changes to specific parameters, these versatile
knobs give you precision rotary control, as well as touch-sensitive input for enabling
automation or resetting levels. Holding the Shift modifier key changes the gearing for
finer precision control, while holding the Control modifier key while touching one of
these knobs will reset the knob’s current parameter to its default value.
 Fixed Buttons: Fixed buttons serve a specific function and produce the same results
every time they are used, regardless of the operational mode or current workflow.
 Soft Menu Toggle Buttons: The twelve Select (SEL) buttons near the top of the fader
channel strips are multi-functional toggle switches that change based on the console
mode and active control button.
 Faders: As you guessed, the 12 touch-sensitive electronic faders give you precision
volume control for your tracks and buses, and correspond with faders on the onscreen
Mixer in DaVinci Resolve.

Desktop Console Modes
The upper section of the 12 Channel Strips, including the Select (SEL) buttons, knobs, and LCD
screens, can operate individually per channel in Strip mode or combined for a comprehensive
set of parameter controls in Focus mode. In both cases, the different tasks are engaged via the
button selection in the Control section to the left of the knobs and LCD display area.
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 Strip Mode: This is the default console mode, when none of the control
buttons are active.
Strip mode functionality includes:
– 12 identical sets of fader channel controls, one for each fader channel strip.
– Each LCD display, knob, and SEL button is associated with the Fader, Mute

and Solo button that is in line with that channel strip.
– The Select buttons are used for track selection and illuminate accordingly

when they are switched on.
 Focus Mode: In contrast, Focus mode, focuses all of the knobs, Select buttons, and
LCD displays on a single mixing task or parameter control set determined by the
active Control button. These focused control sets mirror signal processing available in
the Fairlight page Mixer, such as Pan and EQ, as well as dynamics like the Compressor
and Limiter.
Focus mode functionality includes:
– The LCD display at the top of each channel strip provides visual feedback for the

active parameter set assigned to the adjacent knob and SEL button.
– SEL buttons become toggle switches for the active parameter control set.
– Knobs are mapped as precision encoders for the active parameter control set.
– Focus mode controls collectively mirror the corresponding parameter controls in the

Fairlight page UI.
– Focus mode parameter sets control the signal processing for the active track or bus

determined by the selection buttons prior to entering Focus mode. The active track
is the most recently selected track.
– When the Master (MSTR) control button is active, the focus mode LCD, SEL buttons,

and knobs are mapped to each bus as Mute and Level controls, respectively.
– When the Channel (CHNL) control button is active, the focus mode LCD, SEL buttons,

and knobs are mapped to the most commonly used signal processing parameters
for the active track.

Latch and Momentary Press Functions
Many Fairlight Desktop Console buttons have multiple operational states, which elicit different
results depending on how you press or hold the key. The three types of button presses are:
 Latch: Quickly pressing and releasing a button, just as you would with normal typing, is
referred to as latching and results in toggling on or off that button’s function.
 Momentary hold: A momentary hold involves pressing and holding a key with one
hand to access additional functions that can be quickly latched with the other hand.
Momentary hold functions are common with Modifier keys.
 Double Press: Two short taps to the key and release. The double press triggers an
enable modifier with Select (SEL) buttons for exclusion or to select a range of tracks.

NOTE: From this point forward, descriptions such as press or latch indicate a latched
operation, and instructions to hold and release refer to momentary operations.
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Undo, Modifier and Arrow Keys
While working with the Fairlight Desktop Console, you will always have access to the Undo,
Modifier, and Arrow keys, conveniently located on the lower left side of the console. The Arrow
keys function like the Arrow keys on a standard keyboard and are used in conjunction with the
transport buttons to move the playhead (CTI), selected clip, range, or selected tracks
incrementally up, down, right, or left. The Undo key offers the failsafe option to go back a step
at any time, just as you would expect during normal keyboard and mouse workflows.
Additionally, the SHIFT, ALT and CTL modifier keys are used with other console controls to
expand functionality and speed up your workflow. For example, if you hold the Control key, the
Rewind and Fast Forward transport buttons become Project Start and Project End buttons to
quickly jump to the beginning or end of the Timeline. The Shift modifier key can be used with
the knobs for refined incremental parameter control, while the ALT modifier key used with Undo
results in Redo functionality to go forward a step.
NOTE: If your Desktop Console is connected to a Fairlight Audio Editor,
the Control (CTL), Shift, and ALT keys on the Desktop Console work in tandem with the
modifier keys on the Fairlight Audio Editor.

Track Select Buttons
The Fairlight Desktop Console includes a dedicated row of multi-function Select (SEL) buttons
at the top of the channel strips for selecting either tracks or master buses. From left to right, the
12 Select buttons follow the order of the tracks in the Timeline from top to bottom. Use the bank
buttons to move to the next or previous set of 12 tracks.
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TIn Focus mode, track Select buttons become toggle switches for the parameter assigned to
that channel strip. Focus mode parameter sets are determined by the control buttons in the
upper left of the Desktop Console.
In Strip mode, the Select buttons can be used to select the track or bus assigned to that
specific channel strip. Pressing a Select button is the same as clicking a track header or
channel strip in the Fairlight page Mixer with your mouse. Select buttons illuminate when

Chapter – 12

Using The Fairlight Desktop Console

305

latched and the top of the corresponding LCD brightens so you can always see at a glance
which tracks are selected in Strip and Focus modes. Likewise, if you are using an optional HDMI
monitor with your Desktop Console, you’ll see illuminated Select buttons for each selected
track in the Channel Extension buttons along the bottom of the screen.
The Active track reflects whichever track is actively being controlled or touched with any of the
channel strip controls. You can select and control multiple tracks at once, however only the
most recently touched track is considered the active track. For easy identification, the active
track’s name turns red in both the LCD display and the Fairlight page Timeline. It is important to
recognize the active track because that will be the track that receives focused parameter
controls in Focus mode.

Track Select Button Press Options
The default Strip mode Select buttons include some unique selection nuances to improve your
efficiency without the need for a mouse.
– Press once to select or deselect a track.
– Select as many tracks as needed, one track at a time, by simply latching the

corresponding SEL button.
– Double-press any SEL button to deselect all other tracks and exclusively select the

current track.
– To select a range of tracks, hold a SEL button, then double-press another SEL button

to select both tracks as well as all contiguous tracks between them. In this case, the
button that was double-pressed will become the active track.

TIP: To select all tracks or an extensive range of tracks, open the Tracks Index
panel in the Fairlight page. Select a track in the Index, then hold Shift while
turning the dial to extend selection. Additionally, you can select a track in the
Tracks Index and choose Edit > Select All, or press Cmd-A on your keyboard
to select all tracks.

Strip mode Select buttons latched on tracks A1, A3, and A5, and
the red track name on the A3 track indicating it is the active track
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The Fairlight Timeline and Mixer showing the same track selection, A1, A3, and A5, with A3 as the active track.

Channel extension buttons on the optional HDMI monitor showing
illuminated Select Buttons for tracks A1, A3, and A5.

Fairlight Desktop Console
Now that you are familiar with the general layout, types of controls, modes, and other options in
the Fairlight Desktop Console, you are ready to take a more detailed look at the different areas
of operation and how everything works together. One primary concept to keep in mind is that
the Fairlight Desktop Console is actually a large multi-faceted mouse, designed specifically to
control the DaVinci Resolve Fairlight page. Therefore, the better you understand the Fairlight
page, the more proficient you’ll be with your console.
Please refer to previous Fairlight chapters for detailed information on the software interface,
tools, functions, and audio workflows. Meanwhile, this section will give an overview of the entire
Fairlight Desktop Console and focus in-depth on unique features and functions that go beyond
the standard keyboard and mouse options in the Fairlight page.

Control Buttons
The twelve control buttons in the upper-left corner of the Desktop Console offer fast access to
all of the mixing parameters available in the Fairlight Mixer, without the need to grab your
mouse. Each control button maps a different set of mixing parameters to the upper section of
the channel strips. These parameter control sets are identical to the parameter controls in the
corresponding UI windows accessible in the Fairlight Mixer. Additionally, if you are using an
HDMI monitor with your Desktop Console, the active control set parameters on the monitor
screen are highlighted in blue text.
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If you recall, the control sets include the LCD screens, knobs, and SEL buttons and work
collectively for Focus mode operations. The control area defaults to the standard operational
strip mode whenever there are no control buttons active.
Control Buttons
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Control buttons that assign control sets to the adjacent Select buttons, knobs, and LCDs

Default mode where SEL is Select button, knob controls Pan,
and LCD shows channel info for each of the 12 channel strips.

NOTE: In each of the following control set examples, track A3 DIA - Kate is the active
track. You can easily identify the active track because the track-based Focus mode
control sets always display the active track’s name, number, and color in the first
channel strip’s LCD.
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Control Buttons from left to right, starting with the top row, include:
MSTR: As the name suggests, the Master control button dedicates the adjacent channel strips
and control area to the Master buses. The default Master control set gives you direct channel
control for up to 12 master buses. The knob controls the corresponding Master bus level, while
the SEL button allows the bus to be selected as the monitoring source.

Master control set mapping shows MAIN 1, MAIN 2, SUB 1, SUB 2, AUX 1, and AUX 2

CHNL: The Channel control set assigns up to 12 of the most used channel controls to the knobs
and another of the most used switches to the SEL buttons as primarily In/Out or On/Off
switches. Knob controls update in realtime as they are adjusted. SEL switches illuminate when
latched and the label on the corresponding switch in the LCD turns red. The Channel controls
from left to right are: Active Track DIA - Kate A3, PATH Trim, HIGH PASS FILTER Frequency, Low
EQ Gain, LOW MID Gain, HIGH MID Gain, HIGH Gain, LOW PASS FILT Frequency,
COMPRESSOR Threshold, LIMITER Threshold, PAN Left/Right and Front/Back. These controls
are also available in the associated Focus mode control sets.

Page 1 of the Channel control set mapping

PAN: The Pan control set maps all of the pan parameters available in the Pan window to the
control area knobs with graphical feedback in the LCD. Pan controls are applied to the selected
track. Pan controls assigned to each knob from left to right are: PAN, Left/Right, Front/Back,
Rotate, Spread, Diverge, and Boom. Pan, Divergence, and Boom have On/Off switches
assigned to the adjacent SEL switches.
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Pan control set mapping includes all parameters in Fairlight Pan window

Pan window available in theFairlight page Mixer

Pan control set visual feedback in optional HDMI monitor
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PLUG: The Plug-in control sets differ from plug-in to plug-in. However, for each plug-in slot
there are up to 12+12 user-mappable parameters on the encoder knobs as well as On/Off on
SEL1, plus up to 11 user-mappable switch functions. In this example, the Fairlight FX Echo plug-in
automatically maps parameters to the first 9 knobs and first two switches: ECHO On/Off, FILTER
LowCut and STEREO Switch, FEEDBACK High Ratio, LEFT CHANNEL Delay Time, RIGHT
CHANNEL Delay Time, Feedback Delay, OUTPUT Dry/Wet, and Level.
Hold Plug and press User 1 to User 6 to choose a different plug-in slot for focus. This also opens
the corresponding Plug-in window in the Fairlight page interface.

Echo control set mapping

Echo Plug-in window that mirrors the Plug-in
control set on the Fairlight Desktop Console

EQ: The EQ control set includes two pages of controls. Press the EQ button to load the Page 1
control set. The subsequent channel strips include the controls for Bands 2-5, alternating gain
and frequency on the remaining encoder knobs, while the SEL switches toggle either the
Frequency band ON/OFF of the shape. Hold CTL and press EQ to switch to Page 2. Page 2 of
the EQ control set focuses on the High Pass and Low Pass filters on Bands 1 and 6, and the SEL
switches toggle the filters ON/OFF or shape. Press EQ again to return to Page 1 and repeat as
needed to toggle between Page 1 and Page 2. The EQ control set mirrors all of the parameter
controls available in the Fairlight EQ window.
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EQ control set Page 1 with controls for Bands 2-5

EQ control set Page 2 with controls for the filters on Bands 1 and 6

Fairlight EQ controls available via the Fairlight Mixer

Chapter – 12

Using The Fairlight Desktop Console

312

EQ control set visual feedback in optional HDMI monitor

EXP: The EXP control set includes all of the Expander and Gate parameter controls available in
the Fairlight Dynamics window. The first channel strip shows which track is in focus, or active,
while the SEL button toggles between Expander/Gate controls. The subsequent six channel
strips include knob control for the Expander/Gate parameter in the order they appear on the
Dynamics window. From left to right in Channel Strips 2-7 the controls are: Threshold, Range,
Ratio, Attack, Hold, and Release.

Fairlight Expander/Gate control set

Fairlight Expander/Gate parameters
in the Dynamics windows
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COMP: The Compressor control set includes all of the Compressor parameters as available in
the Dynamics window. As with all of the other control sets, the Channel 1 position is where you’ll
find the On/Off switch assigned to the SEL button. These subsequent controls from left to right
include: Threshold, Ratio, Attack, Hold, and Release on the 2-5 knobs, and a Send/Listen SEL
toggle for SideChain compression in the channel 6 position.

Fairlight Dynamics window, Compressor controls

Fairlight Compressor controls
available via the Fairlight Mixer

LIM: Like the other dynamics control sets, the Limiter control set includes all Limiter parameter
controls assigned to the encoder knobs in the order they appear in the Dynamics window. The
Limiter controls include: On/Off, Threshold, Attack, Hold, and Release.

Fairlight Dynamics window, Limiter controls
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Fairlight Limiter controls available
via the Fairlight Mixer

Fairlight Dynamics Window,
which includes Gate, Expander,
Compressor, and Limiter.

Compressor control set
visual feedback in optional
HDMI monitor. All Focus mode
dynamics parameters grouped
together in one section of
the HDMI data screen. The
active dynamics controls are
highlighted in blue.
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INP: This is the Input button and mirrors the Path Settings controls available on the Input
section of the Fairlight Mixer. These controls appear in the same order as the do in the Fairlight
page: SOURCE, PATH Mic/Inst, Rec Level, Trim, and Direct Output. The INP control set maps
Mic Gain to the Channel 3 knob, or hold ALT to use the same Knob for Rec Level adjustments.

Input control set mapping

Path Settings available in the Input section of the Fairlight Mixer

Input control set with Path visual feedback in optional HDMI monitor
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SEND: This control set uses the SEL buttons to toggle Bus Send 1 On/Off for each of the
12 channels. These send controls mirror the Bus Send controls available in the Fairlight Mixer.
When active, the knob controls the Bus Send 1 Level, or press ALT to control the Bus
Send L/R Pan.

Send control set mapping

Bus Send window available in the Fairlight page Mixer

Send control set visual feedback in optional HDMI monitor
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Fader Channel Strips
The most prominent real estate on the Fairlight Desktop Console is dedicated to the fader
channel strips. As mentioned earlier, the upper section of these channel strips operate
independently in Strip mode, or collectively for Focus mode tasks. The default operational
mode of the console provides 12 fader channel strips, each with a Fader, Mute, Solo and Select
(SEL) button, a rotary control knob for pan adjustments and a LCD Screen that displays channel
information. Any changes applied to the channel strip controls are mirrored in the
DaVinci Resolve Timeline and Mixer accordingly.
The desktop console remains in default mode for standard mixing operations unless one of the
buttons in the control section is selected. For example, you may be using the faders and pan
knobs on-the-fly to adjust track levels and panning during playback. Without stopping, you’d
like to adjust the EQ for the active track. No problem, just press the EQ control button and the
entire upper section of the channel strips, including the SEL buttons, knobs, and LCD screens,
change function to the EQ focused mode. In EQ focused mode, the collective LCD screens,
SEL switches, and knobs control specific EQ parameters that mirror the Fairlight Mixer’s EQ
window controls.
When you finish adjusting the EQ, simply unlatch the EQ control button, and the console returns
to the default mixing functionality. You can switch between control modes as often as you like
during playback, recording, or other mixing tasks.
This section describes the default functionality of the fader channel strips.
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12 fader channel strips with Fader,
Control knob, SEL, Solo, and Mute buttons.

Touch-Sensitive Faders
The bottom-half of the Fader Channel Strip area comprises 12 identical touch-sensitive
motorized faders that offer precision gain controls for 12 signal paths. These faders correspond
with faders on the Fairlight page Mixer. Touching a fader results in realtime graphical and
numeric feedback of the current level on the adjacent LCD screen. Additionally, each weighted
100mm fader has a DC belt-driven cordless motor and offers precision touch-control
fader automation.
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Faders can be reset to unity (0dB) by simply pressing the Control (CTL) button while touching a
fader. Hold Control and swipe your hand along each of the twelve faders to reset them all in a
single maneuver.

Channel Strip Control Buttons
Each channel strip also contains illuminated Mute, Solo, and Select status buttons for the
individual channels. These toggle buttons can be pressed individually or swiped on or off.
Highly-visual LED lights make it easy to spot which buttons are switched on or off at a glance,
which is especially important in the middle of a mixing session. These channel strip buttons and
their toggled states are mirrored in the DaVinci Resolve Edit and Fairlight page Mixers and
Timeline track headers, as well as in the strip mode layout in the optional HDMI monitor.
Channel Strip Control Buttons include:
Key

Hold

Description

SEL: In default mode, this button can be used to select a track,
VCA master, or bus master assigned to that channel strip. Press SEL
once to select or de-select a track. You can select as many tracks as you
need for a given task. Channel buttons, located to the right of the
Channel Strip control buttons, can be used as modifiers to change the
SEL switch functions.
– Latch the AUTO channel modifier button to change the SEL switch

function to Automaton Write.
– Latch the REC channel modifier button to change the SEL switch

function to Arm for recording.
– In Focus mode, latch the ENAB channel modifier button to enable the

SEL switches to be used as Track Select buttons.
SOLO: Use this button to hear only this channel during playback. Multiple
tracks can be soloed simultaneously to isolate selective tracks for
playback while all non-soloed tracks will be muted. Solo buttons work for
the corresponding channel in both Strip and Focus modes.
Use modifier keys for enhanced solo functionality:
– Hold Control and press any Solo button to clear all soloed buttons.
– Hold Control and press any Solo button again to restore soloed tracks.
– Hold ALT and press Solo to toggle on or off Solo Safe status. Tracks

set to Solo Safe will always play, even if Solo is enabled for other
tracks, and are easily identified by the blue-highlighted Solo status
icon in the Fairlight page Mixer and Timeline track headers.
MUTE: This button turns the channel off and on for playback. Mute
buttons on the Desktop Console correspond with the Mute buttons on
the Fairlight page Mixer and track headers.
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Desktop Console with active Mute, Solo, and Select buttons in the fader channel strips

Optional HDMI monitor display showing track status for the channels in Strip mode

Channel Control Knobs
Each channel strip includes a touch-sensitive multi-function encoder knob with realtime
graphical and numeric feedback of the current position on the adjacent LCD screen. The
Channel Control knobs default to left-right (L/R) Pan controls and offer smooth precision rotary
adjustments. The handy touch-control of these knobs is perfect for recording Pan automation
because you can start recording data the instant you touch a knob and stop when you release
it. Knob settings are mirrored in the corresponding Mixing window in DiVinci Resolve.
Use modifier keys for enhanced control knob functionality:
Channel Knob

Hold

Description
– Hold SHIFT in conjunction with the knob for refined

incremental control.
– Hold ALT to switch from L/R Pan to front-back (F/B) panning and

corresponding feedback on the LCD screen.
– Hold CTL and touch any knob to reset the designated

parameter to the default value.

Chapter – 12

Using The Fairlight Desktop Console

320

LCD Screens
At the top of each channel strip you’ll ﬁnd a high-resolution LCD color display that shows the
Track or Bus name, color, metering up to 7.1.4 wide, bus assignments, and panning if in Default
strip mode. The information displayed for each track directly correlates with the Fairlight page
Mixer and track headers.

Fader channel strip LCD
screens showing track name,
number, color, pan status, level
meters, and VCA group number

Fairlight page track headers showing
track name, number, color, and level meters

NOTE: The LCD screens display different information based on the current Control
mode in use on the Fairlight Desktop Console. You’ll find detailed images of the other
Control modes later in this chapter.

Automation Buttons
The Fairlight Desktop Console includes automation controls designed to allow the operator to
record every static and dynamic parameter change you make in the process of balancing,
mixing, and sweetening the overall sound of your timeline in the Fairlight page. The six
Automation buttons offer the same automation controls available in the Fairlight page
Automation toolset.
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Automation buttons include:
Key

Description

ON: Use this button to turn automation mode on and off.

STOP: Toggles the On-Stop mode through Event, Hold, or Return.

MODE: This button toggles between Write or Trim action.
TCH: The Touch button toggles the automation touch mode through three
recording options including: Off, Latch, and Snap.
ENAB: Hold this button while touching any fader strip control to enable/disable
it for automation recording. Simply touch one of the faders or knobs, or press any
channel strip button to enable automation for the designated parameter.
Additionally, the User button Mix User set offers additional enables in the
Enables Quick Menu layout.
CURV: Hold the Curve button and touch any fader strip control to show its
parameter’s automation curve on the selected channels in the Fairlight
page Timeline.

Automation writing fader automation data on the A3 track

Automation mirroring the Desktop Console, writing
fader automation data on the A3 track
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Fairlight page Automation controls

NOTE: Automation is only available in the DaVinci Resolve Fairlight page. For detailed
information about Fairlight’s automation recording toolset and how it works in
DaVinci Resolve, see Chapter 152 “Recording,” in the DaVinci Resolve
Reference Manual.

Channel Buttons
One way the Fairlight Desktop Console is able to pack enhanced functionality with minimal
Channel strip buttons, is to repurpose the SEL button as needed for different workflows. Even
in default mode, the channel select button (SEL) can easily be used as a switch for common
strip mode functions. That’s where the Channel buttons come into play. The Channel buttons
temporarily assign channel-specific button functions from the Fairlight page track headers and
Mixer to the Channel Select button (SEL). When engaged, the Channel buttons turn the SEL
button into a toggle switch that mirrors its functional counterpart on the Fairlight page.
These functional override Channel buttons include ENAB, AUTO, and REC. Plus, there is an A/B
channel button used with USER 1 to USER 6 to control external applications, as well as Left and
Right Bank buttons for mapping and toggling through banks of tracks.
The AUTO, REC, and ENAB channel SEL switch modifier buttons can be latched for extended
use or engaged via momentary press, so you can quickly use the modified SEL switch and
release to return to the task at hand. Pressing any of the focus mode Control buttons will
automatically unlatch the Channel modifier button and reassign the SEL switches accordingly.

Track header includes Automation
Write and REC Arm buttons that
mirror Channel Button functions.
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Channel buttons include:
Key

Hold

Description

AUTO: This button modifies the SEL buttons to switch the channel in and
out of automation writing and can be used on-the-fly to punch in and
punch out during playback. This functions the same as clicking the
Automation Write button on the track header or channel strip in the
Fairlight page Mixer.
REC: Latch this button to assign the SEL switches as Arm buttons to
quickly arm tracks for recording.
ENAB: Use this SEL button modifier to temporarily override the
Focus mode SEL switches and enable them to be used as Track
Select buttons.
A/B: This A/B switch is used in conjunction with USER 1 to USER 6 and
allows the faders to be switched to control external applications via
MCU master mode.
BNK >: Bank Forward banks the faders by 12 forward, or the next
12 channels or buses in the Timeline.
– Hold ALT while pressing this button to bank the faders one at a time.

You can use this ALT banking option to create custom fader banks.
– Hold CTL and press the BNK > button to locate the first bus.
– Hold a fader while pressing the BNK> button to leave that

channel on that strip.
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Key

Hold

Description

< BNK: Bank Back banks the previous set of 12 tracks or
buses to the 12 fader channel strips.
– Hold ALT while pressing this button to bank the faders one at a time

in the relative direction.
– Hold CTL and press the < BNK button to locate the first track.
– Hold a fader while pressing the < BNK button to leave that

channel on that strip.

TIP: When working with high track counts, you can quickly jump to the last track/first
bus by pressing CTL+ BNK >. Once you have located the first bus, you can press <
BNK to bank through your lower tracks 12 at a time from the last track toward the first.
To jump back to the first tracks, press CTL+ < BNK.

Monitoring Controls
The Monitoring controls on the right side of the Fairlight Desktop Console is where you control
the listening levels for the Control Room and Studio speakers. These controls default to Control
Room monitor levels and can be changed at any time using the Monitor knob and buttons. Hold
the CANS button to re-target all of the Monitoring controls for studio monitoring.
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Monitoring Knob
Use this dial anytime during recording, playback, or mixing to adjust the Control Room or Studio
listening levels. Changes to the Control Room levels are reflected in the DaVinci Resolve
Timeline monitoring controls located in the upper-right corner of the Edit page and Fairlight
page Timelines. If you are using an optional HDMI Monitor, you’ll see the monitoring controls in
the upper-left corner of the screen.
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Control Room monitoring controls include:
Key

Hold

Description

DIM: This button reduces the Control Room monitor volume by -15dB.
Press to toggle Dim on or off. The DIM button state is mirrored in the
DaVinci Resolve monitoring controls. When DIM is toggled on, the level
slider in the onscreen monitoring controls turns yellow. Control Room
levels automatically DIM during Studio talkback. Use the Monitoring knob
to adjust the DIM level.
MUTE: Use this button to mute or unmute the Control Room monitors as
well as turn on or off Fixed Level monitoring.
– Press to mute or unmute Control Room monitoring.
– Hold CTL and press Mute to switch on or off Fixed Level monitoring.

When Fixed Level monitoring is switched on, the level slider in the
onscreen monitoring controls turns blue.
– Hold SHIFT + ALT while turning the Monitoring Control Knob to adjust

the fixed level.

SRC: Use this button to toggle between the last two selected monitor
sources. Holding this Source button along with the associated USER
button selects a specific bus for monitoring. For example, If you Hold SRC
and press USER 2, the monitoring will change to bus 2, while holding SRC
and pressing USER 5 will change the monitoring to bus 5.
SPKR: This button toggles between the last two selected monitor sets.
Holding this Speaker button and pressing the associated USER button
selects the specific monitor set. The two default speaker sets are MAIN
and NEAR. Holding SPKR and pressing USER 2 will switch to the NEAR
monitoring set, and holding SPKR and pressing USER 1 will return the
Control Room monitoring to the MAIN speaker set.

Studio monitoring controls include:
Key

Hold

Description

Studio knob: Hold CANS to use this to dial the monitoring level of the
speakers in the Studio.
DIM: Hold CANS and press this button to reduce the Studio monitor
volume by -15dB.
MUTE: Hold CANS and use this button to mute or unmute
Studio monitoring.

Chapter – 12

Using The Fairlight Desktop Console

326

Key

Hold

Description

SRC: Hold CANS while pressing this button to toggle between the last
two selected Studio monitor sources.
SPKR: Hold CANS and press this button to toggle between the last two
selected Studio monitor sets.
TALK: Either Momentary press or latch this button to engage a talkback
microphone. When latched, the talkback mic remains live. Press and hold
the talk button to use talkback without latching. In this case, the talkback
mic will remain live only during the momentary-press and shut off when
you release. Engaging talkback also DIMS the Control Room circuit. You
can modify the talkback functionality and general purpose input and
output (GPI/GPO) in the Talkback controls available in the Fairlight menu
in DaVinci Resolve.
CANS: Hold this button to temporarily target all of the monitoring controls
for Studio monitoring.

NOTE: “Cans” is studio jargon for professional headphones. Studio headphones, or
cans, are a universal symbol for recording studio monitoring. Often the producer,
engineer, and clients sit in the control room and monitor the session via professional
speakers, while the talent, within the studio, monitors playback and performances
via cans.

Fairlight page monitoring controls

Search Dial and Transport Controls
Some of the most useful controls on the Desktop Console are the search dial and transport
buttons which function exactly as expected for a professional audio control surface. The search
dial and surrounding transport buttons offer a complete set of transport commands designed to
let you keep your hand in one position while you quickly navigate the Timeline from end to end
or anywhere in between in seconds. Additionally, the dial can be used for focused timeline
zooming and scrolling.
As a means of navigation, scrubbing, playback and zooming, the dial has four modes of
operation that are initiated by the respective buttons located above and below the search dial.
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Search dial operational modes include the following:
Key

Hold

Description

Jog : This is the search dial’s default operational mode.
In Jog mode, the playhead movement is contingent on the movement of
the dial, so you can freely jog forward or in reverse at variable speeds
while turning the dial and stops when the dial is released. Jog mode is
often used to scrub a specific area to focus on audible cues for mixing,
editing, and trimming.
– If the transport is stopped, press Play to engage the dial. Then turn

the dial to jog.
– If the “Always On” option is checked in System Preferences, the jog

dial unconditionally controls the transport immediately whenever you
move the dial, even during playback. This “always on” convenience
does not affect the transport during recording, Shuttle or Scroll
operations.
– Hold CTRL while turning the jog dial to increase playhead movement.

Release CTRL to return to standard jog speed.
Shuttle: In Shuttle mode, turning the dial forward (clockwise) or back
(counter-clockwise) starts playback in fast forward or rewind at variable
speeds based on the amount the dial is turned. Releasing the dial while
shuttling forward or back will continue constant playback at the current
speed until the playhead reaches the beginning or end of the project.
– In Shuttle mode, holding CTRL while turning the jog dial increases

the speed 8X.
Scroll: In Scroll mode, the playhead position is controlled by the dial to
quickly move earlier or later in the Timeline.
– Hold CTL while scrolling to move the playhead from the project start

(first frame) to the project end (last frame) in a single rotation of the dial.
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Key

Hold

Description

Zoom: The Zoom button, which looks like a magnifying glass, is used in
combination with the dial and modifier keys to offer numerous quick
zooming and scaling options while you work.
The Zoom button can also be combined with the User buttons to show
and map the onscreen User Mapping menu.
– Hold Zoom and turn the dial to change the horizontal scale of the

Timeline on the computer screen.
– Hold CTL + Zoom and turn the dial to change the vertical scale of

the Timeline, which in turn changes the height of the tracks and the
subsequent number of tracks visible in the Timeline.
– Hold Shift + Zoom and turn the dial to move the current track selection

to higher or lower tracks.
– Hold Shift + CTL + Zoom and turn the dial to control waveform zoom of

selected tracks.

X2

– Double-press Zoom to zoom your entire program to fit within the

current visible width of the Timeline. Double-press Zoom again to
toggle back to the previous zoom level.
– Zoom + any User button toggles on or off the User Mapping menu

onscreen. The User Mapping menu is a 2x3 grid that changes in real
time by using the SHIFT and CTL modifier buttons.

NOTE: Horizontal scaling zooms around the playhead, while vertical zooming focuses
on the active selected track.

In addition to the jog dial, you’ll find a set of five standard transport control buttons that can be
used for recording, playback, and navigation.
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The transport buttons include:
Key

Hold

Description

Record: When used in conjunction with Play starts and stops,
recording switches the transport in and out of record mode for the
record-enabled channels.
Fast Reverse: Depending on Control Panel options in System
Preferences, this button either places the transport into rewind or
jumps left.
– Hold CTL and press the Fast Reverse button to jump the playhead to

the project start.
Fast Forward: Depending on Control Panel options in System
Preferences, this button either places the transport into fast forward or
jumps right.
– Hold CTL and press the Fast Forward button to jump the playhead to

the project end.
Stop: You guessed it. This button stops playback or recording.

Play: Places the transport into the default jog mode. Press again
starts playback.
X2

– Double-press Play to start playback when the transport in not

engaged, or in Stop, Shuttle, or Scroll mode.
– Hold CTL and press Play to locate to the last play point and play again.

Control Panels Options in DaVinci Resolve Preferences
The Control Panels preferences offer several options to customize your Desktop Console
transport controls, including:
 Use Fast Forward and Rewind as Jump: Check this option if you want use the Fast
Forward and Rewind keys to jump to clips, fades, markers, or transients on the selected
tracks. Choose the Jump navigation options in the Timeline Options menu in the
Fairlight Page toolbar.
 Always in Jog: When this option is On, any movement of the dial will cause the
transport to switch to Jog. Always in Jog affects the dial when the transport is not in
motion and does not override Shuttle, Scroll, or Record operations.

TIP: Always in Jog is handy while previewing new material, editing, arranging, and
organizing tracks. This is great because you can grab the dial and instantly navigate.
However, when performing complex mixes and writing automation, it’s a good idea to
turn this option off, so you can’t accidentally bump or nudge the dial while you work.
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Audio Console options in System Preferences

Timeline Options menu with navigation options, including:
clips, fades, markers, and transients

Modifier and Undo Buttons
The modifier buttons are conveniently located in the lower-left corner of the console, just where
you are accustomed to finding them on a standard computer keyboard. These versatile buttons
add functionality to other controls throughout the console. There’s also an Undo button that you
can use as often as needed while you work.
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Modifier and Undo keys include:
Key

Hold

Description

SHIFT: The Shift modifier key is used in conjunction with numerous other
buttons and controls to expand functionality. For example, hold Shift
while turning a Channel knob for refined control. Hold Shift + Zoom while
turning the dial to move the current selection to higher or lower tracks.
ALT: Use the ALT button to reveal alternative parameters or functions.
A few examples of ALT modifier functions include:
– Hold ALT to change the Strip mode Pan control knob function from left/

right panning to front/back panning.
– Hold ALT and press Solo to toggle Solo Safe status on or off.

CTL: The Control button is the most commonly used modifier button
and is the easiest to find without looking, since it is the first button in the
lower-left corner of the console. A few examples of the CTL button’s
uses include:
– Hold CTL while touching any Channel Control knobs or faders to reset

them to the default value.

– Hold CTL while using the Search Dial to increase speed.
– Hold CTL and Zoom while turning the dial to zoom vertically.
– Hold CTL and press UNDO to REDO one step.
– Hold CTL and press Left Arrow to mark an In point.
– Hold CTL and press Right Arrow to mark an Out point

UNDO: Use this button anytime you need to go back and Undo your last
step. This works as expected, no surprises here. Just a reliable means of
taking a step back if you make a mistake or get ahead of yourself and
perform an operation you didn’t intend. The good news is that you can
also hold CTL and press UNDO to REDO a step.
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Arrow Keys
These Arrow keys serve a myriad of uses during your post production workflows, from
moving the playhead one frame left or right with the Left and Right Arrows, to jumping clip to
clip up or down the Timeline with the Up and Down Arrows. The Fairlight Desktop Console
includes a set of four arrow keys that you can use for standard arrow movement, as well as
console‑specific operations.
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Arrow buttons, clockwise from the top, include:
Key

Hold

Description

Up Arrow: Use this button to move a selection up in a list, Media Pool or
sound library. The Up Arrow is also used for navigation to move the
playhead to the next clip, fade, marker, or transient in the Timeline. These
“jump to” navigation functions are determined by the Navigation options
in the Timeline Options menu.
– Hold Shift and press Up arrow to move forward to the next marker.

Right Arrow: Used to move the playhead forward one frame or one
second at a time.
– Press Right Arrow to move the playhead one frame forward.
– Hold Shift and press Right Arrow to move one second forward.
– Hold CTL and press Right Arrow to mark an Out point.

Down Arrow: Use this button to move a selection down in a list, Media
Pool or Timeline. The Down Arrow is also used for navigation to move the
playhead to the previous clip in the Timeline. Shift plus the Down Arrow
button moves to the previous marker.
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Key

Hold

Description

Left Arrow: Used to move the playhead back one frame or one
second at a time.
– Press Left Arrow to move the playhead one frame back.
– Hold Shift and press Left Arrow to move one second back.
– Hold CTL and press Left Arrow to mark an In point.

NOTE: Once you set an In or Out point in the Timeline, you can use the dial to extend
the selected range. To clear the In and Out points (Range), press Option-X on the
computer keyboard.

User Buttons
The six sequentially numbered User buttons are user-defined quick keys that change operation
depending on the mode and function in combination with other button groups. For example, a
re-recording mix engineer performs different tasks than the ADR engineer, so each professional
would set up the User buttons to give them easy access to the functions and modes they need
most for their workflow. User buttons can be used alone, or in combination with other buttons
for specific functions and workflows.
At the time of this documentation, the User Buttons are mapped to 6 User Sets, including Edit,
Mix, Record, Views, User 1, and User 2. Each of the 6 User Sets is then mapped to additional
menu layouts each with six menu options related to that set. User button quick menus offer fast
mouse-free two-handed editing options, like those available in the Fairlight Audio Editor. The
difference is that you look at the Quick Menu dialog on the computer screen to see which
functions are assigned to the User buttons instead of the labels on the console keys.
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Working with the User Buttons and the Quick Menu Dialog
The Quick Menu is a dialog in the Fairlight page user interface that you can show or hide by
holding Zoom and pressing any of the User buttons. What makes the Quick Menu dialog unique
is its 2x3 grid design containing six user-defined buttons that can be toggled from the
corresponding User buttons on the Desktop Console. To select an option from the Quick Menu,
you simply press the User button in the same position. This innovative physical button-to-dialog
button relationship makes it easy to learn the quick menus and functions as well as build
lightning-fast muscle memory to trigger the actions while you work.

Six User buttons in a 2x3 pattern and Quick Menu dialog with a 2x3 button grid that matches the
User buttons; Quick Menu shows the User Sets menu and Edit set (User Button 1) option highlighted.

NOTE: The Quick Menu dialog can be moved anywhere on the Fairlight page
interface, so you can see it at a glance, without obstructing view or workflow.

User Button and Quick Menu Functional Overview
The default Quick Menu layout is Edit, however you can change the layout anytime by pressing
the appropriate modifier keys along with the corresponding User button. For ease of operation,
you use the Zoom button to show or hide the Quick Menu, and the modifier keys to change
layouts. It requires two modifier keys (ALT+CTL) to change to a different User set, and one
modifier (ALT) to select a different submenu layout within the current User Set. This is similar to
using a mouse to open a submenu in the Fairlight Page interface, or pressing Menu keys to
reveal Menu Option keys on the Fairlight Audio Editor. Once you have selected a Quick Menu
layout, such as Edit - Basic, you can then engage any of the six actions by pressing the
corresponding User button. User Button layouts are identified by the name in the Quick Menu
header. Hyphenated names represent the current User Set followed by the submenu layout.
For example, EDIT - BASIC identifies the Edit User Set showing the Basic submenu layout of six
different Edit actions that can be engaged by pressing the corresponding User button.
 Press Zoom plus any User button to Show the floating Quick Menu dialog on the
Fairlight Page interface.

+

=

Six User buttons and the EDIT - BASIC User Set
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 Once the Quick Menu dialog is showing, it will remain on screen until you press Zoom
plus a User button to close. You can also close the Quick Menu dialog by clicking the
Close (x) button on the dialog.
 The Quick Menu retains the most recently used layout whenever you show or hide it.
 Press CTL + ALT to show the six User Sets including: EDIT, MIX, RECORD, VIEWS, USER
1 and USER 2.

=

Press CTL + ALT to view the six User Sets

 To choose a User Set, continue holding the CTL + ALT modifiers with one hand and
press the User button that corresponds with the User Set you wish to use with the other
hand. For Example: Hold CTL + ALT to show all 6 User Sets, then press User Button 1 to
show the Edit User Set. Once you have selected the Edit User Set, you can release the
CTL + ALT keys.

+

=

 Press ALT to show the submenu layouts for the current User Set. In this example, there
are four EDIT submenu layouts mapped to the first four buttons.

=

NOTE: Quick Menu buttons that are blank have not been
mapped to a function.

 To choose an option from the Quick Menu, press the User button in the same position.
For example, In the EDIT User Set, the CLIP submenu layout is in the same position
as User 4, therefore, you press User 4 to choose the EDIT-CLIP layout. The EDIT-CLIP
layout, in turn, offers three clip-based actions that can be engaged by pressing the
corresponding User button. No modifier keys are needed to choose an option from the
current user set layout, hence the name Quick Menu.
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+

=

 To quickly change to a different submenu options layout in the same Quick Menu User
Set, press ALT to show the submenu option sets, then press the User button for the
desired layout. In this example, to change from the EDIT-CLIP options to the EDITBASIC options, press ALT to see the different submenu options, and User 1 to choose
the Basic option in the 1 position.

=

+

=

 To engage the options currently mapped to the Quick Menu, press the corresponding
User button. For example, in the Edit - Basic Quick Menu, press User 1 to Cut, User 2 to
Copy, User 3 to Paste, User 4 to Split, User 5 to Trim Head, and User 6 to Trim Tail.
 To hide the Quick Menu dialog, Press Zoom plus any User button.

+

NOTE: Once you incorporate User buttons and Quick Menu options into your
everyday workflows, you’ll find that switching between layouts and engaging
options is as effortless as using keyboard shortcuts or right-click menu options
in the DaVinci Resolve interface.
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EDIT User Set
There are four Edit menu layouts: Basic, Level, Nudge, and Clip. Press ALT to show the different
Edit menu layouts in the Quick Menu dialog. Press the associated User button to choose an Edit
layout. In this case, the Basic button is in the top-left grid position, so pressing the User 1 button
would select the Edit-Basic layout. Once selected, the button in the Quick Menu dialog is
highlighted. Release Alt to show the selected Quick Menu layout with button-menu options
related to specific Editing tasks.

Edit Quick Menu layouts include Basic, Level, Nudge, and Clip.

Edit-Basic Quick Menu layout

Edit-Level Quick Menu layout

Edit-Nudge Quick Menu layout

Edit-Clip Quick Menu layout

Edit Quick Menu layouts and button options include:
 BASIC: Use to this button layout to place common fast-editing actions at your fingertips.
Use the dial and transport controls with your right hand for navigation and selection,
while quickly choosing editing actions via the User buttons with your left hand.
– Cut : Press User 1 to cut the currently selected material and place it in the clipboard.

The cut material maintains its relationship to the playhead in a semi-transparent
form, so you can see exactly where it will be pasted as you move the playhead or
selection to a new location. To Paste the clip, press the User 3 button. Alternatively,
you can cut and paste clips on-the-fly by holding the User 1 button to cut, continue
playback or move the playhead until the semi-transparent clip is in position, then
release the User 1 button to paste.
– Copy: Press User 2 to copy the currently selected material to the clipboard. Move

the semi-transparent copied clip to position, then press the User 3 button to paste.
Since this is a standard clipboard editing tool, you can paste additional copies of the
material by pressing User 2 again. If you’d rather copy and paste during playback,
press and hold User 2 to copy the selection and release to paste.
– Paste: Press User 3 to paste the current clipboard material into the Timeline based

on the selected tracks and playhead position.
– Split: Press User 4 to split the clip or clips at the playhead position, creating a new

edit point between two clips. The split editing action is based on the selected tracks
and playhead position.
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– Trim Head: Press User 5 to erase the portion of the selected clip to the left of the

playhead. Alternatively, press and hold User 5 while the playhead is over a selected
clip to reveal all of the clip’s handles (unused frames) to the left of the playhead.
While continuing to hold User 5, move the playhead along the extended clip to
find a new starting frame. Release User 5 to trim the head of the clip to the new
playhead position.
– Trim Tail: Press User 6 to erase the portion of the selected clip to the right of the

playhead. Alternatively, press and hold User 6 while the playhead is over a selected
clip to reveal all of the clip’s handles (unused frames) to the right of the playhead.
Continue holding User 6 while moving the playhead to the last desired frame.
Release User 6 to trim the clip’s tail to the new playhead position.

NOTE: Although you can manually click to select individual clips with a mouse
while editing with a standard keyboard. Fairlight Console audio editing is
centered around automatic clip selection based on the selected tracks and
playhead position for fast, on-the-fly workflows. As the playhead passes over
a clip on a selected track, that clip is automatically selected, thus allowing
effortless Cut, Copy, Paste, and Trim functions at the touch of a button.

 LEVEL: As the name suggests, the options in this User Button menu are all based on
controlling the selected clip’s level. Like the Edit-Basic options, the Edit-Level options
are based on selection and playhead position.
– Clip Level: Hold User 1 and turn the dial to increase or decrease the selected clip’s

level. This affects the selected clip beneath the playhead and can be performed
while the transport is stopped or during playback as the playhead passes over a clip
in the selected track.
– Fade Head: Press User 3 to apply a fade from the playhead to the head of the

selected clip.
– Fade Tail: Press User 4 to apply a fade from the playhead to the tail of the

selected clip.
– In Shape: Hold User 5 and turn the dial to change the Fade In Shape based on the

playhead position.
– Out Shape: Hold User 6 and turn the dial to change the Fade Out Shape based on

the playhead position.
 NUDGE: This User Button menu layout focuses on refining the positions and
timing of the clips.
– Slip Media: Hold User 1 and turn the dial to slip the clip’s media without changing

the clip duration or position.
– Media Left:
– Media Right:
– Nudge Left: Press User 5 to move the selected clip one frame at a time to the left.
– Nudge Right: Press User 6 to move the selected clip one frame at a time to the right.

 CLIP: Use this menu layout for quick control of the selected clip.
– Mute Clip: Press User 1 to mute (disable) the selected clip within a track. Press User 1

again to un-mute (enable) the clip.
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– Reverse Clip: Press User 2 to reverse the clip beneath the playhead on the selected

track. Press User 2 again to reverse again, so it plays forward.
– Inspect Clip: Press User 3 to show the Inspector panel in the Fairlight Page

interface. Press User 3 again to hide the Inspector.

MIX User Set
There are 5 Mix menu layouts for working with mix automation: Basic, Punch, Preview, Copy/
Paste, and Enables. Press ALT to show the different Mix menu layouts in the Quick Menu dialog.
Press the associated User button to choose a Mix options layout.

Mix Quick Menu layouts include Basic, Punch,
Preview, Copy/Paste, and Enables.

Mix-Basic Quick Menu layout

Mix-Punch Quick Menu layout

Mix-Preview Quick Menu layout

Mix-Copy/Paste Quick Menu layout

Mix-Enables Quick Menu layout 	Mix - unmapped - User-defined
Quick Menu layout

Mix Quick Menu layouts and buttons include:
 BASIC: Use this submenu options layout to access common functions while previewing
or working with previously recorded automation data.
– All Read : Press User 1 to get controls out of Write or Preview before the

transport starts moving.
– Copy Mix: Press User 3 to copy all automation data within the selected range to

the clipboard. This is the first step in copying automation data from one track or bus
to another.
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– Paste Mix: Press User 4 to paste data from a copied automation range into the

range selection in the Timeline, based on enabled parameters in the Automation
toolset. For example, if you copy a range of automation from the MUSIC 1 track,
all of the automation data within that range is copied to the clipboard. However,
if only the Fader and Pan parameters are enabled in the Automation toolset, only
those automation curves will be pasted to the selected range on the Music 2 track in
the Timeline.
– Erase Mix: Press User 5 to erase the automation data within the selected range.

 PUNCH: As the name suggests, the options in this Mix layout offers range-based
options to control when and where new automation data is written into an existing mix.
– Auto In : Press User 1 to start an automation pass, pre-rolling, then punching In at the

range start point.
– Auto Out: Press User 2 to start an automation pass, pre-rolling, then punching in at

the range Out point.
– Auto Punch: Press User 3 performs an automation pass, pre-rolling, then punching In

and Out at the range start and end points.
– Join Mix: Press User 4 to punch into Automation Write with all enabled parameters

during playback, with exactly the parameter values you had when Write last stopped.
This is handy for making a second pass and finessing a section you just mixed.
– Punch In: Press User 5 to switch automation from Preview or Read to Write during

playback. Once you Punch In, all enabled parameters will remain in Write mode until
you stop playback or press User 6 to Punch Out.
– Punch Out: Press User 6 to stop writing Automation and enter Read mode

during playback.
 PREVIEW: This Mix menu layout offers Preview-related mix options that allow you to
suspend Automation Read or Write for enabled controls while you find new settings
for them.
– Preview: Press User 1 to switch on the Preview automation controls and audition new

settings for the enabled controls without changing the recorded automation data.
– Fill Range: Press User 3 to perform and instant automation pass, writing the current

values of all parameters that are in Preview mode through the range.
– Glide Range: Press User 4 to perform an instant automation pass that writes a glide

through the range from the value at the start of the range to the current control level
of the parameter, for all parameters that are in Preview mode.
– Punch In: Press User 5 to switch from Preview to Write mode starting at the point

where you press Punch In and applying the current control levels until you stop
playback or press User 6 to Punch Out.
– Punch Out: Press User 6 to stop writing automation and return to Preview mode

during playback.
 COPY/PASTE: Use this Mix menu layout to quickly copy and paste automation from
one range to another.
– Copy: Press User 1 to copy all automation data within a range.
– Paste ALL: Press User 2 to paste all copied automation data to a range.
– Paste EQ: Press User 3 to paste only the copied EQ automaton data to a range.
– Paste DYN: Press User 4 to to paste only the copied Dynamics automaton data

from the built-in Fairlight Dynamics processing on each track to a range. Dynamics
include: Expander, Gate, Compressor, and Limiter automation.
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– Paste PLUGS: Press User 5 to paste only the copied plug-ins automaton

data to a range.
– Paste PATH: Press User 6 to to paste only the copied Path settings automaton data

to a range.
 ENABLES: Use this menu layout to quickly enable or disable automation recording for
specific parameter sets.
– Fader: Press User 1 to enable or disable Fader automation.
– Mute: Press User 2 to enable or disable Mute button automation.
– Pan: Press User 3 to enable or disable Pan automation.
– EQ: Press User 4 to enable or disable EQ button automation.
– DYN: Press User 5 to enable or disable parameters in the built-in Dynamics window.
– PLUGS: Press User 6 to enable or disable Plug-in automation.

NOTE: The Mix user set and subsequent Quick Menu options are only functional while
the Automation toolset is On and showing in the Fairlight Page user interface. Press
the On button in the Automation area at the top of the Desktop Console to toggle
Automation On or Off.

RECORD User Set
This user set offers the same recording options that are available in the Fairlight Audio Editor for
both Manual and ADR recording. There are four Record Quick Menu layouts: Manual, Rate Clip,
ADR List, and ADR Record.

Record Quick Menu layouts include Manual,
Rate Clip, ADR List, and ADR Record.

Record-Manual Quick Menu layout

Record-Rate Clip Quick Menu layout

Record-ADR List Quick Menu layout

Record-ADR Record Quick Menu layout
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Record Quick Menu layouts and buttons include:
 MANUAL: Use to this button layout to place common fast-editing actions at your
fingertips. Use the dial and transport controls with your right hand for navigation
and selection, while quickly choosing editing actions via the User buttons with your
left hand.
– Rec Here : Press User 1 to initiate the Record Here action from the current playhead

position. When you engage Record Here, the playhead goes back the pre-roll
duration, then punches into Record at the location where you issued the command.
This can be useful when you zoom in to
– Rec Again: Press User 2 to repeat the last recording you made, both entry and exit,

whether it was manually or automatically punched in.
– Rec Clip: Press User 3 to initiate the Record Clip manual recording method. After

pre-roll, the playhead punches in and out to match the duration of the clip under
the playhead on the selected track. If no clip is beneath the playhead, the transport
moves forward to the next clip in the track and records there.
– Rec Range: Press User 4 to record the current range. With this manual recording

method, the playhead includes a pre-roll and punches into Record at the Range In
point, and then punches out at the Range Out point.
– Punch Again: Press User 5 to engage Punch Again recording. Punch Again pre-rolls,

then enters record at the exact same place as last time, whether it was manually
or automatically activated. When entering this record operation, you still need to
manually Punch Out. This allows you to get the same start point for recording but
with a manual exit.
– Rec Head: Press User 6 to enter the Record Head method, which pre-rolls, then

starts recording at the head of the first clip to come beneath the playhead in the
selected track. When entering this record operation, you still need to manually
Punch Out.
 RATE CLIP: As the name suggests, the options in this User Button menu are all based
on rating the ADR recordings from 1-Star (*) to 5-stars (*****). These ratings appear in the
ADR Record panel Take list after each recorded take.
– * : Press User 1 to mark a 1-star rating on the selected take.
– **: Press User 2 to mark a 2-stars rating on the selected take.
– ***: Press User 3 to mark a 3-stars rating on the selected take.
– ****: Hold User 4 to mark a 4-stars rating on the selected take.
– *****: Hold User 5 to mark a 5-stars rating on the selected take.

 ADR LIST: This ADR recording layout offers actions available in the ADR List panel.
These actions are used for selecting and setting ADR cues.
– Prev Cue : Press User 1 to select the previous cue in the Cue list.
– Next Cue: Press User 2 to select the next cue in the Cue list.
– Set Cue In: Press User 3 to set the current Timeline In point as the Cue In.
– Set Cue Out : Press User 4 to set the current Timeline Out point as the Cue Out.
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 ADR RECORD: Use this this ADR recording layout for rehearse and record options
available in the ADR Record panel.
– Prev Cue: Press User 1 to select the previous cue in the Cue list.
– Next Cue: Press User 2 to select the next cue in the Cue list.
– REH Cue: Press User 4 to rehearse the selected cue. This runs the section of the

Timeline specified by a cue without actually recording anything, giving the talent
an opportunity to run through their dialog and practice their timing and delivery.
Beeps and on-screen streamers are not played during a rehearsal.
– Rec Cue: Press User 5 to initiate recording of the cue to the specified audio track,

with cue beeps and video streamer cues.
– Play Cue: Press User 6 to play the currently selected take from the Take list

(described below). If no take is selected, the most recently recorded one on
top is played.

NOTE: At the time of this documentation, the Views, User 1, and User 2 sets are not yet
functional. Stay tuned for future updates where these will be customizable userdefined layouts that can be set up similar to the Keyboard Customization window.

Fairlight Desktop Console
Configurations
There are three ways that you can configure the Fairlight Desktop Console with your
DaVinci Resolve workstation:
As a standalone mixing controller, simply connect the Fairlight Desktop Console to your
DaVinci Resolve computer for professional control of the Edit page Mixer as well as the Fairlight
page recording, mixing, and automation workflows.

Fairlight Desktop Console
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Add a second monitor via HDMI for enhanced visual feedback of the mixing parameters while
you work with the console. This configuration gives you realtime graphical updates on the
screen, similar to the Channel Control LCD in the full-sized modular Fairlight consoles.

Fairlight Desktop Console connected to a second monitor via HDMI for enhanced visual feedback

Fairlight Desktop Console connected to a second monitor via HDMI with nearby computer screen to display the
DaVinci Resolve interface and enhanced channel-based visual feedback from the console on the HDMI screen

Connect to a Desktop Fairlight Audio Editor and DaVinci Resolve computer for control of nearly
every function on the Fairlight Page interface. This expanded desktop configuration is similar to
a 2-bay Fairlight modular console at about half the price.

Fairlight Desktop Console connected to a second monitor and the Fairlight Audio
Editor with DaVinci Resolve computer screen
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Chapter 13

Deliver Page
Improvements
DaVinci Resolve 17 brings numerous improvements for project delivery,
focusing on more advanced settings for professional workflows.
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General Deliver Page Improvements
Resolve 17 has added some technical and usability improvements that apply to the entire
Deliver page.

Media Offline Warning at Render Queue
When you attempt to add a job to the Render Queue with a timeline that contains any offline
material, DaVinci Resolve now automatically gives you a warning. You may choose to either
cancel adding the job, or to add it anyway, knowing you’re about to render one or more
offline clips.

Media Offline warning box that appears if your timeline contains
offline clips or frames and is added to the Render Queue

Support for Using Multiple Databases in Remote Rendering
You can now set up remote renders for projects in all connected Davinci Resolve databases.
Previously, remote rendering would only work with the currently active database. To activate
this feature, check the “Automatically scan other databases for Remote Rendering jobs” box in
the General settings of the System tab, of the DaVinci Resolve Preferences. For more
information on Remote Rendering, see Chapter 166 “Rendering Media” in the DaVinci Resolve
Reference Manual.
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New Features
The Deliver page also has some new features for more advanced workflows.

Script Triggers in the Render Settings
You now have the option of triggering a script to execute before or after rendering a timeline,
by checking the “Trigger Script at” box in the Advanced Settings section of the Video tab in the
Render Settings. You can select the specific script to execute using the corresponding
drop-down menu.
Scripts must be written for the Resolve scripting framework in either Python or Lua, and placed
in the following directory:
 MacOS: /Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/
Scripts/Deliver/
 Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Fusion\Scripts\Deliver
 Linux: /opt/resolve/Fusion/Scripts/Deliver

“Render Codec” Metadata Variable
You can now add the Render Codec as a metadata variable when creating a custom file name
or render path. To use this new variable, press the “%” key in the filename or location fields in
the Render Settings, then start typing the word “render.” You can then select Render Codec
from the scrolling list using the arrow keys.

Specific Format Export Improvements
DaVinci Resolve 17 has introduced a significant improvement to IMF and DCP exporting, as well
as updates to Alpha Channel exports and the Pro Tools Render Setting.

Support for Rendering Alpha Channels in Single Clip Mode
DaVinci Resolve now allows rendering alpha channels in Single Clip mode if the selected codec
supports an alpha channel (i.e., ProRes 4444, DNxHR 444, etc.). This lets you apply a single
alpha channel to an entire timeline for export, rather than just at the individual clip level.
To Render an Alpha Channel in Single Clip Mode:
1 Select “Single Clip” mode in the Render Settings.
2

Select a codec that supports an alpha channel in the Video tab’s Codec and Type
selection boxes.

3

Select the checkbox “Export Alpha” that appears under the Frame rate selector.

4

If supported by the codec, you can chose the Alpha Mode type. Premultiplied is
the default.

If the codec you have selected does not support an alpha channel, the “Export Alpha” box will
not appear as an option.
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Support for Rendering IMF Segments and DCP Reels
DaVinci Resolve now supports splitting IMF and DCP projects into separate segments and
reels, in addition to rendering media as a single file. This can be useful for breaking up your
timeline to fit within allowed file sizes on legacy file systems, separating marketing and studio
assets from the final film, or just being able to replace certain sections of the film without having
to re-encode the entire file.
To Render an IMF Segment or DCP Reel:
1 Choose IMF or DCP from the Format Settings in the Video Tab of the Render
Settings panel.
2

Navigate to the “Segment list” or “Reel list” section of the Composition Settings.

3

Choose from the following options:
– Single segment / reel: Encodes the Timeline into a single file (default setting).
– Regular intervals of: Encodes the Timeline into multiple segments/reels, each one

the duration of the value set in the “mins” field.
– Align to clips on the first video track: Encodes the Timeline into multiple

segments/reels, each individual clip on the V1 track of the Timeline becomes its
own separate file.
– Keep audio as single segment (IMF only): Select this checkbox to keep the audio

portion of the IMF as a single file, regardless of the segment options selected above.
4

Press the Add to Render Queue button.

IMF Segment options

Pro Tools Wave Export of Multichannel Audio
Recent Pro Tools updates have allowed for specific kinds of multichannel audio file support.
DaVinci Resolve 17 has updated its Pro Tools Render Settings to accommodate this feature.
The standard mono round trip export from DaVinci Resolve to Pro Tools remains the default
setting, with the “Render one track per channel” box checked in the Audio tab of the Pro Tools
Render Setting in the Deliver page. With this option, a 5.1 polyphonic .wav file would be
exported as six individual mono .wav files.
With this new feature, if the “Render one track per channel” box is unchecked, DaVinci Resolve
will output multichannel polyphonic .wav files instead. If you do this, it’s important to check in
advance that Pro Tools supports the particular multi-channel formats you want to export before
committing to this workflow.
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